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Preface

Understanding the PeopleSoft Online Help and PeopleBooks

The PeopleSoft Online Help is a website that enables you to view all help content for PeopleSoft
applications and PeopleTools. The help provides standard navigation and full-text searching, as well as
context-sensitive online help for PeopleSoft users.

Hosted PeopleSoft Online Help

You can access the hosted PeopleSoft Online Help on the Oracle Help Center. The hosted PeopleSoft
Online Help is updated on a regular schedule, ensuring that you have access to the most current
documentation. This reduces the need to view separate documentation posts for application maintenance
on My Oracle Support. The hosted PeopleSoft Online Help is available in English only.

To configure the context-sensitive help for your PeopleSoft applications to use the Oracle Help Center,
see Configuring Context-Sensitive Help Using the Hosted Online Help Website.

Locally Installed Help

If you’re setting up an on-premise PeopleSoft environment, and your organization has firewall restrictions
that prevent you from using the hosted PeopleSoft Online Help, you can install the online help locally.
See Configuring Context-Sensitive Help Using a Locally Installed Online Help Website.

Downloadable PeopleBook PDF Files

You can access downloadable PDF versions of the help content in the traditional PeopleBook format on
the Oracle Help Center. The content in the PeopleBook PDFs is the same as the content in the PeopleSoft
Online Help, but it has a different structure and it does not include the interactive navigation features that
are available in the online help.

Common Help Documentation

Common help documentation contains information that applies to multiple applications. The two main
types of common help are:

*  Application Fundamentals
» Using PeopleSoft Applications

Most product families provide a set of application fundamentals help topics that discuss essential
information about the setup and design of your system. This information applies to many or all
applications in the PeopleSoft product family. Whether you are implementing a single application, some
combination of applications within the product family, or the entire product family, you should be familiar
with the contents of the appropriate application fundamentals help. They provide the starting points for
fundamental implementation tasks.
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In addition, the PeopleTools: Applications User's Guide introduces you to the various elements of the
PeopleSoft Pure Internet Architecture. It also explains how to use the navigational hierarchy, components,
and pages to perform basic functions as you navigate through the system. While your application or
implementation may differ, the topics in this user’s guide provide general information about using
PeopleSoft applications.

Field and Control Definitions

PeopleSoft documentation includes definitions for most fields and controls that appear on application
pages. These definitions describe how to use a field or control, where populated values come from, the
effects of selecting certain values, and so on. If a field or control is not defined, then it either requires
no additional explanation or is documented in a common elements section earlier in the documentation.
For example, the Date field rarely requires additional explanation and may not be defined in the
documentation for some pages.

Typographical Conventions

The following table describes the typographical conventions that are used in the online help.

Typographical Convention Description

Key+Key Indicates a key combination action. For example, a plus sign
(+) between keys means that you must hold down the first key
while you press the second key. For Alt+W, hold down the Alt
key while you press the W key.

... (ellipses) Indicate that the preceding item or series can be repeated any
number of times in PeopleCode syntax.

{ } (curly braces) Indicate a choice between two options in PeopleCode syntax.
Options are separated by a pipe (| ).

[ ] (square brackets) Indicate optional items in PeopleCode syntax.

& (ampersand) When placed before a parameter in PeopleCode syntax,
an ampersand indicates that the parameter is an already
instantiated object.

Ampersands also precede all PeopleCode variables.

> This continuation character has been inserted at the end of a
line of code that has been wrapped at the page margin. The
code should be viewed or entered as a single, continuous line
of code without the continuation character.

ISO Country and Currency Codes

PeopleSoft Online Help topics use International Organization for Standardization (ISO) country and
currency codes to identify country-specific information and monetary amounts.
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ISO country codes may appear as country identifiers, and ISO currency codes may appear as currency
identifiers in your PeopleSoft documentation. Reference to an ISO country code in your documentation
does not imply that your application includes every ISO country code. The following example is a
country-specific heading: "(FRA) Hiring an Employee."

The PeopleSoft Currency Code table (CURRENCY CD TBL) contains sample currency code data. The
Currency Code table is based on ISO Standard 4217, "Codes for the representation of currencies," and
also relies on ISO country codes in the Country table (COUNTRY TBL). The navigation to the pages
where you maintain currency code and country information depends on which PeopleSoft applications
you are using. To access the pages for maintaining the Currency Code and Country tables, consult the
online help for your applications for more information.

Region and Industry Identifiers

Information that applies only to a specific region or industry is preceded by a standard identifier in
parentheses. This identifier typically appears at the beginning of a section heading, but it may also appear
at the beginning of a note or other text.

Example of a region-specific heading: "(Latin America) Setting Up Depreciation"

Region Identifiers

Regions are identified by the region name. The following region identifiers may appear in the PeopleSoft
Online Help:

¢ Asia Pacific
*  Europe
e Latin America

¢ North America

Industry Identifiers

Industries are identified by the industry name or by an abbreviation for that industry. The following
industry identifiers may appear in the PeopleSoft Online Help:

e USF (U.S. Federal)

¢ E&G (Education and Government)

Translations and Embedded Help

PeopleSoft 9.2 software applications include translated embedded help. With the 9.2 release, PeopleSoft
aligns with the other Oracle applications by focusing our translation efforts on embedded help. We

are not planning to translate our traditional online help and PeopleBooks documentation. Instead we
offer very direct translated help at crucial spots within our application through our embedded help
widgets. Additionally, we have a one-to-one mapping of application and help translations, meaning that
the software and embedded help translation footprint is identical—something we were never able to
accomplish in the past.
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Using and Managing the PeopleSoft Online Help

Select About This Help in the left navigation panel on any page in the PeopleSoft Online Help to see
information on the following topics:

» Using the PeopleSoft Online Help.
* Managing hosted Online Help.

* Managing locally installed PeopleSoft Online Help.

PeopleSoft CS Related Links

Hosted Online Help Home

PeopleSoft Information Portal

My Oracle Support

Contact Us

Send your suggestions to psoft-infodev_us@oracle.com.

Please include the applications update image or PeopleTools release that you’re using.

Follow Us

Icon Link

Watch PeopleSoft on YouTube

[-]

Follow @PeopleSoft Info on X.

>

Read PeopleSoft Blogs

0]

Connect with PeopleSoft on LinkedIn
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Chapter 1

Getting Started with Student Records

Student Records Overview

Student Records enables you to enter, track, and process all of your academic information. Campus
Solutions minimizes repetitive data entry while enabling you to gain maximum control over the records—
from the course catalog and schedule of classes to student programs, plans, and subplans.

After applicants are admitted and matriculate, Student Records moves forward to activate, enroll, grade,
evaluate, and graduate students. In concert with PeopleSoft Academic Advisement processes, the Student
Records application tracks students through graduation.

Student Records Business Processes

We discuss these business processes in the Student Records business process documentation:

*  Repeat Checking: Enables you to manage students' repeat coursework.

* Course Catalog: Enables you to set up courses.

»  Enrollment Requisites: Enables you to set up requisite groups, equivalencies, and course lists.

*  Schedule of Classes: Enables you to schedule classes, search for facilities, and roll the schedule from
term to term.

» Instructor Workload: Enables you to update, track, and report workload hours for individuals.

*  Program Activation and Management: Enables you to activate students into academic programs and
maintain their academic program, plan, and subplan data.

*  Batch Term Activation: Enables you to activate groups of students into terms.

*  Quick Activation: Enables you to activate students into academic programs, bypassing the Activate
Applications matriculation process (ABPCPPRC) in PeopleSoft Recruiting and Admissions.

»  Student Career Term Record Management: Enables you to monitor and track student career term
related records.

*  Enrollment Appointments: Enables you to create and manage enrollment appointments.
* Class Enrollment Transactions: Enables you to enroll students into classes through various processes.

»  Enrollment Related Processes: Enables you to enroll perform withdrawals and cancellations, manage
wait lists, view summary statistics, and more.
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Enrollment Verification.: Enables you to process enrollment verification reports for students, and
if you have licensed PeopleSoft Learner Services, students can request the enrollment verification
through self service.

Transfer Credit: Enables you to evaluate, process, and post course, test, and other transfer credit using
defined rules or manual rules.

Attendance Tracking: Enables you to generate attendance rosters and track student attendance.

Student Data Tracking: Enables you to link milestones to student records, manage honors and
awards, manage academic standing, track student groups, maintain service indicators, and maintain
extracurricular activities.

Interoperability for Learning Management Systems: Give you the ability to provide a third-party
learning management system (such as Blackboard Courselnfo) with personal profile data for learners
and instructors, including enrollment data and maintenance, and limited course scheduling data
maintenance.

Grading: Enables you to generate grade rosters, enter grades and reviews, the midterm deficiency
report, and the grade lapse process.

Graduation: Gives you the ability to define degrees and honors, run the graduation reporting process,
and graduate students.

Transcripts: Gives you the ability to set up transcript data, define a transcript request, and produce
transcripts.

Academic Statistics Consolidation and Reporting: Enables you to prepare the system to consolidate
academic statistics for students, to run processes that consolidate academic statistics, to make use of
the consolidated statistics after processing them.

(CAN) Canadian Government Reporting: Enables users with an installation country of Canada to
generate reports for federal and provincial agencies.
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Student Records Integrations

The following diagram illustrates the Campus Solutions applications that work with Student Records:

FeopleSoft : eap'.f S
Financial Aid acruiting &
Admissions
PeopleSoft I 1 PeopleSoft
Gradebook Student Financials
o g [
FeopleSoft
Student Records
o ]
Third-party PeapleSoft
distance learning Contributor
vendors Relations
FeopleSoft FeapleSoft
Academic Campus
Advisement Community

We discuss integration considerations in the Student Records implementation topics.

Supplemental information about third-party application integrations is located on the My Oracle Support

website.

Student Records Implementation
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Student Records also provides component interfaces to help you load data from your existing system into
Student Records tables. Use the Excel to Component Interface utility with the component interfaces to

populate the tables.

This table lists all of the components that have setup component interfaces:

Component

Component Interfaces

References

ACAD _CALENDER TBL

SSR_ACAD_CALENDAR TBL

See “Defining Traditional Academic
Calendars” (Campus Solutions
Application Fundamentals).

CIP_CODE TABLE

SSR_CIP_CODE_TABLE

See “Modifying CIP and HEGIS
Codes” (Campus Solutions Application
Fundamentals).

HEGIS_CODE_TABLE

SSR_HEGIS_CODE_TABLE

As above.
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Other Sources of Information

In the planning phase of your implementation, take advantage of all Oracle PeopleSoft sources of
information, including the installation guides, data models, business process maps, and troubleshooting
guidelines.

See PeopleTools: Component Interfaces

See PeopleTools: Setup Manager

Additional Information for Getting Started with Student Records

60

Additional, essential information describing the setup and design of your system appears in two
companion volumes of documentation: Campus Solutions Application Fundamentals documentation and
Campus Community Fundamentals documentation.

See Campus Solutions Application Fundamentals
See Campus Community Fundamentals

For information about deferred processing, see “Additional Information for Getting Started with Campus
Solutions” (Campus Solutions Application Fundamentals).
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Defining Student Records Installation
Settings

Reviewing or Defining Student Records Installation Settings

To review or define Student Records installation settings, use the Student Records Installation component

(SSR_INSTALLATION). The following topics discuss:

* How to review or define Student Records default installation settings.

* How to review or define Enrollment Requirement Roster default installation settings.

* How to review or define Enrollment Requirement Processing default installation settings.

Pages Used to Review or Define Student Records Installation Settings

Page Name

Definition Name

Navigation

Usage

Student Records Installation

SSR_INSTALLATION

Set Up SACR >

Install > Student Records
Installation > Student
Records Installation

Review or define Student
Records default installation
settings for general options,
class searches, and enrollment
requirement / requisite
checking.

Enrollment Requirement
Roster

SSR_INSTALLATION2

Set Up SACR >

Install > Student Records
Installation > Enrollment
Requirement Roster

Review or define default
installation settings for the
enrollment requirement roster.

Enrollment Requirement
Processing

SSR_INSTALLATION3

Set Up SACR >

Install > Student Records
Installation > Enrollment
Requirement Processing

Review or define default
installation settings for
enrollment requirement
processing.

Reviewing or Defining Default Installation Settings

Access the Student Records Installation page (Set Up SACR > Install > Student Records

Installation).
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This example illustrates the fields and controls on the Student Records Installation page. You can find

definitions for the fields and controls later on this page.

Student Records Installation

Defaults & Options

¥ Use SR Class Schedule Facility Conflict Checking
Default Section Size| 30

Student Records Installation Enrl Requirement Roster Enrl Requirement Processing

Transcript Date Print | Do Mot Print Any Dates

GPA Rounding/Truncating Option | Round to 3 decimal places

Class Search

Class Search Results Limits
Warning Limit 50 rows

Error Limit| 9999 rows
Class Search Subject Option

'® Drop-Down List Box '~ Prompt Search

Enrollment Requisite Checking
Validate Conditions Using:

'® Max Program Effdt for Term

') Action Date

When Enrollment Requirement Status is Conditionally Satisfied
'~/ Retum a warning message
'® Success
New Features

¥/ Fluid Self Service
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Defining Student Records Installation Settings

Field or Control

Description

Use SR Class Schedule Facility Conflict Checking

Select to enable facility conflict checking when scheduling
classes. The check box value migrates from the Installation
page to the Academic Institution 2 page to the Campus Table
page. The system uses the value on the Campus Table page
during processing. Clear this check box on the Campus Table
page to use an external facility conflict checking process.

Note: This check box has no relation to the Check for
Facility Conflict check box on the Facility Table page, which
controls whether you can schedule multiple events in the same
facility.

Default Section Size

Enter a number to use as a default for class size. This value

is used in the creation of new class sections. The value is
originally rolled into the Catalog record when it is created, and
then it is used to enter the number by default into the ENRL
CAP field in the CLASS_TBL.

Transcript Date Print

Select the date on which you want the system to print when
printing student transcripts. Select a value to be the default
value when a row is entered. Select one value per term. Values

are:

Print Class Dates: Prints the valid start and end dates for each
class on a transcript.

Print Session Dates: Prints the valid start and end dates for a
session within a term on a transcript.

Print Term Dates: Prints the valid start and end dates for the
term on a transcript.

Do Not Print Any Dates: No dates print on the transcript.

GPA Rounding/Truncating Option (grade point average
rounding/truncating option)

Enter a value to indicate the number of decimal places to
which you want to round or truncate the grade point average
displayed for a student throughout the system. The maximum
allowed is three decimal places.
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Class Search

Field or Control Description

Class Search Results Limits Enter a value in the Warning Limit and Error Limit fields to
indicate the number of classes for the system to display when a
student searches for a class.

*  Warning Limit: When the limit is reached, the student
receives a Warning message. The student can continue to
the search results or cancel and add additional criteria to
narrow the search.

e Error Limit: When the limit is reached, the student
receives an Error message requesting that the student
specify additional search criteria.

Class Search Subject Option Select to indicate whether the Course Subject ficld on the
Search for Classes page appears as a drop-down list box or as
a select subject button.

Note: Regardless of the option setting, the Course Subject
field dynamically changes to a select subject button if the
selected institution has more than 300 course subjects.

Enroliment Requisite Checking

Use this group box to select how the requisite checking process validates programs, plans, and subplans
for requisites that specify program, plan, or subplan conditions—for example, if a student enrolls in

a class for a term and the class has a requisite condition of Plan = BIOCHEM, what is the maximum
effective date that a plan of BIOCHEM can have to meet the requisite for that term.

Validate Conditions Using:
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Field or Control

Description

Max Prog Effdt for Term (maximum program effective date
for term)

Copyright © 1988, 2023, Oracle and/or its affiliates.

This option is selected by default.

The requisite checking process uses the following logic
to establish if a student meets program, plan, or subplan
conditions:

»  If'the enrollment action date is before or equal to the

term begin date, use the term begin date to determine the

program, plan, or subplan: Find the maximum effective-
dated row, where the effective date is before or equal to

the term begin date.

For example, on 05/30/07 a student tries to enroll in

a Fall 2007 class that has a requisite condition of the
LAU program. Fall 2007 commences on 08/30/07. The
student's current program is FAU (with an effective date
of 01/01/06), but the student has a future-dated program
change of 07/01/07 for the LAU program. The student

meets the requisite condition because the maximum

effective-dated program row (which is before or equal to

the term begin date) is for the LAU program.

»  If'the enrollment action date is after the term begin date
and before or equal to the maximum program effective
date for Term, use the action date to determine the

program, plan, and subplan: Find the maximum effective-

dated row where the effective date is before or equal to
the enrollment action date.

For example, on 09/05/07, a student tries to enroll in a
Fall 2007 class that has a requisite condition of the LAU
program. The student transferred to the LAU program
effective 09/02/07. Fall 2007 commences on 08/30/2007
but has a maximum effective for term of 09/14/07. The
student therefore meets the requisite condition.

e If the enrollment action date is after the maximum

program effective date for term, use the maximum

program effective date for term to determine the program,

plan, or subplan: Find the maximum effective-dated
row where the effective date is before or equal to the

maximum program effective date for term.

For example, on 09/17/07, a student tries to enroll in a
Fall 2007 class that has a requisite condition of the LAU
program. Fall 2007 commences on 08/30/07 but has a
maximum program effective date for term of 09/14/07.
The student transferred to the LAU program effective
09/15/07. The student does not meet the requisite
condition, because FAU, not LAU is the program for
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Field or Control

Description

which the maximum effective date is before or equal to

the maximum effective date for term.

Action Date

The requisite checking process uses the enrollment action date
instead of the maximum program effective date for term when
the term begin date is reached:

»  If the enrollment action date is before or equal to the term
begin date, the process uses the same logic as when the
Max Program Effdt for Term option is selected.

*  If'the enrollment action date is after the term begin date,
use the enrollment action date to determine program, plan,
or subplan: Find the maximum effective-date row where
the effective date is before or equal to the enrollment
action date.

For example, on 09/17/07, a student tries to enroll in a
Fall 2007 class that has a requisite condition of the LAU
program. Fall 2007 commences on 08/30/07 but has a
maximum program effective date for term of 09/14/07.
The student transferred to the LAU program effective
09/15/07. The student meets the requisite condition
because LAU is the program for which the maximum
effective date row is before or equal to the enrollment
action date.

When Enrollment Requirement Status is Conditionally Satisfied:

Field or Control

Description

Return a warning message

When requisite checking uses in-progress courses to satisfy an
enrollment requirement, the user receives a warning message
indicating that the prerequisite has been met conditionally and
that the prerequisite must be satisfied prior to the start of the
class.

Success

This option is selected by default. When requisite checking
uses in-progress courses to satisfy an enrollment requirement,

a message of success is returned.

See Understanding Enrollment Requisite Setup and Maintenance
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New Features

Field or Control Description

Fluid Self Service Select this check box together with the check boxes Track

Admin Changes to Classes (on the Class Search Setup page)
and Track Admin Changes to Courses (on the Browse
Course Catalog Options page) to automatically track changes
to courses and classes. These are used to determine what
appears in class search and the course catalog in Fluid user
interface.

See:

»  “Setting Up Class Search and Enrollment for Fluid User
Interface” (Campus Self Service )

*  “Configuring Display Settings for the Course Catalog in
PeopleSoft Fluid User Interface” (Campus Self Service )

Related Links

“Understanding PeopleSoft Fluid User Interface Homepages” (Campus Solutions Application
Fundamentals)

“Setting Up Self-Service Features for Student Records” (Campus Self Service )

“Configuring Search Options in PeopleSoft Fluid User Interface” (Campus Self Service )

Reviewing or Defining Enroliment Requirement Roster Default Installation
Settings

The Post Enrollment Requirement Checking feature:

Provides the ability to capture the status of the enrollment requirement check at the time of enrollment
(satisfied, conditionally satisfied, overridden, permitted, enrollment component). Enrollments that

do not satisfy the requirement are rejected. The feature captures the status for both enrolled and wait
listed students.

Provides the ability for users to re-run the Enrollment Requirement Checking process (where the
Enrollment Engine calls Academic Advisement for enrollment requirement evaluation) on enrolled
and wait listed classes after in-progress grades have been posted. The capability is delivered in on-
line/remote call mode as well as a batch process.

Includes an administrative component that allows decision makers to identify and view students who
are in non-compliance of class enrollment requirements.

Includes functionality to identify and process students that need to be dropped from classes for non-
compliance as a result of post-enrollment requirement checking.

Through the use of communications, includes functionality to notify students when they have been
administratively dropped from a class for non-compliance.
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If you plan to use communications for post enrollment requirement checking, use the instructions in
the following document to set up communications and then use the 3Cs process to create and generate
the communication, see PERC Communications Setup and Processing in My Oracle Support (ID
1982691.1).

» Includes a batch process to generate reports of students in non-compliance of enrollment
requirements.

Access the Enrollment Requirement Roster page (Set Up SACR > Install > Student Records
Installation > Enrollment Requirement Roster).
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This example illustrates the fields and controls on the Enrollment Requirement Roster page. You can find
definitions for the fields and controls later on this page.

Student Records Installation Enrl Requirement Roster Enrl Requirement Processing

Enroliment Requirement Roster

Collapsible Area Defaults

[] Collapse Course Information group box
O Collapse Enroliment Requirement group box
i Collapse Filter group box

Roster and Batch Processing Filter Default Settings

Enrollment Status
Display Enrolled Waitlisted il Cropped

Most Recent Requirement Status
Display students in non-compliance
Mot Satisfied Conditionally Satisfied
Display other students
] Enroliment Component [] Overridden

(1 Permitted [] satisfied [ unknown

Drop Review for Batch Processing

Enroliment Requirement Rosters must be reviewed prior to batch processing of
drops

Enroliment Action Reason

When a student is dropped for non-compliance of enrollment requirements, set Drop
Action Reason to:

PERC

Additional Student Information for Decision Makers

Provide link to student Course History

Provide link to Student Statistics
(&) Academics page from Student Senices Center
) Administrative Term History page

Security

[] Enforce Academic QOrganization Security

Notes

[] Enable notes to be deleted
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Find documentation about the pages that are used to run Post Enrollment Requirement Checking—the
Enrollment Requirement Roster page and the Run Post Enrollment Requirement Checking page—in the
Post Enrollment Requirement Checking topics.
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Field or Control

Description

Collapse Course Information group box, Collapse
Enrollment Requirement group box, and Collapse Filter
group box

Clear these check boxes if you want course information,
enrollment requirement description, and enrollment
requirement roster filter to appear expanded by default on the
Enrollment Requirement Roster. Select if you want the fields
to appear collapsed.

Regardless of this setup, you can expand and collapse the
fields on the Enrollment Requirement Roster.

Roster and Batch Processing Filter Default Settings

Field or Control

Description

Enrollment Status

Select the enrollment statuses that you want to appear by
default in the Set Filter Options group box on the Enrollment
Requirement Roster. You can override the values on that page.

Most Recent Requirement Status: Display Students in non-
compliance

Select the enrollment requirement non-compliance statuses
that you want to appear by default on the Enrollment
Requirement Roster. You can override the values on that page.

Most Recent Requirement Status: Display other students

Select any additional enrollment requirement statuses you
want to appear by default on the Enrollment Requirement

Roster. You can override the values on that page.
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Drop Review for Batch Processing

Defining Student Records Installation Settings

Field or Control

Description

Enrollment Requirement Rosters must be reviewed prior
to batch processing of drops

Select this check box to ensure that an enrollment requirement
roster is set to Review Complete before batch drop processing
occurs. The Review Complete for Batch Drop Processing
check box appears on the Enrollment Requirement Roster and
the following message appears on the Process Drop Requests
for Post Enrollment Requirements batch processing page:
Drops are only processed for classes where Drop Review is set

to Complete.

Clear this check box if you do not use batch processing of
drops or if you do not want to ensure that the enrollment
requirement roster is reviewed before batch dropping students
for non-compliance. The Review Complete for Batch Drop
Processing check box is not available on the Enrollment
Requirement Roster and the message does not appear on the
batch drop processing page.

Enrollment Action Reason

Field or Control

Description

When a student is dropped for non-compliance of
enrollment requirements, set Drop Action Reason to

Define a default drop action reason code value to be used
when a student is dropped for non-compliance of enrollment
requirements. The value action reason code of PERC is
delivered but can be changed. The value should be unique.
When a class is dropped using the action reason code of
PERC, the enrollment record is retained regardless of the
Academic Calendar date for the drop delete deadline.

Additional Student Information for Decision Makers

Field or Control

Description

Provide link to student Course History

Select this check box to allow decision makers and other

users to access student course history from a link on the
Enrollment Requirement Roster (the Course History link on
the Audit / Information Links tab). Clear the check box to hide
the Course History link.
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Field or Control

Description

Provide link to Student Statistics

Select this check box to allow decision makers and other
users to access student academic statistics from a link on the
Enrollment Requirement Roster (the Statistics link on the
Audit / Information Links tab). Select an option to identify
whether the user links to the Academics page (recommended)
as used in the Student Services Center or the Administrative
Term History page. Clear the check box to hide the Statistics
link.

Security

Field or Control

Description

Enforce Academic Organization Security

Select this check box to enforce academic organization
security within the Enrollment Requirement Roster and related
processing.

Notes

Field or Control

Description

Enable notes to be deleted

Select this check box to enable notes to be deleted from the
Enrollment Requirement Roster: Tracking of Key Transactions

& User Notes page. Clear to prevent notes from being deleted.

Reviewing or Defining Enroliment Requirement Processing Default

Installation Settings

Find documentation about the pages that are used to run Post Enrollment Requirement Checking—the
Enrollment Requirement Roster page and the Run Post Enrollment Requirement Checking page—in the

Post Enrolment Requirement Checking topics.

Access the Enrollment Requirement Processing page ((Set Up SACR > Install > Student Records
Installation > Enrollment Requirement Processing).
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This example illustrates the fields and controls on the Enrollment Requirement Processing page (1 of 2).
You can find definitions for the fields and controls later on this page.

Student Records Installation Enrl Requirement Roster Enr Requirement Processing

Enroliment Requirement Processing

Allow Post Enroliment Requirernent Checking to be run from Enroliment
Requirement Roster
Allow Drop Request Indicator to be set for Students in Mon-Compliance
Default to:
] If process results in a status of Conditionally Satisfied
F If process results in a status of Mot Satisfied

Page Processing
Run Post Enrollment Requirement Checking

Allow Drop Processing to be run from Enrallment Requirement Roster
Default drop process to:
For students listed above, process drops for:
(® selected students
() students where Drop Request Indicator is selected
O students with a post enrollment requirement status of;

Conditionally Satisfied
Mot Satisfied

Allow Override of Action Date

Process Drops for Hon-Compliance

Return YWarning Message when processing more than | 15 students at a time

Error Message - Limit page processing to a maximum of | 20 students at a time

Processing Limit
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This example illustrates the fields and controls on the Enrollment Requirement Processing page (2 of 2).
You can find definitions for the fields and controls later on this page.

Batch Processing

Hun Po=t Enrollment Requirement Checking

Allow Drop Request Indicator to be set for Students in Mon-Compliance
Default to:
O] If process results in a status of Conditionally Satisfied
I If process results in a status of Mot Satisfied

Proc:ess Drop= for Non-Compliance

Default Mon-Compliance Selection Tao:
Frocess Drops for:
(* students where Drop Request Indicator is selected

) students with a post enrollment requirement status of:

Conditionally Satisfied
Mot Satisfied

Allow Override of Action Date

Communication Category Default

|F'ERC PERC Processing

Use the Page Processing group box to select the information and values that you want to appear by default
on the Enrollment Requirement Roster.

Page Processing: Run Post Enroliment Requirement Checking

Field or Control Description

Allow Post Enrollment Requirement Checking to be run Select this check box to allow users to run post enrollment
from Enrollment Requirement Roster requirement checking from the Enrollment Requirement
Roster. If selected, the Run Post Enrollment Requirement
Checking group box appears on the roster. If cleared, the
group box is not available—users would instead run batch post

enrollment requirement checking.
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Field or Control

Description

Allow Drop Request Indicator to be set for Students in
Non-Compliance

If post enrollment requirement checking is enabled, select this
check box to allow the Drop Request Indicator to be set from
the Enrollment Requirement Roster processing page: If the
check box is selected, the Set Drop Request for Students in
Non-Compliance options appear in the Run Post Enrollment
Requirement Checking group box on the roster. If the check
box is cleared, the options are hidden.

Default to: If process results in a status of Conditionally
Satisfied and Default to: If process results in a status of Not
Satisfied

If you have selected the Allow Drop Request Indicator to
be set for Students in Non-Compliance check box, use these
check boxes to set the status default settings—Conditionally
Satisfied and Not Satisfied—on the Enrollment Requirement
Roster.

You can override the values on the Enrollment Requirement
Roster.

Page Processing: Process Drops for Non-Compliance

The check boxes and values that are selected here appear by default on the Enrollment Requirement

Roster but can be overridden on that page.

Field or Control

Description

Allow Drop Processing to be run from Enrollment
Requirement Roster

Select this check box to allow users to run drop processing
from the Enrollment Requirement Roster. If selected, the
Process Drops for Non-Compliance group box appears on
the roster page. If cleared, the group box is not available—

users would instead run batch drop processing.

Default drop process to:

If drop processing is enabled from the Enrollment
Requirement Roster, define the default selection to:

+  selected students: The drop process is run only for
selected students.

+ students where Drop Request Indicator is selected:
The drop process is run only for students for whom the

Drop Request Indicator value is selected.

+  students with a post enrollment requirement status
of: The drop process is run only for students with a post
enrollment requirement status of either Conditionally
Satisfied or Not Satisfied. When this option is selected,
the Conditionally Satisfied and Not Satisfied check
boxes become available for selection.
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Field or Control

Description

Allow Override of Action Date

If drop processing is enabled from the Enrollment
Requirement Roster, select this check box to allow a user to
override the action date: the Override Action Date check box
is available on the Enrollment Requirement Roster. The user

must have enrollment security to override the action date.

Page Processing: Processing Limit

Field or Control

Description

Return Warning Message when processing more than

Set the maximum number of students that can be selected for
page processing before receiving a warning message. Our
recommendation for a warning message is for 15 students—
you therefore receive a warning message when 16 students or

more are selected.

Error Message - Limit page processing to a maximum of

Set the maximum number of students that can be selected for
page processing before receiving an error message. To assist
with response time, use batch Post Enrollment Requirement
Checking processing for large numbers of students. Our
recommendation for an error message is for 20 students—you
therefore receive an error message if 21 or more students are

selected.

Batch Processing: Run Post Enrollment Requirement Checking

Field or Control

Description

Allow Drop Request Indicator to be set for Students in
Non-Compliance

Select this check box to allow the Post Enrollment
Requirement Checking batch process to set the Drop Request
Indicator for a student when the process results in a non-
compliant status. If you select this check box, the Action
group box which contains the Set Drop Request Indicator
for Students in Non-Compliance options is available on the
Run Post Enrollment Requirement Checking page.

Default to: If process results in a status of Conditionally
Satisfied and Default to: If process results in a status of Not
Satisfied

Use these check boxes to set the status default settings on
the Run Post Enrollment Requirement Checking page:
Conditionally Satisfied status and/or Not Satisfied.

You can override the values on the batch processing page.
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Batch Processing: Process Drops for Non-Compliance

Field or Control

Description

Default Non-Compliance Selection To

Process administrative student drops for students who are non-

compliant with class enrollment requirements.

Process Drops for

Set the default options that you want to appear in the Non-
Compliance Selection group box on the Process Drop

Requests for Post Enrollment Requirement page:

+ students where Drop Request Indicator is selected: the
process drops only students for whom the drop request

indicator is selected.

*  students with a post enrollment requirement status
of:When this option is selected, the Conditionally
Satisfied and Not Satisfied check boxes become available
for selection. The process drops only students that have
a non-compliant post enrollment requirement status that
matches the check box selection.

Allow Override of Action Date

Select this check box to allow a user to override the action
date for Process Drop requests: the Override Action Date
check box is available on the Process Drop Requests for Post
Enrollment Requirement page. The user must have enrollment

security to override the action date.

See Managing the Enrollment Requirement Roster

Communication Category Default

This value default is used when creating communications for PERC. A value of PERC is delivered but

can be changed. The value should be unique.

See “Defining a Communication Category” (Campus Community Fundamentals).

If you plan to use communications for post enrollment requirement checking, use the instructions in the
following document to set up communications and then use the 3Cs process to create and generate the

communication:

See: PERC Communications Setup and Processing.pdf in My Oracle Support (ID 1982691).
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Preparing for the Course Catalog and
Schedule of Classes

Setting Up Catalog and Schedule Options

When you first create or update the course catalog and schedule of classes, the system prompts you for
various types of optional course and class data. This section discusses how to:

Define class notes.

Define global notes.

Define course attributes.

Define when a course is typically offered.
Define exam codes.

Define course material types.

Define course material type order.

Pages Used to Set Up Catalog and Schedule Options

Page Name Definition Name Navigation

Usage

Class Notes Table CLASS NOTES_TBL Curriculum

Management > Schedule
of Classes > Class Notes
Table > Class Notes Table

Define class notes.

Global Notes Table GLOBAL NOTES TBL Curriculum

Management > Schedule
of Classes > Global Notes
Table > Global Notes
Table

Define global notes.

Course Attributes CRSE _ATTR TBL Set Up SACR > Product
Related > Student
Records > Curriculum
Management > Course
Attributes > Course
Attributes

Define course attributes and
attribute values.
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Page Name

Definition Name

Navigation

Usage

Course Typically Offered

SSR_CRSE TYP_OFFER

Set Up SACR > Product
Related > Student
Records > Curriculum
Management > Course
Typically Offered

Define when a course is
typically offered.

Exam Code Table

EXAM_CODE

Curriculum

Management > Schedule
of Classes > Exam Code

Table > Exam Code Table

Define exam time codes
for different types of
examinations.

Course Material Type

SSR_CRSE_MAT TBL

Set Up SACR > Product
Related > Student
Records > Curriculum
Management > Course
Material Type > Course
Material Type

Define course material types.

Course Material Type Order

SSR_CRSE_MAT_ORD

Set Up SACR > Product
Related > Student
Records > Curriculum
Management > Course
Material Type Order >
Course Material Type Order

Organize course material to be
displayed in a specific order.

Defining Class Notes

80

Access the Class Notes Table page (Curriculum Management > Schedule of Classes > Class Notes
Table > Class Notes Table).

Note: Class notes differ from global notes in that class notes are attached to classes on the Notes page,
whereas global notes are attached to entire academic subject areas or academic groups.

Field or Control

Description

for the note.

Effective Date Enter an effective date for the class note. The effective date
determines when the status that you select is valid.

Status Select a status for the class note. Select Active when adding
a new class note. Select /nactive if your institution no longer
uses this class note.

Description In the Description field, enter a short, informative description

This is used for internal processes only.
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Field or Control

Description

Long Description

In the Long Description field, enter a detailed description for
the note.

This text appears in the schedule of classes if you assign this
note to a class on the Notes page.

Defining Global Notes

Access the Global Notes Table page (Curriculum Management > Schedule of Classes > Global

Notes Table > Global Notes Table).

Note: You always associate global notes with an academic institution, academic group, and term. You
can further associate global notes with a subject area. If you do not specify a subject area, the global note
appears on the top of every corresponding schedule of classes page, before or after the academic group or

subject area.

Field or Control

Description

Print Location

Indicates whether the note text appears on the schedule of
classes report before or after the subject area (if you specify
a subject area), or whether the note text appears before or
after the academic group for the term (if you do not specify
a subject area). Available values are Print After and Print
Before. You should not change these values because doing so
requires a substantial programming effort.

Description

Enter a short description for the global note.

Long Description

Enter a detailed description for the global note.

This text appears on the schedule of classes report in the
location that you specify.

Defining Course Attributes

Access the Course Attributes page (Set Up SACR > Product Related > Student Records >
Curriculum Management > Course Attributes > Course Attributes).
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This example illustrates the fields and controls on the Course Attributes page. You can find definitions for

the fields and controls later on this page.

Course Attributes

Course Attribute: HOM

First | 4] 1 of 1 n Last

Find | Views Al

*Course Attribute Value: DHON

*Effective Date: 010111900 5 *Status: =
*Description: [Hanors Course
Short Description: Honors Show In Class Search
Attribute Values pind | view Al First Bl 12 or2 B Laet
“Course Attribute Value: ICHON [¥] catalog Print Schedule Print =
“Description: |Cu|lege Honors Show In Class Search
“Formal Description: [Conege Honors Course
=

Catalo-g Print Schedule Print

“Description: |Departmenta| Honors

Show In Class Search

|Departmenta| Honors Course

*Formal Description:

Note: Use course attributes for institutional research purposes and to print repetitive text in the schedule
of classes or course catalog, such as Offered in Fall Only. Course attributes are attached to courses on
the Catalog Data page and to classes on the Basic Data page. Unlike requirement designations, course
attributes do not transfer to PeopleSoft Academic Advisement.

Field or Control

Description

Status

Select a status for this course attribute. Select Active when
adding a new course attribute. Select /nactive if your
institution no longer uses this attribute and any of the
corresponding attribute values.

Description

The description that you enter here appears on the schedule
of classes report or the course catalog report if you select the
Schedule Print check box or the Catalog Print check box.

Course Attribute Value

When you attach attributes to courses and classes, you can
also specify attribute values. Therefore, you can define parent
course attributes that have one or more attribute values.

Insert rows to create multiple attribute values.
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Field or Control Description

Catalog Print Select to display the course attribute formal description in the
course catalog report.

Note: The SSR_COURSE (Course Catalog) web service is
one of a number of delivered Enrollment Web Services. The
service operation SSR_ GET_COURSES: Browse Course
Catalog Summary obeys the Catalog Print setup that you
select on the Course Attributes page and on the Requirement
Designation Table page.

For detailed information about Enrollment Web Services, see
Enrollment Web Services Developers Guide and Enrollment
Web Services Users Guide in My Oracle Support (ID 1371391.

1.

Schedule Print Select to display the course attribute formal description in the
schedule of classes report.

Show in Class Search If this check box is selected for a Course Attribute and the
Class Search Profile (for example, STDNT) includes a search
criteria of Course Attribute, then a student can search by the
Course Attribute in Self Service.

If this check box is selected for a Course Attribute Value,
the Class Search Profile (for example, STDNT) includes a
search criteria of Course Attribute, and the Include Course
Attribute Value check box is selected for the profile, then
a student can search by the Course Attribute Value in Self
Service.

See Setting Up Class Search Profiles

See “Searching for Classes Using Classic Self-Service Pages”
(Campus Self Service )

See Searching for Classes

Description Enter a description of the attribute values.

Formal Description Enter the text that you want to appear on the schedule of
classes report or the course catalog report if you select the
Schedule Print check box or the Catalog Print check box.

Defining When a Course is Typically Offered

The values that you define here are available in the Course Typically Offered field on the Offerings page
of the Course Catalog component.

Related Links

Creating Course Offerings
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Access the Exam Code Table page (Curriculum Management > Schedule of Classes > Exam Code
Table > Exam Code Table).

This example illustrates the fields and controls on the Exam Code Table page. You can find definitions for
the fields and controls later on this page.

Exam Code Table

Academic Institution:
Term:
Session:

PSUMNY PeopleSoft University
0310 1998 Spring
1 Regular Academic Session

[IitF [osrzoieee [ [200aM [11:00am  [Final ~| [:004m 1210 TR T F [T [ [=]

=zl izisem |zosemw R R TR TOC [F [

i T I BT I i 2 i i i i N E

[ItreF P |osrz0r1 998 3 [12:30PM [#:30PM [Final
[TRAM o5 ar 998 [H [g:00aM [11:008m  [Final
[TRPM o5 a1 998 [ [12:30PM [#30PM [Final

R R T s 2 i 2 i i i I R

Note: Define exam time codes for each term and session. The system uses these codes when you run
the exam scheduling process on the Exam Scheduling page. You can also manually post these codes to

individual classes.

Field or Control

Description

Exam Time Code

Enter an exam time code to define (in an abbreviated manner)
the exam code.

Exam Date

Enter the date for the exam.

Exam Starting Time

Enter the start time of the exam.

Exam Ending Time

Enter the end time of the exam.

Exam Type

Select the exam type. Values for this field are delivered with
your system as translate values. You can modify these translate
values.

Class Start Time From

Enter the minimum start time for classes with which you want
to associate the exam time code. The system uses the value
during the exam scheduling process. The system schedules
exams for classes that fall within the two start times (and days)
that you designate.

84

Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 3

Defin

Preparing for the Course Catalog and Schedule of Classes

Field or Control

Description

Class Start Time To

Enter the maximum start time for classes with which you want
to associate the exam code. The system uses the value during
the exam scheduling process. The system schedules exams for
classes that fall within the two start times (and days) that you
designate.

M (Monday), T (Tuesday), W (Wednesday), T (Thursday), F
(Friday), S (Saturday), and S (Sunday)

Select the days of classes that you want to associate with the
exam code.

Related Links
Scheduling Examinations

ing Course Material Types

Access the Course Material Type page (Set Up SACR > Product Related > Student Records >
Curriculum Management > Course Material Type > Course Material Type).

Field or Control

Description

Status Select a status for this course material type. Select Active when
you add a new course material type. Insert a new effective date
and select /nactive if your institution no longer uses this course
material type.

Description The description that you enter here appears in the Textbook

Assignment group box on the (Schedule of Classes) Textbook
page and is used on the Class Detail page and the Faculty and
Student Center Textbook Summary page.

See Defining Textbooks for Classes

See “Searching for Classes Using Classic Self-Service Pages” (Campus Self Service )

See “Viewing a Class Schedule” (Campus Self Service )

See “Using the Self-Service Faculty Center” (Campus Self Service )

Defining Course Material Type Order

Access the Course Material Type Order page (Set Up SACR > Product Related > Student
Records > Curriculum Management > Course Material Type Order > Course Material Type

Order).
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This example illustrates the fields and controls on the Course Material Type Order page. You can find
definitions for the fields and controls later on this page.

Course Material Type Order

1 |_ TEXTBOOK — C Tembook
2[20  ARTICLE @ Adicle
330  |OTHER CL Other Course Material =]

EI

Note: The system uses the display order that you define here to determine the order in which course
materials appear on the Class Detail page and on the self-service Faculty and Student Textbook Summary
pages. If you do not define a course material display order, the course material appears at the end of the

li

1st.

Field or Control

Description

Display Order Define the order in which you want the course material type
to appear on Class Detail page and on the faculty and student
Textbook Summary pages.

Course Material Type Select a value based on the course material type values that
you defined on the Course Material Type page.

Description The description appears by default from the Course Material

Type page.

Defining Buildings, Rooms, and Classroom Facilities

86

To set up facilities, use the Building Table (BLDG_TBL), Room Characteristics Table
(ROOM_CHRSTC_TBL), and Facility Table (FACILITY_TBL) components.

During the class scheduling process, you probably need to assign classes to classrooms, and you should
set up your classroom facilities in advance. This section discusses how to:

Define buildings.

Define room characteristics.
Define facilities and rooms.
Define facility components.

Define facility characteristics.
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Pages Used to Define Buildings, Rooms, and Classroom Facilities

Page Name

Definition Name

Navigation

Usage

Building Table

BLDG_TBL

Set Up SACR >
Foundation Tables >
Facilities > Building
Table > Building Table

Define all campus buildings
that you might use in class
and event scheduling.
Building codes that you create
here are prompt values on the
Facility Table page.

Room Characteristics Table

ROOM_CHRSTC TBL

Set Up SACR >
Foundation Tables >
Facilities > Room
Characteristics Table >
Room Characteristics Table

Define room characteristics,
such as types of seating

and resources that are
available. You attach room
characteristics to facilities
on the Facility Characteristic
page and you can use them
when you:

¢ Define courses.

e Schedule classes.

e Plan events.

You must enter a numeric

room characteristic code from
01 to 96.

Facility Table

FACILITY_TBL

Set Up SACR >
Foundation Tables >
Facilities > Facility
Table > Facility Table

Define facilities and facility
components.

Facility Component

FACILITY_COMPONENT

Set Up SACR >
Foundation Tables >
Facilities > Facility
Table > Facility
Component

Link components of facilities
to parent facilities.

Facility Characteristic

FACILITY CHRSTC

Set Up SACR >
Foundation Tables >
Facilities > Facility
Table > Facility
Characteristic

Define room characteristics
and facility blackout times.

Defining Buildings

Access the Building Table page (Set Up SACR > Foundation Tables > Facilities > Building

Table > Building Table).

Copyright © 1988, 2023, Oracle and/or its affiliates.

87



Preparing for the Course Catalog and Schedule of Classes

Chapter 3

Field or Control Description

Status Select the status of the building. Select Active when the
building is being used on the Facility Table page. Select
Inactive when you no longer use the building.

Description Enter a description of the building.

Short Description Enter a short description of the building.

Defining Room Characteristics

Access the Room Characteristics Table page (Set Up SACR > Foundation Tables > Facilities >
Room Characteristics Table > Room Characteristics Table).

Field or Control Description

Status Select a status for this room characteristic. Select Active when
adding a new room characteristic. Select nactive only if your
institution no longer uses this room characteristic.

Description Enter a description.

Short Description Enter a short description.

Defining Facilities and Rooms

Access the Facility Table page (Set Up SACR > Foundation Tables > Facilities > Facility

Table > Facility Table).
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This example illustrates the fields and controls on the Facility Table page. You can find definitions for the

fields and controls later on this page.

Find | View & First P4 4 of 1 [ Lot

[+[=]

I Active A I

Facility Tahle acility Component
SetlD: oMY
Facility ID: AMGE101
*Effective Date: [0 800 [
*Description: |&ngelt 01
*Short Description: Angel101
*Building: laNGE
Room: 1
*Location Code: [HacENDA @
*Facility Type: Im,
Academic Organization:
Minimum LHilization Percent: I_D

™ Facility Group

¥ General Assignment

¥ Check for Facility Conflict

T

I j‘

As an example, you might want to define Angel Hall Room 125 and its components, Angel 125A, 125B,
and 125C. You cannot link components to parent facilities on the Facility Component page unless you
first define both the parent facility and the facility components on the Facility Table page.

Field or Control Description

Status Select a status for this facility. Select Active when adding a
new facility. Select Inactive only if your institution no longer
uses this facility.

Facility Group If this check box is selected and unavailable for entry, the
facility is a parent facility with facility components.

Building Enter the building in which the facility is located. Define
buildings on the Building Table page.

Room Enter the room number.

Capacity Enter the maximum number of people that a facility
accommodates.
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Field or Control

Description

Location Code

You can specify locations such as a building cluster on campus
or satellite campuses. Define location codes on the Location
Address page (Set Up Common Objects > Foundation
Tables > Organization > Location Address

See:

»  “Setting Up Locations” (Campus Solutions Application
Fundamentals)

*  PeopleSoft HCM: Application Fundamentals “Setting Up
Organization Foundation Tables”

Facility Type Select a facility type to further define the space. Values for this
field are delivered with your system as translate values. You
can modify these values.

Partition Select a partition field value to indicate the section of the

campus where the facility is located, such as First, Second,
Third, or Fourth quadrant. Use the Partition field to interact
with Universal Algorithm Schedule25, which can look at
where an instructor's office is located and attempt to schedule
the instructor's classes in facilities within the same partition.
The maximum number of partitions for Universal Algorithm
Schedule25 is 96. Therefore, be sure that you select a value
between 0/ and 96. Values for this field are delivered with
your system as translate values. You can modify these values.
For more information about the interface with Universal
Algorithm Schedule25, refer to the Universal Algorithm
Schedule25 documentation.

Academic Organization

Enter an academic organization to indicate that this facility

is reserved for the sole use of that academic organization.
Locations might be reserved by an academic organization so
that only classes for that academic organization are assigned
to that location when you are using the Universal Algorithm
product, Universal Algorithm Schedule25. When using the
PeopleSoft internal facility search and assignment feature, the
system does not use academic organization.

General Assignment

Select to open the location for general assignment. When
you select this check box, the Academic Organization field
becomes unavailable.

Minimum Utilization Percent

Enter the minimum usage that a facility should experience.
This field is for internal record keeping only, and has no
programming associated with it.

Check for Facility Conflict

Select to have the system allow only one class to be scheduled
for this facility at any given period of time. If you want to
schedule more than one class at the same time in this particular
facility, such as a field or gymnasium, do not select this check
box.

Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 3

Defining Facility Components

Preparing for the Course Catalog and Schedule of Classes

Access the Facility Component page (Set Up SACR > Foundation Tables > Facilities > Facility
Table > Facility Component).

This example illustrates the fields and controls on the Facility Component page. You can find definitions

for the fields and controls later on this page.

SetlD:
Facility 1D:

Effective Date:
Building:

AMGEDT 25A
ANGED1 258

AMGED125C

Earcility Table Facility Component

aQ
aQ
aQ

PSLIMY

AMGETD1 Angel101
01/01M 900 Status:
Angel Room:

“Component Facility ID

Angel 1254
Angel 1258

Angel 125C

Facility Characteristic

Active
101

Find | View & First (4 4 o 1 [ | ost

Capacity: 110

Fingd | e Al First E 1-3 of 2 |I| Lazt

Building Room Capacity

Angel 1254 20 =]
Angel 1268 20 =
Angel 1250 20 =]

As an example, Angel 125A, B, and C might be linked as components of Angel 125. To link facility
components to a parent facility, you must first define all facilities on the Facility Table page. As soon as
components are linked to a parent facility, the system calculates the capacity of that facility by adding up
the capacities of all components. If a class is scheduled in a component of a facility and someone attempts
to schedule a class in the parent facility, the system prevents the new scheduling.

Field or Control

Description

Component Facility ID

Select the component facility ID for a component that you
want to link to this facility. All facilities on the Facility
Table page are available for selection. To link more than one
component to a parent facility, add rows.

Defining Facility Characteristics

Access the Facility Characteristic page (Set Up SACR > Foundation Tables > Facilities > Facility
Table > Facility Characteristic).
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Facility Characteristic page. You can find

definitions for the fields and controls later on this page.

FEacility Tahle

Component | Facility Characteristic

SetlD: PEUMY

Facility ID: ANGETD Angel101
Effective Date: 0140141800 Status:  Active
Building: Angel Room: 101

Room Characteristics

Capacity: 110

Fir=t E 1-2 of 2 II' Last

Facility Black-out Times

]
*Room Characteristic: ’WO\ White Board *Quantity: 2 FE
*Room Characteristic: ’F Q Biology Labaoratary *Quantity 3 =l

+
*Facility Black-Out Nbr *Start Time *End Time Mm T W T F 5 § HE
1 £i:00AM T.504M |2 I I IR IR I
+
*Facility Black-Out Nbr *Start Time *End Time M T W T F = 5 FE]
2 1:00PM T00PM | I A A S e
Field or Control Description

Room Characteristic

Select characteristics for this room. Room characteristics are
defined on the Room Characteristic Table page. Insert rows to
add characteristics. The system uses the Room Characteristic
field to interact with Universal Algorithm Schedule25. The
maximum number of room characteristics for Universal
Algorithm Schedule25 is 96. Therefore, be sure that you select
values between 0/ and 96.

Quantity

Enter the quantity of the room characteristic. For example,
enter 2 to indicate that the room has two white boards.

Facility Black-Out Nbr (facility black-out number)

You can define periods when a facility is unavailable. The
facility blackout number is system-generated. This number
indicates the number of blackout periods that exist for a
facility. You can override the system-assigned facility blackout
number.

Start Time and End Time

Enter a start and end time for the blackout period.

M (Monday), T (Tuesday), W (Wednesday), T (Thursday), F
(Friday), S (Saturday), and S (Sunday)

Select the days of the week for which the blackout period
applies.

Note: Student Records provides the facility blackout structure for compatibility with Resource 25. When
using Resource 25, the system prevents class and event scheduling during blackout periods. When using
Campus Solutions internal conflict checking logic, the system does not use this structure.
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Designating Approved Instructors and Advisors

This section discusses how to:

* Assign faculty rank and advisor status.

* Designate approved course instructors.

Pages Used to Designate Approved Instructors and Advisors

Page Name

Definition Name

Navigation

Usage

Instructor/Advisor Table

INSTR_ADVISOR

Curriculum

Management > Instructor/
Advisor Information >
Instructor/Advisor

Table > Instructor/
Adyvisor Table

Indicate faculty rank, advisor
status, instructor availability,
and the courses that an
instructor can teach.

Note: You are not adding
new people to the database
on this page, but updating
information for individuals
who are already in the
database. The IDs that are
available depend upon the
way that you set up your
instructor edit.

Approved Courses

INSTR_ADVISOR2

Curriculum

Management > Instructor/
Adyvisor Information >
Instructor/Advisor

Table > Approved Courses

Indicate courses that an
instructor can teach. The
system uses the values that
you enter as part of the
Instructor Edit feature, which
is an option that enables

you to link instructors to
specific campuses, subjects,
or courses within an academic
organization. This way, when
you schedule classes, only the
relevant instructors appear as
choices.

Assigning Faculty Rank and Advisor Status

Access the Instructor/Advisor Table page (Curriculum Management > Instructor/Advisor
Information > Instructor/Advisor Table > Instructor/Advisor Table).
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This example illustrates the fields and controls on the Instructor/Advisor Table page. You can find
definitions for the fields and controls later on this page.

Instructor/Advisor Table Approved Courses

Raymond Reyholds

Instructor Details

SR0449

Find | i Al First E 1 af 1 |I| Last

0712772004 [z *Status: IActiﬁ.rE vI [#][=]

PeopleSoft University

=] [T Advisor

Instructoriddvisor Role

Advisor Number: 1
*fcademic Career: UGRD C

Ly Q3
ENGL-BA O

Academic Program:

*Effective Date:

*Instructor Type: |A55i5ta nt Professor

*Academic Institution: PEUNY

*Primary Acad Org: ENGLISH — Q e
*Instructor Available: |*°\‘fa”5'b|E =]

Percent of Appointment: E|
Lndergraduate

Liberal Arts Undergraduate

First E 10of 1 |E| Laszt

Academic Plan: English (BA)
Academic Sub-Plan: Q
Field or Control Description

Instructor Type

Select an instructor type. Values for this field are delivered
with your system as translate values. Do not modify these
values in any way. Any modifications to these values require
a substantial programming effort. If you select a value of
Advisor Only, the system selects the Advisor check box by
default and you cannot change it.

Advisor

Select to indicate that the individual is also an advisor and to
place the individual into the system's Advisor view. You can
later select the Advisor view as a search tool on various pages.

Academic Institution

Select the academic institution with which you want to
associate this record.

Primary Acad Org (primary academic organization)

Select a primary academic organization for this instructor.
Academic organization values are defined on the Academic
Organization Table page.

Instructor Available

Select the instructor's availability to teach within the effective
dates. Select Available, Sabbatical, or Unavailable. If the
instructor has an advisor type of Advisor Only, the system
populates the Instructor Available field with Unavailable by
default. You can override this value.
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Use the Instructor/Advisor Role scroll area to indicate the academic career, program, plan, and subplan

to which the instructor or advisor is linked.

Field or Control

Description

Adyvisor Number

The system populates this field with / by default. If an
instructor advises students in more than one academic career,
program, plan, or subplan, you can have multiple advisor
numbers by adding rows.

Percent of Appointment

Enter a percent of appointment value that this instructor

has for the indicated academic career, program, plan, and
subplan. Instructors with dual appointments can have different
percentages reflecting their responsibility. The total percentage
must equal 100.

Academic Career

Select the academic career to which the instructor or advisor is
linked. Academic career values are defined on the Academic
Career Table page.

Academic Program

Select the academic program to which the instructor or
advisor is linked. Academic program values are defined on the
Academic Program Table component.

Academic Plan

Select the academic plan to which the instructor or advisor is
linked. Academic plan values are defined on the academic plan

pages.

Academic Sub-Plan

Select the academic subplan to which the instructor or
advisor is linked. Academic subplan values are defined on the
academic subplan pages.

Designating Approved Course Instructors

Access the Approved Courses page (Curriculum Management > Instructor/Advisor Information >

Instructor/Advisor Table > Approved Courses).

To make use of the values on this page, enable the Instructor Edit feature. To do so, on the Academic
Organization Table page, choose to edit instructors against the Instructor/Advisor table rather than the
Personal Data table for the related academic organization. You must also select this option on the Course

Catalog Description page for the courses involved.

Having done this, when you schedule classes on the Class Meeting Pattern/Instructor page and have to
assign an instructor to a class that falls within the academic organization and courses that you have set up
in this manner, the system displays only the relevant instructors in the ID field.
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In the lower portion of the page, select the subjects, courses, or campuses at which the instructor is
approved to teach based on effective date. The availability of these fields depends on the options that your
institution selects by which to edit instructors on the Academic Organization Table page.

Field or Control Description

Seq Nbr (sequence number) The system populates the Seq Nbr field by default. Sequence
numbers are sequential numbers that the system assigns to
identify rows in the table.

Acad Org (academic organization) Select the academic organization to indicate that the
instructor is approved to teach all courses within the academic
organization that you specify. If your institution has set up the
academic organization to edit instructors by campus, subject,
and course, you can further narrow the courses. This field is
required.

Subject Area If available, select the subject area that the instructor is
approved to teach. Subject area values are defined for each
academic institution on the Academic Subject Table page.

Course ID If available, select the course ID of the course that the
instructor is approved to teach. You are prompted from the
course catalog. If your course catalog has only one offering
number, the system supplies the offering number by default.

Offer Nbr (offering number) If available, select the offering number of the class that the
instructor is approved to teach.

Catalog Nbr (catalog number) The system displays the catalog number, based on the course
catalog definition.

Campus Select the campus for which the instructor can teach. Campus
values are defined for each academic institution on the
Campus Table page.

Add rows to further specify courses that the instructor is
approved to teach.

Defining Requirement Designations

To set up requirement designations, use the Requirement Designation Table component
(RQ_DESIGNATION_TBL).

This section provides an overview of requirement designations and discusses how to define requirement
designations.
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Understanding Requirement Designations

Requirement designations, unlike course attributes, transfer to PeopleSoft Academic Advisement. A
requirement designation can be extra credit that a student has done for a course, such as design credit. For
example, you can attach a requirement designation of Design to all first-, second-, third-, and fourth-year
architecture studio courses that carry the optional add-on enrollment of Design Credit. When students
enroll in any of these studios, they can elect to take the course to fulfill their design credit certification.
Requirement designations are intended as optional add-on credit for a course in which some students

are taking the class alone, and others in the same class are taking both the class and attempting to pass

the requirement designation portion. In this way, the requirement designation reflects extra credit. Some
students in the class attempt it, while others do not.

Requirement designations should be used sparingly, and are not intended to track general advisement
requirements. They are meant as additional qualifiers that alone may be a requirement. With relation

to the previous example, you may require a total of six hours of design credit across four years of
architecture study, in addition to the minimum unit and grade-point-average requirements for the courses.
By using a requirement designation, you enable students to complete their design credit at any stage

and pace across four years. Student A might attempt design credit during second and fourth years, in

the spring term. Student B might complete all six design hours while enrolled in the fourth-year studio,
during the fall and spring terms. Although these two students are in the same studio classes across the four
years, they pace themselves and complete assignments differently. Student A begins to explore design
practices as a sophomore (by doing some type of additional design work in consultation with a professor),
while student B decides to wait and load up on design work the last year of his or her career as an
architecture student. Typical requirement designations may include Counts Toward Design Certification,
Preparation for Licensing Exam, Electing course to be the basis of Liberal Arts Thesis Credit, and so on.
Requirement designations can be graded as Satisfied or Not Satisfied.

In the previous example, the design credit requirement designation was set up as an enrollment option.
Students can elect to take the design credit requirement designation at the time of enrollment in
certain architecture studio classes. You can also create a requirement designation that is not optional at
enrollment. This type of requirement designation is strictly attached to a class. Taking the class, along
with the requirement designation, is required of all students who enroll. The distinction between a
requirement designation that is elective at enrollment and one that is automatically added to a student's
enrollment request is the way that you set the At Student's Option check box on the Requirement
Designation Table page. This option and others like it are discussed in the following section.

Related Links
“Setting Up Academic Course Lists” (Academic Advisement)
Understanding Grading
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Page Used to Define Requirement Designations

Page Name Definition Name

Navigation Usage

Requirement Designation
Table

RQ_DESIGNATION_TBL

Set Up SACR > Product
Related > Student
Records > Curriculum
Management >
Requirement Designation
Table > Requirement
Designation Table

Define requirement
designations.

Defining Requirement Designations

Access the Requirement Designation Table page (Set Up SACR > Product Related > Student
Records > Curriculum Management > Requirement Designation Table > Requirement

Designation Table).

This example illustrates the fields and controls on the Requirement Designation Table page. You can find
definitions for the fields and controls later on this page.

Requirement Designation Table

Requirement Designation: COLB

*Effective Date: 01/01/1995 51 *Status:

*Description: College Breadth Requirement

*Short Description: CollBredth

*Formal Description:

Academic Institution: PSUNV|Q

Q

[] at Student's Option
[¥] Catalog Print
[#] Print in Transcript

Academic Plan:

Satisfies A&SCI College Breadth Requirernent

PeopleScft University

] Separate Course Grade
[ schedule Print
[ pisplay in AA Reports

First n 10of1 n Last
=l

Find | View Al

Show In Class Search

Field or Control

Description

Status

Select a status for this requirement designation. Select Active
when adding a new requirement designation. Select /nactive
only if your institution no longer uses this requirement
designation.

Description, Short Description, and Formal Description

Enter a description, short description, and formal description.
The formal description appears on the course catalog report,
schedule of classes report, and transcript if specified.
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Field or Control

Description

Academic Institution

Select an academic institution with which to associate the
requirement designation. This affects the availability of this
requirement designation on the course catalog and schedule of
classes prompts.

Academic Plan

Select an academic plan if you want to link the requirement
designation to a specific plan. At enrollment, a student must

be active in the specified plan to enroll in any class with the
related requirement designation. The Enrollment Request 1
page includes overrides that enable you to override this general
rule if you have the appropriate security permissions. On the
Enrollment page, the system does not validate this.

At Student's Option

Select to indicate that the student can select the requirement
designation at enrollment. You can indicate a student's choice
of requirement designation on the Enrollment Request Page,
the Student Enrollment 4 page, or the Block Enrl Detail 2

page.

If you do not select this check box, students who enroll in
classes that have this requirement designation are required
to take the course and attempt the additional requirement
designation credit.

See:

*  Processing Enrollment Transactions Through the
Enrollment Request Component

*  Processing Enrollment Transactions Through the Block
Enrollment Feature

Catalog Print

Select to enable the display of the formal description of the
requirement designation and the course in the course catalog
report.

Note: The SSR_COURSE (Course Catalog) web service is
one of a number of delivered Enrollment Web Services. The
service operation SSR_GET_COURSES: Browse Course
Catalog Summary obeys the Catalog Print setup that you
select on the Requirement Designation Table page and on the
Course Attributes page.

For detailed information about Enrollment Web Services, see
Enrollment Web Services Developers Guide and Enrollment
Web Services Users Guide in My Oracle Support (ID 1371391.

1.

See

Schedule Print

Select to enable the display of the formal description of the
requirement designation and the course in the schedule of
classes report.
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Field or Control

Description

Print in Transcript

Select to print the requirement designation and requirement
designation grade on the student's transcript.

Separate Course Grade

Select to indicate that the requirement designation involves
work that someone must grade separate from the course.

If this check box is cleared, students who earn credit for

the course will, by default, earn a grade of Satisfied for the
requirement designation. The professor does not need to assign
two grades for every student (for example, a letter grade of

B for the course, and a grade of Satisfied for the requirement
designation).

Alternatively, should the professor want to evaluate a student
on each of these two areas independently, select the check box.
This setting is optimal in the event that a student receives a
passing grade for the class, but fails to successfully complete
the requirement designation. In this instance, the professor
could assign a letter grade of B to the class, and assign a grade
of Not Satisfied for the requirement designation. The class
would not fulfill an advising requirement that requires both

a class and a requirement designation for the class. It would
fulfill only an advising requirement that requires the class
alone.

See Using the Grade Roster Page to Enter Grades.

Display in AA Reports

Select to enable the system to display the requirement
designation code and description in the advisement report.

Show in Class Search

If this check box is selected for a Requirement Designation
and the Class Search Profile (for example, STDNT) includes a
search criteria of Requirement Designation, then a student can
search by the Requirement Designation in Self Service.

See Setting Up Class Search Profiles

See “Searching for Classes Using Classic Self-Service Pages”
(Campus Self Service )

See Searching for Classes

Setting Up Unit Conversions

To set up unit conversions, use the Unit Conversion Table component (UNIT CONVR_TBL).

This section provides an overview of unit conversions, lists prerequisites, and discusses how to set up unit

conversion rules within your institution.
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If students at your institution take classes outside of their current career, you

Preparing for the Course Catalog and Schedule of Classes

should define unit

conversions. You should especially do this if some careers are on a quarter system and other careers are
on a semester system (for example, if an MBA student takes a law course, but the MBA program is on a

quarter system and the law program is on a semester system). The system als

o uses the unit conversion

rules when you process internal transfer credit for students, which can include students with internal

coursework that transfers from one career to another career, or students with
transfers from one program to another program.

Prerequisites

internal coursework that

If you want to use term types other than the translate values that are delivered by Campus Solutions, you

must first create them in the TERM_TYPE CONVR _TO translate table.

Page Used to Set Up Unit Conversions

Page Name

Definition Name

Navigation

Usage

Unit Conversion Table

UNIT_CONVR_TBL

Set Up SACR > Product
Related > Student
Records > Enrollment >

Set up unit conversions within
your institution.

Unit Conversion Table >
Unit Conversion Table

Setting Up Unit Conversion Rules within Your Institution

Access the Unit Conversion Table page (Set Up SACR > Product Related > Student Records >

Enrollment > Unit Conversion Table > Unit Conversion Table).

This example illustrates the fields and controls on the Unit Conversion Table
definitions for the fields and controls later on this page.

page. You can find

Unit Conversion Table

SetiD: PELINY

Term Unit Type: S Semester Hours

o1i11900 [3)

*Effective Date:
*Term Type Convert To Unit Multiplier
Quarter Hours | 1.5000

Fir=t E 1 af 1 |I| Laszt

(=]
First E = |£| Last

[+ [=]
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Field or Control Description

Term Type Convert To Select the value to which you want to convert the value in the
Term Unit Type field.

Unit Multiplier Enter the number for the system to use to multiply the term

unit type units by to convert them to the term type convert to
value, for example, (term unit type units) x (unit multiplier) =
(term type convert to units).

Defining Standard Meeting Patterns

Define class meeting patterns for your classes on the Standard Meeting patterns page on the Academic
Group Table.

Related Links

“Defining Standard Class Meeting Patterns” (Campus Solutions Application Fundamentals)

Defining Modes of Instruction

To set up instruction modes, use the Instruction Mode component (INSTRUCT_MODE).

You need to set up instruction mode values that you use when you define courses and schedule classes.
This section discusses how to define instruction modes.

Page Used to Define Modes of Instruction

Page Name Definition Name Navigation Usage

Instruction Mode INSTRUCT _MODE Set Up SACR > Product | Define instruction modes.
Related > Student
Records > Curriculum
Management >
Instruction Mode >
Instruction Mode

Defining Instruction Modes

Access the Instruction Mode page (Set Up SACR > Product Related > Student Records >
Curriculum Management > Instruction Mode > Instruction Mode).
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Important! Set up an instruction mode value of P for every institution in your system. You can enter
any description and short description; however, you should use /n Person for both fields. The system
uses this value as a default for the Instruction Mode field on the Schedule of Classes - Basic Data page
(when you enter the page in Add mode). In addition, you can generate rosters only for those classes with
an instruction mode value of P on the Basic Data page.

Field or Control

Description

Effective Date and Status

The effective date determines when the status that you select is
valid. The active effective date must be equal to or before the
effective date of the course component to which you assign the
instruction mode.

Description Enter the description of the instruction mode. The system
displays this value on the Course Catalog report and the
Schedule of Classes report, as well as on the Course Catalog
component and Schedule of Classes online pages.

Short Description Enter a short description for the instruction mode.

Print On Course Catalog

Select to display the instruction mode on the course catalog
report.

Print On Schedule of Classes

Select to display the instruction mode description on the
schedule of classes report, as well as on the online schedule of
classes.

Print On Transcript

No programming is attached to this field.

Setting Up Class Search Profiles

This section discusses class search configuration only for the classic user interface and describes how to:

* Define class search criteria.
* Define class search result options.

* Define class detail options.

For information about other Class Search setup such as search results limits,

See Reviewing or Defining Student Records Installation Settings

The delivered Class Search Profiles are:

e STDNT (Student/Visitor Self Service)

* INSTR (Instructor/Advisor Self Service accessed through Faculty and Advisor Centers)
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*  ADMIN (Administrative class search)

* SSAPT (for use with Program Enrollment)

Pages Used to Set Up Class Search Profiles

Chapter 3

Page Name

Definition Name

Navigation

Usage

Search Configuration

SSR_CLSRCH_CONFIG

Set Up SACR > Product
Related > Student
Records > Curriculum
Management > Class
Search Configuration >
Search Configuration

Define class search criteria.

Class Result Options

SSR_CLSRSLT_CONFIG

Set Up SACR > Product
Related > Student
Records > Curriculum
Management > Class
Search Configuration >
Class Result Options

Define class search result
options.

Class Detail Options

SSR_CLSDTL_CONFIG

Set Up SACR > Product
Related > Student
Records > Curriculum
Management > Class
Search Configuration >
Class Detail Options

Define class detail options.

Defining Class Search Criteria

104

Access the Search Configuration page (Set Up SACR > Product Related > Student Records >
Curriculum Management > Class Search Configuration > Search Configuration).

Note: This page is not used for class search in Fluid.
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This example illustrates the fields and controls on the Search Configuration page. You can find definitions

for the fields and controls later on this page.

Search Configuration Class Result Options

Class Search Profile  SSaPT

Search Options

I Inct Topic on Course Keyword
I Inct Long Desc on Crse Keyword

Class Detail Options

I Include Course Attribute Value

Add Search Grnup| Reset\Values |

Configure Search

Group Sequence 1
Message Set Number | 146580 C

Use
Common Search Criteria
— |Attribute

r ISessinn Code 'I

|I'u'|eeting Times

r [
r |Dlass Days |
r [
-

| Instructar Mame

MR ININ

| Cpen Only j

EY , b=
Find | B | 88 Fist B0 4505 B gt

Common Attribute

Find  First B 1 of 1 I3 Last

¥ Active [=]
¥ Collapse by Default
Message Number 3146 Q  Filter Class Search Results

[+] [=]
[+] [=]
[+] [=]
[+] [=]
[+] [=]

Use this page to define, for each profile, the search criteria that are available on the Search for Classes
page. For example, if you select Session Code for the INSTR profile, then instructors who use class
search in Self Service can select session as a search criterion.

Search Options

Field or Control

Description

Incl Topic on Course Keyword (Include Topic on Course
Keyword)

If this check box is selected and a Class Search Profile
includes Course Keyword, then if a user searches by cognitive,
the search returns all classes for which cognitive is found in
the Course Description or Long Course Title. The search also
returns all classes for which cognitive is found in the course
topic Description or Formal Description if a Course Topic ID
exists for the class.
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Field or Control

Description

Incl Long Desc on Crse Keyword (Include Long Description
on Course Keyword)

If this check box is selected and a Class Search Profile
includes Course Keyword, then if a user searches by cognitive,
the search returns all classes for which cognitive is found

in the Course Description, Long Course Title, or Long

Description.

Include Course Attribute Value

If a Class Search Profile includes Course Attribute, then:

«  Ifthis check box is selected, a user can search by Course
Attribute and Course Attribute Value—for example, search
by Course Attribute: Honors, and Course Attribute Value:
Math Department Honors.

»  If'this check box is cleared, a user can search by Course

Attribute only.

Configure Search

Field or Control

Description

Add Search Group, Group Sequence, and Seq Nbr
(sequence number)

Configure groups of search criteria for a profile and define the
sequence order in which fields are displayed on the Search for
Classes page.

Criteria can used in only one group box within a profile.

Message Set and Message Number

Define the labels for class search groupings through the
Message Catalog (Message Set 14690).

Reset Values

Click this button to access a default setting where all values
are displayed and configured into two groups: Class Search,
which is expanded by default and Additional Search Criteria,
which is collapsed by default. You can then modify the search
criteria and groupings.
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Field or Control

Description

Use Common Attribute

Select this check box to use class association attributes in class
search.

When you select the check box, the Search Criteria field is
not available and the Common Attribute field displays the
available class association attributes as defined on the CLASS
_ASSOC Record Context. An attribute can be used only once
within a profile.

When students search for classes from Program Enrollment
Self Service, a controlled class search is used. Therefore unlike
other class search profiles, you do not need to include Subject
and Course Number as search criteria for the SSAPT profile.

See Using the Common Attribute Framework to Extend Class

Associations for Program Enrollment

Related Links
Searching for Classes

“Searching for Classes Using Classic Self-Service Pages” (Campus Self Service )
“Using Program Enrollment Self-Service Features” (Campus Self Service )

Defining Class Search Result Options

Access the Class Result Options page (Set Up SACR > Product Related > Student Records >
Curriculum Management > Class Search Configuration > Class Result Options).

Copyright © 1988, 2023, Oracle and/or its affiliates.

107



Preparing for the Course Catalog and Schedule of Classes Chapter 3

This example illustrates the fields and controls on the Class Result Options page. You can find definitions
for the fields and controls later on this page.

Search Connguration’ | Class Result Options || Class Detail Options

Class Search Profile SSAPT

Instructions

[+ Show Class Result Instructions

Message Set Number | 14690 Message Number 3265
Message Text Use the class section links to access additional class detail

[¥ Use Search Result Filters
Filter ltems Find | B | 88 st B qaopa I ot

[ 1] r [ Academic Shift = [ Filter Defaurt =] [+ [=]

[ 2 r [Instruction Mads =] [ Filter Default =] =

[ 3 r [ Location =] [ Filter Default =] =]

[ 4 ~ [ Student Language =] [Filter Default =] =
Instructions

You can define user-specific (student, faculty, admin) introductory text which appears on the class Search
Results page if the Show Class Result Instructions check box is selected.

See “Searching for Classes Using Classic Self-Service Pages” (Campus Self Service ).

Filters
This group box is currently available for SSAPT (Program Enrollment - My Schedule Builder) only.
See “Using Program Enrollment Self-Service Features” (Campus Self Service )

See Managing APT Enrollment

For information about defining academic shifts (Academic Shift page), see “Defining Academic Shifts”
(Campus Solutions Application Fundamentals)

For information about how to indicate that you want to use Academic Shift and the setup required to
assign a shift to a student (Academic Institution 3 page), see “Setting Additional Institution Defaults and
Options” (Campus Solutions Application Fundamentals)

For information about attaching an academic shift to a student’s academic program (Student Program
page), see Maintaining Student Academic Programs

For information about additional setup required for Common Attribute values, see:

“Understanding Common Attribute Framework” (Campus Community Fundamentals)
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“Associating a Common Attribute to a Record” (Campus Community Fundamentals)

Maintaining Student Additional Information

Field or Control

Description

Use Search Result Filters

If you select this check box, filters appear on the class Search
Results page, as explained below.

Sequence Number

Determines the order in which filters appear on the class
Search Results page.

Use Common Attribute

If you select this check box and then select a Common
Attribute value (and the attribute is associated with the
relevant associate class in the Schedule of Classes component),
then the attribute is available as a filter on the Search Results
page when a user searches for classes.

When viewing the class search results, the filter check box is
selected by default if the attribute is attached to the student's
program as well as the relevant associated class and section.
The user can change the filter. However, if the Match selection
option on the Class Result Options page is Required Match
and there is a match on the student's attribute and associated
class attribute, then the Search Results page shows matching
class sections only. The student cannot change the filter.

See Adding Class Association Attributes Using the Schedule
of Classes Component

Criteria

Select a value to indicate that the criteria should be available
as a filter on the Search Results page when a user searches for
classes.

If you select the Academic Shift criteria, an Academic Shift
value must be selected for the class in the Schedule of Classes

component.

See Defining Class Meeting Patterns
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Field or Control

Description

Match

Filter Default: A filter option appears with a check box
selected on the class Search Results page when the class
search returns a class with sections that match the filter
criteria. A student can clear or re-select the check box to
expand or narrow the search results. If no match occurs, the
filter does not appear on the Search Results page

Required Match: The class Search Results page displays

only sections that match the required criteria. A filter option
appears with a check box selected but the student cannot clear
or change the filter criteria. For example, if an institution
wants to display to the student only class sections that match
the student's campus (see Student Program/Plan component),

the institution can define campus as a required match.

See Maintaining Student Program Stacks

Note: If no matches are found for a given default filter criteria,
the respective filter does not display on the Search Results
page. For example, if there is a filter default defined for the
attribute of student language but there are no sections with

the associated class attribute for a student language value, the
filter does not display on the Search Results page.

Note: If a student accesses My Schedule Builder and only one
class section matches the Required Match filter criteria, that
section displays on My Schedule Builder. The student does not
see the Search Results page.

Defining Class Detail Options

110

Access the Class Detail Options page (Set Up SACR > Product Related > Student Records >
Curriculum Management > Class Search Configuration > Class Detail Options).

Use this page to define, by profile, the fields that appear on the Class Detail page. For example, if you
select the Enroll Rqmt: Requisite check box for the STDNT profile, then in Self Service, when a student
clicks the link for the class and is taken to the Class Detail page, the student can see the enrollment

requisite information for that class.

All check boxes are selected by default.
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Field or Control

Description

Textbook Information

The information that appears on the Class Detail page depends
on the data that you enter on the Schedule of Classes—
Textbook page (Curriculum Management, Schedule of
Classes, Schedule New Course, Textbook).

See Defining Textbooks for Classes
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Understanding Repeat Checking Functionality

The Student Records repeat checking functionality is a flexible, fully integrated feature that updates
students' academic statistics based on an academic institution's course repeat policies. Through the repeat
schemes, repeat codes, and repeat rules that your institution defines, the functionality regulates academic
statistics that are usually governed by the grading scheme.

The repeat checking functionality enables you to manage repeats at the beginning, middle, and end of
students' coursework. The functionality enables you to:

* Identify automatically that students are repeating courses when students enroll in classes (front-end
processing).

» Identify automatically that students are repeating courses when you grade students through the
Enrollment Request page (back-end processing).

» Identify automatically that students are repeating courses when you post transfer credit (back-end
processing).

* Identify in batch that students are repeating courses by running the Repeat Checking process once per
term through the Repeat Checking page.

» Identify repeats manually by assigning repeat codes to students' records on the Student Enrollment
page, Enrollment Request page, or Quick Enrollment page.

The repeat checking functionality consists of the following two processes, both of which are fully
integrated with each other:

* The Allowable Repeats process, which enables you to define rules on the Catalog Data page of the
Course Catalog (CRSE_CATALOG) component that regulate whether a student can repeat a course or
course topic for credit and, if so, how many total units and total completions the student can attempt.

In conjunction with this setting at the course catalog level, you can define by grade (Repeat Checking
Option) or by existing repeat code (Count and Process Option) if a class is defined as an allowable
repeat.

» The Repeat Checking process, which takes effect only after a student exceeds either repeat maximum
in the course catalog.

You can also define by grade (Repeat Grade Option) or by existing repeat code (Count and Process
Option) if a class should be processed by the repeat check engine.

To use the repeat checking functionality, your institution must first define repeat schemes, repeat codes,
and repeat rules.
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*  Repeat schemes are the set of valid repeat codes that an academic institution can use to define the
repeat rules for an academic career.

*  Repeat codes are the settings that adjust academic statistics.

Repeat codes can adjust academic statistics in the following ways: they prevent the system from
including repeated coursework in a student's grade point average (GPA) and they prevent the system
from including repeated coursework in a student's academic level. You can also decide to not adjust
statistics for previously assigned repeat codes.

*  Repeat rules are defined by academic careers and assigned to academic programs. The rules are
analyzed during the repeat checking process and appropriate repeat codes are then assigned to the
student enrollment record.

Repeat rules inform the Repeat Checking process when a student's repeated coursework matches
the repeat policy of an academic career or an academic program. The Repeat Checking process then
assigns the appropriate repeat codes to the student's enrollment record.

After you define these elements, you must link the repeat rules to academic careers. These rules carry to
the academic program unless you make a different repeat rule assignment at that level. You can assign

to academic careers and academic programs only the repeat rules that are valid for the repeat scheme of
the academic career. Finally, you must specify when you want the Repeat Checking process to run at the
academic institution, academic career, and academic program levels. These controls enable you to turn on
and off automatic repeat checking during enrollment and grade input. They also enable you to temporarily
suspend automatic repeat checking during peak enrollment and grade input periods.

After your institution defines these elements, the repeat checking functionality is ready to use. When the
Repeat Checking process runs, it looks for a matching pair of course IDs or courses deemed equivalent
(on the Course Equivalencies page). When the process finds a matching pair, it associates the appropriate
repeat rule and assigns the designated repeat code to the student's enrollment record for the repeated class.
You can view the assigned repeat code on the Enrollment Request page or the Quick Enrollment page.
Depending on your setup, the repeat code can prevent a repeated course from counting towards a student's
academic level or GPA.

The Allowable Repeats process and Repeat Checking process set the repeat candidate flag
(REPEAT _CANDIDATE) on the student's enrollment record (STDNT_ENRL) to ¥ or N for all
components of a class. The COBOL process sets the flag to Y for all classes identified as repeat
candidates as long as the following conditions are met:

*  You must set up front-end repeat checking to issue warning messages whenever the COBOL process
encounters a repeat candidate.

* You must process the enrollment transaction through the enrollment engine.

The COBOL process does not validate enrollment transactions that are processed through the Enrollment
(STDNT_ENRL) component and, therefore, does not issue a warning repeat message. For enrollment
transactions that are processed through the Enrollment component, the system sets the repeat candidate
flag on the student's enrollment record to N, even for repeated classes.

On the Repeat/Incomplete page of the Academic Program Table (ACADEMIC PROG_TBL) component,
if you set the Process on Enrollment field to No and the Course Catalog Repeat Messages field to
Warning, the Allowable Repeats process is activated. When students submit enrollment requests and the
student exceeds the total completions allowed for the class, as determined by the Course Catalog Detail
page, they receive a warning message.
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If you set the Process on Enrollment field to Yes, the Course Catalog Repeat Messages field is
automatically set to Warning and becomes unavailable for edit. On enrollment requests, the Repeat
Checking process looks to the repeat rule setup for messaging rules.

For the process to correctly and consistently set the repeat candidate flag to ¥, you must set the
Enrollment Message field to Warning for the repeat rule on the Repeat Rule2 page and for every detail
rule on the Repeat Rule Detail 1 page. If you set the Enrollment Message field to /gnore, the process
does not send a message for that rule and, even if the course is a repeat candidate, the process sets the
repeat candidate flag to &V, provided that it does not violate other repeat rules.

This diagram explains the Repeat Engine logic:

Repeat Candidate
May be subject to Sort Order
front-end s Tarm (descending)
messaging « Origin (descending)
4 = Enroliments
Course 3 = Course Transfer Credits
Saiiepdrai - — >R R — Then— - Repeat [ 2 = Test Transfer Credits
1 = Other Transfer Credits
s Sorl Dates (descending)
Z s Grade points per uml
Current {descending)
Attempt /"‘ L
i Analyzes Overlay
> & Assign Repeats from
S p—
Determine Run Option: | s e ke
-Grade Yes Table
-Repeat Code I
+ Determine Only One Analyzes Overlay
Al Previous Previous | Previous es—e & Assign Repeals from
Atternpts Atternpt Match Atternpt RRD3 to student data
. 0 —
Match Options
Determine Run Option; No |- Earned Credif
-Grade L e Grade Opfions (Best/
-Hﬂpﬂat Gﬂdﬂ WOISU

Uinits Aftempfed
Determine Match Most Recent Term

Priority Enraliment
/ All Attempls / Course Transfer

Test Transfer
Othar Transfar

) s Most Recent Date
Dg:{anrégeﬁtlﬁ;g . I'_ Include in GPA
v
¢ Determine Analyzes Cvarlay
Matched Previous »| & Assign Repeals from
Analyze RR2 » gn hepe
b Attempt RRD3 to student data
v :
Analyze RRD1/RRD2 I
RR2 — Repeat Rule 2 e e » sign Repe
RR3 - Repeat Rule 3 from RRD3 to AA
RRD1 — Repeat Rule Detail 1 Results Table
RRDZ — Repeal Rule Detail 2
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Related Links
Understanding the Three Repeat Checking Methods

Defining Repeat Schemes and Repeat Codes

To set up repeat schemes and codes, use the Repeat Scheme Table (REPEAT SCHEME TBL)
component.

This section discusses how to create repeat schemes and codes.

Page Used to Define Repeat Schemes and Repeat Codes

Page Name Definition Name Navigation Usage

Repeat Scheme Table

REPEAT SCHEME TBL

Records and Enrollment >
Term Processing > End of
Term Processing > Repeat

Create repeat schemes and
the repeat codes within each
scheme.

Scheme Table > Repeat
Scheme Table

Creating Repeat Schemes and Codes

Access the Repeat Scheme Table page (Records and Enrollment > Term Processing > End of Term
Processing > Repeat Scheme Table > Repeat Scheme Table).
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This example illustrates the fields and controls on the Repeat Scheme Table page. You can find definitions

for the fields and controls later on this page.

Repeat Scheme Table

SetlD: PSUNY

*Effective Date: 01/01/1900 [3
‘Status:

Repeat Scheme: UGRD

Find | view &l [ q o5 1 [¥]

[+ [=]

‘Description: \Undergraduate

‘Short Dese:  FSU
4] 1orzz

[+][=]

‘Repeat Code: EXCHM
*Description: |Repeated - Bxcluded

‘Short Desc; | Hepeated

Formal Description: |R9F'93t9d - BExcluded
CJEarn Credit
Cinclude in GPA

Print Repeat Date

Print Repeat Description

*Units Attempted: | fes

When this code exists in student data

[ ] pisplay in AA Reports

‘Count and Process Option: | 1) Count="% Pracess=Y

|

Allow to be overlaid
[] Bypass processing if it is on Current Attempt

The purpose of repeat codes is to adjust students' academic statistics appropriately when students repeat
courses, rather than having the system calculate statistics by using the grading scheme.

Field or Control

Description

Repeat Code Enter a repeat code for this repeat scheme. If assigned, this
code appears on a student's enrollment record. You can view
codes that are assigned to a student's enrollment records on the
Enrollment Request page or the Quick Enrollment page.

Earn Credit Select to indicate that a student with this repeat code on a class

enrollment record can earn credit for the class. To prevent a
repeated course from counting toward a student's academic
level, clear this check box.

Include in GPA (include in grade point average)

Select to indicate that a student with this repeat code on a
class enrollment record can have the class included in the
GPA calculation. To prevent a repeated course from being
calculated in the student's GPA, clear this check box.
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Field or Control

Description

Print Repeat Description

Select to have the system print the formal description of this
repeat code on the student's transcript when applicable.

Print Repeat Date Select to print the date that the student completed the repeated
course on the student's transcript.
Units Attempted From the following choices, enter a value to indicate how

the units attempted from a repeated course count towards a
student's academic statistics when this repeat code is assigned
to the student's class enrollment record. Values for this field
are delivered with your system as translate values. Do not
modify these values in any way. Any modifications to these
values require substantial programming.

Yes: Indicates that a student with this repeat code on a
class enrollment record can have the class included in units
attempted.

No: Prevents the units from a repeated course from counting
toward a student's academic statistics.

In Progress: Units in progress is used for courses coded with
this repeat code.

Display in AA Reports (display in Academic Advisement
reports)

Select to allow the system to display the repeat code and its
description in the advisement report.
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Field or Control

Description

Count and Process Option

Select an option to indicate whether a class with this repeat
code should be counted as a repeat candidate and whether the
class should be processed by the Repeat Checking process.
Values are:

1) Count =Y Process = Y: If you select this option, any class
with this repeat code is counted in the pool of repeat attempts
and is selected and processed when the Repeat Checking
process is run.

2) Count =Y Process = N: If you select this option, any class
with this repeat code is counted in the pool of repeat attempts,
but is not selected and processed when the Repeat Checking

process is run.

3) Count = N Process = Y: If you select this option, any class
with this repeat code is not counted in the pool of repeat
attempts, but is selected and processed when the Repeat
Checking process is run.

4) Count = N Process = N. If you select this option, any
class with this repeat code is not counted in the pool of repeat
attempts, nor is it selected and processed when the Repeat

Checking process is run.

Note: The Repeat Checking process analyzes the value in the
Repeat Checking Option field on the Grading Scheme Table
page before it analyzes the value in the Count and Process
Option field on this page.

See Understanding Repeat Checking Functionality.

Allow to be overlaid

Select this check box to allow the Repeat Checking process to
overlay this repeat code in subsequent process runs. Clear the

check box if this repeat code should never be replaced.

Bypass processing if it is on Current Attempt

Select this check box if the current attempt already has this
code assigned and the class should not be picked up by the
Repeat Checking process.

Defining Repeat Rules

Copyright

To set up repeat rules, use the Repeat Rule (REPEAT RULE) component.
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This section discusses how to do the following tasks and concludes with an example of a repeat rule:

* Describe repeat rules.

* Define conditions for repeat rules.

* Define the criteria and order that are used to determine a match when three or more repeat candidates

are processed.

» Define repeat rule sequences.

* Define conditions for repeat rule sequences.

* Designate process actions for repeat rule sequences.

If you want to run repeat checking at the academic career level but want to exclude an academic program
without having to select each academic program for which you do want to run repeat checking, you

can set up a repeat rule called NONE. After naming the repeat rule, complete the required fields in the
component and attach it to the academic program that you want to exclude. When the Repeat Checking
process sees the NONE repeat rule, it does not run for that academic program.

Pages Used to Define Repeat Rules

Page Name Definition Name Navigation Usage
Repeat Rule REPEAT RULE Records and Enrollment > | Describe the repeat rules that
Term Processing > End of | you later link to academic
Term Processing > Repeat | careers and academic
Rule > Repeat Rule programs.
Repeat Rule2 REPEAT RULE2 Records and Enrollment > | Define the total attempts and
Term Processing > End of | units that are allowed for a
Term Processing > Repeat | course to which the repeat
Rule > Repeat Rule2 rule applies.
You define the repeat code
that is assigned to the
student enrollment if the
defined attempts or units are
exceeded. You establish how
the enrollment engine notifies
a student when this violation
occurs. Lastly you can define
if there are any repeat codes
that are exempted from the
attempts and units allowed
totals.
Repeat Rule3 REPEAT RULE3 Records and Enrollment > | Select the criteria and the
Term Processing > End of | order that are used by the
Term Processing > Repeat | Repeat Checking process to
Rule > Repeat Rule3 determine a match between
the current attempt and
multiple previous attempts.
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Page Name

Definition Name

Navigation

Usage

Repeat Rule Detail 1

REPEAT RULE DTL

Records and Enrollment >
Term Processing > End of
Term Processing > Repeat
Rule > Repeat Rule Detail
1

Further define a rule when
your institution restricts the
number of times that a student
can repeat a course within

a certain grade range. This
page describes the previous
course in the matched pair of
repeat courses. For example,
a student can repeat courses

Term Processing > End of
Term Processing > Repeat
Rule > Repeat Rule Detail
3

with F or D grades (grade
points between 0.00 and 1.
999) only twice.
Repeat Rule Detail 2 REPEAT RULE DTL2 Records and Enrollment > | Define what the repeat
Term Processing > End of | checking rule should do,
Term Processing > Repeat | based on the value of a
Rule > Repeat Rule Detail | preexisting repeat code on the
2 current course attempt.
Repeat Rule Detail 3 REPEAT RULE DTL3 Records and Enrollment > | Designate the codes that

the Repeat Checking

process should assign to the
enrollment records of both the
current and previous course
attempts.

Describing Repeat Rules

Access the Repeat Rule page (Records and Enrollment > Term Processing > End of Term

Processing > Repeat Rule > Repeat Rule).

This example illustrates the fields and controls on the Repeat Rule page. You can find definitions for the
fields and controls later on this page.

Repeat Rule

Academic Career:

‘Repeat Rule:
‘Effective Term:

*Description:

‘Long Description:

Repeat Rule2

Academic Institution:

Repeat Rule Detail 1

PEUMNY FaopleSoft University

UGRD Undergraduate

UNDERGRD
0650 QL

2010 Fall

Repeat Rule Detail 2

|Undergraduate Repeat Rule

Repeat Rule Detail 3

*Short Description: |Jnderard

Undergraduate Repeat Rule
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Your repeat rules are keyed by the academic careers, so your description might be Undergraduate Repeat
Rules, Fine Arts Repeat Rules, Graduate Repeat Rules, and so on.

Field or Control

Description

Repeat Rule

Enter the code for this repeat rule. You can attach this code

to academic careers on the Repeat Checking page (Academic
Career Table (ACAD_CAREER TBL) component) and to
academic programs on the Repeat/Incomplete page (Academic
Program Table component).

Effective Term

Enter the term that this repeat rule becomes effective. Only
terms associated with the academic career are available. The
system validates the repeat rule by effective term.

Defining Conditions for Repeat Rules

Access the Repeat Rule2 page (Records and Enrollment > Term Processing > End of Term
Processing > Repeat Rule > Repeat Rule2).

This example illustrates the fields and controls on the Repeat Rule2 page. You can find definitions for the
fields and controls later on this page.

Repeat Rule Repeat Rule2 Repeat Rule3 Repeat Rule Detail 1 Repeat Rule Detail 2 repeat Rule Detail 3
Academic Institution: FEURNY PeopleSoft University
Academic Career: UGRD Undergraduate
Repeat Rule: LNDERGRD Effective Term: n6a0 2010 Fall =]
Total Attempts Allowed: lE
Total Units Allowed:
‘Repeat Code Violated: ILeL & llegal Repeat
Enrollment Message:
Current Repeat Codes Exempted from Attempts/Units Allowed
1} |GRFR Q. Exception/Grandfather Clause 5) Q
2} |PETM Q. Repeat Allowed via Petition 8) Q
3) Q 7) Q
4 Q 3) Q
Field or Control Description

Total Attempts Allowed

Enter the total number of attempts that a student can make for
a course to which this repeat rule applies. The value that you
enter should include all attempts of the course, including the
first attempt.
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Field or Control

Description

Total Units Allowed

Enter the total number of units that a student can take for a
course to which this repeat rule applies. The value that you
enter should include all units taken for the course, including
the units of the first attempt.

You can set both total attempts and total units maximums, or
you can set just one. If you set both maximums, the Repeat
Checking process uses the first maximum that it reaches.

If you set neither maximum, the process uses the system
defaults, 99 for total attempts and 999 for total units.

Note: If your institution restricts only the number of times or
units that a student can repeat a course within a certain grade
point range, use the Repeat Rule Detail 1 page to set these
restrictions.

Repeat Code Violated

Enter the repeat code that the Repeat Checking process assigns
to a student's enrollment record if the student exceeds the
defined attempts or units.

For example, if your organization allows students to repeat a
course only twice, regardless of any grades that the student
receives, you would enter 3 in the Total Attempts Allowed
field—one for the initial enrollment plus two additional
repeated attempts. Then, if the student attempts to enroll in the
course a fourth time which exceeds the total attempts allowed
for the rule, the process assigns the Repeat Code Violated
value to the course.

If your organization chooses to have no restriction on the
number of times a student can repeat a course, use the total

attempts allowed default value of 99.

You must enter a Repeat Code Violated value.

Enrollment Message

You can define how the Repeat Checking process alerts a
student during enrollment if the student exceeds the total
attempts or units allowed:

»  Select Error to stop the enrollment process and alert the
student by displaying an error message.

*  Select Warning to alert the student by displaying a
warning message about the possible consequences of
continuing with the enrollment.

*  Select Ignore if you do not want the Repeat Checking
process to issue a message.

The enrollment message applies only to repeat checking on
enrollment (front end).
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Field or Control Description
Current Repeat Codes Exempted from Attempts/Units Use this field to ensure that a repeat code on the current
Allowed attempt is not counted in the total attempts or units if it is

manually assigned during the enrollment process.

In the above example, if you set PETM as the repeat code on
the current attempt, the class is exempt from exceeding the
defined total attempts or units.

You can assign repeat codes to a student's enrollment record
on the Enrollment Request, Quick Enrollment, or Student
Enrollment 1 page.

Defining the Criteria and Order That are Used to Determine a Match When
Three or More Repeat Candidates are Processed

Access the Repeat Rule3 page (Records and Enrollment > Term Processing > End of Term
Processing > Repeat Rule > Repeat Rule 3).

This example illustrates the fields and controls on the Repeat Rule 3 page. You can find definitions for the
fields and controls later on this page.

Repeat Rule Repeat Rule2 Repeat Rule3 Repeat Rule Detail 1 Repeat Rule Detail 2 Repeat Rule Detail 3
Academic Institution: PEUMNY PeapleSoft University
Academic Career: UGRD Undergraduate

Repeat Rule: UMDERGRD Effective Term: 0E4a0 2010 Fall (=]
Prior Attempt Match Priority

1st | Eam CreditFlag=Y v |

2“(|| Best Grade Points Per Unit v|

3ra| Units Attempted = ¥ v |

4th | Most Recent Term v

5th| From Enrallment v|

ﬁml From Course Transfer Credit V|

?“llll Fram Test Transfer Credit v|
Bthl From Other Transfer Credit v|
Q-thl ost Recent Date b |
10th | “l

Use the Repeat Rule 3 page to define the criteria and the order that are used by the Repeat Checking
process to determine which previous attempt should be matched with the current attempt. This criteria is
processed only when multiple previous attempts exist.
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Field or Control

Description

Prior Attempt Match Priority

Select the process order in which you want the Repeat
Checking process to identify the class to be matched with the
current attempt. The selected class is assigned the Set Prior
Attempt value that is defined on the Repeat Rule Detail 3

page.
Select up to ten processing options to indicate the order in
which you want the Repeat Checking process to find a prior
attempt match. This logic is invoked only when the student
has two or more previous repeat candidates for the class. The
process stops when it finds a class that meets the criteria or
it finds a blank value in the Prior Attempt Match Priority
field.

The processing options are:

* EarnCredit Flag =Y

*  Best Grade Points Per Unit or Worst Grade Points Per
Unit

»  Units Attempted = Y

*  Most Recent Term

*  From Enrollment

*  From Course Transfer Credit
»  From Test Transfer Credit

*  From Other Transfer Credit
*  Most Recent Date

o Includein GPA =Y

You can change the order of the criteria to meet the
requirements of your institution.

Note: Regardless of the order that you select for the Prior
Attempt Match Priority field, when the Repeat Checking
process utilizes either the Best Grade Points Per Unit or Worst
Grade Points Per Unit options, it matches only on classes for
which the Earn Credit flag =Y.

Note: When multiple previous attempts exist, the Repeat
Checking process invokes the default criteria order to find
a match if only minimal criteria are defined—for example,
if only From Course Transfer Credit is listed and no match
exists, the remaining criteria are processed in default order
until a match is found.
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Access the Repeat Rule Detail 1 page (Records and Enrollment > Term Processing > End of Term

Processing > Repeat Rule > Repeat Rule Detail

This example illustrates the fields and controls on the
for the fields and controls later on this page.

1.

Repeat Rule Detail 1 page. You can find definitions

Repeat Rule Repeat Rule3

Academic Institution: PSLINY FeopleSoft University

Academic Career: LIGRD

Undergraduate

lgnore w

[Special Permission

Enrollment Message:

‘Description:

Repeat Rule Detail 1

Repeat Rule: UNMDERGRD  Effective Term: 0650 2010 Fall
Repeat Rule Sequence
*Seq. No: |—1 EI
Grade Points: 0.000 Through: 4.000
Total Attempts Allowed: W Total Units Allowed: l—
Repeat Code Violated: Lol @ lllegal Repeat

<epeat Rule Detail 2

<epeat Rule Detail 3

‘Long Description: Special permission to repeat course

Field or Control

Description

Seq No (sequence number)

Enter the sequence number for this detail line of the repeat
rule. You can have as many rule detail lines as necessary.
The sequence number tells the system the order in which to
evaluate the detail lines of the repeat rule.

For example, you might have four detail lines: one for special
permission of all grades; one for the repeats of F grades (those
grade points between 0.000 and 0.999), which are permitted
twice; one for repeats of D grades (those with grade points
between 1.000 and 1.999), which are permitted once; and one
for repeats of all other grades (those with grade points between
2.000 and 4.000).

Important! The sequence number of the detail lines is crucial
because as soon as the Repeat Checking process (SRPCERPT)
finds a rule detail line that applies, it ignores subsequent detail
lines.

Grade Points

Enter the lowest value in a range of grade points per unit for
which the detail line of the repeat rule applies.
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Field or Control

Description

Through

Enter the highest value in a range of grade points per unit for
which the detail line of the repeat rule applies.

For example, at PSUNV we use a 4 point grade scale. To apply
a detail line to the grade of F, we would enter Grade Points 0.
000 and Through 0.999. To apply the detail line to all grades
we would enter Grade Points 0.000 and Through 4.000.

Total Attempts Allowed

Enter the number of attempts that a student is allowed within
this grade point range. This number includes the original

attempt and repeat attempts. The value that you enter should
include all attempts of the course, including the first attempt.

Total Units Allowed

Enter the total units for which a student is allowed to receive
a grade within this grade point range. The value that you enter
should include all units taken for the course, including the
units of the first attempt.

You can set both total attempts and total units maximums, or
you can set just one. If you set both maximums, the Repeat
Checking process uses the first maximum that it reaches.

If you set neither maximum, the process uses the system
defaults, 99 for total attempts and 999 for total units.

Repeat Code Violated

Enter the repeat code that the Repeat Checking process assigns
to a student's enrollment record if the student exceeds the
defined attempts or units of this detail line of the repeat rule.

For example, if your organization allows students to repeat

a course only twice, within a certain grade point range, you
would enter 3 in the Total Attempts Allowed field—one for
the initial enrollment plus two additional repeated attempts.
Then, if the student attempts to enroll in the course a fourth
time and violates the total attempts allowed for the rule, the
process assigns the Repeat Code Violated field value to the
course. If your organization has no restriction on the number
of times that a student can repeat a course within a certain
grade point range, use the Total Attempts Allowed default
value of 99.

You must enter a Repeat Code Violated field value.

Enrollment Message

You can define how the Repeat Checking process alerts a
student during enrollment if the student exceeds the total
attempts or units allowed of this detail line of the repeat rule:

*  Select Warning to alert the student by displaying a
warning message about the possible consequences of
continuing with the enrollment.

*  Select Ignore if you do not want the Repeat Checking
process to issue a message.

The enrollment message applies only to repeat checking on
enrollment (front end).
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Access the Repeat Rule Detail 2 page (Records and Enrollment > Term Processing > End of Term
Processing > Repeat Rule > Repeat Rule Detail 2).

This example illustrates the fields and controls on the Repeat Rule Detail 2 page. You can find definitions

for the fields and controls later on this page.

Repeat Rule eneat Rule2 ! lepeat Rule Detail 1 Repeat Rule Detail 2 | Repeat Rule Detail 3
Academic Institution: PSUINY PeopleSoft University
Academic Career: UGRD Undergraduate

Repeat Rule: UMDERGRD Effective Term: 0650  2010Fall
Find | “iewe 211 First E = |E| Last
Sed. No: 1 E|
O lgnore (& Must Equal

Current Repeat Codes For Ignore/Must Equal Condition
1) |[GRFR 3, Exception/Grandfather Clause 5) Q

2) Q 6) Q
3) Q 7) Q
4 Q g) Q

Sometimes a course that the student repeats already has a repeat code assigned. For a student's current
course attempt, a repeat code might have been assigned manually during the enrollment process on either
the Student Enrollment 1 page, the Quick Enrollment page, or the Enrollment Request page. Use this page
in conjunction with the rules that you define on the Repeat Rule Detail 1 page.

Field or Control

Description

Ignore

Select to have the Repeat Checking process (SRPCERPT)
ignore this detail line of the repeat rule when evaluating the
current course attempt if the repeat code already present for the
current course matches any of the repeat code values that you
select in the Current Repeat Codes For Ignore/Must Equal
Condition group box fields.

Must Equal

Select to have the Repeat Checking process consider this
detail line of the repeat rule when evaluating the current
course attempt only if the repeat code already present for the
current course matches any of the repeat code values that you
select in the Current Repeat Codes For Ignore/Must Equal
Condition group box fields.

In this example, for Seq. No 1 of the Repeat Rule Detail 1
page to be applied, the current attempt of the course must
already have repeat code GRFR assigned.
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Designating Process Actions for Repeat Rule Sequences

Access the Repeat Rule Detail 3 page (Records and Enrollment > Term Processing > End of Term
Processing > Repeat Rule > Repeat Rule Detail 3).

This example illustrates the fields and controls on the Repeat Rule Detail 3 page. You can find definitions

for the fields and controls later on this page.

Academic Institution: PEUNY

Academic Career: UGRD

Repeat Rule: LUNDERGRD

Seq]. No:

If Current Attempt is Best Grade

If Prior Attempt is Best Grade

If Current and Prior Attempt Grades are the same

RepeatRule | RepeatRule? | RepeatRule2 | Repeat Rule Detail1 | RepeatRule Detail2 | Repeat Rule Detail 3

FeopleSoft University

Undergraduate

Effective Term: 0Es0 2010 Fall

Set Current Attempt: GPAl x Repeat for GPA Improvement
Set Prior Attempt: ExCM @ Repeated - Excluded

Set Current Attempt: GPA Q Repeat far GPA Improvemeant

Set Prior Attempt: ExcM & Repeated - Excluded

Set Current Attempt: GPA & Repeat for GPA Improvement

Set Prior Attempt: EXCM QU Ropeated - Excluded

Enter codes for each repeat rule detail line that you create for the repeat rule. The Repeat Checking
process assigns these repeat codes only if the student's grade point on the prior course attempt falls within
the range that you specify on the Repeat Rule Detail 1 page.

Field or Control

Description

Set Current Attempt Enter a repeat code for the current attempt. The Repeat
Checking process assigns the repeat code that you select here
to the student's current attempt of the course.

Set Prior Attempt Enter the repeat code for the prior attempt. The Repeat

Checking process assigns the repeat code that you select here
to the student's previous attempt of the course.

If Current Attempt is Best Grade

In the If Current Attempt is Best Grade group box, select the appropriate repeat codes for the Repeat
Checking process to post to a student's enrollment record if the current attempt of the course has the best

grade.
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If Prior Attempt is Best Grade

In the If Prior Attempt is Best Grade group box, select the appropriate repeat codes for the system to
post to a student's enrollment record if the prior attempt of the course has the best grade.

If Current and Prior Attempt Grades are the same

In the If Current and Prior Attempt Grades are the same group box, select the appropriate repeat
codes for the system to post to a student enrollment record when the current and prior attempt grades are
the same.

Examples of Multiple Repeat Matching

If multiple repeated courses are counted, the prior attempt that is selected to match with the current
attempt is determined by the setup on the Repeat Rule 3 page.

The following options are available:
e Earn Credit Flag=Y

* Best Grade Points Per Unit or
*  Worst Grade Points Per Unit
e Units Attempted =Y

* Includein GPA=Y

*  Most Recent Term

*  From Enrollment

*  From Course Transfer Credit
*  From Test Transfer Credit

*  From Other Transfer Credit

¢ Most Recent Date

Note: In certain scenarios, certain options are inserted into the logic: best/worst grade matches are based
on the earn credit flag = Y and the most recent date is analyzed if more than one of the same Most Recent
Term exist.

Here are some scenarios in which the following repeat codes are assigned:
*  EXCM (Earned Credit and Include in GPA = N)
e GPAI (Earned Credit and Include in GPA =)

*  PETM (Earned Credit and Include in GPA =Y). Setup to not be overlaid.

Example 1

The course is set up in the course catalog to allow credit for two repeats:
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» Fall 2006, grade C
» Fall 2007, grade D
» Fall 2008, grade B
Scenario 1 - Best Grade

According to school policy, the student can retake the course an unlimited number of times. No limits
exist on the Repeat Rule 1 or Repeat Rule Detail 1 setup.

The course that is selected as the previous course attempt is the course with the best grade points per unit
where the Earn Credit check box is selected on STDNT ENRL. In this example, the Fall 2008 attempt is
the current attempt, while Fall 2006 is selected as the previous attempt.

Based upon the Repeat Rule Detail 3 setup (If Current Attempt is Best Grade - Current = GPAI, Prior =
EXCM), the repeat codes are assigned:

* Fall 2006, grade C EXCM
e Fall 2007, grade D

» Fall 2008, grade B GPAI
Scenario 2 - Worst Grade

The course that is selected as the previous course attempt is the course with the worst grade points per
unit where the Earn Credit check box is selected on STDNT ENRL. In this example, the Fall 2008
attempt is the current attempt, while Fall 2007 is selected as the previous attempt.

Based upon the Repeat Rule Detail 3 setup (If Current Attempt is Best Grade - Current = GPAI, Prior =
EXCM), the repeat codes are assigned:

» Fall 2006, grade C
* Fall 2007, grade D EXCM
» Fall 2008, grade B GPAI

The student takes the class again with an A grade. Again the course that is selected as the previous course
attempt is the course with the worst grade points per unit where the Earn Credit check box is selected on
STDNT_ENRL. In this example, the Fall 2009 attempt is the current attempt, while Fall 2006 is selected
as the previous attempt (because Fall 2007 has the Earn Credit flag = N due to the existing EXCM code).

Here is how the enrollment records for this example would look:
» Fall 2006, grade C EXCM

» Fall 2007, grade D EXCM

* Fall 2008, grade B GPAI

» Fall 2009, grade A GPAI

Example 2

The course is set up in the course catalog for no allowable repeats:
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» Fall 2006, grade C
» Fall 2007, grade D
Scenario 1 — Most Recent Term

According to school policy, the student can retake a course an unlimited number of times, but only the
latest attempt counts.

Because the Most Recent Attempt option disregards the Earn Credit flag on STNDT ENRL, this setting
always compares with the most recent attempt.

Based on the Repeat Rule Detail 3 setup (If Prior Attempt is Best Grade - Current = GPAI, Prior =
EXCM), the repeat codes are assigned:

* Fall 2006, grade C EXCM
e Fall 2007, grade D GPAI

The student takes class Fall 2008, grade A. Fall 2008 is considered the current attempt and Fall 2007 is
the Most Recent Attempt. Based upon the Repeat Rule Detail 3 setup (If Current Attempt is Best Grade
- Current = GPAI Prior = EXCM)), the repeat codes are assigned as follows because the school policy
always counts the latest attempt:

» Fall 2006, ENGL 101, grade C EXCM
e Fall 2007, ENGL 101, grade D EXCM
» Fall 2008, ENGL 101, grade A GPAI

The student takes class Fall 2009, grade B. Fall 2009 is considered the current attempt and Fall 2008 is
the Most Recent Attempt. Based upon the Repeat Rule Detail 3 setup (If Prior Attempt is Best Grade

- Current = GPAI, Prior = EXCM)), the repeat codes are assigned as follows because the school policy
always counts the latest attempt:

* Fall 2006, ENGL 101, grade C EXCM

» Fall 2007, ENGL 101, grade D EXCM

» Fall 2008, ENGL 101, grade A EXCM

* Fall 2009, ENGL 101, grade B GPAI

Scenario 2 — Most Recent Term with repeat code to not be overlaid

School policy (as defined on Repeat Rule Detail 1) does not allow a repeat on grade points < 2.000, but
the student petitions and receives permission. The following repeat codes are manually assigned after the
student completes Fall 2007:

« Fall 2006, grade D EXCM
» Fall 2007, grade C PETM

The student takes class Fall 2008, grade A. Fall 2008 is considered the current attempt and Fall 2007 is
the prior attempt. The Repeat Rule Detail 3 is setup as If Current Attempt is Best Grade - Current = GPAI,
Prior = EXCM. While it still matches on Fall 2007, because the PETM is not to be overridden, the repeat
codes are assigned as follows:
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» Fall 2006, ENGL 101, grade C EXCM

» Fall 2007, ENGL 101, grade D PETM

» Fall 2008, ENGL 101, grade A GPAI

Scenario 3 — Most Recent Term — Multiple Same Terms exist — Most Recent Date

When multiples of the same Most Recent Term exist, the repeat engine analyzes the session start dates to
determine the Most Recent Date.

e Summer 2006, grade D (session 1 — June 1 start date)
e Summer 2006, grade D (session 2 — July 5 start date)

Because the start date of session 2 is the most recent date, it is determined to be the current attempt while
session 1 which has an earlier start date is considered the prior attempt. Based on the Repeat Rule Detail
3 setup (If Current and Prior Attempt are Same Grade - Current = GPAI, Prior = EXCM), the repeat codes
are assigned:

e Summer 2006, grade C (session 1 — June 1 start date) EXCM
*  Summer 2006, grade D (session 2 — July 5 start date) GPAI

Student takes class Fall 2008, grade A. Fall 2008 is considered the current attempt and Summer 2006
session 2 is the prior attempt (based on the Most Recent Date). Based on the Repeat Rule Detail 3 setup
(If Current Attempt is Best Grade - Current = GPAI, Prior = EXCM)), the repeat codes are assigned as
follows because the school policy always counts the latest attempt:

e Summer 2006, grade C (session 1 — June 1 start date) EXCM
e Summer 2006, grade D (session 2 — July 5 start date) EXCM

« Fall 2008, ENGL 101, grade A GPAI

Note: When Most Recent Date is used as a criteria, the session start date is the first determiner. If the start
dates are the same, then the session end dates are used as the determiner.

Scenario 4 — Most Recent Term — Enrollment before Transfer

According to school policy, the most recent attempt is always counted, but internal enrollments are
counted before transfer credit. To accommodate such a policy the repeat checking matching option might
be setup as follows:

¢ Most Recent Term
¢ From Enrollment

When multiples of the same Most Recent Term exist, the repeat engine analyzes the session start dates to
determine the Most Recent Date.

» Fall 2006, grade C (session 1) Enrollment
» Fall 2006, grade C (session 1) Transfer Credit

Based on the Repeat Rule Detail 3 setup (If Current and Prior Attempt are Same Grade - Current = GPAI,
Prior = EXCM), the repeat codes are assigned:
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» Fall 2006, grade C (session 1) Enrollment GPAI
» Fall 2006, grade C (session 1) Transfer Credit EXCM

Student takes class Fall 2008, grade A. Fall 2008 is considered the current attempt and Fall 2006 session
1 Enrollment is the prior attempt. Based on the Repeat Rule Detail 3 setup (If Current Attempt is Best
Grade - Current = GPAI, Prior = EXCM), the repeat codes are assigned as follows because the school
policy always counts the latest attempt:

» Fall 2006, grade C (session 1) Enrollment EXCM
» Fall 2006, grade C (session 1) Transfer Credit EXCM

» Fall 2008, grade A GPAI

Related Links
Running the Repeat Rule Checking Process in Batch

Example of a Repeat Rule

134

The following example shows how your institution might set up a repeat rule with two detail lines. This
example defines a repeat rule that allows students to repeat a course twice only or earn up to 12 units in a
repeated course. In addition, students must seek special permission to repeat classes. If students receive a
D or F in the course, they can repeat the course only once rather than twice. The Repeat Rule2 page might
look like this:

RepeatRule | Repeat Rule2 RepeatRuled | Repeat Rule Detail 1 Repeat Rule Detail 2 Repeat Rule Detail 3
Academic Institution: FEUNY FeaopleSaft University
Academic Career: UGRD Undergraduate

First K 20 5 0 Last

Repeat Rule; LIMNDERGRD Effective Term: nga0 2010 Fall (=]
Total Attempts Allowed: |_3
Total Units Allowed: 12.00

‘Repeat Code Violated: oL & llegal Repeat

Enrollment Message: Warning  +

Current Repeat Codes Exempted from Attempts/Units Allowed
1) [PETM 2L RepeatAllowed via Petition 5) Q

2) Q 6) Q
3) Q 7) Q
4) Q 8) Q

* The Total Attempts Allowed field is set to 3.

Undergraduate students can repeat courses twice only (first attempt plus two repeats equals three total
attempts).
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Undergraduate students can repeat courses for a total of 12 units, as specified in the Total Units
Allowed field.

We enter /LGL (illegal repeat) in the Repeat Code Violated ficld.

If the process finds a student in violation of the total attempts allowed or total units allowed, the
process assigns the I/LGL repeat code to the student's enrollment record for the repeated course.

The Enrollment Message field is set to Warning.

If the Repeat Checking process identifies the repeat on enrollment as exceeding the total attempts
allowed or total units allowed, it issues a warning message to alert the student about the possible
consequences of continuing with the enrollment.

We enter a repeat code exemption.

If a student's current term enrollment contains the PETM (repeat allowed via petition) repeat code,
the repeat rule does not prevent the enrollment—this exemption would also override the total attempts
allowed or total units allowed maximums on the Repeat Rule2 page during back-end processing. For
the student's enrollment to contain this repeat code, manually assign it to the enrollment record on the
Student Enrollment 1 page, the Quick Enrollment page, or the Enrollment Request page. In addition,
the assumption is that the exemption codes are included in special permission rules where these codes
are established as Must Equal conditions on the Repeat Rule Detail 2 page, though this is not required.

To require that students seek special permission to repeat classes, the Rule Detail 1 page might look like
this:

Repeat Rule Repeat Rule2 RepeatRulesd | Repeat Rule Detail 1 Repeat Rule Detail 2 Repeaat Rule Detail 3

Academic Institution: FELUNY PeapleSotft Univarsity

Academic Career: UGRD Undergraduate
Repeat Rule: UMDERGRD  Effective Term: 0gs0  20M10Fall

Repeat Rule Sequence Find | First E 1of 1 m Last
‘Seq. No: |—1 El
Grade Points: 0.000 Through: 4.000
Total Attempts Allowed: 'E Total Units Allowed:

Repeat Code Violated:  ILGL CU lllegal Repeat

Enrollment Message:

‘Description: |Spet:|al Fermission

‘Long Description: Special permission to repeat course

The sequence number is 1.
The Repeat Checking process considers this detail line first.

The process includes any repeated courses that have a grade-points-per-unit range from 0.000 through
4.000.
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This range ensures that the Repeat Checking process evaluates every attempt, regardless of the
student's grade. Because this is our most restrictive rule, we want the Repeat Checking process to
consider this rule first.

» Because the student must have special permission to repeat a course, we enter the value of 99 in the
Total Attempts Allowed ficld.

A student can repeat a class as many times as special permission is given.

* No total units allowed restriction exists for this detail line of the repeat rule.

The Repeat Rule Detail 2 page might look like this for the special permission detail line:

Academic Career:

Repeat Rule:

Academic Institution:

Repeat Rule Repeat RuleZ Repeat Rule3

Repeat Rule Detail 1

PSUMNY FeopleSof University

UGRD Undergraduate

UMNDERGRD

Effective Term:

Repeat Rule Detail 2 Repeat Rule Detail 3

2010 Fall

5 Q&
ol A
al Q&
gl  Q

Seq. No: 1
O lgnore & Must Equal
1) lﬁq Repeat Allowed via Petition
al  Q
. Q
alQ
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The Repeat Checking process applies the codes on the Repeat Rule Detail 3 page if the current course
attempt has been coded with PETM. The Rule Detail 3 page might look like this for the special
permission detail line:

Repeat Rule Repeat Rule2 epe tepeat Rule Detail 1 epeat Bule Detall2 | Repeat Rule Detail 3
Academic Institution: FEUMNY PeopleSoft University
Academic Career: UGRD Undargraduate

Repeat Rule: UNDERGRD Effective Term: 0E&50 2010 Fall

Find | View &l 4] 4 051 [P
Seq.No: 1 El

If Current Attempt is Best Grade

Set Current Attempt: REXC O Repeated - Excluded from Stats
Set Prior Attempt: REIG Q Repeated - Included in GPA

Iif Prior Attemnpt is Best Grade

Set Current Attempt: REIG Q Repeatad - Included in GPA
Set Prior Attempt: REXC Q@ Repeated - Excluded from Stats

If Current and Prior Attemnpt Grades are the same

Set Current Atempt:  [REXC U Repeated - Excluded from Stats

Set Prior Attempt: REIG QU Repeated- Included in GPA

» If'the current attempt of the class has the best grade, the system codes that class with REXC and sets
the prior attempt to REIG.

» If the prior attempt of the class has the best grade, the system codes that class with REXC and sets the
current attempt to RE/G.

» If the current and prior attempt have the same grade, the system codes the current attempt as REXC
and the prior attempt as REIG.
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If the current course attempt does not meet the criteria (current attempt has PETM) then the program

moves to the next sequence detail line.

For the next detail line of the repeat rule, we want to specify that students can repeat D and F grades only

once. The Repeat Rule Detail 1 page looks like this:

138

Repeat Rule Repeat Rule2 Repeat Rule3 Repeat Rule Detail 1 Repeat Rule Detail 2 Repeat Rule Detail 3

Academic Institution: PSURY PeopleSoft University

Academic Career: UGRD Undergraduate
Repeat Rule: UNDERGRD  Effective Term: 0650 2010 Fall

Repeat Rule Sequence Fird | e Al First 4 [Py [+ L ast
*Seq]. No: I—Q El
Grade Points: o.aoo Through: 1999
Total Attempts Allowed: |_2 Total Units Allowed:
Repeat Code Violated:  ILGL <L llegal Repeat

|RepeatDs and Fs

Enrolliment Message:

‘Description:

‘Long Description: Ds and Fs may be repeated only once {two total atternpts)

The sequence number is 2.

The system considers this detail line of the repeat rule second in the Repeat Checking process.
Repeated courses that have a grade-points-per-unit range from 0.000 through 1.999 are included.
Note that the grade range is concerned with only the grade of the prior course in the matched pair.

A student is permitted to repeat a D or F grade once, and this is reflected in the Total Attempts
Allowed field value of 2.

Course attempts include all attempts of the course, not just the repeats. In addition, the allowable
course catalog repeats constitute the first attempt in this total attempts allowed. Therefore, if the
catalog allows four attempts, all four of those attempts would constitute the first attempt in this
number.

No total units allowed restriction exists for this rule.

If students violate the number of attempts, the Repeat Checking process assigns the repeat code /LGL

to the student's enrollment record for the current attempt, as defined in the Repeat Code Violated
field.
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The Repeat Rule Detail 2 page might look like this for this detail line of the repeat rule:

Repeat RuleZ

Academic Institution: PEUMNY PeapleSoft University
Academic Career: UGRD Undergraduate
Repeat Rule: UMDERGRD Effective Term: 0650 2010 Fall
Seq). No: 2
@ lgnore (2 Must Equal
1 [ExCM C  Repeated - Excluded 5) [ a
2) lﬁQ Repeat Forgiveness Atternpt 6) I—Q
3) lﬁQ Repeat Fargiven - Included 7 I—Q
1) WQ Repeat Fargiven - Excluded 8) I—Q

On this page, the system does not apply this rule detail sequence if the current attempt has any one of the

selected repeat codes attached to it.

The Repeat Rule Detail 3 page might look like this for this detail line of the repeat rule:

Academic Institution: PEUNY PeapleSoft University

Academic Career: UGRD

Undergraduate

Repeat Rule: LUMDERGRD Effective Term: 0650 2010 Fall

Seq]. No:

If Current Attempt is Best Grade
Set Current Attempt: GPAl & Repeat for GPA Improvement
RINC & Replaces Previous Atternpt

Set Prior Attempt:

Repeat Rule Detail 3

If Prior Attempt is Best Grade
Set Current Attempt: GPA & Repeat for GPA Improvement

Set Prior Attempt: RING Q Replaces Previous Atternpt

If Current and Prior Attempt Grades are the same
Set Current Attempt: GPA & Repeat for GPA Improvement

Set Prior Attempt: RING & Replaces Previous Attempt

Note: When the Repeat Checking process finds a matched pair of courses that violates a detail line of the

repeat rule, it moves on to the next pair of matching courses.
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Setting Up Repeat Checking for Academic Institutions

This section discusses how to set up repeat checking for academic institutions.

Page Used to Set Up Repeat Checking for Academic Institutions

Page Name

Definition Name

Navigation

Usage

Academic Institution 5

INSTITUTION_TABLES

Set Up SACR >
Foundation Tables >

Academic Structure >

Academic Institution
Table > Academic

Set repeat checking controls
for academic institutions.
Academic institution level
is the highest level of control
for the automatic Repeat

Institution 5 Checking process.

Setting Repeat Checking Controls for Academic Institutions

Access the Academic Institution 5 page (Set Up SACR > Foundation Tables > Academic
Structure > Academic Institution Table > Academic Institution 5).

This example illustrates the fields and controls on the Academic Institution 5 page. You can find
definitions for the fields and controls later on this page.

AcademicInstitution 1 || Academicnstitution 2 || AcademicInstitution 3 || Academic Institution 4 || Academic Institution 5 || Academic Institution 5 | [¥)

Academic Institution PSUNYV PeopleSoft University
First ‘4' 10of1 ‘B Last

[+l (=]

Find | View All

Effective Date 01/01/1900 Status Active

Repeat Check

*Process on Enrollment | No hd Temporarily Suspend Repeat Check on Enrollment

*Repeat Grade Check| Mever e Temporarily Suspend Repeat Check on Grade Input

Process on Transfer Credit

Repeat Check at Topic Level O

Capture Repeat Assignment Date
On Enroliment Process
[CJon Repeat Process

Grade Match Option Best grade

Academic Program Options

Select Acad Prog During Enroll

Set Form Of Study to Enroliment on Program Change
Waitlist Options

[Jcheck Service Indicator

Class Enrollment Total - Facility Capacity Edit

Oedit Ffacility capacity against enrollment total on class limit override

O edit Ffacility capacity against enrollment total on class limit permission
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Field or Control

Description

Process on Enrollment

Use this field to activate or deactivate the automatic Repeat
Checking process at enrollment time (front-end processing)
for this entire academic institution. Enter one of the following
values.

Yes: Enter if you want the Repeat Checking process to
automatically run during enrollment for this academic
institution. This is a front-end process that checks repeats,
based on repeat rules that you set up in the Repeat Rule
component. The process is front-end because it checks for
repeats at enrollment, rather than when you post grades. You
can run the Repeat Checking process for this entire academic
institution, for students in specific academic careers within
the academic institution, or for students in specific academic
programs within the academic careers. When you enter Yes
at the academic institution level, this value cascades down to
the academic career and academic program levels. Thus, when
you enter Yes for an academic institution, every academic
career and academic program within that institution is also
set to Yes. However, you can still manually enter No at the
academic career and academic program levels.

No: Enter if you do not want the Repeat Checking process to
run for this entire academic institution during enrollment. If
you enter No here, the system sets the Process on Enrollment
field at the academic career and academic program levels to
No and renders them unavailable.

Warning! When you enter Yes at the academic institution
level, every academic career and program within this
institution is set to Yes. The same is true if you enter No. If you
change the setting from Yes to No, you also change the settings
for every academic career and program within this institution.
To reset the fields, you must go into each academic career and
academic program and change them manually.
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Field or Control

Description

Repeat Grade Check

Use this field to activate or deactivate repeat checking on
grade input for this entire academic institution. The available
values are:

All Crse (all courses): Enter if you want the Repeat Checking
process to run during grade input (on the Enrollment Request
page) for every course in this academic institution. This is a
back-end process that checks for repeats based on repeat rules
that you set up in the Repeat Rule component. The process is
back-end because it checks for repeats when you post grades,
after the student has already completed the class. You can
run the Repeat Checking process for this entire academic
institution, for specific academic careers within the academic
institution, or for specific academic programs within academic
careers. When you enter A/l Crse at the academic institution
level, the system runs the Repeat Checking process for every
academic career within this academic institution that has a
value of A/l Crse in the Repeat Grade Check field in the
Academic Career Table component. Similarly, if you select
All Crse at the academic career level, the system looks at the
repeat grade check setting at the academic program level to
determine whether to run the Repeat Checking process for
each academic program within the academic career.

Never: Enter if you do not want the Repeat Checking process
to run during grade input on the Enrollment Request page.

If you enter Never here, the system sets the Repeat Grade
Check field at the academic career and academic program
levels to Never, and renders the field unavailable.

Only Rep (only repeats): Enter if you want to run the process
against all class enrollments on a student's enrollment record
(STDNT_ENRL table) where the repeat candidate field is

set to Y. The only time that the system does not set the repeat
candidate field to Y is for class enrollments that are entered
through the Enrollment component or for classes for which the
course is defined as an allowable repeat through the Course
Catalog component.

Warning! When you enter All Crse at the academic institution
level, every academic career and academic program within this
academic institution is also set to A// Crse. The same is true

if you enter Never: If you change the setting from A/l Crse to
Never, you also change the settings for every academic career
and program within this academic institution. To reset the
fields, you must access each academic career and program and
change them manually.

Note: The automatic Repeat Checking process runs only
when you post grades using the Enrollment Request page. The
process does not run when you post grades using the grade
roster, Quick Enrollment page, or Student Enrollment 1 page.
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Field or Control Description

Temporarily Suspend Repeat Check on Enrollment Select to temporarily suspend the Repeat Checking process
at enrollment for this academic institution. This check box
enables you to temporarily suspend repeat rule checking
during peak enrollment periods, when the Repeat Checking
process would seriously impair performance. After the peak
period has passed, return to this page and clear this check box
to re-enable the Repeat Checking process on enrollment. Use
this functionality sparingly, because students attempting to
repeat a class are not warned about a possible illegal repeat.
Selecting this check box renders the Process on Enrollment
and Temporarily Suspend Repeat Check on Enrollment
fields at the academic career and program levels unavailable.
However, selecting this check box does not change the
settings in the Process on Enrollment fields at the academic
career or program levels. Note that this is the main difference
between the cascading functionality through the Process

on Enrollment and Repeat Grade Check fields and the
suspension functionality—suspension does not alter the
previous settings of lower levels.

Temporarily Suspend Repeat Check on Grade Input Select to temporarily suspend the Repeat Checking process
during grade input for this academic institution. This check
box enables you to temporarily suspend repeat checking
during peak grading periods, when the Repeat Checking
process would seriously impair performance. After the peak
period has passed, come back to this page and clear this check
box to re-enable the Repeat Checking process on grade input.
Use this functionality sparingly because the system does not
check for repeats, so you will not know whether any repeat
rules apply to students until you run the Repeat Checking
process manually. Selecting this check box renders the Repeat
Grade Check and Temporarily Suspend Repeat Check

on Grade Input fields at the academic career and program
levels unavailable. However, selecting this check box does not
change the settings in the Repeat Grade Check fields at the
academic career or program levels. Note that this is the main
difference between the cascading functionality through the
Process on Enrollment and Repeat Grade Check fields and
the suspension functionality—suspension does not alter the
previous settings of lower levels.

Process on Transfer Credit When you post on line or batch transfer credit, use this check
box to include or exclude the Repeat Checking process. The
check box is selected by default.

Note: If the value in the Scope field on the Repeat Checking
page is All Work for Term or Transfer/Test Credit, the Repeat
Checking process assigns repeat codes to transfer credit even
though the Process on Transfer Credit check box is not
selected.
If you do not want to run repeat checking on transfer credit,
clear the Process on Transfer Credit check box and enter a
value of Student Enrollments Only in the Scope field on the
Repeat Checking page.
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Field or Control

Description

Repeat Check at Topic Level

Select if you want to enable repeat checking at the course topic
level for this institution. Define repeat rules in the Repeat
Rules component. You can disable repeat checking at the
course topic level for a specific course on the Course Catalog -
Catalog Data page.

Capture Repeat Assignment Date

Select the On Enrollment Process check box if you want the
Repeat Date (REPEAT DT) populated on STDNT ENRL
when repeats are processed during the Enrollment process.

Select the On Repeat Process check box if you want the
Repeat Date (REPEAT DT) populated on STDNT ENRL
when repeats are processed during the Repeat Checking
process.

Grade Match Option

Use the Repeat Rule3 page to establish grade match options.

Academic Program Options

Field or Control

Description

Select Acad Prog During Enroll (select academic program
during enrollment)

Select to enable the Academic Program field on all
enrollment pages that allow users to select an academic
program to associate with each class. The field is available
within enrollment only when a student is matriculated in
more than one program. Clearing this check box hides

the Academic Program field on all enrollment pages and
associates the student's primary academic program with each

class.

See “Setting Up Self-Service Options” (Campus Solutions
Application Fundamentals).

Waitlist Options

Field or Control

Description

Check Service Indicator

Select if you want to check service indicators when you run
the Waitlist Process.

Class Enroliment Total - Facility Capacity Edit

Use this region to set whether to show a warning or rejection message when you don’t want:

* Administrators to override class limits if it exceeds facility capacity.
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*  Administrators or students to use class permission if the enrollment will exceed facility capacity.

Field or Control

Description

Edit facility capacity against enrollment total on class limit

override

Select this option to decide whether you want to display a
warning or rejection message to inform administrators that the
institution doesn’t allow the total class enrollment to exceed
facility capacity.

The message appears when administrators attempt to override
the class limit during an enrollment transaction, and that
override would exceed the facility capacity for that class

section.

Edit facility capacity against enrollment total on class limit
permission

Select this option to display a warning or rejection message
that informs administrators or students that the institution
doesn’t allow the total class enrollment to exceed the facility

capacity.

The message appears when either administrators or students
attempt to use a Class Permission number during an
enrollment transaction to override class limits, and that
override would exceed the facility capacity for that class
section.

See Managing Enrollment Capacity.

Setting Up Repeat Checking for Academic Careers

This section discusses how to set repeat checking controls for academic careers.

Page Used to Set Up Repeat Checking for Academic Careers

Page Name Definition Name

Navigation Usage

Repeat Checking ACAD CAR RPT CHK

Set Up SACR >
Foundation Tables >
Academic Structure >
Academic Career Table >
Repeat Checking

Set repeat checking controls

at the academic career level.

Also, link a repeat rule to an
academic career.

Setting Repeat Checking Controls for Academic Careers

Copyright

Access the Repeat Checking page (Set Up SACR > Foundation Tables > Academic Structure >

Academic Career Table > Repeat Checking).
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This example illustrates the fields and controls on the Repeat Checking page. You can find definitions for

the fields and controls later on this page.

IEl Repeat Checking el ervice Options

PSURMY
LIGRD

Academic Institution:
Academic Career:

FeapleSoft University
Undergraduate

First E 1of 1 |I| Last

Effective Date: 010111900 Status:  Active

Repeat Check

Scheme: UGRD Q Lndergraduate

Repeat Rule: UNDERGRD & Undergraduate Grading Rule

*Process on Enrollment: I Mo :l' = Tempaorarily Suspend Repeat Check an Enrallment

*Repeat Grade Check: INever :l' = Temporarily Suspend Repeat Check on Grade Input
Course Catalog Repeats

*Course Catalog Repeat Message: |Warning :"

Field or Control Description

Scheme Enter a repeat scheme for this academic career. Repeat
schemes contain the set of all valid repeat codes for this
academic career.

Repeat Rule Enter a repeat rule to assign to this academic career. Repeat

rules contain the conditions that define your repeat checking
policies. For example, the repeat rule can specify how many
times a student can take courses given certain conditions,

such as the grades earned. Settings at the academic career
level serve as defaults for all of the academic programs within
this academic career wherein a repeat rule is not attached to
the academic program. Repeat rules must be assigned to an
academic career for the Repeat Checking process to function
at enrollment or grade input. Define repeat rules on the Repeat
Rule page.
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Field or Control

Description

Process on Enrollment

Use this field to activate the Repeat Checking process for the
academic career at enrollment. Values are Yes and No.

Enter Yes if you want the Repeat Checking process to run
during enrollment for this academic career. This front-end
process checks repeats based on repeat rules that you set up in
the Repeat Rule component. The process is front-end because
it checks for repeats at enrollment rather than when you post
grades. You can run the Repeat Checking process for the
entire academic institution, for students in particular academic
careers within the academic institution, and for students in
primary academic programs within academic careers. When
you enter Yes at the academic career level, the system runs

the Repeat Checking process for all students in every primary
academic program within this academic career that has a value
of Yes in the Process on Enrollment field in the Academic
Program Table component. This field is unavailable if No is
entered at the academic institution level.

Warning! When you enter Yes at the academic career level,
every academic program within this academic career is also
set to Yes. The same is true if you enter No. If you change the
setting from Yes to No, you also change the settings for every
academic program within this academic career. To reset the
fields, you must go into each academic program and change
them manually.

Copyright © 1988, 2023, Oracle and/or its affiliates.

147



Setting Up Repeat Checking

148

Chapter 4

Field or Control

Description

Repeat Grade Check

Use this field to activate the Repeat Checking process on grade
input for this academic career.

All Crse (all courses): Enter this value if you want the Repeat
Checking process to run during grade input for this academic
career. This back-end process checks repeats based on repeat
rules that you set up in the Repeat Rule component. The
process is back-end because it checks for repeats when you
post grades on the Enrollment Request page, after the student
has completed the class. You can run the Repeat Checking
process for the entire academic institution, for academic
careers within the academic institution, and for academic
programs within academic careers. When you enter A/l Crse
at the academic career level, the system runs the Repeat
Checking process for every academic program within this
academic career that has a value of 4// Crse in the repeat
grade check field in the Academic Program Table component.
This field is unavailable if Never is entered at the academic
institution level.

Never: Enter this value if you do not want the Repeat
Checking process to run during grade input on the Enrollment
Request page. If you enter Never here, the system sets the
Repeat Grade Check field at the academic program level to
Never and renders the field unavailable. Likewise, the Repeat
Grade Check field on this page is unavailable when you enter
Never at the academic institution level.

Only Rep (only repeats): Enter if you want to run the process
against all class enrollments on a student's enrollment record
(STDNT_ENRL table) for which the repeat candidate field is
set to Y. The only time that the system does not set the repeat
candidate field to Y is for class enrollments that are entered
through the Enrollment component or for classes for which the
course is defined as an allowable repeat through the Course
Catalog component.

Warning! When you enter Never; the system changes the
setting in the Repeat Grade Check field for every academic
program to Never. To reset the fields, you must go into each
academic program and change them manually.

Note: The automatic Repeat Checking process runs only
when you post grades using the Enrollment Request page. The
process does not run when you post grades using the grade
roster, Quick Enrollment page, or Student Enrollment 1 page.
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Field or Control Description

Temporarily Suspend Repeat Check on Enrollment Select to temporarily suspend the Repeat Checking process
during enrollment for this academic career. This option
temporarily suspends repeat checking during peak enrollment
periods, when the Repeat Checking process would seriously
impair performance. After the peak period, return to this page
and clear this check box to re-enable the Repeat Checking
process on enrollment. Use this functionality sparingly,
because students attempting to repeat a class are not warned
about a possible illegal repeat. Selecting this check box
renders the Process on Enrollment and Temporarily
Suspend Repeat Check on Enrollment fields at the academic
program level unavailable. However, selecting this check box
does not change the settings in the Process on Enrollment
fields at the academic program level.

Temporarily Suspend Repeat Check on Grade Input Select to temporarily suspend the Repeat Checking process
during grade input for this academic career. This check box
enables you to temporarily suspend repeat checking during
peak grading periods, when the Repeat Checking process
would seriously impair performance. After the peak period
has passed, return to this page and clear this check box to re-
enable the Repeat Checking process on grade input. Use this
functionality sparingly because the system does not check
for repeats while grading through the Enrollment Request
page, so you will not know whether any repeat rules apply to
students until you run the Repeat Checking process in batch.
Selecting this check box renders the Repeat Grade Check
and Temporarily Suspend Repeat Check on Grade Input
fields at the academic program level unavailable. However,
selecting this check box does not change the settings in the
Repeat Grade Check fields at the academic program level.
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Field or Control

Description

Course Catalog Repeat Message

Enter the message type that the system displays during
enrollment when the course catalog Allowable Repeats process
detects that the student has previously taken the course. The
choices are:

Error: Issues an error and prevents the student from enrolling
in the repeated class.

Warning: Issues a warning that the repeatable limit, as
established on the course catalog, has been exceeded. The
system allows the student to enroll in the class.

None: Issues no warning or error and allows the student to
enroll in the class.

The course catalog Allowable Repeats process runs at class
enrollment and looks at settings at the course catalog level

to see whether a course can be repeated. This process does
not affect student statistics; it is used to determine whether a
student can repeat a course. When the completions maximum
or units maximum is exceeded, the system issues enrollment
messages, depending on the message type selected (assuming
that the course catalog repeats functionality is in effect).

The system renders the Course Catalog Repeat Message
field unavailable when you enterYes in the Process on
Enrollment field. The system renders the field unavailable
because when you run the Repeat Checking process on
enrollment, the course catalog Allowable Repeats process does
not issue a message when a repeated course is in violation of
the course catalog repeat maximums. The Repeat Checking
process analyzes the student's enrollment records for repeated
courses and issues warnings only after the course catalog
Allowable Repeats process identifies an enrollment that
exceeds the completions maximum or units maximum set on
the Catalog Data page of the Course Catalog component.

Setting Up Repeat Checking for Academic Programs

This section discusses how to set repeat checking controls for academic programs.

Page Used to Set Up Repeat Checking for Academic Programs

Page Name

Definition Name

Navigation Usage

Repeat/Incomplete

INCOMPLETE_GRADE

Set Up SACR >
Foundation Tables >
Academic Structure >
Academic Program
Table > Repeat/
Incomplete

Set repeat checking controls
at the academic program
level and link repeat rules to
academic programs.
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Setting Repeat Checking Controls for Academic Programs

Access the Repeat/Incomplete page ((Set Up SACR > Foundation Tables > Academic Structure >
Academic Program Table > Repeat/Incomplete).

Linking a repeat rule to an academic program is the last step in setting up repeat checking. However,

this is not a required step. If you do not attach a repeat rule at the academic program level, the Repeat
Checking process uses the repeat rule set for the academic career to which the academic program belongs.
Thus, link a repeat rule to an academic program on/y if 'you do not want the Repeat Checking process to
use the repeat rule that is specified for the academic career.

See “Defining Repeating Rules and Grade Lapse Rules for Academic Programs” (Campus Solutions
Application Fundamentals).
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Understanding the Course Catalog

When you first set up your course catalog, make sure to do some preliminary work to research how

your institution structures course prerequisites and corequisites, and how new requisites are created

and approved. Our course requisite design lets you structure requirements that can be shared among
many courses. Requirements can encompass prerequisite courses, grade point average (GPA) and unit
requirements, and course lists, among other factors. To minimize duplicate data entry, plan your requisite
requirements carefully. In addition, note that the data you enter in the course catalog is provided by
default to the schedule of classes. This feature is key because it saves you data entry time when you
schedule classes. The Course Catalog (CRSE _CATALOG) component uses effective dating, which
enables you to track historical course changes and to prepare for curriculum changes in the future.

Prerequisites for Setting Up the Course Catalog

Before you can define courses in the course catalog, you must set up the following data for your
institution:

* Institution codes

e Academic groups

*  Subject area

» Campuses

* Academic organizations

* Academic careers

* (Optional) Room characteristics

e (Optional) Requirement designations

* (Optional) Course attributes

Related Links

“Defining Academic Institutions” (Campus Solutions Application Fundamentals)
“Defining Academic Groups” (Campus Solutions Application Fundamentals)
“Defining Subject Areas” (Campus Solutions Application Fundamentals)
“Setting Up Campuses” (Campus Solutions Application Fundamentals)

“Defining Academic Organizations” (Campus Solutions Application Fundamentals)
“Defining Academic Careers” (Campus Solutions Application Fundamentals)
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Defining Buildings, Rooms, and Classroom Facilities

Defining Requirement Designations
Setting Up Catalog and Schedule Options

Creating Course Offerings

This section provides an overview of course offerings, lists prerequisites, and discusses how to:
* Define course catalog data.

* Define course offerings.

* Define course components.

* (NZL) Set up government reporting data.

* Link milestones to course data.

» Interface course offerings with the general ledger.

Understanding Course Offerings

The Course Catalog component contains several pages that enable you to enter all information for a
course offering: the course title, units, workload hours, components, description, topics, requisites, and
so on. We review each of the pages in the order in which you use them to set up a new course offering.
In our design, a course offering includes all components of a course, such as lecture, laboratory, and
discussion.

You complete these steps to create a course:

1. Define the course title, description, units, grade bases, repeat rules, equivalent course groups, topics,
and course attributes on the Catalog Data page.

2. Define the course offering number, catalog number, subject area, academic organization,
Classification of Instructional Programs (CIP) and Higher Education General Information Survey
(HEGIS) codes, and attach requirement designations on the Offerings page.

3. Define the course components and the final exam and room characteristics on the Components page.

4. Map courses as course item types to specific general ledger accounts on the GL Interface page.

Prerequisites

154

After you set up your institution codes, academic groups, subject areas, campuses, academic
organizations, and academic careers, you can set up the basics of your course catalog. At this point, you
should have set up room characteristics, requirement designations, enrollment requisites, and course
attributes also.
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Page Name Definition Name Navigation Usage

Catalog Data CRSE_CATALOG Curriculum Define course titles, course
Management > Course units, grade bases, topics, and
Catalog > Course repeat rules.
Catalog > Catalog Data

Offerings CRSE_CATALOG_OFFER Curriculum Define course numbers, link
Management > Course academic organizations to
Catalog > Course course offerings, and so on.
Catalog > Offerings

Components CRSE_CATALOG_CMPNT | Curriculum Define components, such

Management > Course
Catalog > Course
Catalog > Components

as lecture, laboratory,

and discussion, as well

as instructor workload
hours, room characteristics,
additional fees, and final
exams.

Crse Catalog NZL (course
catalog New Zealand)

SSR_CRS_CAT NZL

Curriculum
Management > Course
Catalog > Course
Catalog > Crs Catalog
NZL

Set up SDR and EFTS data
for a course.

Note: The fields on this page
are available only if you select
the New Zealand Catalog,
SDR, EFTS, StudyLink
check box on the Academic
Institution 6 page. You should
also select the New Zealand
NSI and SDR Personal
Data, SDR Degree check box
on the SA Features page in
the Student Administration
Installation component.

Course/Milestone Link

SSR_CRS_MILESTN

Curriculum
Management > Course
Catalog > Course
Catalog > Course/
Milestone Link

Link milestones to courses
and (NZL) establish links

between a course and unit
standard milestones.
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Page Name Definition Name Navigation Usage

GL Interface (general ledger | CRSE_OFFER GL Curriculum Map course fees as item

interface) Management > Course types to their proper general
Catalog > Course ledger accounts. The system
Catalog > GL Interface generates charges to the

student's account based on the
course code you define on this
page and offsets these charges
based on the general ledger
you define on this page. Your
office should coordinate the
information on this page with
your controller's office.

Defining Course Catalog Data

Access the Catalog Data page (Curriculum Management > Course Catalog > Course Catalog >
Catalog Data).

This example illustrates the fields and controls on the Catalog Data page (1 of 2). You can find definitions
for the fields and controls later on this page.

Catalog Data C 5 Components | GL Interface

Course ID: nofoo1

1 First E 1 of 1 IE Last
Course Offering  [4] 4 5 4 [¥] =]

*Effective Date: oM 900 (3 *Status: IACHVE 'I

*Description: |Cn|lege Algebra MATH 101

Long Course Title: ICDIIege Algebra :I
Long Description: Review of fundamental concepts of algebra. Development of matrices, ﬂ

determinants, Cramer's rule, logarithms, sequences and series, comhbinatorics,
and probakhility.

=
Minimum Units: ELL Last Course of Mult Term Seq: r
Maximum Units: ELT *Enroliment Unit Load Calc Type: | Actual Units |
Academic Progress Units: lﬁ Course Count: IW
Financial Aid Progress Units: ’W Course Contact Hours: lw

Course Grading
*Grading Basis: I Stdnt Opt vI *Grade Roster Print: I Compaonent vI

Graded Component: Lecture
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This example illustrates the fields and controls on the Catalog Data page (2 of 2). You can find definitions
for the fields and controls later on this page.

Repeat for Credit Rules

Repeat for Credit Total Units Allowed: 3.00
D Allow Multiple Enroll in Term Total Completions Allowed: ’_3

‘Instructor Edit: Instriadvi “
“Add Consent:

Requirement Designation: Q
Equivalent Course Group: a

Additional Course Information

‘Drop Consent:

Course Attributes

MOMN-MAJORS . Open to non-majors only. =

u p
Customize | Find | == Firzt 1 af 1

*Formal Description

Override Topic Link1ID  []

u p
Customize | Find | == Firzt 1 af 1

| 1 |Intmductiuntu College Algebr

|Intr0 Aghr

|Intmductiuntu College Algehr 100 E|

The system generates a unique course ID when you add a new course, as long as you do not enter a course
ID yourself. You should let the system generate the course ID.

Field or Control

Description

Effective Date

Enter an effective date for this course. The effective date
defines when the status you enter is valid. Use a new effective
date each time you make a change to a course offering. Insert
new rows as needed, and modify the record. Effective dates
enable you to track historical course changes.

Status

Enter a status for this course. Enter Active when the course
is valid for your institution. You can keep all courses in the
database for historical research purposes by inserting a new
effective-dated row and setting the status to Inactive for
courses that you no longer offer.

Note: When you schedule a class for a term, the system
prompts against the Catalog Data page using the start date of
the term as the effective date to find the appropriate row in the
catalog. Therefore, you do not need to create a new catalog
entry for every term. Instead, insert a new effective-dated row
for your revisions.

Short Course Title and Long Course Title

The short title appears on items such as transcripts, advisement
reports, study lists, and the schedule of classes. The long
course title appears on the Browse Course Catalog page and
the course catalog report.
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Field or Control Description
Long Description The long description can appear in the course catalog report if
specified.

Course Units/Hours/Count

You can attach four unit types to a course in the course catalog:
e Minimum units

e Maximum units

* Academic progress units

* Financial aid progress units

These values appear by default on the Schedule of Classes - Class Associations page, where you can
override course unit values for a class. When a student enrolls in a class, corresponding fields on the
enrollment page populate with the values on the Class Associations page. After a student enrolls, the
system uses each unit type to determine the student's academic and financial aid load, academic level, and
grade point average. In general, the minimum, maximum, academic progress, and financial aid progress
units are always the same. The exception is multi-term courses, remedial courses, and variable unit
courses.

Note: For courses that use the same minimum and maximum units, the Minimum Units field populates
the Units Taken field on administrative enrollment pages and the Units field on self-service enrollment

pages.
Field or Control Description
Minimum Units and Maximum Units Enter the minimum units and maximum units that the course is

worth. The minimum and maximum units are the same, except
for a variable unit class. For a variable unit class, the minimum
and maximum units would constitute a range, and the student
or administrator would be able to select from within that range
how many units the class is worth. For example, the minimum
units could be set at 2, and the maximum units could be set at
3. After you schedule the class, you can enroll the student and
enter the number of units the student chooses to take for the
class in the Units Taken field on the enrollment page.
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Field or Control

Description

Academic Progress Units

The system uses academic progress units in conjunction with
the billing factor to calculate billing units and, subsequently,
per unit fees. The system also uses academic progress units
to calculate academic load. Academic progress units are
usually equal to the minimum/maximum units, except for

a multi-term class. A multi-term class is when all credit
for a sequence of classes (HIST 101a + 101b) is granted
after a student completes the last course in the sequence.

To prevent the student from earning units taken, which are
used to calculate GPA, or units earned, which are used by the
Academic Advisement application, you could enter 0 in the
Minimum Units field and the Maximum Units field. Then,

you could enter 3 (or another unit value) in the Academic

Progress Units field.

The system would calculate the billing units and academic
load using 3 (or another unit value) academic progress units,
but the student would earn no credit.

Financial Aid Progress Units

Enter the number of units for the course that the system counts
towards tracking a student's financial aid load for a term.

Note: When minimum units and maximum units are not equal, the Academic Progress Units field and
the Financial Aid Progress Units field on the Catalog Data page become unavailable, and Progress Units
and FA Progress Units on the enrollment page appear by default from the student's Units Taken field

value.

Field or Control

Description

Last Course of Multi-Term Sequence

Select this check box so that academic progress units can be
less than the minimum units for this course. The academic
progress units for the last course in a multi-term course is
less than the minimum units because the minimum units have
been accumulating over the entire sequence, and they are
only granted after the student completes the last course. The
academic progress units, however, are still granted for each
course in the sequence, so they are less than the minimum
units at the end of the sequence. See the Multi-Term Course

example in the next section.
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Field or Control

Description

Enrollment Unit Load Calc Type (enrollment unit load
calculation type)

The value you enter determines how the enrollment engine
calculates the student's academic load. Values for this field are
delivered with your system as translate values. Do not modify
these values in any way. Any modifications to these values

requires a substantial programming effort. Values are:

Actual Units: The system populates the Enrollment Unit
Load Calc Type field with Actual Units by default. Enter

this option for any course that has identical values for the
Minimum Units, Maximum Units, and Academic Progress
Units fields. The exception to this rule is when you are
creating a variable unit course; even though the minimum and
maximum units are different, use Actual Units. The enrollment
engine calculates the number of units the student can take in
the term by looking at the Units Taken field on the Enrollment
Request 1 or Student Enrollment 1 page (see the Variable Unit
Course example that follows). You can also enter this option
for a remedial course, as an example, if you do not want the

course to count toward the student's academic load.

Academic Units: Enter this option for any course that does

not have identical minimum units, maximum units, and
academic progress units, such as remedial courses and
multi-term sequence courses. Entering this option requires

the system to look at the academic progress units when it
calculates academic load. For example, the minimum units and
maximum units might be 0 because you do not want academic
level and GPA to be affected by this course. The academic
progress units might be 3 so that the course would be used to
calculate academic load and billing units (see the Multi-Term
Course example that follows). Furthermore, you could use this
option for a remedial course, as an example, if you wanted

the course to be used in calculating load but not in calculating
GPA.

Course Count

If you count courses (in addition to units) toward academic
advising requirements or limits, enter a course count value
in this field. The system populates this field by default from
the course catalog. The course count indicates the worth, or
count, of the course towards an advising requirement. Some
institutions count courses, as well as units, towards degree
requirements.
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Field or Control Description

Course Contact Hours The system populates this field by default from the Schedule
of Classes - Instructor Contact Hours page, where the value is
used to calculate total contact hours. Each component of the

course can have different contact hours on the Components

page.

Grading Basis Enter a grading basis for the course. Grading basis values are
defined on the Grading Scheme Table page. You can override
the grading basis for individual class offerings when you

create the schedule of classes.

Graded Component The system displays the graded component based on the
Grade Roster Print field value on this page and the Graded
Component field value on the Components page.

Grade Roster Print Enter the type of grade roster that you want to print for this
course offering, as processed through the Grade Roster Print
page. Values for this field are delivered with your system

as translate values. Do not modify these values in any way.
Any modifications to these values requires a substantial
programming effort. Values are:

By Student: Enter to print grade rosters for each student. Each
student has a distinct grade roster, separated by a page break.

Component: Enter to print grade rosters for the graded
component of the course. The graded component is specified
on the Components page.

Instructor: Enter to print grade rosters for the graded
component of the course. The graded component is specified
on the Components page. A copy of the grade roster prints for
each instructor, primary or otherwise. The number of copies
that prints is equal to the number of instructors for the course,
primary or otherwise.

None: Enter to not print a grade roster for the course.

Repeat for Credit Select this check box to indicate that the class can be repeated
for additional credit, as opposed to repeating for grade
improvement only. If you do not select the check box, the class
is subject to the repeat rules set up in the Repeat Rule Table
component.
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Field or Control

Description

Allow Multiple Enroll in Term (allow multiple enrollments

Select this check box to permit a student to enroll in this

in term) course multiple times within the same term. An example
would be an independent study course.
Total Units Allowed The system populates this field by default with the maximum

units for the course (by default, one full course completion is
always permissible). However, if you select the Repeat for
Credit check box, you may edit and increase this value. This
value must be equal to or greater than the maximum units for
the course. The system enforces the lower of the two limits,
units or completions, that you define.

Total Completions Allowed

The system populates this field with / by default (by default,
one full course completion is always allowed). However, if
you select the Repeat for Credit check box, you may edit and
increase this value. This value must be equal to or greater than
1. The system enforces the lower of the two limits, units or
completions, that you define.

Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 5

Setting Up the Course Catalog

Field or Control

Description

Instructor Edit

Enter a value to indicate how you want the system to prompt
for instructor IDs during class enrollment. This option
determines the availability of and the prompt values for the
instructor ID field on the Enrollment Request, Quick Enroll,
Enrollment, and self-service enrollment pages. The system
populates the value for the Instructor Edit field by default
to the Class Associations page, where you can override the
value. Values for this field are delivered with your system

as translate values. Do not modify these values in any way.
Any modifications to these values requires a substantial

programming effort. Values are:

No Choice: Enter if you want the system to make the
Instructor ID field on the Enrollment Request page
unavailable and to automatically assign the instructor who is
scheduled to teach the class, as indicated on the Assignment
tab of the Schedule of Classes - Meetings page: Thus, the
student has no choice of instructor.

Class Instructor Edit: Enter this option if you want the system

to make the Instructor ID field on the Enrollment Request,
Quick Enroll, Enrollment, and Self Service Enrollment

pages available and to prompt the user with only the Primary
Instructors for the class, as defined on the Meetings page.
Select this option for independent study courses or the like,
for which the student can select one of several Primary

instructors.

Instructor/Advisor Edit: If you enter this option, the
Instructor ID field appears on the Enrollment Request, Quick
Enroll, Enrollment and Self Service Enrollment pages. The
system prompts the user with only the instructors available to
teach this course, as defined on the Instructor/Advisor Table

page.

See Designating Approved Instructors and Advisors.
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Field or Control

Description

Add Consent and Drop Consent

The No Consent value appears by default. Values for these
fields are delivered with your system as translate values. Do
not modify these values in any way. Any modifications to
these values requires a substantial programming effort. Values

are:

No Consent: Enter if no special consent is required for a

student to add or drop a class.
Instructor or Department: Enter if consent is required.

Consent can be granted by using class permission numbers or
student specific permissions. The consent requirement can be
overridden in the enrollment process by setting an override

permission option.

Requirement Designation

Enter a requirement designation for the course. A requirement
designation can be additional work that is needed for a course,
such as Design Credit, or a requirement designation can
specify a special variety of a course to use in a course list for
the Academic Advisement application.

Requirement designation values are defined on the
Requirement Designation Table page. Example requirement
designation values are Design Credit, Thesis Choice, and so

on.

Requirement designations are provided to the Academic

Advisement application.

Equivalent Course Group

You can enter an equivalent course group for the course.
Equivalent course groups are defined on the Course
Equivalencies page. Here, you are adding the course to a
group of equivalent courses for requisite checking and degree
progress requirement purposes. If two courses have the same
Equivalent Course Group number, then they are equivalent to
each other and can fulfill the same requirement.

Course Attribute and Course Attribute Value

Enter the general characteristics that describe the course
offering in the Course Attribute and Course Attribute
Value fields. Course attributes are defined on the Course
Attribute Table page. Course attributes are not provided to the
Academic Advisement application. They are primarily used
for institutional research purposes, and for printing repetitive
text in the catalog and schedule of classes. Example course
attribute and course attribute values are Degree Seeking Only -
Open to Students in Any Plan and Fall - Offered in Fall Only.
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Field or Control Description

Override Topic Link ID Select to manually update topic link IDs. When you select this
check box, the Topic Link ID field becomes available for edit.
Use this functionality to link course topics across effective-
dated rows by giving them the same topic link ID.

Description Tab
See the previous exhibit for a view of this tab.

Use the Description tab to define course topics associated with a course. You attach topics to specific
classes on the Schedule of Classes - Basic Data page.

Field or Control Description

Course Topic ID The system assigns a unique course topic ID number to
identify the topic record. Insert rows to add topics.

Course Topic Title, Short Description, and Formal Enter the course topic title, short description, and formal
Description description.
Topic Link ID The system assigns a unique topic link ID number for each

topic. The repeat checking process uses this number when
determining if the topic was already taken. If you create a new
effective-dated row for this course, the system carries over the
topic link ID to the new effective-dated row. If the Override
Topic Link ID check box was selected, the Topic Link ID
field becomes available for edit. This selection enables you

to link course topics within a course across effective-dated
rows by giving them the same topic link ID. Because the
repeat checking process uses the topic link ID, the process
views similar topics that have the same topic link ID as being

identical.
Repeat For Credit Tab
Select the Repeat For Credit tab.
Field or Control Description
Repeat for Credit Select to allow students to repeat the topic for credit. If you

do not select this check box, additional enrollment in the same
topic is subject to the repeat rules set up in the Repeat Rule
Table component.

Copyright © 1988, 2023, Oracle and/or its affiliates. 165



Setting Up the Course Catalog

166

Chapter 5

Field or Control

Description

Total Units Allowed and Total Completions Allowed

If you select the Repeat for Credit check box, the Total Units
Allowed and Total Completions Allowed fields become

available for entry. Enter the maximum number of units and

course completions allowed for credit within the topic. If you

enter a value in both fields, the system enforces the lower of

the two limits.

Example of Multi-Term Course

At PSUNYV, when a student takes History 101a for the fall term and History 101b for the spring term,
the student's credit for both courses is contingent upon the successful completion of the entire course
sequence. To define this multi-term course in the course catalog, we purposefully place the minimum
units, maximum units, and academic progress units out of synchronization so that the enrollment engine
correctly calculates the student's academic load and GPA. The course catalog might look similar to this:

Course Term of Minimum Maximum Academic Last Course | Enrollment
Student Units Units Progress of Multi-Term | Unit Load
Enroliment Units Sequence Calculation
Type
History 101a Fall 1999 0 0 3 No Academic Units
History 101b Spring 2000 6 6 3 Yes Academic Units

Because the minimum and maximum units are set to 0, History 101a is not calculated in the student's
GPA or Academic Level ( that is, if academic level increments by units). But, when the student completes
History 101b, he or she will receive credit for both classes because the minimum and maximum units are
set to 6. Academic load and billing units are counted for both classes because academic progress units are
set to 3, and the Enrollment Unit Load Calculation type is set to Academic Units.

Example of Variable Unit Course

At PSUNYV, students can select how many units they earn for ENGL 1a. They can select from the range of
2 and 3 units. Because ENGL 1a is an elective course, they can take it for only 2 units, in which case they
are not required to complete a final project. Students who complete the project earn 3 units. In this case,

the course catalog might look similar to this:

Course Minimum Units | Maximum Units | Academic Financial Aid Enrollment Unit
Progress Units | Units Load Type
ENGL la 2 3 Unavailable Unavailable Actual

When students enroll in ENGL la, they have to select how many units to take. If they enroll online
or through an interactive voice response system, they can select the number of units they want to take
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when they add the class. If they enroll in person, the Registrar's Office most likely creates an enrollment
request. If the minimum and maximum unit fields on the Course Catalog Data page vary, the Units Taken
field on the Enrollment Request page becomes available, and the Registrar's Office can enter the number
of units the student chooses to take. The possible enrollments would look like this:

Student Units Taken Units Earned Academic Financial Aid Billing Units
Progress Units | Units

Student 1 2 2 2 2 2

Student 2 3 3 3 3 3

As shown, the student chooses the number of units to take and the system determines the units earned,
academic progress units, and financial aid units based on the units you enter in the Units Taken field
when the student enrolls in the class.

Defining Course Offerings

Access the Offerings page (Curriculum Management > Course Catalog > Course Catalog >
Offerings).
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This example illustrates the fields and controls on the Offerings page. You can find definitions for the

fields and controls later on this page.

Course |ID 000145

Effective Date 01/01/2008 Status Active

Description Accounting & Fin Mgmt 14
Course Offering

*Course Offering Nbr |1
*Academic Institution |PSAUS |
*Academic Group ECON |
*Subject Area ACCT QU Accounting
Campus [MAIN |3 Main Campus
*Academic Organization ACCT_AUS |Q

*Academic Career \UGRD | Undergraduat:
dergraduate

Course Typically Offered kv
Tuition Group Q
Dynamic Class Date Rule [DYN_AUS le

“* Dynamic Date Rule

DAIIDW OEE Enrollment

Enrollment Requirement Group

Requirement Group Q

Long Description

Taxonomy

CIP Code Q
HEGIS Code Q

Field of Education Code 020101 Q. Accounting

PeopleSoft Australia Uni

A Faculty of Economics

Department of Accountin

Find | View All First ‘4’ 10f1 ‘& Lad
Find | View All First ‘4" 10f1 ‘&' Last
*Catalog Nbr[103 accT =

Alluw Course to be Scheduled

DExam Only Course

Catalug Print
F'rintlnstructurin Schedule
Schedule Print

Schedule Term Roll

D Use Blind Grading

D GL Interface Required

D Split Ownership

Course Academic ltem

*Work Experience Indicalurl Mot Wholl

% Experience

Summer School Full Fee Ind. E551 |

~]

DYear Long Indicator E622
DEmuue From HEIMS Reporting
DUse Discipline Group From Plan

Discipline Group Code 0202 Q Accounting

Field or Control

Description

Course Offering Number

The system generates the course offering number and uses

it for sequencing. The system also uses the course offering
number to distinguish cross-offered courses for which the
course ID is the same, as are the requisites, but the course
itself is listed in different subject areas, academic groups, and
SO on.

Catalog Number

Within an academic group, catalog number ranges are linked
to academic careers on the Academic Group Table page. If
you have already specified an academic group for this course
offering, the system automatically displays the appropriate
academic career when you enter a catalog number. This

field is 10 digits. The system reserves the four left digits
exclusively for numeric characters, and the right six digits for
both alpha and numeric characters. A field edit enforces this
programming.
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Field or Control

Description

Course Typically Offered

Values available here are defined in the Course Typically
Offered component.

See Defining When a Course is Typically Offered.

The system automatically reformats the catalog number you enter to fit the defined system format, as this

table illustrates:

Catalog |N N N A/N A/N A/N A/N A/N A/N
Number
12 1
120 1 2
1A A
12B 1 B
120AB 1 2 A B
B12 B 1 2
AB1200 A B 1 2 0 0
10001A |1 0 0 1 A
1B12 B 1 2
N = numeric character
A/N = alpha or numeric character
Field or Control Description

Academic Institution

The system displays the academic institution by default.
Multiple institutions can offer the same course by way of
multiple course offerings.
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Field or Control

Description

Academic Group

Enter the academic group to which this course offering
belongs. You can define global notes by academic group,
which can appear on the Schedule of Classes report. In
addition, academic group controls the valid meeting pattern
values and their corresponding normal class duration values.
Academic group values are defined on the Academic Group
Table page.

Subject Area Enter the subject area of the course offering. Subject area
values are defined on the Academic Subject Table page.
Campus Enter the campus at which your institution offers the course. If

the course is offered at one campus, you should place a value
in this field. If the course can be offered at multiple campuses,
leave this field blank.

Academic Organization

The system populates this field by default from the academic
organization linked to the subject on the Academic Subject
Table page. You can override the value.

Academic Career

Enter the academic career to which this course offering
belongs. The system automatically displays the default
values of the Dynamic Class Data Rule, Allow OEE
Enrollment, and OEE Dynamic Date Rule fields according
to your settings for these fields in the Academic Career Table
component. The default values of these fields vary depending
on the academic career that you enter and the effective date of
the course. Academic career is important because it specifies
which students can enroll in the class (in accordance with the
Academic Career Pointers page specifications), as well as
which grading bases are available.

Tuition Group

The system charges tuition based on the student’s enrollment
records. If the tuition group that you set on this page matches
the student’s assigned tuition group, the additional fee defined
on the course component is assessed.
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Field or Control

Description

Dynamic Class Date Rule

If you have specified a dynamic class data rule for the
academic career to which you assign this course offering,

the system displays that rule by default in this field. You can
override the default value. Select a dynamic class date rule to
have the system assign that rule by default to all dynamic class
sections of this course offering that you schedule (excluding
open entry and open exit sections). Attaching your rule to

the course offering rather than to the class section ensures
consistency and eases maintenance because you only have

to attach the rule to a course one time (to apply to all class
sections), rather than having to attach a rule to each course
offering that you schedule. The system requires dynamic date
calculation for each class section that you schedule for this
course offering. After you schedule the class sections, you can
run the Dynamic Class Dates process to calculate landmark
dates for each class section. The process automatically uses the
rule that you specify here for all dynamic date class sections.
You can override this default rule on a section-by-section basis
through the Dynamic Class Date page. This field prompts

you with only the dynamic class data rules that have not been
designated for OEE enrollment on the Dynamic Class Dates
page. If you leave this field blank and schedule the course
within a dynamic date session, you receive a warning message
indicating that a rule has not been defined. You need to define
a rule on the Dynamic Class Dates page.

Allow OEE Enrollment (allow open entry/exit enrollment)

The system assigns the value of this check box by default
based on the Allow OEE Enrollment check box on the
Academic Career Table page for the academic career with
which you have associated this course offering. You can
override this default on an offering-by-offering basis. Select
this check box to attach a dynamic date rule to the offering,
thus enabling students to enroll in OEE class sections of this
course offering. The OEE Dynamic Date Rule field becomes
available for edit. If you do not select the check box, you can
always define the rule on the Dynamic Class Dates page.
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Field or Control

Description

OEE Dynamic Date Rule (open entry/exit dynamic date
rule)

The system assigns the value of this field by default based

on the OEE Dynamic Date Rule field on the Academic
Career Table 2 page for the academic career with which you
associate this course offering. An open entry/exit (OEE)
dynamic date rule is a dynamic class date rule that has been
designated for OEE enrollment. The enrollment engine uses
the OEE dynamic date rule to calculate significant class dates
for a student whenever a student enrolls in an open entry/
exit class. This field is available for edit only if you select the
Allow OEE Enrollment check box for this course offering.
Select an OEE dynamic date rule to have the system assign
that rule by default to all OEE class sections of this course
offering that you schedule. Attaching your rule to the course
offering rather than the class section ensures consistency

and eases maintenance because you only have to attach the
rule to a course one time (to apply to all class sections),
rather than having to attach a rule to each course offering
that you schedule. The system thus automatically requires
dynamic date calculation for each OEE class section that you
schedule for this course offering. After you schedule the class
sections, you can run the Dynamic Class Dates process to
calculate landmark dates for each class section. The process
automatically uses the rule that you specify here for all OEE
class sections. You can override this default rule on a section-
by-section basis through the Dynamic Class Data page. The
system prompts you with only the dynamic class data rules
that have been designated for OEE enrollment on the Dynamic
Class Dates page.

If this field is blank and you schedule the course within an
OEE session, you receive a warning message that indicates
a rule has not been defined. You can then save the page and
define the rule on the Dynamic Class Dates page.

Course Approved

Enter the course approved status. Values for this field are
delivered with your system as translate values. Do not modify
these values in any way. Any modifications to these values
requires a substantial programming effort. Enter Pending

or Denied to prevent anyone from scheduling the class—

the system does not list the course in the class scheduling
function. Enter Approved and select the Allow Course to

be Scheduled check box to enable scheduling of the course
offering.

Allow Course to be Scheduled

Select this check box so that the course can be scheduled
for a term. A course can only be scheduled for a term if you
select this check box and set the Course Approved field to
Approved.

Exam Only Course

Select this check box when a course will have no class sections
scheduled and the only requirement for the course is that
students must complete an examination. When the check

box is selected, the Allow Course to be Scheduled field is
disabled and the field defaults to the Activity Registry when
this course is entered as the Course Control Record.
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Note: For courses that are set up solely as transfer articulation courses, set the Course Approved field
to Approved but clear the Allow Course to be Scheduled check box. This setting ensures that you never

accidentally schedule the course.

Field or Control

Description

Catalog Print

Select to display the course offering in the course catalog
report.

Print Instructor in Schedule

Select to display the names of all the assigned instructors in
the schedule of classes report.

Schedule Print

Select to display the course offering in the schedule of classes.
The system selects this check box by default.

Schedule Term Roll

Select to enable the prior term copy function for this course
offering.

See Copying Classes from One Term to Another.

Use Blind Grading

Select to enable grade rosters for blind grading. The system
populates this field by default from the Academic Subject
Table page.

When you generate grade rosters for a course that invokes

blind grading, instead of student names on the roster, the
system generates random numbers.

See Printing Grade Rosters

See Entering Grades Online

GL Interface Required

Select to include this class in the GL Interface process. If you
select this check box, the system requires you to enter the
necessary data into the GL Interface page of this component.

Split Ownership

Select if multiple academic organizations own the course.
If you select this check box, the Owner group box becomes
available for entry.

Course Academic Item

Click to access the Course Academic Item page.

See Creating Academic Items for Courses
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Field or Control

Description

Requirement Group

Enter the requirement group that links the appropriate

requisites to this course.

Enrollment requirement group values are defined on the
Course Requisite page and can consist of a variety of
elements: courses, units, GPA, and so on.

Long Description

The system enters the long description of the enrollment

requirement group from the Course Requisites page.

Taxonomy

Field or Control

Description

CIP Code (Classification of Instructional Programs code)

Enter the CIP code for the course. CIP codes provide a
taxonomic scheme that support the accurate tracking,
assessment, and reporting of fields of study and program
completions activity. The system prompts you from the CIP
Code Table page.

HEGIS Code (Higher Education General Information Survey
code)

Enter the HEGIS code for the course. HEGIS codes provide

a taxonomic scheme that support the accurate tracking,
assessment, and reporting of fields of study and program
completions activity. The system prompts you from the HEGIS
Code Table page.

(AUS) Field of Education Code

The system enters the Australia Department of Education,
Science and Training (DEST) field of education code that you
entered on the Subject Taxonomy page for this course.

Note: This field is available only when you select the DEST,
HECS, Centrelink, TAC check box on the Academic

Institution 6 page.

(AUS) HECS Band ID (higher education contribution
scheme band ID)

The system enters the Australia DEST HECS band ID for the
field of education code.

Note: This field is available only when you select the DEST,
HECS, Centrelink, TAC check box on the Academic

Institution 6 page.
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Field or Control Description

(AUS) Work Experience Indicator Select the work experience indicator for this course.

This value is used to confirm whether the course is considered
wholly or partially work experience in industry for Australian
DEST reporting purposes.

Note: This field is available only when you select the DEST,
HECS, Centrelink, TAC check box on the Academic
Institution 6 page.

(AUS) Summer School Full Fee Ind. E551 Select to indicate whether the unit is a full-fee summer or

winter school unit of study.

(AUS) Year Long Indicator E622 Select to indicate that the unit of study is a full year unit.

(AUS) Exclude from HEIMS Reporting Select to indicate you don’t want to report this course to
HEIMS.

(AUS) Use Discipline Group From Plan Select to disable the discipline group field. The system uses

the discipline group from a student's plan when a student
enrolls in this course.

Note: This field is available only when you select the DEST,
HECS, Centrelink, TAC check box on the Academic
Institution 6 page.

(AUS) Discipline Group Code The system enters the discipline group from the Subject

Taxonomy page.

Note: This field is available only when you select the DEST,
HECS, Centrelink, TAC check box on the Academic
Institution 6 page.

Ownership
Use this group box to link course offerings to multiple academic organizations.

The system assumes a course offering has a single academic organization owner, unless you indicate
split ownership on this page. Course ownership data is tracked for reporting and analysis purposes at the
course offering level.

Important! The Ownership group box is only available if you select the Split Ownership check box.
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Field or Control Description

Enter the academic organization owners of the course offering.
The system prompts you from the Academic Organization

Academic Organization

Table page.

Percent Owned Enter the percentage of ownership. The total percentage must

equal 100.

Examples of Equivalent and Cross-Offered Courses

Equivalent courses, unlike cross-listed courses, can have different requisites, requirements, and so on.
Each equivalent course has a unique course ID number. Use the Course Equivalency component to create

Equivalent Course Groups.

Define cross-offered courses on the Course Catalog - Offerings page. Cross-offered courses have the same
course ID number; therefore, they possess the same Catalog Data page information. When classes are
scheduled, each class is associated with a single offering.

Note: Repeat checking and multiple enrollment rules apply across all offerings of the course because the
same course is offered in every case.
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The following examples show the defined course ID number 003302, Literature and Philosophy. It
is a cross-offered course in both the English and Philosophy departments. In all ways, the two course
offerings are exactly the same. They possess the same description, equivalencies, and so on. On the
Offerings page, the course offering number distinguishes the two offerings.

In course offering number 1, we indicate that Literature and Philosophy is listed under the English
Literature subject area, catalog number 270.

Catalog Data Offerings Components Crse Catalog NZL Course/Milestone Link GL Interface

Course 1Dt 003302
First n 10f1 u Last

Effective Date: 01/01/1800 Status: Active

Description: Lit and Phils

Course Offering pind | view Al First Bl 4 or2 I ast
*Course Offering Nbr: ’_1 *Catalog Nbr: 270 EMGLLIT =]
*Academic Institution: ,m Q FPeopleSoft University
*Academic Group: WO\ College of Liberal Arts “Course Approved:
*Subject Area: Wo\ English Literature Allowr Course to be Scheduled:
Campus: I—Q Exam Only Course: [ ]
*Academic Organization: ENGLISH Q Enalish Catalog Print
*Academic Career: ,mq Undergraduate Print Instructor in Schedule

Course Typically Offered | Spring b Schedule Print

Tuition Group: a Schedule Term Roll

Dynamic Class Date Rule: RULE10 Q Rule 10 for Dynamic Date Cntl DUseBIindGrading

[1GL Interface Required
[+] Allow OEE Enrollment [ spiit Ownership

OEE Dynamic Date Rule: | OEE15WK-1 QU oEE 15 week Schedule Course Academic ltem

Enroliment Reguirement Group

Requirement Group: Q

Long Description:

CIP Code: Q
HEGIS Code: Q
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Add another row for course offering number 2. The second offering of Literature and Philosophy is listed
under the Philosophy subject area, catalog number 170.

Catalog Data Offerings Components Crse Catalog MNZL CourseMilestone Link GL Interface

Course D¢ 003302

First [ 4] 10f1 n Last

Effective Date: 01/01/1900 Status: Active

Description: Lit and Phils
Course Offering Find | View All First 4] 20f2 n Last
*Course Offering Nbr: |2 “Catalog Nbr: 170 FHILO [=]
*Academic Institution: IWQ FPeopleSoft University

*Academic Group: lm Q Caollege of Liberal Ars “Course Approved:
~Subject Area: WQ Philosaphy Allowr Course to be Scheduled:
Campus: I—Q Exam Only Course: []
*Academic Organization: |PHILOSOPHY QU prijggopny [ catalog Print
*Academic Career: lmo\ Undergraduate Print Instructor in Schedule

Course Typically Offered | 4 Schedule Print

Tuition Group: [ a Schedule Term Roll

Dynamic Class Date Rule: [RULET0 < Rule 10 for Dynamic Date Cnt DUﬁeB"ndGmdm.

C1GL Interface Required
[] Allow OEE Enrollment [ split Ownership
OEE Dynamic Date Rule: OEE15WK-1 |Q QOEE 18 Week Schedule Course Academic ltem

Enrollment Requirement Group

Requirement Group: Q
Long Description:

CIP Code: aQ,
HEGIS Code: Q

Select the Catalog Print and Schedule Print check boxes to enable printing of both course offerings in
the catalog and schedule.

Related Links
“Setting Up Course Fees and Class Fees” (Student Financials)

Defining Course Components

Access the Components page (Curriculum Management > Course Catalog > Course Catalog >
Components.).
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This example illustrates the fields and controls on the Course Catalog - Components page (1 of 2). You
can find definitions for the fields and controls later on this page.

Components GL Interface
Course ID: 001001
Effective Date: 0170171900 Active
Course Component
*Course Component: I Lecture [ " Auto Create
Instructor Contact Hours: I Graded Component
Default Section Size: [ ] W Primary Component
Workload Hours: ’— - LA G
OEE Workload Houre: ,— " Generate Class Mtg Attendance
*Final Exam: fes i
Exam Seat Spacing: ’_1 M
Provider for Authentication I j
LMS Extract File Type: I j

This example illustrates the fields and controls on the Course Catalog - Components page (2 of 2). You
can find definitions for the fields and controls later on this page.

¥ Use Present
¥ Use Reason
¥ Uuse Tardy

¥ Use Left Early

Course Attendance First (U 4 o 1 [ Lot
P
Instruction Mode: P Q In Persan . EI
*Attendance Type: I Class Meeting [~

¥ Use Contact Minutes
¥ Use To and From Time
[ override Template Date ! Time

Room Characteristics Required

*Room

Characteristic Description

Podium

First E 1 of 1 |I| Last

Characteristic

Guantity

Course Component

Field or Control

Description

Course Component

Enter a course component for the offering. Values for this
field are delivered with your system as translate values. You
can modify these values. The course component indicates the
parts of the course offering, for example, lecture, laboratory,
seminar, and so on. One course offering can have multiple
components.
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Field or Control

Description

Instructor Contact Hours

Enter the contact hours you want to record for the instructors
teaching this component of the course. You can also assign
specific instructors and corresponding contact hours when
scheduling classes on the Schedule of Classes - Meetings
page. Use this field only if you want to report contact hours
manually.

The Instructor Workload feature does not reference this free-
form field.

Default Section Size

Enter the default section size. You can override section sizes
in the schedule of classes. The system uses the value in this
field to populate the Requested Room Capacity field and the
Enrollment Capacity field.

Workload Hours

If you want to track instructor workload based on course
component workload hours, enter a workload hours value

for the course component. The system uses the value that

you specify here to populate the same fields on the Class
Associations - Class Components page when you schedule

a new course. Therefore, if you set the lecture workload

hours to 3 on the Course Catalog - Components page, then
whenever someone schedules a lecture for this course, the
lecture component, 3 workload hours, appears by default on
the Class Components page. Similarly, if you set the laboratory
component to 1 workload hour on the Components page, then
whenever someone schedules a laboratory for this course, the
laboratory component, 1 workload hour, appears by default
on the Class Components page. The user can modify the
component values on the Class Components page if necessary.
This field is optional.
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Field or Control

Description

OEE Workload Hours (open entry/open exit workload
hours)

If you want to track instructor workload based on course
component OEE workload hours, enter an OEE workload
hours value for the course component. The value you specify
here represents the number of workload hours for the entire
course, unlike regular workload hours, which represent
weekly hours for the course. The system populates the value
in this field by default to the same components on the Class
Associations - Class Components page when you schedule

a new course. In other words, if you set the lecture OEE
workload hours to 45 on the Components page, then whenever
someone schedules a lecture for this course, the lecture
component, 45 OEE workload hours, appears by default on the
Class Components page. Similarly, if you set the laboratory
component to 15 OEE workload hours on the Components
page, then whenever someone schedules a laboratory for this
course, the laboratory component, 15 OEE workload hours,
appears by default on the Class Components page. You can
modify the component values on the Class Components page
if necessary. This field is optional.

Final Exam

Enter a value to indicate whether a final exam is given in the
course. The value you enter here defaults to the Schedule of
Classes. Final exam values are delivered with your system
as translate values. Add as many values to the translate table
for the final exam as needed. The only value that you must
not remove from the translate table is Yes, which has coding
attached to it. Values are:

Yes: The Yes value enables block final exam scheduling. This

value cannot be modified without programming effort.

No: Indicates that this component has no final exam. Entering
No eliminates this component from the block exam scheduling
process.

Last Class: Indicates that a final exam is taken in the
last regularly scheduled class (as opposed to during final
examination week). Entering Last Class eliminates this
component from the block exam scheduling process.

Exam Seat Spacing

If you enter Yes in the Final Exam field, the Exam Seat
Spacing field becomes available for entry. Enter the number of
spaces between student's seats during the exam. For example,
enter 2 to have two empty seats between each student taking
the exam. This value has no programming tied to it. Use this
field for your information or for third-party interface.

Copyright © 1988, 2023, Oracle and/or its affiliates.

181



Setting Up the Course Catalog

182

Chapter 5

Field or Control

Description

Provider for Authentication

If this course is a learning management system (LMS) course
requiring self-service user authentication, and the Provider for
Authentication is not set on the Academic Institution 3 page,
then enter the provider here. The value entered here appears by
default on the schedule of classes when you schedule a class,
but you can override it. If this field is left blank, any time you
schedule a class for this course the system uses the LMS file
type from the Academic Institution 3 page.

LMS File Type

If your institution uses the LMS interoperability feature,
enter the LMS file type for the interface. The value entered
here appears by default in the schedule of classes when you
schedule a class, but you can override it. If this field is blank,
any time you schedule a class for this course, the LMS file
type is provided by default from the setting on the Academic
Institution 3 page.

Values are XML V1.01, Blackboard Courselnfo 4, and API
Input. WebCT Campus Edition and WebCT Vista both support
XML V1.1 and user authentication.

Auto Create

Select for each component to have the system automatically
create that component of the course in the schedule of classes.
This saves you data entry and ensures that the system
schedules at least one section for each required component.

See Scheduling New Classes.

Graded Component

Select to enable grading of this component. Only one
component can have a final grade. The value you select for
this course offering appears by default on the (Schedule New
Course, Schedule of Classes) Basic Data page when you
schedule a class section for this course offering.

Primary Component

Select whether this is the primary component of the course. If
you are using the Dynamic Class Dates feature, it is mandatory
that you select a primary component for the course, even if
you only have one component. The Dynamic Class Dates
process always uses the scheduled class section of the primary
component to calculate the landmark dates on a dynamic
academic calendar. The process uses the primary component
value on the Class Associations - Class Components page.

Optional Component

If available for entry, select so that the system does not require
that students enroll in this component. If you clear the check
box, the system requires students to enroll in the component.
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Field or Control

Description

Include in Dynamic Date Calc (include in dynamic date
calculation)

Select to include this component of the course offering, in
addition to the primary component, in the Dynamic Class
Dates process. The system automatically selects and makes
unavailable for edit this check box for the primary component
of a course because the Dynamic Class Dates process always
uses the scheduled class section of the primary component to
calculate the landmark dates on a dynamic academic calendar.
This check box is optional for other components. The value
here appears by default on the corresponding field for all class
sections of the component that you schedule on the Basic
Data page. For non-primary components, you can override the
default value on a section-by-section basis.

Generate Class Mtg Attendance (generate class meeting

attendance)

Select to indicate that you want the system to always generate
attendance rosters for all classes your institution schedules for
this course component. This value defaults to the Schedule

of Classes where you can override this setting. Selecting

this check box marks the class so that when you generate
attendance rosters through the Attendance Roster Generator
page you have the option to limit processing to only the
classes that have this check box selected and that meet

your processing criteria. If you clear this check box on the
Attendance Roster Generator page, the generator creates
attendance rosters for all classes that meet your processing
criteria, regardless of the check box setting. When you
generate attendance rosters through the Class Attendance page
and this check box is selected for a scheduled class, the setting

has no effect on processing.

Add Fee

Click to add an additional fee for the course component and
to access the Course Fees Modal page. The additional fee is

attached to the course component that you specitfy.

See “Setting Up Course Fees and Class Fees” (Student

Financials).
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Field or Control

Description

Instruction Mode

The instruction mode indicates whether the course component
is taught In Person or using Interactive TV, World Wide Web,
Correspondence, and so on. The instruction mode relates to
the attendance type. You can indicate an instruction mode,
then select attendance type values for the course component
that relate only to this instruction mode. For example, by
selecting the In Person instructor mode, you can select an
attendance type that applies only to the /n Person instruction
mode. If you leave the Instruction Mode field blank, the
attendance types that you define for the course component
applies to all instruction modes. When you create and update
attendance rosters, only the attendance type values that relate
to the instruction mode for the class are available for you to
use. Instruction modes for classes are set on the Schedule of
Classes - Basic Data page. Instruction mode values are defined
on the Instruction Mode page.
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Field or Control

Description

Attendance Type

Select each attendance type that your institution might use
for the course component. The attendance type indicates the
type of class meeting attendance roster you want to generate,
such as Class Meeting, Conference, Field Trip, Instructor
Consultation, or Study Group. Add rows for additional
attendance types. When you track attendance, the system
prompts you only with the attendance type values that your
institution defines for the course component. Values for this
field are delivered with your system as translate values. You

can modify these values.

Note: At the least, you should specify the attendance type
value that your institution has selected on the Academic
Institution Table 3 page to use whenever you generate
attendance rosters, as well as the fields you want the system
to use for this component's attendance type. Although you can
generate attendance rosters for a course component without
defining attendance type values and their associated fields, the
system only creates a default attendance roster that includes
the Template Number for the class meeting attendance roster;
the Attendance Type and its description; the Attendance Date;
and each student's ID, name, and career. You must return to the
Components page and define these values for your institution
to be able to track student attendance.

For each attendance type of the course component, select

the fields you want the system to use when generating class
attendance rosters. You can set up the system to generate
attendance rosters with as few or as many fields as you want to
appear for each class section. When you generate attendance
rosters, the available fields that appear on the attendance
rosters for each attendance type depend on the options you
select for each attendance type of the course component.

Values for any given course component's attendance type are:

Use Present

Select in order for the attendance rosters to have a Present

check box on them.

Use Reason Select in order for the attendance rosters to have a Reason
field on them. You can use the reason field to describe a reason
for why a student is present, tardy, leaves early, or any other
reason your institution wants to track.

Use Tardy Select in order for the attendance rosters to have a Tardy

check box on them.
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Description

Use Left Early

Select in order for the Attendance rosters to have a Left Early
check box on them.

Use Contact Minutes

Select in order for the attendance rosters to have a Contact
Minutes field on them. The system populates the contact
minutes time with the total minutes of the class meeting. The
system determines this value based on the Class Meeting
pattern that your institution has set up for the class in the
Schedule of Classes.

Use To and From Time

Select in order for the attendance rosters to have a to and
from time field to designate the start and end time of a class
meeting. The system determines this value based on the class
meeting pattern that your institution has set up for the class in
the Schedule of Classes.

Override Template Date/Time

Select for the attendance rosters to have an attendance date
field on them. Also, you can override the attendance date,
from time, and to time values that appear on the attendance
rosters. Otherwise, the corresponding fields that appear on an
attendance roster template control the attendance date, from
time and to time values that appear for each student on the
attendance rosters. A template only identifies an attendance

roster as unique.

Room Characteristics Required

Field or Control

Description

Room Characteristic

Enter the room characteristics that you require for the course
component. Room characteristic values are defined on the
Room Characteristic Table page. Characteristics you enter
here default to the schedule of classes. Insert rows to add
additional characteristics. This field is used for interfacing

to the Universal Algorithm's product, Schedule 25. The
maximum number of room characteristics for Schedule 25 is
96. Therefore, be sure you select values between 01 and 96 if
you use Schedule 25.

Room Characteristic Quantity

Enter the quantity of each room characteristic that you require.
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(NZL) Setting Up Government Reporting Data

Access the Crse Catalog NZL (course catalog New Zealand) page (Curriculum Management >
Course Catalog > Course Catalog > Crs Catalog NZL).

This example illustrates the fields and controls on the Crse Catalog NZL page. You can find definitions

for the fields and controls later on this page.

@l Crse Catalog NZL CoursefMilestone Link GL Interface

Course ID: 000381

Effective Date: 01/01/1900

Description:

ACCT 101
Course Catalog NZL

BCOW Q@
080101 @ Accounting

*Main Program:
*NZSCED Detail Code:

Intra to Management Accounting

Silver Fern University

Bachelor of Commerce

First n 1 of 1 u Last

Find | View Al

Status: Active

n1of1u

Find | View All

[JEmbedded Literacy/Mumeracy

*Course Type: Type A-Program EFTS w |

EFTS Factor: 0.0000

HQF Level: | Level 1 vl NGQF Credit: I—S
*Course Classification: IU3—Q Arts; Humanities; Social Sciences
*Funding Category: [42 1@ Ars & Soc S - Degree

Pre-Service Stage: | First stage of programme v|

eLearn Status: [ &

Average Course Fee: I—

Foreign Fee: l—
*Eligible for PBRF: |NutPElRF Eligible w

Compulsory Course Costs: l—
*Exempt Indicator:

VRF: [ ]

Field or Control Description

Main Program

Enter the main program for this course.

When you generate the SDR course register file, the
prospectus code from the program you select here is reported
as a qualification code.

NZSCED Detail Code

Enter the NZSCED field of study code for this course.

Set up NZSCED field of study codes on the NZSCED Field of
Study NZL page.
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Field or Control

Description

Course Type

Enter the course type for this course.
Values are:

*  Type A - Program EFTS

*  Type B - Hourly EFTS

If you enter Type B, the system displays the Hours field, in
which you can enter the total hours for the course. The system
calculates the EFTS factor based on the new value.

If you enter Type A, the system recalculates the EFTS factor
whenever the values change for the UNITS_ACAD_PROG,
UNITS_MINIMUM, and UNIT_MAXIMUM fields in the
CRSE_CATALOG record. The system calculates the EFTS
factor for type A courses by multiplying the academic progress
units for the course by the EFTS Translation A value defined
for the institution.

EFTS Factor

The system automatically calculates the EFTS factor for the
course whenever you add a new course or whenever you
change the course type or hours for the course. The system
calculates the EFTS factor by multiplying the course hours by
the EFTS Transaction B value defined for the institution.

NQF Level

Enter the New Zealand Register of Quality Assured
Qualifications level for the credits in this course.

NQF Credit

Specify the number of New Zealand Register of Quality
Assured Qualifications credits contained in this course.

Course Classification

Enter the course classification code for this course.

Define course classifications on the Course Classification
NZL (SSR_CRS_CLSF_FNDC ) page.

Only Course Classifications that have an effective date less
than or equal to the current date and a status of Active are
available for selection in the Course Classification field.

Funding Category

Enter the funding category for this course.

Define funding categories on the Funding Category NZL (SSR
_FUND_CAT_NZL ) page.

Pre-Service Stage

For courses that are part of a teacher training program, enter
the pre-service stage code for the course.

eLearn Status

Enter the eLearn status to indicate whether or not this course is
offered through the internet.
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Field or Control

Description

Average Course Fee

Enter the average fee for the students enrolled in this course
for the reporting period.

Foreign Fee

Enter the tuition fee paid by foreign, fee paying students.

Eligible for PBRF (eligible for Performance Based Research
Fund)

Use this field to indicate if a course is eligible for the
Performance Based Research Fund.

Compulsory Course Costs

Enter a dollar amount for the total compulsory fees for this
course.

Exempt Indicator

Indicate if a course was granted an exemption from FCCM
(Fees/Course Costs Maxima).

VRF (Volume of Research Factor)

Use this field to capture Volume of Research Factor data. This
field is for informational purposes only.

Embedded Literacy/Numeracy

Select this check box to indicate that the course has an
embedded literacy or numeracy component. The check box is
cleared by default.

Related Links

Understanding New Zealand Government Reporting

Linking Milestones to Course Data

Copyright

Access the Course/Milestone Link page (Curriculum Management > Course Catalog > Course

Catalog > Course/Milestone Link).

Field or Control

Description

Milestone

Link a milestone to a course. If the Writing milestone for
example is selected for a course, when a student enrolls in a
section of that course, the Writing milestone is assigned to the
student. A row is inserted in the Student Milestones page.

The Enroll into Course Milestones check box must be
selected on the Academic Institution 2 page and the Academic
Career Table 2 page.

(NZL) Enter the unit standards to link to this course. Link unit
standards to milestones in the NQF Detail group box on the
Milestone Table page.

Related Links

“Defining Academic Institutions” (Campus Solutions Application Fundamentals)
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“Defining Academic Careers” (Campus Solutions Application Fundamentals)
Setting Up Milestones

Tracking Milestones
Preparing for NZQA Reporting

Interfacing Course Offerings with the General Ledger

Access the GL Interface page (Curriculum Management > Course Catalog > Course Catalog >
GL Interface).

Copy and paste icons appear on this page, next to the Jrnl Set field. Use the copy icon to copy the setup
for the row, which can then be pasted to the new, or any proceeding, row.

Field or Control Description

Receivables From Item Type Select if you do not want to track revenue by course. The
system allocates revenue based on the credit entry defined
for the tuition item type. In this case, do not enter ChartField
information.

The system automatically tracks receivables for a course based
on the debit entry defined for the tuition item type (on the Item
Types - GL Interface page). If you want to track revenue by
course, you must select the GL Interface Required check box
on the Catalog Data page and then enter a credit entry for the
class by completing the ChartFields on this page.

Related Links
“Mapping Item Types to General Ledger Accounts” (Student Financials)

Creating Course Equivalency Groups

190

Course equivalency groups link different course ID numbers as equivalent for requisite checking
purposes. The courses themselves can possess different components, requisites, topics, and so on.
Equivalent course groups are for different course IDs and are, therefore, different from multiple-offering
courses.

Complete these steps to create a course equivalency group:
1. Define an equivalent course group on the Course Equivalencies page.
2. Add courses to the equivalency group on the Catalog Data page.

3. Return to the Course Equivalencies page and click the Fetch Equivalencies button to review the
group of equivalent courses.

Related Links
Defining Course Catalog Data
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Page Used to Create Course Equivalency Groups

Page Name Definition Name

Navigation Usage

Course Equivalencies CRSE_EQUIV

Define the course equivalency
group.

Curriculum
Management > Course
Catalog > Course
Equivalencies > Course
Equivalencies

Creating a Course Equivalency

Access the Course Equivalencies page (Curriculum Management > Course Catalog > Course

Equivalencies > Course Equivalencies).

This example illustrates the fields and controls on the Course Equivalencies page. You can find
definitions for the fields and controls later on this page.

Course Equivalencies

05001

a1jo1/1as0 [

Equivalent Course Group:

*Effective Date:

*Status: I Artive - I

First E 1of 1 II' Last

#[=]

|Elementaw Statistics

Statistics

*Description:

Short Description:

Equivalent Courses

Course ID: ao1011 Applied Statistics
Effective Date: 01y as0 Status:  Active
Equivalent Course Group: 05001 Elementary Statistics

Fetch Course Equivalencies |

Course ID: oo1o1z Ecaonarmic Statistics
Effective Date: 014071980 Status:  Active
Equivalent Course Group: 0a001 Elementary Statistics

114

Field or Control

Description

Effective Date

Enter an effective date for this equivalent course group. The
effective date defines when the status you select is valid.
Use a new effective date each time you make a change to
an equivalent course group. Insert new rows as needed,

and modify the record to track historical equivalent course
changes.

Status

Enter a status for this equivalent course group. Select Active
when adding a new equivalent course group. The Inactive
option should only be used if your institution no longer wants
to use this equivalent course group.
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Note: If you want to inactivate an equivalent course group, you need to delete that equivalent course
group number from each course to which it is attached on the Catalog Data page, and change the status to
Inactive on the Course Equivalencies page.

Field or Control Description

Description and Short Description Enter the descriptions of the equivalent course group.

Fetch Course Equivalencies After you attach courses to this equivalent course group on the
Catalog Data page, click this button to view all courses linked
to the equivalent course group.

This example illustrates how to assign courses to a new equivalent course group.

Course Equivalencies

First E 1 af 4 II' Last
Equivalent Course Group: 05001 E|
‘Effective Date: otin1s1880 [ Status: | Active |
‘Description: |E|ememaw Statistics Fetch Course Equivalencies |

Short Description: Statistics

Equivalent Courses Fined First [ 1-

Course ID: o001 Applied Statistics Fing
Effective Date: 09/16/2004  Status:  Active
Equivalent Course Group: 05002 Caleulus 1 STATS 115

Eduivalent Course Group

Course ID: oo1011 Applied Statistics

Effective Date: 01/07/11980 Status:  Active

Equivalent Course Group: 05001 Elermentary Statistics STATS 115
Course ID: nofo1z2 Economic Statistics

Effective Date: 01071 9a0 Status:  Active

Equivalent Course Group: 05001 Elementary Statistics

The system displays an effective date and equivalent course group for every course. To determine when
data for an effective-dated row is superseded, look at the next row. In the example, the system shows that
course ID 001011 was part of Equivalent Course Group 05001 until 09/16/2004. As of 09/16/2004, course
ID 001011 became associated with Equivalent Course Group 05102.

Click the Equivalent Course Group link to view other equivalent course groups for a specific course.

Viewing Course Catalog Summary Information

This section discusses how to review course catalog summaries.
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Page Name

Definition Name

Navigation

Usage

Course Catalog Summary

CRSE_CATALOG_SUM

Curriculum
Management > Course
Catalog > Catalog
Summary > Course
Catalog Summary

View a summary of course
offerings.

Reviewing Course Catalog Summaries

Access the Course Catalog Summary page (Curriculum Management > Course Catalog > Catalog
Summary > Course Catalog Summary).

Field or Control

Description

=

If the course is a part of an equivalent course group, the
equivalent course group appears. Click the Open button to
toggle between the equivalent courses.

Q)

Click the Detail button to go the Course Catalog - Catalog
Data page for the course. You can use this button to view
further details or to modify data for the course.

Related Links

Creating Course Equivalency Groups

Creating Course Offerings

Printing the Course Catalog

This section discusses how to enter course catalog report parameters.

Page Used to Print the Course Catalog Report

Page Name

Definition Name

Navigation

Usage

Print Course Catalog

RUNCTL_SRYCATLG

Curriculum
Management > Course
Catalog > Print Course
Catalog > Print Course
Catalog

Use the Print Course Catalog
page to print the course
catalog (SR301 Report).
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Entering Course Catalog Report Parameters

194

Access the Print Course Catalog page (Curriculum Management > Course Catalog > Print Course

Catalog > Print Course Catalog).

Field or Control

Description

From Date and End Date

Enter a from date and an end date. These dates are the
effective dates of the course offerings. They are required
fields. The system prints all active courses that are greater than
or equal to the from date, and less than or equal to the end
date.

Academic Institution

The system populates this field with the value on the User
Defaults 1 page.

Academic Organization

Enter the academic organization. You are prompted by the
Academic Organization Table page.

Academic Group and Academic Career

Enter the academic group and academic career if you want

to limit the scope of the report. Academic group values are
defined on the Academic Group Table page. Academic Career
values are defined on the Academic Career Table page.

Course Approved

Select whether you want to display Approved, Denied, or
Pending courses. To report courses of all three types, run three
reports, each with a different Course Approved field value.

Catalog Print

Select whether you want to view text designated as catalog
print text. If you select Yes, all courses with the Catalog Print
check box selected on the Course Catalog Offerings page
appear in the report. If you select No, the courses that do

not have the Catalog Print check box selected appear in the
report. If you select All, all courses appear, regardless of the
setting of the check box.

Report Only

Clear this check box to specify that you want to create a
Course Catalog report and send the Course Catalog report to
your file path location in .csv format. Select this check box
to create a Course Catalog report without creating a .csv file.
If you select this check box, the File Path field becomes
unavailable.
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Field or Control

Description

File Path

If you clear the Report Only check box, this field is available.
In addition to sending report output for this process to a

file (through setting preferences in the PeopleSoft Process
Monitor), you can also send any additional output files created
by this process to a file directory. To send the extract output

to a file directory, enter a valid directory path that maps to a
folder with appropriate read/write permission. If you cannot
locate such a folder, consult your system administrator.

Select the print options to display the described detail on the
report. If you clear them, the detail does not appear on the

report.

Run

Click to run the report using PeopleSoft Process Scheduler.
You should set the type to Web and the format to PDF.

Searching for Courses

This section discusses how to:
* Browse the course catalog.
* Select a course offering.

* View course catalog details.

Pages Used to Search for Courses

Copyright

Page Name Definition Name

Navigation

Usage

Browse Course Catalog SSS_BROWSE_CATLG

Curriculum

Management > Course
Catalog > Browse
Catalog > Browse Course
Catalog

Browse the course catalog to
see a list of courses offered at
the institution.

Browse Course Catalog -
Select Course Offering

SSS_BCC_SEL_CRSE

On the Browse Course
Catalog page, click a course
title that includes this
message: *** view multiple
offerings.

Select the appropriate offering
when a course ID has multiple
offerings with the same
subject, course number, and
title, or when multiple course
IDs have the same subject,
course number, and title.

Browse Course Catalog -
Course Detail

SSS CRSE OFFER DTL

Click a course number or
course title on the Browse
Course Catalog page.

View course details and
access class sections.
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Browsing the Course Catalog

Access the Browse Course Catalog page ((Curriculum Management > Course Catalog > Browse
Catalog > Browse Course Catalog).

This example illustrates the fields and controls on the Browse Course Catalog page. You can find
definitions for the fields and controls later on this page.

Browse Course Catalog

Select Institution PeopleSoft University b change

e cCDEFGHIJKLMHNOPQRSTUVWXY?Z
01234567389

AFSE ALL EXPAND ALL

Select subject code to display or hide course information.

D‘ ACCT - Accounting

[* ANATOMY - Anatomy

[* ANTHRO - Anthropology

= ART - Art

. Typically
Course Nbr Course Title Offered
Fall,
100 Bzsic Studio in Art =
Spring
101 Art Survey Fall
Fall,
111 Intreductory Art Seminar = .
I Spring
112 History of World Art Spring
113 History of World Art Fall
Fall,
121 Introductory Painting Spring.
Summer
130 Suoee o frintmEaias Winter
i ¥** view multiple offerings
Field or Control Description
Select Institution Enter the institution for which you want to search for courses.
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Field or Control Description

Course Nbr (course number) and Course Title Click a course number or a course title to view course details
and section information.

You are taken to the Select Course Offering page when a
course ID has multiple offerings with the same subject, course
number, and title, or when multiple course IDs have the

same subject, course number, and title—see ART 130 in the
previous example page. Notice that the course title includes
this message: *** view multiple offerings.

Typically Offered The terms in which a course is typically offered, as defined on
the Offerings page.

Selecting a Course Offering

Access the Browse Course Catalog - Select Course Offering page (on the Browse Course Catalog page,
click a course title that includes this message: *** view multiple offerings.)

This example illustrates the fields and controls on the Browse Course Catalog - Select Course Offering
page. You can find definitions for the fields and controls later on this page.

Browse Course Catalog

Select Course Offering

Return to Browse Course Catalog

ART 130 - survey of Printmaking

Typically | Academic|Academic

C C
aresr — Offered |Group Organization
. . College
M Haciend S ar=
Undergraduate - ? LEAES Winter of Fine Art
Campus Arts
Main Hacienda o CF”F = College of
Undergraduste Winter of Fine - 3
Campus irts Fine Arts

Return to Browse Course Catalog

Use this page to select the appropriate offering when a course ID has multiple offerings with the same
subject, course number, and title, or when multiple course IDs have the same subject, course number, and
title.

Viewing Course Catalog Details
Access the Browse Course Catalog - Course Detail page (click a course number or course title on the

Browse Course Catalog page or a course offering link on the Browse Course Catalog - Select Course
Offering page).
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This example illustrates the fields and controls on the Browse Course Catalog - Course Detail page. You
can find definitions for the fields and controls later on this page.

Browse Course Catalog

Course Detail

Feturn to Browse Course Catalag

PSYCH 495 - Psychology Special Topics

Course Detail

view class sections

Career Undergraduate

Units 2,00 - 2,00

Grading Basis Graded

Course Components Lecture Required
Labaratary Required

Enrollment Information

Typically Offered Fall

Add Consent Instructar Consent Required
Drop Consent Departrnent Consent Required
Enrollment Requirement Muszt be an Honors student
Requirement Designaton Hormoars Option

Course Attribute Open ta seniars anly,

Open to majors anly,

Descrpton

An intensive study of 3 psycholagical topic which carmmands the
curkent focus of interest of both the faculty mermber and the
students,

Course Schedule

Click the view class sections button to view the course schedule details.
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This example illustrates the fields and controls on the Course Schedule page. You can find definitions for
the fields and controls later on this page.

Course Schedule
Terms Offered | 2006 Fall v| show sections I
.Open Bciosed
PSYCH 495 sections for 2006 Fall
Secton Session Topic
01-LEC (1539 Cambined 1 Research Methods in Psych
Days Start End Room Instructor
MWF  1:00PM  1:50PM  Bush 1100 Aurelia Edrmundson,
Edward Litrman
F 2:00PM 4:30PM King 100 Mara Bavlor
Secton Session  Topic
Oif-LAB (15407 1 Reszearch Methods in Psych
Days Start End Room Instructor
F 2:00aM 10:20AM Angel 102 Aurelia Edrmundson
Secton Session  Topic
02-LEC (1541 i Hiztarical Perspective of Psy
Days Start End Room Instructor
il S:00AaM 11:30AM TBA Staff

Ao ait List

Status
@

Dates
08/30/2006 -
12/12/2006

08/30/2006 -
12/12/2006

Status
@

Dates
0af30/2006 -
1271272006

Status
@

Dates

0g/230/2006 -
12/12/2006

Enter a term and click the show sections button to view class sections for the course.
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Understanding Enroliment Requisite Setup and Maintenance

In Student Records, two levels are available at which you can create enrollment requisites and
requirements:

1. Enrollment Requirement Groups, which handle requirements for specific courses or class reserve
capacities.

2. (Optional) Enrollment Requirements (with or without course lists), which handle complicated
requisite rules.

Most likely, you can meet 90 percent of your requisite needs with the Enrollment Requirement Group
component alone.

Related Links

“Understanding Academic Requirement Groups” (Academic Advisement)
“Setting Up Academic Course Lists” (Academic Advisement)

Prerequisites

Depending on the structure and complexity of your enrollment requirement groups, you must first define
the following data:

* Academic institutions.

* Requisite program statuses.

* (Optional) Tests for requisites.

e Student Groups for requisites.

* (Optional) Requisite conditions.

* (Optional) Enrollment requirements.
e (Optional) Enrollment course lists.

* (Optional) Entity groups.

* (Optional) Requirement designations.

e (Optional) Courses.
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Defining Requisite Program Statuses

This section discusses how to define valid academic program statuses for use in requisite checking.

Page Used to Define Requisite Program Statuses

Page Name Definition Name Navigation Usage

Define Requisite Prog Status | SSR_ENR _RPT TYPE Curriculum Enter valid academic program
Management > statuses for use in Enrollment
Enrollment Requisites conditions.

Requirements > Define
Requisite Prog Status >
Define Requisite Prog Status

Defining Requisite Program Statuses

Access the Define Requisite Prog Status page (Curriculum Management > Enrollment
Requirements > Define Requisite Prog Status > Define Requisite Prog Status).

Use this page to identify valid program statuses for an institution. The statuses that are defined on

this component are considered valid for enrollment requisites using conditions that specify academic
programs, plans, or sub-plans. The requisite checking process evaluates only programs, plans, or subplans
for which the student's current (for the enrollment term) academic program status matches one of the
statuses defined here.

Field or Control Description

Effective Date Enter the date for which the program status is effective for
requisites.

Program Status Enter the valid program statuses for the assigned effective
date.

Note: In most cases, you need to define only one status here (ACTV). Adding any other non-active
program statuses allows requisite conditions based on academic program, plan and sub plans to be
satisfied by non-active students.

Defining Tests for Use in Requisites

This section discusses how to define tests for use in enrollment requisites.
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Page Used to Define Tests for Use in Requisites

Page Name Definition Name Navigation Usage

Define Tests for Requisites SSR_REQ _COND_TEST Curriculum Set up test information for use
Management > in conditions in enrollment
Enrollment requirement groups and

Requirements > Define
Tests for Requisites >
Define Tests for Requisites

requirements.

Defining Tests for Requisites

Access the Define Tests for Requisites page (Curriculum Management > Enrollment
Requirements > Define Tests for Requisites > Define Tests for Requisites).

This example illustrates the fields and controls on the Define Tests for Requisites page. You can find
definitions for the fields and controls later on this page.

Define Tests for Requisites

Processing Controls

Months Valid:

T30

Find | wigw Al First E 1of 1 El Last
Academic Institution: PSLIMY PeapleSaft Univarsity =]
Test ID: ACT ACT Assessment
Effective Date: [n1i1ra0n [ Status:

Enable User to Override Months

Test Score Method: | Highest Score

v| Enable User to Override Method

alid Data Sources

‘Data Source: |American College Testing

v =+ [=

‘Data Source: | School

v [+ [=

Use this page to identify the tests and related data that you want to use in conditions in enrollment
requirement groups and requirements. The Test IDs are already defined in the Test Tables component.
Here, you are identifying which Test IDs and related data that you want to use in enrollment requisites.

Important! If you want to use test scores in academic requirements, you must define your Test IDs and
related data in the Define Tests for Advisement component.

See “Setting Up Tests for Use in Academic Advisement” (Academic Advisement)

Note: Tests defined in this component are saved with a requirement usage code of ENR. Users can

retrieve such rows using this component only.
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Field or Control

Description

Test ID

Select the Test ID (such as ACT, GMAT, or GRE) that you
want to use in enrollment requirement groups or enrollment
requirements. The system displays values defined on the Test
Tables page. This field is unavailable for entry unless you are
in Add mode.

Status

Select the status of the report identifier. Values are:
Active: Select when adding a new report identifier.

Inactive: Select only if your institution no longer uses this
report identifier.

Values for this field are delivered with your system as
translate values. Do not modify these values in any way.
Any modification to these values will require a substantial
programming effort.

Months Valid

Enter the number of months for which a test score can be
considered valid. An empty (blank) field is interpreted to mean
that the test is always valid.

Test Score Method

Select the test score method. Values are:

Average of All Scores Taken: Select to have the enrollment
engine average scores for a given test when it processes
the test for a condition in an enrollment requirement or
requirement group.

First Test Taken: Select to have the enrollment engine use the
test score with the earliest date when it processes the test for a
condition in an enrollment requirement or requirement group.

Highest Score: Select to have the enrollment engine use the
highest score for a given test when it processes the test for a
condition in an enrollment requirement or requirement group.

Last Test Taken: Select to have the enrollment engine use the
score from the last test date taken when it processes the test
for a condition in an enrollment requirement or requirement

group.

Lowest Score: Select to have the enrollment engine use the
lowest score for a given test when it processes the test for a
condition in an enrollment requirement or requirement group.

204

Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 6 Setting Up Enroliment Requisites

Field or Control Description

Enable User to Override Method By default, this check box is cleared, which means that the
user is unable to change this value for this test ID in the
Enrollment Requirement, Enrolment Requirement Group, or
Define Requisite Conditions component pages.

Select this check box if you want to enable a user to change
the Test Score Method field value on the enrollment
requirement or enrollment requirement group components.
This check box label is defined in the Message Catalog. You
can change this label as needed.

Enable User to Override Months By default, this check box is cleared, which means that the
user is unable to change the Months Valid field value in

the academic requirement or academic requirement group
component pages. Select this check box if you want to enable
a user to change the Test Score Method field value on the
Enrollment Requirement, Enrolment Requirement Group, or
Define Requisite Conditions components. This check box label
is defined in the Message Catalog. You can change this label
as needed.

Data Source Select one or more valid data sources (American College
Testing, for example) for the test ID you are defining. Values
for this field are delivered with your system as translate
values. You can modify these translate values. The delivered
testing agency values that appear here are American College
Testing, College Board, Educational Testing Services, and Law
School Admission Services. These are the data sources that are
considered valid when processing a test score in an enrollment
requirement or requirement group.

Related Links
“Defining External Tests” (Recruiting and Admissions)
“Setting Up Academic Requirements” (Academic Advisement)

Defining Student Groups for Use in Requisites

This section discusses how to define student groups for use in enrollment requisites.
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Page Used to Define Requisite Student Groups

Page Name Definition Name Navigation Usage

Define Requisite Student SSR_VALID STDNT GR Curriculum Enter student groups for use

Group Management > in enrollment requisites.
Enrollment

Requirements >

Define Requisite Student
Group > Define Requisite
Student Group

Defining Requisite Student Groups

Access the Define Requisite Student Group page (Curriculum Management > Enrollment
Requirements > Define Requisite Student Group > Define Requisite Student Group).

This example illustrates the fields and controls on the Define Requisite Student Group page. You can find
definitions for the fields and controls later on this page.

Define Requisite Student Group
Eind | “fiewe Al First E 1 af 1 IIl Last
o [=]
Academic Institution: PSLIMY FeopleSoft University
Effective Date: 01/01/2004 [
Firzt E 1-Faof 7 |I| Lazt
*Student Group: |P«THL '} Athlete El
‘Student Group: |CSU Q CS5LI Breadth =]
‘Student Group: |EEL Q English as a Second Languane =]
"Student Group: |HONH Q, Honors Society El
'Student Group: |IGTC Q IGETC =]
*Student Group: |ITNL L International Student =]

Use this page to identify the student group codes that you want to use in conditions in enrollment
requirement groups and requirements.

Note: Student groups that are defined in this component are saved with a requirement usage code of ENR.
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Field or Control Description

Effective Date Enter the date for which the student group is effective.

Student Group Enter the valid student group or groups for the assigned
effective date.

Defining Requisite Conditions (Optional)

This section provides an overview of conditions for use in enrollment requisites and discusses how to
define them.

Understanding Requisite Conditions

When you want to create an enrollment requisite that contains a condition, you select a value from the list
of delivered "standard" condition codes (Cumulative Grade Point Average, for example). For example,
you might set up a course prerequisite whose condition is that the student's cumulative GPA is greater
than 3.0.

Requisite conditions enable you to create conditions that are more complex and then use those as
conditions in an enrollment requirement or requirement group. They enable you to use multiple standard
conditions (student group equals athlete and academic standing is good, for example), user programmable
conditions (a milestone, for example), or a combination thereof. For example, you might set up a requisite
condition whereby academic level must be less than sophomore and that the SAT math score must be
greater than or equal to 650.

A condition specification (requisite condition) is a condition that includes connector types, lines, process
types, parameters, and controls. It can also be referenced by another requisite condition. Using Boolean
logic, requisite conditions can be combined within a condition specification to create more complex
requisite conditions. For example, you could create two requisite conditions, and then point to these from
a third requisite condition. Requisite condition #1 equals academic level = freshman and cum GPA>=2.0.
Requisite condition #2 equals sophomore and cum GPA>=2.5. Requisite condition #3 equals requisite
condition #1 OR requisite condition #2.

Page Used to Define Requisite Conditions

Page Name Definition Name Navigation Usage

Define Requisite Conditions | RQ_CONDITION Curriculum Define the conditions for use
Management > in enrollment requirements
Enrollment or enrollment requirement
Requirements > Define groups.
Requisite Conditions >
Define Requisite Conditions
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Access the Define Requisite Conditions page (Curriculum Management > Enrollment
Requirements > Define Requisite Conditions > Define Requisite Conditions).

This example illustrates the fields and controls on the Define Requisite Conditions page (in Add mode).
You can find definitions for the fields and controls later on this page.

Condition Details

Condition Specification:
‘Effective Date:
‘Description:

Long Description:

*Academic Institution:
Connector Type:

Condition Lines

*Condition Line Sequence:
*Condition Process Type:

Condition Process ldemifier:

Condition Line Details

Condition Line Detail Sequence:
Academic Institution:
Academic Career:

Academic Program:

Academic Plan:

Milestone:

Milestone Complete:

Milestone Level:

Minimum Grade Points:
Milestone Title:

Define Requisite Conditions

E 1of 1 II'
0oooas =
01/01/1900 [5] *Status:
|Writing FPortfolio Short Description: Porfalio
Verify that student has completed an Undergraduate Writing portfolio. @

E
PEUNY ¢ FPeopleSoft University Ccalculate Test Score
AMD -

=]

| User Pragrammable Condition

0001 Q

X
PsUNY Q
[ &
[ &
[ a
WRITING @

Milestone Check

FeopleSoft University

Writing Portfolio

|Cnmpleted

W

UNDERGRADUATE O

LIndergraduate Portfalio

Wiriting Partfalio

Field or Control

Description

Condition Specification

This is an arbitrary number that is unique for each condition
specification. You can use this condition specification as

a condition in an enrollment requirement or enrollment
requirement group.

Description

Enter a description for the condition specification that

you want to establish. The description appears on the
enrollment requisite (requirement group) summary, enrollment
requirement summary, the enrollment advisement report,

the requisite requirement report, and the reverse engineering
report.
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Field or Control Description

Short Description and Long Description Enter descriptions for the condition specification that you want
to establish. These descriptions are used for documentation
purposes only.

Academic Institution Select the academic institution. Each condition specification is
associated with only one academic institution.

Connector Type Select the main connector type for this condition specification.
Values are: None, AND, and OR. (None converts to AND.) The
connector type indicates the Boolean operator to be used in the
equation that contains the condition lines.

Condition Line Sequence This number indicates the order in which the condition
lines are evaluated. The condition line sequence number is
automatically assigned, but can be overridden by the user.

Condition Process Type Select a condition process type. Values are:

Standard Condition: Indicates that the condition is one of the
delivered, standard conditions. This is the default field value.
If you use this type, then the condition code field is available.

User Programmable Condition: Indicates that the condition
is a user programmable condition. If you select User
Programmable Condition, the Condition Process Identifier
field becomes available.

If you select the condition process type User Programmable
Condition, and the condition process identifier of Milestone
Check, then you are presented with additional fields. Use
these to specify the details about the milestone for use in this
dynamic condition.
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Field or Control

Description

Condition Code

If you select the Condition Process Type field value of
Standard Condition, then select one of the following delivered
translate values:

None: Indicates no field value.

Academic Level: Indicates the year of study. For example,
valid values include freshman and sophomore. This value is
evaluated against the student based on whatever As of Date
field value is specified at run time.

Academic Plan: Indicates the area of study, for example, a
major or minor within the academic program. Some plans

are subdivided into sub-plans. Academic Plan and Primary
Academic Plan reference the exact same plan when the student
has one plan only.

Academic Plans: Indicates that all of a student's plans are part
of the equation.

Academic Program: Indicates the program of study to which

a student applies and is admitted. Academic Program and
Primary Academic Program reference the exact same program
when the student has one program only.

Academic Programs: Indicates that all of a student's academic
programs are part of the equation.

Academic Standing: Indicates a student's standing at the
institution. For example, values might include good standing,
probation, and dismissal. You define values in the Academic
Standing table. This value is evaluated against the student
based on the as of date that you specify at run time.

Academic Sub-Plan: Indicates a further specialization within
the academic plan.

Academic Sub-Plans: Indicates that all of a student's sub-plans
are part of the equation.

Cumulative Grade Point Average: A student's cumulative
grade point average (derived from the students term history
cumulative statistics, in conjunction with the processing as of
date).

Dynamic Condition: Indicates a dynamic condition that has
been previously created in the Define Dynamic Condition
component.

Primary Academic Plan: Indicates a student's primary
academic plan. The primary academic plan is designated by
the lowest plan sequence number on the Student Plan page.
For example, under a program of LAU, a student might have
two plans, Psychology and Classics Minor. If Psychology
has a plan sequence number of 10 and Classics Minor has a
plan sequence number of 20, then Psychology is the primary
academic plan. On the Student Plan page, student career
number 0 is the primary career.
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Field or Control

Description

Important! The primary academic plan is designated by

the lowest plan sequence number on the Student Plan page,
and the primary academic program is designated by the
lowest career sequence number on the Student Program page.
However, when a student has multiple programs (containing
multiple plans), the primary academic plan is not necessarily
the lowest plan sequence number under a given program,

but it is that plan with the lowest plan sequence number
under the program with the lowest student career number. For
example, under a program of Liberal Arts Undergraduate
(attached to a student career number of 0), a student has a
plan of Psychology with a plan sequence number of 10. The
same student has a plan of Art with a plan sequence number
of 10 under a program of Fine Arts Undergraduate (attached
to a student career number of 1). Both plans have a plan
sequence number of 10, but the plan under the program with
the lowest career number is the primary plan. In this example,
the primary plan is Psychology, which is tied to a student
career number of 0 through the Liberal Arts Undergraduate
program. Primary Academic Program: Indicates a student's
primary academic program. The primary academic program is
the program designated by the lowest career sequence number.
On the Student Program page, student career number 0 is the
primary career.

Student Group: Indicates a grouping of students. For example,
values might include athlete and veteran. You define values in
the Student Group table.

Student Groups: Indicates that all of the student groups
containing a student are part of the equation.

Test Score: Select to use a test score as a condition. If you
select this field value, the following additional fields appear:
Test ID, Test Component, Condition Operator, Test Score,
Months Valid, and Test Score Method.

Months Valid and Test Score Method are editable according
to the setup on the Define Tests for Advisement page.

If you select User Programmable Condition, the Condition
Process Identifier field becomes available. Select the
appropriate value for the condition process. The delivered
values are: 0001 (Milestone Check), 0002 (Internal Degree
Check), and 0003 (External Degree Check). Milestone Check
verifies whether a milestone is completed, in progress, or not
completed. Internal Degree Check verifies whether a student
has received a degree from the home institution. External
Degree Check verifies whether a student has received a degree
from another institution.

Note: You can create additional condition process identifier
field values in the Condition Processes table. Delivered field
values are numbered from 1 through 500. Client-added values
should be numbered above 500.
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Description

Condition Operator

Values are: Equal, Greater Than, Greater or Equal, In, Less
Than, Less or Equal, Not Equal, and Not In. None is the
same as Equal.

The operators of In and Not In are for use with requisite entity
groups and so are available only when you select the following
condition codes: Academic Plan, Academic Plans, Primary
Academic Plan, Academic Program, Academic Programs,
Primary Academic Program, Academic Sub Plan, Academic
Sub Plans, Student Group, and Student Groups.

If you select the operator /n or Not In, the Condition Data
field prompts on requisite entity groups that you set up using
the Requisite Entity Groups component.

Note: A student with a null set of entities is always considered
true for all plurals of that entity for both /n and Not In because
the null set is included in all entity groups and all entity group
complements.

Operators are not used if the precondition is Dynamic
Condition. If the precondition is Dynamic Condition, then
select one of the dynamic conditions that you previously
created in the Define Dynamic Condition component.

Condition Data

The system prompts you with values based on your selections
in the Condition Code and Condition Operator fields.

Field or Control

Description

Academic Institution

If applicable, enter the academic institution. Each condition
line detail is associated with only one academic institution.

Academic Career

If applicable, enter the academic career that contains the
academic program that is associated with this condition line
detail.

Academic Program

If applicable, enter the academic program that is associated
with this condition line detail.

Academic Plan

If applicable, enter the academic plan that is associated with
this condition line detail.

Milestone

Enter the milestone that must be achieved to satisfy this
condition line detail. For example, a milestone could be an
audition, qualifying exam, or thesis. You define milestones in
the Milestone table.
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Field or Control

Description

Milestone Complete

Select the appropriate milestone. Values are:
None: Indicates that the field is not applicable.

Completed: Indicates that the student must complete this
milestone to satisfy the condition line detail.

In Progress: Indicates that the student must be working
towards completing the milestone to satisfy the condition line
detail.

Not Completed.: Indicates that the student must not have
completed this milestone to satisfy the condition line detail.

Milestone Level

Enter the minimum level for this milestone. Some examples of
milestone levels are honors, undergraduate, or graduate.

Minimum Grade Points

Enter the minimum grade points that are acceptable to
complete this condition line detail.

Milestone Title

Enter a descriptive phase as the milestone title. Use this field
for documentation purposes only.

If the condition process type is User Programmable Condition and the condition process identifier
selected is External Degree Check or Internal Degree Check, the user then must select a degree.

Field or Control

Description

Degree

Enter the degree that must be obtained to satisfy the condition
line.

If you select the condition process type of standard condition and the condition code of Test Score, the

appearance of the page changes.

Field or Control

Description

Test ID

Select a Test ID from those defined on the Define Advisement
Tests page.

Test Component

The selection options are based on the Test ID selected.
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Description

Condition Operator

Identifies what type of comparison is to be applied to the
condition data. Possible condition operators include: None,
Less or Equal, Greater or Equal, Equal, Greater Than, Less
Than, and Not Equal. Make sure that you use an operator that
makes sense in the equation. Values for this field are delivered
with your system as translate values. Do not modify these
values. Any modifications to these values require a substantial
programming effort.

Test Score Enter a score required for the test component and condition
operator selected.

Months Valid The value indicates the number of months for which a test
score is valid. This field is available for editing based on the
setup on the Define Tests for Advisement page.

Test Score Method Values are:

Average of All Scores Taken: Select to have the advisement
engine average scores when it processes the tests for a
condition in an enrollment requirement or requirement group.

First Test Taken: Select to have the advisement engine use the
test score with the earliest date when it processes the tests for a
condition in an enrollment requirement or requirement group.

Highest Score: Select to have the advisement engine use the
highest score for a given test when it processes the tests for a
condition in an enrollment requirement or requirement group.

Last Test Taken: Select to have the advisement engine use the
score from the date of the last test taken when it processes
the tests for a condition in an enrollment requirement or
requirement group.

Lowest Score: Select to have the advisement engine use the
lowest score for a given test when it processes the tests for a
condition in an enrollment requirement or requirement group.

When you select the Calculate Test Score check box, other fields become available so that you can
define the details of the calculation to be performed when the dynamic condition is used in an enrollment

requirement or enrollment requirement group.

Field or Control

Description

Test Component Taken Option

This field appears in the Condition Details group box only
when the Calculate Test Score check box is selected. Valid
values are: Tests Taken on Different Dates and Tests Taken on
Same Date.
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Field or Control

Description

Test ID

This field appears in the Condition Details group box only
when the Calculate Test Score check box is selected. These
prompt from the Test IDs defined on the Define Advisement
Tests page.

Condition Operator

This field appears in the Condition Details group box only
when the Calculate Test Score check box is selected.

Identifies what type of comparison is to be applied to the
condition data. Possible condition operators include: None,
Less or Equal, Greater or Equal, Equal, Greater Than, Less
Than, and Not Equal. Make sure that you use an operator that
makes sense in the equation. Values for this field are delivered
with your system as translate values. Do not modify these
values. Any modifications to these values require a substantial
programming effort.

Calculation Method

This field appears in the Condition Details group box only
when the Calculate Test Score check box is selected. Valid
values are: Average of the Components and Sum of the
Components.

Score Required

This field appears in the Condition Details group box only
when the Calculate Test Score check box is selected. Enter a
valid score required as it relates to the values selected in the
preceding fields.

Months Valid

This field appears in the Condition Details group box only
when the Calculate Test Score check box is selected. This
field is available for editing based on the setup on the Define
Tests for Advisement page. The value indicates the number of
months for which a test score is valid.
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Description

Test Score Method

This field appears in the Condition Details group box only
when the Calculate Test Score check box is selected. Values
are:

Average of All Scores Taken: Select to have the advisement
engine average scores when it processes the tests for a
condition in an enrollment requirement or requirement group.

First Test Taken: Select to have the advisement engine use the
test score with the earliest date when it processes the tests for a
condition in an enrollment requirement or requirement group.

Highest Score: Select to have the advisement engine use the
highest score for a given test when it processes the tests for a
condition in an enrollment requirement or requirement group.

Last Test Taken: Select to have the advisement engine use the
score from the date of the last test taken when it processes
the tests for a condition in an enrollment requirement or
requirement group.

Lowest Score: Select to use the lowest score for a given test
when tests for a condition in an enrollment requirement or
requirement group are processed.

Condition Line Sequence

Appears by default, starting with the number 1. Each condition
line must have a unique condition line sequence value.

Test Component

This field appears in the Condition Lines group box only when
the Calculate Test Score check box is selected. The selection
options are based on the Test ID selected.

Minimum Score

This field appears in the Condition Lines group box only when
the Calculate Test Score check box is selected. Enter the
minimum acceptable score for the test component identified
for the condition line sequence.

Related Links

“Defining Custom Conditions” (Academic Advisement)

Defining Entity Groups for Use in Requisites (Optional)
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This section discusses how to define entity groups for use in enrollment requisites.

Entity groups are similar items (programs, plans, subplans, or student groups) that are grouped together
to be used in a condition. An example is that you have a requisite for a course that states a student must
be enrolled in one of five plans to enroll in the course. To make this a simple condition, the five plans are
placed into an entity group. When the condition is defined, it states that academic plans must be in the
entity group. This allows for many similar objects to be grouped together for comparison.
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Requirements > Define
Requisite Entity Groups >
Define Requisite Entity
Groups

Page Name Definition Name Navigation Usage

Define an Entity Group SSR_RQ_ENTITY_GRP Curriculum Define the academic entity
Management > group to be used as a
Enrollment precondition or condition

requirement.

Defining Requisite Entity Groups

Access the Define Requisite Entity Groups page (Curriculum Management

> Enrollment

Requirements > Define Requisite Entity Groups > Define Requisite Entity Groups).

This example illustrates the fields and controls on the Define Requisite Entity Groups page. You can find

definitions for the fields and controls later on this page.

Define Requisite Entity Groups

Fir=t E 1af 1 |I| Last

[+ =]

Long Description:

*Academic Institution:

‘Enttity Group Type:
Entity Group tem Detail

’_ Academic Plan

1olRTQ
2 lRTHET  Q
3 [pance  Q
4 wusea  Q

Fimd | e Al
Entity Group: 000015
‘Effective Date: 0011800 [= ‘Status:
*Description: Fine Arts Majors Short Description; |Fing Arts

Fine Arts Majors

&

PSLIMY w

Description
Art (BFA)

Art Histary (BFA)
Dance (BFA)
Music-BA

FeopleSoft University

First E 1-4 of 4 II' Last

i
Customize | Find | %5

cichela] |
nwoop

Note: Entity groups that are defined in this component are saved with a requirement usage code of ENR.

Field or Control

Description

Entity Group

This system generated number is unique for each entity
group. It can be used to build a condition at the enrollment
requirement group or enrollment requirement level.
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Field or Control Description

Effective Date The latest effective date that you enter for the entity group is
used during processing.

Academic Institution Select the academic institution. Each entity group is associated
with only one academic institution.

Description Enter a description for the entity group. The description
appears in the enrollment requirement group and enrollment
requirement summaries.

Entity Group Type Select the entity group type that indicates the type of items that
are contained in the group. This field value determines what
information appears in the Entity Group Item Detail group
box. Program is the default value.

Entity Group Item Detail

This group box lists the details (entities) in this requisite entity group. An entity group item number is
a sequential line number that the system automatically assigns to each item in the entity group. You can
override the number. The system automatically supplies the description.

Defining Enrollment Requirement Groups

This section provides an overview of enrollment requirement group setup and discusses how to:
* Define enrollment requirement groups.

* Define overall requisite parameters.

* Define requisite details.

* Define requisite detail level parameters.

Understanding Enroliment Requirement Group Setup

218

Enrollment requirement groups encompass requisites based on a variety of factors including grade point
average and units, courses, and much more. Virtually every prerequisite or corequisite that your institution
has for courses can be satisfied with the Enrollment Requirement Group component alone.

Enrollment requirement groups are also used for reserve capacity portions of classes. You can create
enrollment requirement groups which are later attached to classes designating a reserve capacity for
students who meet a certain criteria (for example, you can set aside 10 seats in a class for students with a
certain academic level, cumulative GPA, number of units earned, and so on).

You attach enrollment requirement groups to courses in the course catalog, and you can override these
requisite rules or append them on a class-by-class basis when you create the schedule of classes. One
course catalog offering can refer to one enrollment requirement group rule, but that rule can contain
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multiple course requisites and noncourse enrollment restrictions (such as condition requirements).
Multiple course offerings can use the same enrollment requirement group or different ones. Reusability,
and thus a reduction in data entry and maintenance, is a valuable aspect of this feature.

Of course, a number of ways are available for you to structure your course requisites. Many times more
than one "correct" way exists to structure requisites using a combination of enrollment requirement
groups and enrollment requirements (which we review later in this section). We review examples of
course requisite setup in this section as well.

Here is a high-level overview of how to create a simple enrollment requirement group or reserve capacity:

1. Create a description of the enrollment requirement group on the Course Requisite page.

2. Determine whether parameters such as minimum GPA, units, or number of courses are an attribute of

the requirement on the Requisite Parameters page.

3. Enter any other parameters of the requisite such as a course, a range of courses, a student attribute
(such as program or plan), and so on, on the Requisite Detail page.

4. Determine whether any course validation parameters exist for the requisite courses on the Requisite
Detail Parameters page.

5. Attach the enrollment requirement group to a course offering on the Course Catalog - Offerings page
(as a requisite); or attach the enrollment requirement group to a course on the Schedule of Classes -
Reserve Cap (Schedule of Classes - Reserve Capacity) page (as a reserve capacity).

Pages Used to Define Enroliment Requirement Groups

Page Name Definition Name Navigation Usage

Course Requisite CRSE REQUIS RESTR Curriculum Describe the enrollment
Management > requirement group. The
Enrollment system generates a unique

Requirements >
Enrollment Requirement
Groups > Course
Requisite

numeric identifier for the
group, although you can enter
your own number for the

group.

Requisite Parameters

CRSE_RQS_RSTR_PARM

Curriculum
Management >
Enrollment
Requirements >
Enrollment Requirement
Groups > Requisite
Parameters

Specify overall GPA and
unit requirements for all of
the requisite detail lines in
the group. The GPA, course
and unit minimums that are
entered apply to the overall
course restrictions for the
classes that are specified in
the subsequent requirement

pages.
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Page Name Definition Name Navigation Usage

Requisite Detail CRSE _RQS RSTR DET Curriculum Link the actual courses or
Management > noncourse requirements to the
Enrollment enrollment requirement group.
Requirements > The page is similar to the
Enrollment Requirement Academic Requirement Group

Groups > Requisite Detail | - Detail page in PeopleSoft
Academic Advisement.

Requisite Detail Parameters CRSE RQS _DET PRM Curriculum Further define the details of
Management > Course or Wild Card Course
Enrollment group line types.

Requirements >
Enrollment Requirement
Groups > Requisite Detail
Parameters

Defining Enroliment Requirement Groups

Access the Course Requisite page (Curriculum Management > Enrollment Requirements >
Enrollment Requirement Groups > Course Requisite).

This example illustrates the fields and controls on the Course Requisite page. You can find definitions for
the fields and controls later on this page.

Course Requisite

First n 1 of 1 u Last

Requirement Group: 008047 =]
*Effective Date: 01/01/1900 [ ~Status:
*Description: |Soc 100 Pre-Reqs *Short Description: ERG 2
*Long Description: Requires PHILO 100 { 3 units minimum grade of C) and HISTORY 100 (2 units minimum @

grade of C)
*Report Description: |Soc 100 Pre-Reqs

*Report Long Description: | Course A (SOC 100) requires Course B (PHILO 100) and Course C (HISTORY 100) 3 units @

min Grade Cin each

*Academic Institution: PSUNV Q PeopleSoft University
Academic Group: Q
Subject Area: soc Q Sociology

Catalog Nbr: 100 Q Introduction to Sociology
Enable Catalog Print
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Field or Control

Description

Effective Date

Enter an effective date for this enrollment requirement group.
The effective date must be equal to or less than the effective
date of the course to which this course requisite is attached.

Note: The system accesses the enrollment requirement group
rules based on the start date of the term for which the requisite
checking occurs. As long as your effective date is less than

or equal to the term start date and the status is Active, the
enrollment posting process checks this rule.

Status

Select a status for this enrollment requirement group. Select
Active when adding a new enrollment requirement group.
Select Inactive only if your institution no longer wants to use
this enrollment requirement group.

Note: If you want to inactivate an enrollment requirement
group, you need to delete the number for that enrollment
requirement group from each course to which it is attached on
the Catalog Data page.

Description, Short Description, and Long Description

Enter a description, short description, and long description for
the enrollment requirement group.

Report Description and Report Long Description

Enter a report description and long description for the
enrollment requirement group to be used by the enrollment
requirement checking processes.

Academic Institution

The system populates the academic institution field by default.
You can change the value.

Academic Group, Subject Area, and Catalog Nbr (catalog
number)

The system does not include these values in the analysis of
the requirement group. These values are helpful tools for
searching the database for the appropriate requirement group
to attach to a course. You may want to use these fields to
signify the course to which the requisite is attached, or to
specify department ownership of the requisite.

Enable Catalog Print

Select this check box to display the long description of the
enrollment requirement group in the course catalog.

Defin

Copyright

ing Overall Requisite Parameters

Access the Requisite Parameters page (Curriculum Management > Enrollment Requirements >
Enrollment Requirement Groups > Requisite Parameters).
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This example illustrates the fields and controls on the Requisite Parameters page. You can find definitions

for the fields and controls later on this page.

Requisite Parameters

Requirement Group: 008047 Description:

Effective Date: 01/01/1900 Status:
Course Credit Parameters

Soc 100 Pre-Reqgs
Active

Default for Detail Level

First [ 4] 1 of 1 n Last
=]

Minimum GPA:
Minimum Units: Min Grade Points/Unit:
Minimum Courses:

Detail Selection Parameters

@anp COR

Course Credit Parameters

Course credit parameters are overall criteria that the system uses in the evaluation of all combined

requisite detail lines.

Field or Control

Description

Minimum GPA (minimum grade point average)

Enter the overall minimum GPA for classes that are selected to

meet this requirement.

Minimum Units

Enter the total minimum units for the classes that are selected

to meet this requirement.

Minimum Courses

Enter the total minimum courses for the requirement.

Default for Detail Level

Field or Control

Description

Min Grade Points/Units (minimum grade points/units)

The system uses the minimum grade points per unit value as a
filter in the requisite checking process. This technique is used
to simplify and generalize the comparison logic. The minimum
grade point/unit value is the minimum grade points that are
required for any individual class that is selected to meet the
requirement. The system includes a student's in-progress work
as counting toward the minimum.
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Field or Control

Description

Connector Type

For enrollment requirement groups with more than one
requisite detail line, select the appropriate connector type. The
connector type indicates whether the student must meet a//

of the requirement line detail conditions (AND) or whether

the student only needs to meet one of the requirement line
details (OR). This value is used as the connector default on the
Requisite Detail page when rows are inserted.

Defining Requisite Details

Access the Requisite Detail page (Curriculum Management > Enrollment Requirements >
Enrollment Requirement Groups > Requisite Detail).

This example illustrates the fields and controls on the Requisite Detail page. You can find definitions for
the fields and controls later on this page.

Course Requisite

Requirement Group:
Effective Date:

Group Line Type

*Group Line Type:
Report Description:

Requisite Type:
Course ID:
Term:

Associated Class:

Topic 1D:

Report Long Description:

Requisite Parameters

Requisite Detail

Fir.‘=.-ttI 10f1 n Last

View All

008047 Description: Soc 100 Pre-Reqs
01/011900 Status: Active
*Line: (0010 *[=
|Cour5e v|
|Philo 100
Requires Philo 100 with a minimum grade of C. @

| Pre-Requisite

b

001208 Q
[ la
[ &
&

PHILO 100

Introduction to Philosophy

[include Equivalent Courses
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Field or Control Description

Refresh Parentheses This button is available only when you add a new detail line.
Click this button to refresh the parentheses setting. You cannot
explicitly set parentheses to group detail rows.

If the main connector type is AND, then the system
automatically groups ORs together with parentheses. For
example, if A or B and C or D is entered, then the implied
statement is (A or B) and (C or D).

If the main connector type is OR, then the system
automatically groups ANDs together with parentheses. For
example, if A or B and C or D is entered, then the implied
statement is A or (B and C) or D.

Line The system generates the line number. The number determines
the order in which the system evaluates the detail lines. You
can change the number, but no two lines can have the same
number.
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Field or Control

Description

Group Line Type

Copyright © 1988, 2023, Oracle and/or its affiliates.

Select the requirement line type. The group line type that you
select determines the format for this line. Values for this field

are delivered with your system as translate values. Do not
modify these values in any way. Any modification to these
values requires a substantial programming effort.

The four group line types are:
*  Condition

Specifies allowable values of data elements that are
associated with a student, for example, a condition of
Academic Level. When you specify a condition that
you want to require in the Condition Code field, other
fields appear that enable you to complete the condition
statement. If you select the condition code Dynamic
Condition, select a condition specification that was
previously defined on the Define Requisite Conditions
component. If you select the condition code Test Score,
then you are presented with additional fields (Test ID,
Test Component, Condition Operator, Test Score,
Months Valid, and Test Score Method) based on the
setup on the Define Tests for Requisites page.

*  Course

Specific course a student must take to fulfill the requisite.
Specify the course ID, and if you want to allow equivalent

courses to satisfy this requisite, select the Include

Equivalent Courses check box for the system to include
in its evaluation both the course ID that you specify and

all courses that are set up as equivalent to the selected
course ID for this requirement. If you select this check
box, the following fields become unavailable: Term,

Associated Class, and Topic ID. Clear this check box
to further narrow your course parameters with the Term,

Associated Class, and Topic ID fields. For example,

you can specify not only the course ID, but also the term

in which the specific course must be taken to fulfill the
requisite.

*  Requirement

Specifies individual required elements. You are prompted
for the requirement number. You can enter an enrollment
requirement number or an academic requirement number.

Enrollment requirements are used to fulfill your more
complicated requirement rules and are created in the
Enrollment Requirement component. Specify the

enrollment requirement or academic requirement for this

line in the Requirement field.

You can view examples of how to use an academic

requirement (as opposed to an enrollment requirement).

See “Setting Up Academic Requirements” (Academic
Advisement)

. Wild Card Course
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Field or Control

Description

Specifies a range of courses based upon subject area

and catalog number, for example, wild card course of

English 1## where the range starts at any three-digit
English course beginning with 1. Specify as few or as
many criteria as you want using the Academic Group,
Subject, and Catalog Nbr fields. Blank fields return all
values.

Report Description and Report Long Description

Enter a report description and long description for the requisite
detail to be used by the enrollment requirement checking
processes. If neither of the fields is populated, the enrollment
requirement checking processes generate a default description
based on the data on the page.

This table shows the way the fields on this page change, depending on the group line type that you select:

Group Line Type Fields That Appear Fields That Are Hidden

Condition *  Condition Code
*  Condition Operator *  Course ID

*  Condition Data

*  Requisite Type

*  Include Equivalent Courses

Note: The Condition Operator and
Condition Data fields appear after you
select the condition code.

. Term

*  Associated Class

*  Topic ID

*  Requirement

*  Academic Group

*  Subject

*  Catalog Nbr

* TestID

*  Test Component

*  Condition Operator
*  Test Score

*  Months Valid

e Test Score Method

226
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Group Line Type

Fields That Appear

Fields That Are Hidden

score:
* TestID

*  Test Component

*  Condition Operator
*  Test Score

*  Months Valid

e Test Score Method

Condition If you select a condition code of *  Requisite Type
Dynamic Condition: Condition Data
*  Course ID
* Include Equivalent Courses
* Term
*  Associated Class
*  TopicID
*  Requirement
*  Academic Group
*  Subject
+  Catalog Nbr (catalog number)
*+  TestID
*  Test Component
*  Condition Operator
*  Test Score
*  Months Valid
*  Test Score Method
Condition If you select a condition code of test *  Requisite Type

*  Course ID

* Include Equivalent Courses
* Term

*  Associated Class

*  Topic ID

*  Requirement

*  Academic Group

*  Subject

*  Catalog Nbr (catalog number)
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Group Line Type

Fields That Appear

Fields That Are Hidden

Course *  Course ID *  Condition Code
* Include Equivalent Courses *  Condition Operator
* Term *  Condition Data
*  Associated Class *  Requirement
*  TopicID *  Academic Group
*  Subject
*  Catalog Nbr
*+  TestID
*  Test Component
*  Test Score
*  Months Valid
*  Test Score Method
Requirement Requirement *  Course ID

*  Include Equivalent Courses
* Term

*  Associated Class

*  TopicID

*  Condition Code

*  Condition Operator
*  Condition Data

*  Academic Group

*  Subject

*  Catalog Nbr

* TestID

*  Test Component

»  Test Score

*  Months Valid

e Test Score Method

228
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Group Line Type Fields That Appear Fields That Are Hidden
Wild Card Course *  Academic Group *  Course ID
*  Subject *  Include Equivalent Courses
*  Catalog Nbr + Term

*  Associated Class

*  TopicID

*  Condition Code

*  Condition Operator
*  Condition Data

*  Requirement

* TestID

*  Test Component

»  Test Score

*  Months Valid

e Test Score Method

Field or Control

Description

Include Equivalent Courses

Select for the system to include in its evaluation both the
course ID that you specify and all courses that are set up as
equivalent to the selected course ID for this requirement.
If you select this check box, the following fields become
unavailable: Term, Associated Class, and Topic ID.

with the Term, Associated Class, and Topic ID fields. For

term in which the specific course must be taken to fulfill the
requisite.

Clear this check box to further narrow your course parameters

example, you can specify not only the course ID, but also the

Term

Enter the term in which the student must take the course
that you specify for the course to be used in this enrollment

requirement group. Leave this field blank to return all values.
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Field or Control

Description

Associated Class

Enter the associated class number (of the course that you
specify) that the student must take for the course to be used
in this enrollment requirement group. For class associations,
indicate a term to prompt off valid values. Leave this field
blank to return all values.

Note: You cannot enter 9999, because this special associated
class number can be associated with any other associated class
number and is never an enrollment section.

See Defining Class Associations.

Topic ID

Enter the topic ID (of the course that you specify) that the
student must take for the course to be used in this enrollment
requirement group. This field prompts from the topics defined
in the course catalog. Leave this field blank to return all
values.

Requisite Type

Specify whether this requirement line is a prerequisite or

a corequisite. A prerequisite is something that a student

must complete before the start date of the desired class. If
you use an enrollment course list (as part of an enrollment
requirement), you can allow in-progress coursework to

fulfill prerequisites. A corequisite is something that a student
can complete prior to, or at the same time as, the desired
class. Conditions are always set up as prerequisites in the
background. Students either meet the condition at the time of
enrollment (which means that they currently have the required
condition), or they do not.

Defining Requisite Detail Level Parameters

230

Access the Requisite Detail Parameters page ((Curriculum Management > Enrollment
Requirements > Enrollment Requirement Groups > Requisite Detail Parameters).
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This example illustrates the fields and controls on the Requisite Detail Parameters page. You can find
definitions for the fields and controls later on this page.

Detail Parameters

Requirement Group: 008047 Description:

Effective Date: 01/01/1900 Status:

Course Validation Parameters

Course Information: Introduction to Philosophy

3.00
1.00

Minimum Units:

Minimum Courses:

Requisite Detail Parameters

Soc 100 Pre-Reqs

Active

Min Units/Course:
Min Grade Points/Unit:

Transfer Level Allowed: | Always Allow 8 |

Requirement Designation: Q
Bl
5

Valid Begin:

Valid End:

[] course must be GPA material
Test Credit is Allowed

Other Credit is Allowed

[] Exclude In-Progress Credit

First [ 4] 1 of 1 n Last

First Bl 4 o2 O L aat

[+[=]

3.00

2.00

Note: This page is necessary only if you have a line type of course or wild card course on the Requisite

Detail page.

Field or Control

Description

Minimum Units

Enter the minimum units that are required for the course or the
wildcard course for this requisite detail line.

Min Units/Course (minimum units per course)

Enter the minimum units per course value to indicate the
minimum number of units that a single course must be worth
to be evaluated. For example, if you set this to 3, the system
picks up only courses that are worth three units or greater. If
the system finds a course on the student's record that matches
the course on the Requisite Detail page, but it is only two
units, the course is not used to meet the requisite.

Minimum Courses

Enter the minimum number of courses that are required of
the course or wild card course that you specify. For example,
if you set this to 2, the system looks for at least two courses
of the course or wild card course that you specify. When the
system finds at least two courses that match your requisite

detail line, the requisite is satisfied.

Min Grade Points/Unit (minimum grade points per unit)

Enter the minimum grade points per unit that each course must
have to be used to satisfy the course requisite. For example, if
you set this to 7, then each course must be a grade C or greater
to be evaluated (.7 x 3 units = 2.1, or a grade of C).
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Field or Control

Description

Transfer Level Allowed

Enter a transfer-level-allowed value that indicates what type of
transfer credit (if any) is acceptable. Values are:

Always Allow: All applicable transfer credit can be used to
satisfy the requisite.

Never Allow: Transfer credit can never satisfy the requisite.

Two Year Institution Only: Only transfer credit from two-year
institutions can be used to satisfy the requirement.

On the School Data page, an institution can be identified as a
two- or four-year institution.

See Defining External Organizations.

Requirement Designation

Select the requirement designation that each course for this
requisite detail line must possess to be evaluated. For example,
if you specify a wild card course list of ARCH 4## on the
Requisite Detail page, then specify a requirement designation
of DSGN on the Requisite Detail Parameters page. Only
ARCH 400 - level courses that have a designation of DSGN
(with a grade of Satisfied) meet this requisite.

Requirement designation values are defined on the
Requirement Designation Table page.

See Understanding Requirement Designations.

Valid Begin and Valid End

Enter valid begin and valid end dates to specify the date

range when the courses must be taken to satisfy the requisite.
Leaving these fields blank means that it does not matter when
the courses are taken. When the system compares the date
range, it uses the start and end dates of the term in which the
course was taken. For transfer courses, the system uses the
start date and end date of the articulation term.

Course must be GPA Material

Select this check box to require that courses evaluated for this
requisite must be applied toward the student's career GPA
calculation. For instance, any courses that a student took for a
pass/no pass grade basis would not be evaluated, as typically
this grade basis does not have the Include in GPA check box
selected on the Grading Scheme Table page.

Test Credit is Allowed

Select this check box to allow test credit courses to be
evaluated.

Other Credit is Allowed

Select this check box to allow other credit courses to be
evaluated.
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Field or Control

Description

Exclude In-Progress Credit

If the course that the student takes to satisfy this requisite must
be fully graded for the system to consider it valid, select this
check box. If this check box is cleared, the system will include
in analysis, and pass all parameters any nongraded courses,

as well as any graded courses that have the In-Progress flag
enabled (such as incomplete courses), and that match the
course ID or wild card course on the Requisite Detail page.
Leaving this check box cleared is the least restrictive, and
allows for maximum user/student flexibility.

Examples of Enrolilment Requirement Groups

The enrollment requirement group feature is robust. While reviewing the Academic Advisement
documentation will significantly enhance your knowledge of enrollment requirement groups, we review
some examples in this section of how to set up the Requisite Detail page.

You can create course requirements many ways, and usually more than one way exists to create any
particular course requirement. Some of the complex examples use the enrollment requirement and course

list features, documented later in this section.
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Course or Condition Requisite

At PSUNYV, Psychology 288, Neuropsychology, requires that students have either passed Psychology
124 or declared a primary academic plan of psychology. In this example, Psychology 124 is a course
prerequisite, and the primary academic plan of psychology is a condition prerequisite. Notice that for
the condition, the Requisite Type field becomes unavailable for entry. This is because the system is
populating the field to prerequisite in the background.

The Requisite Detail page has two requisite lines, joined together with an "or" statement:

Reguisite Requisite Parameters Requisite Detail Requisite Detail Parameters
First E 1 of 1 E Last

Requirement Group: anoooa Description: FPsych 288

Effective Date: 01011900 Status: Artive
Group Line Type

Refresh Parertheses | “Ling: NEW HE

*Group Line Type: | Course j

Course ID: ’MO\ Physiological Psycholody PEYCH 124

¥ Include Equivalent Courses

Requisite Type: | Pre-Requisite i
+
Refresh Parertheses | [or = Ling: NEW ==
*Group Line Type: | Condition j
Academic Institution: PeopleSoft Liniversity
Condition Code: Primary Academic Flan j
Condition Operator: Equal =]
Condition Data: FEYCH Q Psychalagy
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Wild-Card Course Requisite

At PSUNYV, Education 338, Development of Reading Skills, requires a prerequisite of any Education 200-
level course, andPsychology 240. In this example, the Education 200 level course is specified as a Wild
Card Course prerequisite, and Psychology 240 is a regular Course prerequisite.

The Requisite Detail page would have two requisite lines, joined together with an "and" statement:

Course Requisite | Requisite Parameters | Requisite Detail | Requisite Detail Parameters

Find | “iewe 21 First E 1 of 1 |I| Last

Requirement Group: 0ooooo Description: Ed 338
Effective Date: 01./01/1900 Status: Active
(Group Line Type Fined | Wiew 1
+
Refresh Parentheses | *Ljne: (0010 [+=]
*Group Line Type: |Wi|d Card Course j
Academic Institution: PeopleSaft University
Academic Group: LBART C College of Liberal Arts
Subject: EDUC Q Education
Catalog Nbr: 2 Q
Requisite Type: | Pre-Reguisite j
Refresh Parentheses | [anD =] “Line: 0020 FE
*Group Line Type: | Course j
Course ID: 003018 QU | aarm Bk PSYCH 240

¥ Include Equivalent Courses

Requisite Type: |Pre—RequiSite j

Requirement, Course, and Course List Requisite

At PSUNYV, Biology 231, Neurobiology, requires Biology 1 and 2 (as almost all biology courses require),
as well as Chemistry 101 and 102. Because the requisite of Biology 1 and 2 will be used repeatedly for
virtually every biology course, we developed an enrollment requirement called Biology 1 and 2. Within
that enrollment requirement is a course list of Biology 100 and 101. In our Biology 231 enrollment
requisite group we define a group line type of Requirement that points to the Biology 1 and 2 requirement,
as well two group line types of Course for Chemistry 101 and Chemistry 102.

Note: Alternative ways are available of defining such a requisite scenario without using course lists, but
this is one way that you can define these requisites.
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After we defined a Biology 1 and 2 course list and an enrollment requirement, we created the enrollment
requirement group, entering the following detail lines on the Requisite Detail page. The page has three
detail lines: one for the enrollment requirement of Biology 1 and 2, one for the course requirement of
Chemistry 101, and the last for the course requirement of Chemistry 102:

equisite 2B Requisite Detail Requisite Detail Parameters

Requirement Group: oooooo Description: MeuroBiology 231

Effective Date: 010171800 Status: Active

Group Line Type

=
*Ling: [MEVY

*Group Line Type: | Reguirement j
Requirement: 000001168 | Biology 1 and 2 Courses
Requirement Usage: Reguisite/Restriction
Requisite Type: | Pre-Reguisite j

On the preceding page:

» This requisite is considered first by the system because the line number is 0070, the lowest number in
our detail lines.

* The group line type is Requirement.
* The requirement is Biology 1 and 2 (Biology 1 and Biology 2).

These are in a course list because they are used repeatedly together as a prerequisite requirement in a
large number of courses.

*  The requisite type is Pre-Requisite.

The second and third detail lines appear like this:

Requisite Parameters Requisite Detail Requisite Detail Paramete

Requirement Group: noooao Description: MeuraBiology 231

Effective Date: 010151900 Status: Active

Group Line Type

+
Refresh Parentheses | IAND 'I #L jpe: |MEW [#=

*Group Line Type: Course j
Course ID:; 001163 & Elementary Chemistry |

¥ Include Equivalent Courses

Requisite Type: | Pre-Requisite =l

On the preceding page:

* The connector type is AND because this rule must be fulfilled along with the Biology 1 and 2
requirement.
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*  The line number is 0020. The system evaluates this rule second, because one rule line is preceding it.
* The group line type is Course.
*  The course ID represents Chemistry 101.

The third detail line for Chemistry 102 is exactly like the preceding sample page.

Condition and Wild-Card Course Requisite, Exclude In-Progress Credit

At PSUNY, for a student to enroll in HONORS 499, he or she must have a verifiable cumulative GPA of
greater than or equal to 3.0.

To create an enrollment requirement group for this course prerequisite:

1. On the Course Requisite page, enter the necessary data.

2. On the Requisite Parameters page, enter / in the Minimum Course field.

3. On the Requisite Detail page, create two detail lines and attach as a requisite to HONORS 499.
4. For the first detail line, create a condition of cumulative GPA greater than or equal to 3.0.

Example of the Requisite Detail page as discussed above:

Course Reguisite ERequisite Parameters Requisite Detail Reguisite Detail Parameters

Find | Wigwe &l First E 1 of 1 |I| Last

Reguirement Group: aooooo Description: Honars 499
Effective Date: 09/01M 300 Status: Active
Group Line Type Find | e Al 1 of 1
+
Refresh Parentheses | ‘Line: [NEW =l
*Group Line Type: | Condition j
Academic Institution: FeopleSoft University
Condition Code: Cumulative Grade Point Avg. j
Condition Operator: = ar= [~
Condition Data: 3.0 Q 3.0

For the second detail line, set the connector type to And, then select a group line type of Wild Card
Course.
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Example of the Requisite Detail page as discussed above:

[ Y Y Requisie Detai ¥ |
Find | View & First 0 1.0t 1 (] Last
Requirement Group: aooooon Description: Honars 498
Effective Date: 014011900 Status: Active

Group Line Type

+
RefreshParenthesesl IAND 'I *Ljme: |MEW FHE

*Group Line Type: |Wi|d Card Course j
Academic Institution: PeopleSoft University

Academic Group: Q

Subject: Q

Catalog Nbr: Q

Requisite Type: | Pre-Requisite j

On the Wild Card Course Detail Requisite Detail page, select the Exclude In-Progress Credit box.

This requisite verifies that not only does the student have a cumulative GPA of greater than or equal to
3.0, but that the student is not a first semester student with no courses completed at all.

If you decide to include in-progress credit, then even those students who have no coursework completed,
but at least one course in progress, will meet this requisite. This assumes that the student will not only
complete his or her in-progress credit, but will also complete the in-progress credit with the required GPA.

If you want to be more conservative with this requisite and really ensure that the student has a proven
track record, be sure to select the Exclude In-Progress check box on the Requisite Detail Parameters

page.

Condition and Course Requisite, Exclude In-Progress Credit

At PSUNYV, a total of five seats are reserved in Advanced Fiction Writing 2 for students who have a
verifiable GPA of greater than or equal to 3.0 and have passed Advanced Fiction Writing 1 with a grade of
A.

To create an enrollment requirement group for this reserve capacity check:
1. On the Course Requisite page, enter the necessary data.
2. On the Requisite Parameters page, enter / in the Minimum Course field.

3. On the Requisite Detail page, create two detail lines and attach as a reserve capacity to Advanced
Fiction Writing 2 on the Schedule of Classes - Reserve Cap page.

4. For the first detail line, create a condition of cumulative GPA greater than or equal to 3.0.

5. For the second detail line, set the connector type to And, select a group line type of Course, select the
course ID for Advanced Fiction Writing 1, and select a requisite type of Pre-Requisite.
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[ I

Y Recisto Deai 1

First E 1 of 1 |I| Last

Course ID:

Requisite Type:

003334 QU ady Fictwrit|

| Pre-Requisite |

Requirement Group: Qoonoo Description: Advanced Fiction Writing 2
Effective Date: 01/01M900 Status: Active
Group Line Type Find | Wieww 1
+
Refresh Parentheses | # jne: [MEW [#=
*Group Line Type: | Candition |
Academic Institution: PeopleSoft University
Condition Code: Cumulative Grade Point Avg. j
Condition Operator: - ar= [
Condition Data: 3.0 Q3
+
Refresh Parentheses | IAND 'I L ing: [NEW [#=
*Group Line Type: | Course j

ENGLCOMP 555

¥ Include Equivalent Courses

On the Detail Parameters page, select the Exclude In-Progress Credit box, and enter a minimum
grade point per unit of 4.0.

This requisite line ensures that, if the system finds Advanced Fiction Writing 1 on the student's record,
the student has completed the course and earned a grade of A.

If you decide to include in-progress credit, then a student with Advanced Fiction Writing 1 in-progress
(but not yet completed or graded) will meet the reserve capacity, and the system will allow this student to
enroll. Sometimes you may want to be this liberal, but in the instance here, we require that the course be
verifiably an A grade.

Course Requisite, Include In-Progress Credit

At PSUNYV, for a student to register for ECON 205, the student must either currently be enrolled in ECON
115, or have completed ECON 115 with a C grade or better.

To create an enrollment requirement group for this requisite:

1.
2.

On the Course Requisite page, enter the necessary data.

On the Requisite Parameters page, enter / in the Minimum Course field.

On the Requisite Detail page, create one detail line and attach as a requisite to ECON 205.

For this detail line, select a group line type of Course, select the course ID for ECON 115, and select a
requisite type of Pre-Requisite.

On the Requisite Detail Parameters page, enter a minimum grade point per unit of 2.00 and leave
cleared the Exclude In-Progress Credit box.
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Example of the Requisite Detail page as discussed above:

Chapter 6

Course Reguisite Reguisite Parameters Requisite Detail Reguisite Detail Parameters
Fing | “iewe Al First E 1 of 1 E Last

Requirement Group: oooooo Description: Econ 205

Effective Date: 01/01/1300 Status: Artive
Group Line Type

Refresh Pareniheses *Line: |[NEW FHE]

*Group Line Type: Course j

Course ID: 001012 geqnomic Statistics

¥ Include Equivalent Courses
Requisite Type: | Pre-Requisite =l

This requisite enables both students with ECON 115 in-progress and students with ECON 115 completed

with a C grade or higher to fulfill the requisite.

Condition Requisite, Include In-Progress Coursework

At PSUNYV, all students with a cumulative GPA of 3.5 and higher may register for EDUC 100 (first

semester freshmen with no verifiable GPA at all are also eligible).

To create an enrollment requirement group for this requisite:

1. On the Course Requisite page, enter the necessary data.

2. On the Requisite Parameters page, enter any necessary data.

3. On the Requisite Detail page, create one detail line and attach as a requisite to EDUC 100.
For this detail line, create a condition of cumulative GPA greater than or equal to 3.5.

Example of the Requisite Detail page as discussed above:

Requisite Parameters

Requisite Detail Fequisite Detail Parameters

Requirement Group: aooooo Description: ECUC 100
Effective Date: 015011800 Status: Active
Group Line Type
NEW [=]
*Ling: |MEVY
*Group Line Type: Condition j
Academic Institution: PeopleSoft University
Condition Code: Cumulative Grade Paint Avg. j
Condition Operator: Far= [~
Condition Data: 35 QA oas

This requisite is satisfied by students with some graded coursework (all of which averages greater than
3.5 GPA), as well as by first semester freshmen with no coursework completed at all. This is because a
null value passes all parameters.
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Example of Maximum Unit Limit for Enroliment

At PSUNYV, students can take no more than 12 units of physical education courses. If students attempt to
enroll in a physical education course that takes them over the 12-unit limit, their enrollment is blocked by
a prerequisite requirement.

To create this maximum unit enrollment requisite:

L.

Create an enrollment course list that references all physical education courses (wild card or course by
course).

Set up any course parameters. Enter minimum grade point per unit values for each course if you want
to count only physical education courses that were successfully completed. If you also want to limit F
graded courses, you can leave this field clear.

Create an academic requirement that has a line item page line type of Course Requirement.
Set the Credit Include Mode field to Verify, and the Maximum Units Allowed field to /2.00.

Be sure this is set to Verify. This is the power that regular ENR usage enrollment requirements do not
have.

Point to your enrollment course list on the Line Item Detail page.
Create an enrollment requirement group that points to the academic requirement.

Attach this requirement as a corequisite.

Example of the Requisite Detail page as discussed above:

Y Y Requistto Detail 1 1
Find | *iews 211 First [4] 1of 1 [¥] Last
Requirement Group: 0o00oo Description: Phys Ed Limnit
Effective Date: 07i28r2004 Status: Active
*Line; (MEWY =
*Group Line Type: Reguirement j
Requirement; 000001168 | Q Phys Ed Limit
Requirement Usage: Requisite/Restriction
Redquisite Type: |Co-Requisite j

Attach this enrollment requisite to all physical education courses.

Defining Enroliment Requirements

This section provides an overview of enrollment requirements and discusses how to:

Define enrollment requirements.

Define overall enrollment requirement parameters.
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* Define enrollment requirement line types.
* Define line item parameters.

¢ Define line item course detail.

Understanding Enroliment Requirements

Enrollment requirements are for more complicated requisite needs, and are also great tools for reusability.
Create enrollment requirements only if you are using the Requirement group line type in an enrollment
requirement group. You can use enrollment requirements in conjunction with other enrollment-
requirement group line types.

To fully understand enrollment requirements, see “Setting Up Academic Requirements” (Academic
Advisement). The pages in PeopleSoft Academic Advisement mirror those in Student Records but

with additional functionality. You can set up enrollment requirement groups that reference academic
requirements (in the event that you need to take advantage of their complex functionality), so we suggest
that you learn as much about them as possible.

Here is a high-level overview of how to define an enrollment requirement:

1. Evaluate your need to use the group line type of Requirement on the Requisite Detail page.

2. Enter a description of the enrollment requirement on the Enrollment Requirement page.

3. Determine whether GPA, units, or courses are part of the requirement on the Parameters page.
4. Select a requirement line type and enter a description on the Line Item page.

5. Enter course credit parameters on the Line Item Parameters page.

6. If you're using a course list, create it in the course list component, and add the course list number on
the Line Item Detail page.

Note: If you are going to select the line type of condition and specify a dynamic condition or test score,
then you must first have set up dynamic conditions and valid test IDs on the Define Requisite Conditions
component and Define Tests for Requisites component, respectively.

Pages Used to Define Enrolilment Requirements

Page Name Definition Name Navigation Usage

Enrollment Requirement CRSE REQUIREMENT Curriculum Describe the enrollment
Management > requirement.
Enrollment
Requirements >
Enrollment
Requirements >
Enrollment Requirement
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Page Name Definition Name Navigation Usage

Parameters CRSE RQRMNT PARM Curriculum Enter overall GPA and
Management > unit requirements for the
Enrollment requirement.
Requirements >
Parameters

Line Item CRSE RQRMNT LINE Curriculum Define the requirement line
Management > type.
Enrollment
Requirements >
Enrollment

Requirements > Line Item

Line Item Parm (line item
parameters)

CRSE RQ LINE PARM

Curriculum

Management >
Enrollment

Requirements >
Enrollment

Requirements > Line Item
Parm

Specify the unit and GPA
requirements for the line type.
The fields that appear on the
page depend on the line type

that you select on the Line
Item page.

Line Item Detail

CRSE_RQ LN DETAIL

Curriculum

Management >
Enrollment

Requirements >
Enrollment

Requirements > Line Item
Detail

Link course lists, derived
course lists, and conditions
to your line items. The page
controls that appear on the
page depend on the line type
that you select on the Line
Item page.

Defining Enroliment Requirements

Access the Enrollment Requirement page (Curriculum Management > Enrollment Requirements >
Enrollment Requirements > Enrollment Requirement).
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This example illustrates the fields and controls on the Enrollment Requirement page. You can find
definitions for the fields and controls later on this page.

Academic Requirement:
*Effective Date:
Requirement Name:

Description:

*Report Description:

*Academic Institution:
Academic Group:
Subject Area:

Catalog Nbr:

*Report Long Description:

Enrollment Requirement Parameters Line Jtem Line ltem Parm Line ltem Detail

000001220

01011900 3

|Econ 100 Level Courses

w Al First [ 4] 1 of 1 n Last

[+[=]

*Short Description: Econ 1008

ER -D Econ 100 Level Courses

|ER— RD Econ 100 Level Courses

ER - RLD Take ECOM 100 Level Courses

Psunv Q
LBART  Q
ECoN @
[ &

PeopleSoft University

College of Liberal Arts

Field or Control

Description

Effective Date

Enter an effective date for this enrollment requirement. The
effective date must be equal to or less than the effective date
of the enrollment requirement group to which this course
requisite is attached.

Note: The system accesses the enrollment requirement rules
based on the start date of the term for which the requisite and
restriction checking occurs. As long as your effective date is
less than or equal to the term start date, and the status of the
enrollment requirement is Active, the system checks the rule in
the enrollment process.

Status

Select a status for this requirement. Select Active when you
add a new requirement. Select /nactive only if your institution
no longer uses this requirement.

Note: If you want to inactivate a requirement you also need
to remove any reference to the requirement number on the
Requisite Detail page.

To determine which enrollment requirement groups reference a
particular requirement, run the reverse engineering report.

See Generating a Reverse Engineering Report.
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Field or Control

Description

Report Description and Report Long Description

Enter a report description and long description for the
enrollment requirement to be used by the enrollment
requirement checking processes.

The report fields are hidden when the group line type is set to
Requirement. In this case, the report descriptions are defined
within the Enrollment Requirements component.

Academic Institution

The system populates this field by default when you access the
page. You can change this value. The institution determines
the enrollment requirement groups that can reference this
requirement.

Academic Group, Subject Area, and Catalog Nbr
(catalog number)

Academic group, subject, and catalog number are not used

by the system in the analysis of the requirement, but are
helpful tools for when you are searching the database for the
appropriate requirement to attach to an enrollment requirement
group. You may want to use these fields to signify the

course to which the requisite will be attached, or to specify
department "ownership" of the requisite. These values are
optional.

Defining Overall Enroliment Requirement Parameters

Access the Parameters page (Curriculum Management > Enrollment Requirements > Enrollment

Requirements > Parameters).

This example illustrates the fields and controls on the Parameters page. You can find definitions for the

fields and controls later on this page.

Effective Date: 01/01/1900 Status:

Course Credit Parameters

Minimum GPA:

Minimum Units:

Parameters Line ltem Line Item Parm Line Item Detail

Academic Requirement: 000001220 Description:  Econ 100 Level Courses

Default for Detail Level

Min Grade Points/Unit:

Find | iew All First n 10of1 u Last

=]

Minimum Courses:

Detail Selection Parameters

@anp  OOR
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Course Credit Parameters

Course credit parameters are overall requirements for all line items. These fields are optional.

Field or Control Description

Minimum GPA (minimum grade point average) Enter the overall minimum GPA that all classes that are
selected to meet this requirement must satisfy.

Minimum Units Enter the total minimum units that all classes that are selected

to meet this requirement must satisfy.

Minimum Courses Enter the total minimum courses that all classes that are
selected to meet this requirement must satisfy.

Default for Detail Level

Field or Control Description

Min Grade Points/Unit (minimum grade points per unit) The system uses the value that you enter as a filter in the
evaluation process. This technique is used to simplify and
generalize the comparison logic. The minimum grade points
per unit are the minimum grade points that are allowed for
any individual class enrollment that is selected to meet the

requirement.
Detail Selection Parameters
Field or Control Description
Connector Type Select the appropriate connector type. The connector

type indicates whether the student must meet ALL of the

requirement detail conditions (AND) or whether the student
needs to meet only one condition (OR). This page control is
used as the connector default on the Requirement Line Item

page when you insert rows.

Defining Enroliment Requirement Line Types

Access the Line Item page (Curriculum Management > Enrollment Requirements > Enrollment
Requirements > Line Item).
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This example illustrates the fields and controls on the Line Item page. You can find definitions for the

fields and controls later on this page.

Enrollment Requirement Parameters Line Item

Line Item Parm Line ltem Detail

First B 1 or 1 B Last

Find | Vi

iew Al

Academic Requirement: 000001220 Description:  Econ 100 Level Courses
Effective Date: 01/01/1900 Status: Active
Line Item Find | View Al First K 4 o1 Il Last
Refresh Parentheses | Line: (0010 [=]
*Line Type: | Course Requirement w |
Line Name: |LI—LN Econ 100 Level Courses *Short Description: ,W
Description: LI-D Complete two of the following courses (minimum grade of B in each): @
ECOMN 120, ECON 140, ECON 142, ECON 150
*Report Description: |LI-RD Econ 100 Level Courses
*Report Long Description: |L!-RLD Complete two of the following courses (minimurmn grade of B in each): @
ECOM 120, ECON 140, ECON 142, ECON 150

Field or Control

Description

Line The number determines the order in which the system
evaluates the detail lines. The system generates a sequential
line number. You can override the number, but it is best to
insert the rows in the correct order.

Line Type The line type that you select determines the format for this

line, and it also determines the fields that become available
for entry on the Line Item Detail page and Line Item Parm
page. Values for this field are delivered with your system
as translate values. Do not modify these values in any way.
Any modification to these values requires a substantial
programming effort.

Each line type value is defined in the PeopleSoft Academic
Advisement documentation.

See “Creating a Requirement Line Item” (Academic
Advisement).

Report Description and Report Long Description

Enter a report description and long description for the line item
to be used by the enrollment requirement checking processes.

Defining Line Item Parameters

Access the Line Item Parm page (Curriculum Management > Enrollment Requirements >

Enrollment Requirements > Line Item Parm).
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This example illustrates the fields and controls on the Line Item Parm page (when the line type is Course
Requirement). You can find definitions for the fields and controls later on this page.

Academic Requirement:
Effective Date:

Line Item Parameters

Line Nbr:

Course Credit Parameters

Minimum GPA:

Minimum Units:

Minimum Courses:

000001220
01/01/1900

0010

3.000
6.00
2.00

Line ltem Line Item Parm

Description:  Econ 100 Level Courses

Status: Active

Description: LI-LKW Econ 100 Level Courses

Maximum Units Allowed:
Maximum Courses Allowed:

Min Grade Points/Unit:

Firatll 1 of 1 n Last

Firat!I 1 of 1 n Last
=]

If the line type is Condition, no fields appear on the Line Item Parm page.

Field or Control

Description

Minimum GPA (minimum grade point average)

Enter the minimum GPA that is the minimum overall GPA
requirement for classes that are selected to satisfy this
requirement. (For example, if a requisite states that the student
needs to take four Math 100-level classes with an overall

GPA of 3.00 for a total of 12 units, then enter 3.00 in this
field.) Any existing value in the Minimum GPA field on the
Parameters page is supplied by default to the Line Item Parm
page when you add a requirement line.

Minimum Units

Enter a value that represents the minimum total units for the
courses that are selected to satisfy this requirement. If this
line item references a course list, then the number of units
represents the total number of units that all courses found on
the student's record (that match the course list) must be worth.

Minimum Courses

Enter value that represents the minimum number of courses
that are required for this requirement. If this line item
references a course list, then the number of courses represents
the total number of courses that all courses found on the
student's record (that match the course list) must be worth.

Maximum Units Allowed

Enter a value that represents the maximum number of units
that can be evaluated for this requirement. This is not a way
to verify whether a student has exceeded a unit limit. This is a
way to limit what is evaluated.
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Field or Control

Description

Maximum Courses Allowed

Enter a value that represents the maximum number of units
that can be evaluated for this requirement. This is not a way
to verify whether a student has exceeded a course count limit.
This is a way to limit what is evaluated.

Min Grade Points/Unit (minimum grade points per unit)

Enter the minimum grade points per unit that each course must
have to satisfy the enrollment requirement. For example, if
you set this to 2.0, then each course that is evaluated must be a
grade C or greater. If a course is evaluated that does not meet
this minimum, the requisite is not satisfied.

Related Links

“Specifying Requirement Line [tem Parameters” (Academic Advisement)

Defining Line Item Course Detail

Access the Line Item Detail page (Curriculum Management > Enrollment Requirements >

Enrollment Requirements > Line Item Detail).

This example illustrates the fields and controls on the Line Item Detail page (when the line type is Course

Requirement). You can find definitions for the fields and controls later on this page.

Parameters Line ltem Line ltem Parm

Line ltem Detail

Academic Requirement: 000001220 Description:
Effective Date:

Line ltem

01/011900 Status:

Line Nbr: 0010 Description:

Line Item Detail
*Line Detail Sequence:

I
000000244

Course List:

*Line Detail Type: |[CLST O,

Econ 100 level courses

First n 1of 1 u Last

Econ 100 Level Courses
Active
Firstn 10f1 u Last

Find | Wiew Al

LI-LMW Econ 100 Level Courses

First n 10f1 u Last
#[=]

Find | View Al

Course List

View

Field or Control

Description

Line Detail Sequence

The system assigns a sequential number to a specific line
detail. You can have multiple detail line sequences under a
single line number. The line detail sequence affects the order
in which the system evaluates each line item detail. Those with
the lowest number are evaluated first.
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Field or Control Description

Line Detail Type Select the line detail type value that indicates the type of line
detail. Values are:

CLST: Indicates a static course list that can be used to satisfy
the requirement.

DLST: Indicates a dynamic, user-defined course list that
the system draws from a subset of a student's transcript or
academic record.

Course List Appears with a line detail type of CLST. Enter the course list
number that indicates a grouping of classes that the system can
evaluate.

Derived Course List Appears with a line detail type of DLST. Enter the derived

course list that indicates a type of class that the system can
draw from a subset of the student's transcript or academic
record.

List Include Mode Appears if you have multiple line item detail rows. Indicates
how a previous line detail sequence interacts with a new
line detail sequence. (This field is available for every line
except the first one.) Choices include: ¥, indicating union; /,
indicating intersection; and N, indicating subtraction.

List Recall Mode Appears with a line detail type of DLST. Indicates the
conditions that the system uses to select courses from the
student's transcript.

View Appears with a line detail type of CLST. Click the View button
to access the course list summary where you can review the
course list details.

Related Links

“Setting Up Requirement Line Item Detail” (Academic Advisement)

Defining Enrollment Course Lists

This section provides an overview of enrollment course lists and discusses how to:
e Create course list descriptions.
* Link courses to the course list.

¢ Define details of courses in the course list.
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Create enrollment course lists only when you are creating enrollment requirements that have a course list
requirement. Enrollment course lists should be set up before enrollment requirements are established.

Enrollment course lists and enrollment derived course lists are available. Enrollment course lists are
static predefined lists of courses. Enrollment derived course lists are dynamically generated course lists
as identified in a particular student's transcript. You can attach both types of course lists to enrollment
requirements and can specify how many courses from the list (static or dynamic) are needed to satisfy
specific enrollment requirements. Course lists and derived course lists are also used in the Academic
Advisement application as a precursor for academic requirements.

Here is a high-level overview of how to define an enrollment course list:

1. Create the enrollment course list description on the Course List Description page.

2. Specity courses for the enrollment course list on the Course List Detail page, including a range of

wild card courses.

3. Enter the parameters of each course list on the Course List Parameters page.

Related Links

“Setting Up Academic Course Lists” (Academic Advisement)

Pages Used to Create Enroliment Course Lists

Requirements >
Enrollment Course Lists >
Course List Description

Page Name Definition Name Navigation Usage

Course List Description RQ_COURSE_LIST ENR Curriculum Describe the course list.
Management >
Enrollment

Course List Detail

RQ _CRSE LIST DET

Curriculum

Management >
Enrollment

Requirements >
Enrollment Course Lists >

Link the actual courses to

the course list. A course is
specified either by a unique
course ID or by using the wild
card indicator.

Requirements >
Enrollment Course Lists >
Course List Parameters

Course List Detail

Course List Parameters RQ_CRSE LST DPR2 Curriculum Define the details of units,
Management > GPA, and other information
Enrollment for each course in the course

list.
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Creating Course List Descriptions
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Access the Course List Description page (Curriculum Management > Enrollment Requirements >
Enrollment Course Lists > Course List Description).

This example illustrates the fields and controls on the Course List Description page. You can find
definitions for the fields and controls later on this page.

Course List Description || 1 |
+
Course List: oooooat1 2y ]
*Effective Date: (IR RIENRRETu]N] Eﬂ *Status: I."-'\Cﬁ\."E vl
*Description: ART 140 and 142
*Short Description: ART Test
Long Description: Art140 and 142 ﬂ
*Academic Institution: LMY FeopleSoft University
Academic Career: UGRDC, Undergraduate
Academic Group: LBART O College of Liberal Arts
Subject Area: &
Catalog Nbr: Q
Field or Control Description

Course List

The system generates a unique course list number each time
that you add a new course list. You should use the system-
generated course list number rather than entering your own
course list number.

Effective Date Enter an effective date for this course list. The effective
date must be equal to or less than the effective date of the
enrollment requirement to which this course list is attached.
Status Select a status for this course list. Select Active when adding

a new course list. Select /nactive only if your institution no
longer uses this course list. If you want to inactivate a course
list, you also need to remove all references to the course list on
active Requirement Line Item Detail pages.

To identify which Requirement Line Item Detail pages
reference a particular course list, run the Reverse Engineering
report.

Academic Institution

The system supplies the academic institution by default. In
Add mode, you can change this value.
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Field or Control

Description

Academic Career, Academic Group, Subject Area, and
Catalog Nbr (catalog number)

Academic career, academic group, subject, and catalog number
are not used by the system in the analysis of the course list,

but are helpful tools for when you are searching the database
for the appropriate course list to attach to an enrollment
requirement. You may want to use these fields to signify the
course to which the course list will be attached, or to specify
department "ownership" of the course list.

Linking Courses to the Course List

Access the Course List Detail page (Curriculum Management > Enrollment Requirements >

Enrollment Course Lists > Course List Detail).

This example illustrates the fields and controls on the Course List Detail page. You can find definitions

for the fields and controls later on this page.

Course List Description Course List Detail Course List Parameters

Course List: 000000246 Description: Math requisite
Effective Date: 01/01/19280 Status: Active
Course List Details First K 1of1 )| Last
*Course Sequence: ’71 [¥| wildCard Indicator Display Wildcard Courses El
Academic Institution: PSUNV PeopleSoft University
Academic Group: l— Q
Subject: MATH @ Mathematics
Catalog Nbr: # O Report Description: Math ##
[“] Include Cross-Listed Courses
Field or Control Description

Fetch

When you access this component, the system loads only
effective-dated rows, without any detail. This is to enhance
performance for those course lists that have hundreds of
course sequence rows. Click the Fetch button to retrieve and
display the course sequence data, including the related detail
parameters for the effective-dated row.
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Field or Control

Description

Course Sequence

This number acts as a course specification, indicating either

a specific course ID or a group of equivalent courses. Each
course sequence number indicates a unique component of the
course list and can be arbitrarily assigned except when you are
using a line type of sequential restriction on the Requirement
Line Item page. If the sequence is important, enter the correct
course order here so that the student must take the courses in
the specified order.

WildCard Indicator

Select this check box to indicate a wild card course, rather than
a specific course ID.

Academic Group

Appears if you select the WildCard Indicator check box.
Specify an academic group for the course offering. All courses
with this academic group may be considered.

Subject

Appears if you select the WildCard Indicator check box.
Specity an academic subject for the course offering. All
courses with this subject may be considered.

Catalog Nbr (catalog number)

Appears if you select the WildCard Indicator check box.
Enter the required portion of the catalog number that is up
to ten characters (NNNNAAAAAA), where the first four
characters are numeric (leading zeroes are blank padded) and
the last six characters a an alphanumeric suffix. For example,
a catalog number of 3## indicates that any 300-level course
is acceptable, including 301A, because suffixes are ignored
when a number wild card is specified unless a suffix value is
exclusively indicated.

Course ID

If the WildCard Indicator check box is cleared, use this field
to specify the exact course ID.

Include Equivalent Courses

Select for the system to include in its evaluation both the
course ID that you specify and all courses that are set up as
equivalent to the selected course ID for this requisite. If you
select this check box, the following fields become unavailable:
Term, Associated Class, and Topic ID.

Clear this check box to further narrow your course parameters
with the Term, Associated Class, and Topic ID fields. For
example, you can specify not only the course ID, but also the
term in which the specific course must be taken.

Term

Enter the term in which the student must take the course that
you specify for the course to be used in this enrollment course
list. Leave this field blank to return all values.

254
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Field or Control

Description

Associated Class

Enter the associated class number (of the course that you
specify) that the student must take for the course to be used
in this enrollment course list. For class associations, indicate
a term to prompt off valid values. Leave this field blank to
return all values.

Note: You cannot enter 9999, because this special associated
class number can be associated with any other associated class
number and is never an enrollment section.

See Defining Class Associations.

Topic ID

Enter the topic ID (of the course that you specify) that the
student must take in order for the course to be used in this
enrollment course list. This field prompts from the topics that
are defined in the course catalog. Leave this field blank to
return all values.

Include Cross-Listed Courses

This check box is available when the WildCard Indicator
check box is selected. Select the Include Cross-Listed
Courses check box to have cross-listed courses evaluated for
purposes of satisfying a requisite. By default, the check box
is cleared and cross-listed courses are not evaluated or used to
satisfy the requisite.

Defining Details of Courses in the Course List

Access the Course List Parameters page (Curriculum Management > Enrollment Requirements >
Enrollment Course Lists > Course List Parameters).

This example illustrates the fields and controls on the Course List Parameters page. You can find
definitions for the fields and controls later on this page.

Course Lis cription Cou

Effective Date: 1§}
Course Information

Course Information:

Min UnitsiCourse:

Min Grade Points/Unit:
Transfer Level Allowed:
Requirement Designation:
Valid Begin:

Valid End:

rse List Detail

Course List: Qoooaoq27

1900

20 Design
2.00
2.00

Course List Parameters

Description:

Status:

ART 140 and 142

Artive

| Atz Allow

BRITQ
B
El

Research Project: Optional

O course must be GPA material
Test Credit is Allowed

Other Credit is Allowed
CExclude In-Progress Credit

Fird |
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Field or Control

Description

Min Units/Course (minimum units per course)

Enter the minimum number of units that the course to which
this line refers must be worth to be used in the course list or as
a wild card course. For example, if you set this to 3, the system
uses only courses for this line that are worth three units each or
greater. If the system finds a course on the student's record that
meets the course list, but it is only two units, the course cannot
be used to satisfy this requirement.

Min Grade Points/Unit (minimum grade points per unit)

Enter the minimum grade points per unit that the
corresponding course or wild card course must have to be used
in the analysis. For example, if you set this to 2.0, then the
course must be a grade C or greater to fulfill this requisite.

Transfer Level Allowed

Enter a value that indicates what type of transfer credit (if any)
is acceptable. Values are:

Always Allow: All applicable transfer credit can be used to
satisfy the requisite.

Never Allow: Transfer credit can never satisty the requisite.

Two Year Institution Only: Only transfer credit from two-year
institutions can be used to satisfy the requirement.

Four Year Institution Only: Only transfer credit from four-year
institutions can be used to satisfy the requirement.

Requirement Designation

Select the requirement designation that the course or wild

card course must have. For example, if you specify a wild
card course of ARCH 4## on the Course List Detail page, then
specify a requirement designation of DSGN on the Course List
Parameters page. Only ARCH 400 - level courses that have

a designation of DSGN (with a grade of Satisfied) meet this
requisite.

Requirement designation values are defined on the
Requirement Designation Table page.

See Defining Requirement Designations.

Valid Begin and Valid End

Enter dates to specify the range of dates when the course must
be taken to satisfy the requisite. Leaving these fields blank
means that the courses can be taken anytime. When the system
compares the date range, it uses the start and end date of the
term in which the course was taken. For transfer courses, the
system uses the start and end date of the articulation term.

Course must be GPA material (course must be grade point
average material)

Select to require that the course taken for this requisite be
applied toward the student's career grade-point-average
calculation. For instance, any courses that a student took for

a pass or no pass grade basis could not be used to meet this
requisite if this grade basis does not have the Include in GPA
check box selected on the Grading Scheme table page.
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Field or Control Description

Test Credit is Allowed Select to allow test credit courses to be evaluated.

Other Credit is Allowed Select to allow other credit courses to be evaluated.

If the course taken to satisfy this course list must be fully
graded for the system to consider it valid, select this check
box. If this check box is cleared, the system will include in
analysis and "pass" all parameters any non-graded course, as
well as any graded course that has the In-Progress flag turned
on (such as Incomplete), and that match the course ID or wild
card course on the Requisite Detail page. Leaving this check
box cleared is the least restrictive, and allows for maximum

Exclude In-Progress Credit

user/student flexibility.

Viewing Enrollment Requisite Summary Information

This section lists the pages used to:
* Review summary rules for enrollment requirement groups.
* Review summary rules for enrollment requirements.

* Review summary rules for enrollment course lists.

Related Links

Defining Enrollment Requirement Groups
Defining Enrollment Requirements

Defining Enrollment Course Lists

Pages Used to View Enroliment Requisite Summary Information

Requirements >
Enrollment Requisite
Summary > Enrollment
Requisite Summary

Page Name Definition Name Navigation Usage

Enrollment Requisite ADVIS RQ GRP_SUMM Curriculum View enrollment requirement

Summary Management > group rules. This page is
Enrollment shared with the Academic

Advisement application.

RQS_SUMM DESC Click the requirement
group description link on
the Enrollment Requisite

Summary page.

Requirement Group
Description

View a summary of requisite
description information.
This page is shared with

the Academic Advisement
application.
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Requirements >
Enrollment Requirement
Summary > Enrollment
Requirement Summary

Page Name Definition Name Navigation Usage

Enrollment Requirement ADVIS RQ SUMMARY Curriculum View enrollment requirement

Summary Management > rules. This page is shared with
Enrollment the Academic Advisement

application.

Requirement Description

RQ _SUMM_DESC

Click the requirement
description link on the
Enrollment Requirement
Summary page.

View a summary of
enrollment requirement rules.
This page is shared with

the Academic Advisement
application.

Requirement Line Description

RQ LN SUMM DESC

Click the requirement line
description link on the
Enrollment Requirement

View a summary of
enrollment requirement rules.
This page is shared with

Requirements > Course
List Summary > Course
List Summary

Summary page. the Academic Advisement
application.
Course List Summary RQ _COURSELIST SUMM | Curriculum View the courses within
Management > an enrollment course list.
Enrollment This page is shared with

the Academic Advisement
application.

Course Description

CLST SUMM DESC

Click the course description
link on the Course List
Summary page.

View the course ID and
description for each
requisite course. This page
is shared with the Academic
Advisement application.

Generating a Reverse Engineering Report

This section provides an overview of the Reverse Engineering Report and discusses how to generate the

report.

Related Links

“Producing a Reverse Engineering Report” (Academic Advisement)

Understanding the Reverse Engineering Report

258

Use the Reverse Engineering Report page to search for a requirement, course, course list, or condition that
the system is using. You can search to find out which requirement group contains a specific requirement;
which course list contains a specific course; which requirement contains a specific course list; and which
requirement group, requirement, or requirement line contains a specific condition.
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The Reverse Engineering reports include enrollment and academic advisement requirement groups,
requirements, and course lists.

To produce a Reverse Engineering report:
1. Enter the report type and any other general parameters on the Reverse Engineering Report page.

2. Click the Run button to process the report.

Page Used to Generate a Reverse Engineering Report

Page Name Definition Name Navigation Usage

Reverse Engineering Report | RUNCTL_SRREVENG *  Academic Enter the parameters that
Advisement > are to capture the data that
Advisement Reports > | you want to review. Select a
Reverse Engineering report type to enable the page

to display the appropriate
*  Curriculum parameter fields.

Management >
Enrollment
Requirements >
Reverse Engineering
Report

Generating the Enroliment Requirement Group Report

This section provides an overview of the enrollment requirement group report and discusses how to
generate the report.
Understanding the Requirement Group Report

The Requirement Group report lists the contents (or structure) of a specific enrollment requirement group
or all enrollment requirement groups that meet the criteria established for the report. This report provides
an easy way to verify the enrollment requirement groups for any institution, subject, or catalog number.
For example, if you need a list of all the enrollment requirement groups defined for courses at PSUNV
with a subject of BIOLOGY, you can run this report.

Here is a high-level overview of how to run the requirement group report:
1. Enter your processing parameters for the requirement group report.
2. Specify details about how much or little you want to print about each enrollment requirement group.

3. Click the Run button to process the report.

Copyright © 1988, 2023, Oracle and/or its affiliates. 259



Setting Up Enroliment Requisites

Chapter 6

Page Used to Generate the Requirement Group Report

Page Name Definition Name Navigation Usage

Requirement Group Report RUNCTL_SRENRADV Curriculum Enter your processing
Management > parameters for the
Enrollment requirement group report.

Requirements >
Requirement Group
Report > Requirement
Group Report

Generating the Requirement Group Report

260

Access the Requirement Group Report page (Curriculum Management > Enrollment
Requirements > Requirement Group Report > Requirement Group Report).

Field or Control

Description

As of Date

The system automatically populates this field with the current
date, but you can modify it.

The report accurately reflects the requirements contained in
the specified requirement group (or requirement groups that
meet the search criteria) as of this date.

Requirement Group

Enter the requirement group for this report. Each enrollment
requirement group consists of detail lines pointing to
conditions, courses, or requirements as well as parameters that
include unit and course requirements.

Note: If you enter a requirement group number, then the
remaining search fields on the page become unavailable.

If you do not enter a requirement group number, then the
remaining search fields are available for entry and you can use
them to identify a set of enrollment requirement groups.

Academic Institution, Academic Group, Subject, Catalog
Nbr (catalog number)

Enter the institution, group, subject, or catalog number for
which you want to report related enrollment requirement
groups. Leave this field blank to return all values (wild card).

Honor Blank Values

Select to indicate that the blank fields on this page represent
actual values. For example, if the check box is selected and
the Academic Group field is left blank, then the report does
not contain enrollment requirement groups with an academic
group because no academic group has been specified. If the
check box is not selected, the blank field acts as a wild card
and every enrollment requirement group with an academic
group in the specified academic institution is contained in the
report.
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Use this group box to control how descriptions are presented in the summary report.

Values for these fields are delivered with your system as translate values. Do not modify these values.
Any modifications to these values require a substantial programming effort.

Field or Control

Description

Print Group Level

Select the type of requirement group description to be included
in the report. Values are:

*  All: Indicates that the standard, short, and long
descriptions on the Requirement Group page, plus the
catalog description print on the report.

*  Catalog: Indicates that the description on the
Requirement Group page prints on the report.

*  All Excpt Cat: Indicates that the standard, short, and long
descriptions on the Requirement Group page print on the
report.

*  Long: Indicates that the long description on the
Requirement Group page prints on the report.

*  Standard: Indicates that the description on the
Requirement Group page prints on the report. This value
appears by default.

Print Requirement Level, Print Line Level , Print Course
Level

Select the type of requirement level, requirement line, and
course list description to be included in the report. Values are:

*  All: Indicates that the standard, short, and long
descriptions on the Requirement page, Requirement Line
Item page, or Course List Description page print on the
report.

*  Long: Indicates that the long description on the relevant

page prints on the report.

*  Standard: Indicates that the description on the relevant

page prints on the report. This value appears by default.

Detail Options
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Field or Control

Description

Print Group Level, Print Requirement Level , Print Line
Level

Select to print the requirement group detail, requirement detail,
or line detail on the report. If the check box is cleared, no
group detail prints.

Course List Detail Level

Select how the course list detail should appear in the report.
Values are:

*  None: Converts to List and Courses.

»  List and Courses: Indicates that the course list, plus
specific courses print on the report. This value appears by
default.

»  List and Courses with Detail: Indicates that the course
list, plus specific courses with detail print on the report.

*  List Only: Indicates that only the course list prints on the
report.

»  List Only with Detail: Indicates that the course list with
detail prints on the report.

Values for this field are delivered with your system as translate
values. Do not modify these values. Any modifications to
these values require a substantial programming effort.

Generating the Requirement Report

Understanding the Requirement Report

262

1.

This section provides an overview of the enrollment requirement report and discusses how to generate the
report.

The Requirement report lists the contents (or structure) of a specific enrollment requirement or all of
the academic requirements that meet the criteria established for the report. This report is an easy way to
verify the academic requirements that you have defined for enrollment requisites. For example, if you
need a printout of all of the enrollment requirements that are defined at PSUNV with an academic group
of LBART you can run this report.

While preparing to print this report, you can request that the requirements, lines, and courses be
summarized in generalized terms or in specific detail. The parameters that you define for the requirement
advisement report appear on the report.

Here is a high-level overview of how to run the requirement group report:

Select the academic requirement or enter other general parameters on the Requirement Report page.
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2. Enter the description and detail options.

3. Click the Run button to generate the report.

Page Used to Generate the Requirement Report

Page Name Definition Name Navigation Usage

Requirement Report SSR RUNCTL RQR _ADV | Curriculum Enter your processing
Management > parameters for the
Enrollment requirement report.

Requirements >
Requirement Report >
Requirement Report

Generating the Requirement Report

Access the Requirement Report page (Curriculum Management > Enrollment Requirements >
Requirement Report > Requirement Report).

Field or Control Description

As of Date The system automatically populates this field with the current
date, but you can modify it.

The report accurately reflects the requirement lines in the
specified requirement (or requirements that meet the search
criteria) as of this date.

Academic Requirement Enter the requirement for this report. Each enrollment
requirement consists of detail lines pointing to conditions as
well as parameters that include unit and course requirements.

Note: If you enter a requirement number, then the remaining
search fields on the page become unavailable. If you do not
enter a requirement number, then the remaining search fields
are available for entry and you can use them to identify a set of
enrollment requirements.

For information about other fields on this page, refer to the field descriptions for the Requirement Group
Report page in the previous section.

Generating the Entity Group Table and Condition Table Reports

The Entity Group Table report and Condition Table report display all the information about the
appropriate data defined in the tables for the particular institution and the as of date.

To generate an Entity Group Table or Condition Table report:
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1. Select the as of date and institution on the Entity Group Table and Condition Table Reports page for
which you want to report conditions.

2. Click the Run button.

3. Select either the Condition Table Report or the Entity Group Table Report process to specify the
report type.

4. Click the OK button to process the report.

Page Used to Generate the Entity Group Table and Condition Table Reports

Page Name Definition Name Navigation Usage

Entity Group Table and SSR_RUNCTL_MIS_RPT Curriculum Process one or both

Condition Table Reports Management > enrollment requirement
Enrollment administrative reports: the
Requirements > Entity Group Table report and
Miscellaneous Requisite the Condition Table report.

Report > Entity Group
Table and Condition Table | The Entity Group Table report
Reports lists all the entity groups for
the institution based on the as
of date that you enter.

The Condition Table

report lists all the dynamic
conditions for the institution
based on the as of date that
you enter.

Processing the Entity Group Table and Condition Table Reports

Access the Entity Group Table and Condition Table Reports page (Curriculum Management >
Enrollment Requirements > Miscellaneous Requisite Report > Entity Group Table and
Condition Table Reports).

Field or Control Description

As of Date The report accurately reflects the retrieved information as of
this date. This field is automatically populated with the current
date, but you can modify it. A value is required in this field.
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Understanding Program Enroliment

In order to gain the most value from the documentation about Program Enrollment, we recommend that
you are familiar with the following features:

» Basic PeopleSoft tree structure, vocabulary and components.

*  Campus Solutions academic structure.

* Campus Solutions course catalog.

» Basic academic structure security.

We also recommend that you access the Activity Management documentation. See:

Setting Up an Activity Management Framework

Understanding Activity Management

Program Enrollment describes an educational model where students must complete a strictly defined

set of courses towards their academic objective in a specified sequence. Requirements must also be
completed at certain points in the program and are often structured in a series of levels or stages, where
one stage must be successfully completed before a student can progress and enroll in the next set of
courses, examinations, or other academic activities. In core Campus Solutions, enrollment is largely a
course driven process in which students select courses (with some controls and restrictions) that apply
toward degree requirements. The Program Enrollment feature provides a flexible structure that can
enable institutions to build frameworks that use various program requirements to organize curriculum and
provide the structure to order and control enrollment.

At the center of the setup for Program Enrollment are two important components:

* Academic Item Types: Academic programs that follow the Program Enrollment model have various
items like courses, milestones, study periods, and groups of courses, for example, that organize what
students are required to enroll in and when they are required to enroll. Academic Item Types allow
you to define the attributes and to establish the role and level of each of these types of items and build
them into a program structure hierarchy.

* Academic Item Registry (AIR): The foundation of program enrollment setup is the Academic Item
Registry (AIR). Use AIR to define the framework, content, and rules for a program of study —
essentially a set of academic requirements that define what courses a student needs to take and the
sequence in which they need to be taken and satisfactorily completed.

The features described in this documentation, principally Academic Item Types and the Academic
Item Registry, allow you to create program offerings using hierarchical frameworks that support
institutional policies and practice for recording and calculating results, tracking student progress
through a program of study, and ultimately assessing whether a student is eligible for the relevant
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degree or award upon completion. These hierarchies are organized using parent child relationships,
in which the various levels can contribute to the next level. These hierarchies can be generated and

viewed as a tree that represents the various levels of a program of study.

This is an example of the Program Structure page.

100 - Graduate Business
200-Year One
220 - Term One Year One
240 - Term Two Year One IF;?:‘:I Program of Study
300 - Year Two Year One and Two
320 - Term One Year Twa Direct children of the )
BA=Tem TwoYearTwg {iStudy g::t;z:,t?c:.":iﬁ.h:::ud
courses/groups of courses
Program Structure
Business Administration - Graduate 100 - Graduate Business
i - Business Administration - Graduate Year One 200 - Year One
| |- BusnAdmin - ¥r One Semester One 220 - Term One Year One
I 11— BUSADW 515: Ethics Mgmt Course
i1 i- and BUSADM 520: Political Bus Envir Course
11 1- and BUSADM 510: Securities Lw Course 00000001791
I 1 1- and BUSADM 5218B: Adv Crganizational Behavior Course 00000001792
i1 i- and BUSADM 5214 Organizational Behavior course 00000001790
I 1- and Busn Admin - Yr One Semester Two Semester, 00000001785 240 - Term Two Year One
I 1 1- BUSADWM 525 Manag Writing Course 00000001793
I 1 i- and BUSADM 561: Corp Strategy | Course 00000001796
i1 i- and BUSADM 565: Oral Comm for Bus Courge 00000001797
I 1 |- and BUSADM 528: Manag Writ Strat Course 000000017
P10 i- and BUSADM 545 Acquisitions Course 00000001795
= i - and Business Administration - Graduate Year Two Year 00000001782 300 - Year Two
= | 1- BusnAdmin - ¥r Two Semester One Semester 00000001786 320 - Term One Year Two
I 1 i~ BUSADW G20: Corp Strategy Il Course 00000001798
i1 i- and BUSADM §35: Expt Sys for Bus Courge 00000001799
I 1 1- and BUSADM 870: Adv Comp Anly Course 00000001800
I 1 1- and BUSADM 625A: Business Communications Course 00000001801
i1 i- and BUSADM 825B: Intl Business Communications Course 00000001802
= I 1- and Busn Admin - Yr Two Semester Two Semester 00000001787 340 - Term Two Year Two
!0 i- BUSADW 675: App Regr Anly Course 00000001802
I 11— and BUSADM 676: App Multivariate course 00000001504
i 1 i- and BUSADM 682: Japanese Bus System Course 00000001805
I 11— and (BUSADWM 7254 Strategic Management Seminar Course 00000001806
I 11— orCorporate Internship) Student Milestone 00000001808
i1 i- and BUSADM 713: Forecasting Courge 00000001807
= - and Communications Competency Course Cluster 00000001783
| 1- BUSADM 525 Manag Writing Course 00000001793
| 1- and BUSADM 625A: Business Communications Course 00000001801
| _i1- and BUSADN G25B: Intl Business Communications Course 00000001802

The example above shows a program constructed based on the Academic Item Registry. This

particular component (Build Program by Format) shows the tree-like framework of the program and,
in the grid section, shows how the parent and child data represent the program structure depicted in

the tree.

The Academic Item Registry allows an administrative user to generate a full view of a program’s

structure in a Program Template. AIR setup represents an extensive way for an institution to
categorize all of the objects that are used to define and constitute a full program offering. This

structure is used to organize enrollment transactions.
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This is an example of the Template page.

Setting Up Program Enroliment

Template Template - Long

Academic Institution PeopleSoft University

Academic Item 1D 00000001780 Business Administration - Graduate
Academic [tem Type Frogram of Study

As of Date [12/03/2013 [H]  Generate |

Frogram Format Structure View

Enmlment
C dlapse Ilem Description Categol Item Type Item ID
=

Business Administration - Graduate Program of Study 00000001780

= |- Business Administration - Graduate Year One Year 00000001781
= i |- BusnAdmin - Yr One Semester One Semester 00000001784
11 1- BUSADM 515 Ethics Mgmt IMandatary Course 00000001788

i1 1- and BUSADWM 520: Political Bus Envir IMandatary Course 00000001789

11 1- and BUSADM 510: Securities Lw IMandatory Course 00000001791

11 1- and BUSADM 521B: Adv Crganizational Behavior Electives Course 00000001792

i1 I- and BUSADM 521A: Organizational Behavior Mandatary Course 00000001790

= i 1- and Busn Admin - Yr One Semester Two Semester 00000001785
11 1- BUSADM 525 Manag Writing IMandatory Course 00000001793

! 1 1- and BUSADM 561: Corp Strategy| EIZL‘C:LF:: Course 00000001796

' 1 - and BUSADM 585: Oral Comm for Bus Eﬁgﬁ:”:sd Course 00000001797

11 1- and BUSADM 528: Manag Writ Strat Electives Course 00000001794

11 1- and BUSADM 545 Acquisitions Electives Course 0oooooo17as

= i - and Business Administration - Graduate Year Two Year 00000001782
= 1 1- BusnAdmin - Yr Two Semester One Semester 00000001786
11 1- BUSADM &20: Corp Strategy Il Electives Course 00000001798

! 1 1- and BUSADM §35: Expt Sys for Bus Required Course 00000001799
Electives E—

11 1- and BUSADM &70: Adv Comp Anly Electives Course 00000001800

! ! - and BUSADM 625A Business Communications Elii;:”:: Course 00000001501

! 1 I- and BUSADM 625B: Intl Business Communications EIZLS:LF:SU Course 00000001802

= i 1- and Busn Admin - ¥Yr Two Semester Two Semester 00000001787
11 1- BUSADM &75: App Regr Anly Electives Course 00000001803

I 1 1- and BUSADM G76: App Multivariate Electives Course 00000001804

11 1- and BUSADM 682: Japanese Bus System Electives Course 00000001805
14— and (BUSADW 7254 Strategic Management Seminar Eiﬂ:,‘fd Course 00000001306

Other features that comprise the fundamental support of Program Enrollment setup are:

*  Program format

*  Enrollment cohort

* Enrollment category

¢ [tem attributes

*  Course group

Understanding the Academic Item Registry

The Academic Item Registry (AIR) is used to define the framework, content, and rules for a ‘program of
study’, such as a bachelor’s or master’s degree, or set of academic requirements that specify what courses

a student needs to take and when they need to be taken, as well as the rules for calculating results and

degree or qualification awards. The AIR allows you to organize academic requirements into a hierarchy
that can be used to provide a program template for driving and controlling enrollment activity.
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The AIR provides a flexible way for your institution to define all of the objects that constitute a program
offering. These entries must be categorized and grouped in order to define program hierarchies. The

categories are established by system and user defined Academic Item Types that allow you to define the
types of attributes an item can have, and to establish the role and level of an item in a program hierarchy.

Academic item types can:

» Represent a level in a program of study hierarchy, the program itself, a year or stage, a list of courses,
or a single course.

» Provide user defined values with configurable attributes.
* Allow you to create as many items/levels as you need to define your program offerings.
* Point to existing Campus Solutions core objects such as courses, components, and milestones.

* Be configured to represent a level in a structure where statistics (for example, credits, results) can
accumulate.

Although you can define your own academic item types, some item types are delivered as system data.
For further information,

See Using Delivered Academic Item Types

This documentation discusses the AIR (and supporting features) and its role as a tool to define and
maintain the programs of study for an institution.

The AIR also provides the data or academic items that feed into the student data structure—the Academic
Progress Tracker (APT).

See Understanding the Academic Progress Tracker

Setting Up Academic Item Types

This section discusses how to:
* Define academic item types.
* Define academic item type attributes.

» Use delivered academic item types.

Pages Used to Set Up Academic Item Types

268

Page Name Definition Name Navigation Usage

Academic Item Type SSR_ITEM _TYPE Set Up SACR > Product | Define academic item types.
Related > Student
Records > Program
Enrollment > Academic
Item Type > Academic
Item Type

Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 7 Setting Up Program Enroliment
Page Name Definition Name Navigation Usage
Attributes SSR ITEM _TYPE DEFN Set Up SACR > Product Define academic item type

Related > Student
Records > Program
Enrollment > Academic
Item Type > Attributes

attributes.

Defining Academic Item Types

Access the Academic Item Type page (Set Up SACR > Product Related > Student Records >
Program Enrollment > Academic Item Type > Academic Item Type).
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This example illustrates the fields and controls on the Academic Item Type page. You can find definitions
for the fields and controls later on this page.

Academic ltem Type Aftributes

Academic ltem o
T Description
FRG

Program of Study

PHAZE FPhase
STAGE Stage of Program

L2
Perzonalize | Find | = | B

o Ite:
=nort Description
Short Description Order

Erogram of Study 100
Fhase 20

ElE

Stage 20

ACCUMUZPECIAL Specialisation generic

Specialisation gener | 325

VEAR | Year
W Sermester
[STUDYPERIOD | Study Period
MAJOR Majar
’m Requirement
SPECIALISATION | Specialisation
MINGR Mingor
DIFFERENTIATION Differentiation
CLUSTER Course Cluster
COURSELIST Course List

COURSEGROUP  Course Group

UE Teaching Unit
INTERMSHIF Internship

COURSE Course
COMPONENT Component
MILESTOMNE Student Milestone

'_
m
=
HER
=

35

-
[1e]
[1]
=
[S5]
n
=]

Semester

Study Period

= =
[ I = R |
[ [ R = (R ]

Majar

I
(&)1
=

Requirement
Specialisation

4=
[y T R ]
(=T N =]

Minar

I
]
o]

Differentiation

n
=]
=]

Course Cluster

Course List

[y B =}
(=R g =]
(=0 g =]

Course Group

Teaching Unit Go0
Internship 700
Course | 700
Thesis oo
Component lﬁ

Student Milestone ann

Program Format Tree Hode

K & & & EE

T e e e SN

HEHHHHIEHBHEIHBNBEHBBBGBFRKMBE

First n 1-22 of 22 n Laszt

ojofiniofofofioinfoiofoliofofofofoiofofofofiolin] |

Define academic item types (by installation) on the Academic Item Type page by inserting new rows in
a grid. When you insert a new row, you are taken to the Attributes page to define the detail for the item
type. The Academic Item Type page also provides a summary view of all academic items. You can also
update Item Order and Program Format Tree Node values on this page. The default sort order for the grid
is by Item Order so that you can quickly scan items to verify logical order.

Note: You cannot delete an academic item type row here if an academic item of this type has been created

in the Academic Item Registry.

See Setting Up Academic Item Registry Entries, Item Details, and Item Security
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Field or Control Description

Description and Short Description Click the Description or Short Description links to access the
Attributes page and further define the item type.

Item Order Enter a number to define the hierarchy and sort order of the
items in the user interface. The lowest number represents the
highest node — for example, the number that you enter for
YEAR is lower than the number you enter for COURSE.

The potential children of an academic item type must have an
item order greater than that of the item type itself. You define
child item types for an academic item type in the Item Type
Matrix component.

See Identifying Child Item Types and Syncing Entities

We advise you to increment child item orders by ranges of 50
or 100, ensuring that you have space between two levels so
that you can insert additional items in your structure if needed
in the future. If two academic items are at the same level in
your program hierarchy, they can bear the same Item Order
number.

PRG item type is delivered with an item order of 100 but you
can change the item order. The system ensures that the item

order for PRG is always the lowest.

For more information about delivered item types,

See Using Delivered Academic Item Types

Program Format Tree Node Select to identify an academic type as one that can be used to
construct a Program Format definition. The Program Format
Tree Node field also appears on the Attributes page. For more
information about this field,

See Setting Up Program Formats

See Defining Academic Item Type Attributes

See Setting Up Academic Item Registry Entries, Item Details, and Item Security

Defining Academic Item Type Attributes

Access the Attributes page (Set Up SACR > Product Related > Student Records > Program
Enrollment > Academic Item Type > Attributes).
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This example illustrates the fields and controls on the Attributes page. You can find definitions for the

fields and controls later on this page.

Academic ltem Type Attributes

Academic ltem Type COMPONENT System Data
*Descﬁption|0::umpnnent

Short Descﬁption|CnmpDnent
*ltem Order| 800

Program Format Tree Node
[ Grading Item Type

ltem Type Properties

Credits
Degree
[ Instructions
Item Parameters

Child Academic Items
] Show Connectors
[ ] Add parent before children

[ Results
[ child Grading Items
] Requires Enrollment Category

Activity Management Mapping

Content Definition Coursewaork

Content Type Component

AIR Entity SCC_ENTITY_20120613165411
APT Entity SCC_ENTITY_20120525001442

Extension Record SSR_AIR_H_CMPMNT

Associated Field Reguired

1 S5R_COMPONENT

Find | View Al First Bl 23 of24 I Last

[+[=]

Use the Attributes page to define the types of attributes that are available for an item in the AIR, and,
through the Extension Record, what type of external (to AIR) objects can be referenced by the item (such

as courses or milestones).

See Defining Academic Item Type Attributes

The setup options that you select on the Attributes page impact the Academic Item Registry component

(AIR).
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See Setting Up Academic Item Registry Entries, Item Details, and Item Security

Field or Control

Description

System Data If an academic item type is delivered as system data, the
System Data check box is selected and is not available for edit.
See Using Delivered Academic Item Types

Item Order Define the value for this field on the Academic Item Type

page. You can update the value here.

Program Format Tree Node

This check box identifies an academic item type as one that

is used to define a Program Format, which provides the
framework for a program of study, based on level, such as year
or stage, study period or semester.

Grading Item Type

If you select this check box, academic items of this type can
be assigned as child grading items for another academic item
type using the Grading Academic Items grid on the Item
Details page in AIR. When selected, this check box makes the
Grading Items check box in the Item Type Properties group
box unavailable for editing—an academic item that is identified
as a grading item cannot itself have grading items attached

to it. A grading academic item type could represent a set of
courses for which a result might need to be calculated outside
of the regular, structured program requirements. For example,
a Chemistry student might need to achieve an average score
of 70 in all courses taken from the Chemistry department. A
grading academic item type could also be used to determine
if a student was eligible for some kind of degree or certificate
award.

Item Type Properties

Field or Control

Description

Credits

If you select this check box, the Credits field is available for
the academic item on the Academic Items Registry page. This
allows you to assign a credit value to an academic item which
is also reflected in student's APT instance (if the item is added
to it). The field is disabled for COURSE items, because a
course credit value is established and maintained in the course

catalog.
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Field or Control Description

Degree If you select this check box, the Degree field is available for
the academic item on the Academic Items Registry page,
allowing you to assign the item a Degree value in AIR. You
would typically select the check box only for an item type that
represents an overall program of study leading to a degree or
certificate, or for an item type that represents an element of

a program (for example, a year or stage) for which a student
might receive an award (or intermediate degree) during
progress towards the overall degree/certification objective.

Note: Note: Currently this field is informational only.

Instructions Select this check box to enable the Instructions field on the
Item Details page in the AIR component.

Item Parameters Select this check box to enable the Academic Item Parameters
grid on the Item Details page in the AIR component. This
check box is disabled for the delivered COURSE item type.

See Using Delivered Academic Item Types

Child Academic Items If you select this check box, academic items of this type can
have other academic items associated with them as children
—the Child Academic Items grid becomes available in AIR
on the Item Details page. For example, an item representing a
Year or Stage would probably need to have child items such as

courses.

For COURSELIST item types, the Child Academic Items
check box is selected and not available for edit.

Show Connectors Select this check box to activate AND/OR connectors in the
AIR Child Academic Items grid.
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Field or Control

Description

Add parent before children

This property is used in the student self-service user interface.
When the check box is selected, no child item of the item can
be selected until the item itself is added to APT. For example,
if a CONCENTRATION has four child courses, you must first
add the CONCENTRATION item to APT before you can add
the child course. This serves two main purposes: It provides
another way of representing the parent/child dependency to
self-service users and allows you to attach rules to a parent
item that can enforce eligibility before course selection—for
example, a student might need a particular number of credits in

order to select a particular concentration.

Note: Select this check box only for an academic item type
that is truly an optional selection, regardless of the child items
and enrollment categories.

Results If you select this check box, results can be attached to
academic items of this type in the Item Type Usage grid on the
Result Type page.
See Setting Up Result Types

Child Grading Items If you select this check box, the Grading Academic Items grid

is available in AIR on the Item Details page.

Requires Enrollment Category

If you select this check box, items of this type require an
Enrollment Category code when they are inserted as child
items of another item.

See Defining Academic Item Details

Activity Management Mapping

These mapping fields allow you to map an academic item type to one of the delivered Activity
Management Content Types. This mapping is used when defining Result Types.

See Setting Up Result Types

See Setting Up an Activity Management Framework

Field or Control

Description

Content Definition

Currently only the Coursework content definition is available.
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Field or Control Description

Content Type This field lists all Activity Management Content Types flagged
as system data.

Entities
Field or Control Description
AIR Entity and APT Entity A system generated ID for the entity that is created for this

academic item ID.

Program Enrollment uses the Entity Registry to access AIR
and APT data.

See “Setting Up Entity Registry” (Campus Community
Fundamentals)

Note: For information about the Sync Entities process and when you must run the process,

See Identifying Child Item Types and Syncing Entities

See Using Item Attributes to Extend AIR Data Elements

See Using Item Attributes to Extend APT Instance Header Data Elements

Note: Each time that you create a new academic item type or make changes to an existing academic
item type, you must run various entity sync processes. The steps you must follow are documented in the
“Identifying Child Item Types and Syncing Entities” section.

See Identifying Child Item Types and Syncing Entities

Using Academic Iltem Type Extensions

An academic item type can point to an existing Campus Solutions object. The AIR structure can use core
functionality, such as courses and milestones and Program Enrollment features such as Course Groups.

An object that is created outside of the AIR, for example, a course, must still be registered within

the structure. To do this, you create academic items that are linked to the external object through an
extension record. The extension record contains the necessary keys to allow the external (to AIR) object
to be referenced within the hierarchy. The addition of an extension record (and associated fields) to an
academic item type opens up the indicated fields in the AIR, providing the link to the external object.

The Extension Record field prompts against PS record definitions with the pattern % AIR _H % (where
% represents the record prefix and name/suffix). This is the recommended naming convention for any
custom extension that you add.

The following extension records are delivered:
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» SSR _AIR HDR PRG: Program Extension: Used by the delivered Academic Item Type PRG. Used to
store Program (item type) specific fields.

This example illustrates a SSR_AIR_HDR_PRG extension record.

Extension Record 55R_AIR HDR_PRG

| Assnciated Field Reuired

1 SSR_AVAIL_TO USE
2 SSR_FORMAT _ID

3 SSR_LAST ADM_DT ]
4 SSR_LAST PRS DT ]

* SSR_AIR H CRSE: Course Catalog extension: Used by the delivered Academic Item Type
COURSE and references a Course defined in the Course Catalog. As delivered, you can create
academic items that point to a course ID or a course offering or to a course ID/offering with a specific

Course Topic ID.

Note: Course ID is always required (Required check box is selected and not available for edit).

This example illustrates a SSR_AIR _H CRSE extension record.

Extension Record SSR_AIR_H_CRSE
Associated Field Required
1 CRSE_ID

2 CRSE_OFFER_NBR
3 CRS_TOPIC_ID

« SSR _AIR H CMPNT: Course Component extension: Allows you to create academic items at a level
below the course. Academic items representing Course Components can be built and graded in AIR
and then be available for use in calculating the overall course and for evaluation outside of the course.
For example a student might need a CHEM 101 LAB score of 65 in addition to an overall course
result of 60, in order to pass a particular requirement.
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This example illustrates a SSR_AIR H CMPNT extension record.

Extension Record SSR_AIR_H_CMPNT

| Assmiated Field Required

1 SSR_COMPONENT ~

* SSR_AIR H CGRP: Course Group extensions: Used by the delivered COURSEGROUP Academic
Item Type, and allows you to create academic items that reference the Course Group feature which
makes available loosely defined group of courses (using wild card indicators within a program
hierarchy).

See Setting Up Course Groups

This example illustrates a SSR_AIR H CGRP extension record.

Extension Record SSR_AIR_H_CGRP

| As sociated Field Required

1 SSR_CRS_GRP_ID ~

* SSR AIR H MLSTN: Milestone extension: Used by the delivered MILESTONE Academic Item
Type, and allows you to create academic items that point to existing Milestone records, making the
Milestone itself available in a program hierarchy.

This example illustrates a SSR_AIR_H MLSTN extension record.

Extension Record SSR_AIR_H_MLSTN

1 MILESTONE v

Using Delivered Academic Item Types

The following academic item types are delivered as system data. The item order value shown for each
item can be modified if needed.

*  PRG: Program of Study:

* PRG is used for all academic items that represent an overall educational objective and that
comprise all of the child items necessary to achieve the objective.
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Note: You must define an academic item with an Academic Item Type of PRG for every Program
of Study that you want to build in AIR.

This example illustrates an academic item type of PRG.

Academic ltem Type Attributes

Find | View Al First B 4 or24 I L ast

[+][=]

Academic Item Type PR3 System Data
*Description |F'r|:|gram of Study

Short Description |F'rngram of Study

*ltem Order| 100

Program Format Tree Node
Grading ltem Type

Item Type Properties

[ credits

Degree
Instructions

[tem Parameters

Child Academic ltems
Show Connectors
[ Jadd parent before children

Results
Child Grading ltems

Requires Enrollment Category

AIR Entity SCC_ENTITY_20120613165705
APT Entity SCC_ENTITY_20120525001729

Extension Record 33F_AIR_HDR_PRG

Aszszociated Field Required

4 SSR_AVAIL_TO_USE

2 S5R_FORMAT_ID

3 S5R_LAST _ADM_DT [F]
4 SSR_LAST_PRS_DT F]

* PRG is the root item for all AIR based programs. All other academic item types must have an item
order greater than the PRG item order value.

* Attribute Restrictions: All attributes are available except for Requires Enrollment Category.
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COURSE: Course

Chapter 7

COURSE points to a predefined Course Catalog offering (can be defined down to the Course

Topic ID).

Note: All Courses that are used in an AIR program definition must be defined as academic items

in AIR.

This example illustrates an academic item type of COURSE.

Academic ltem Type Attnibutes

Academic Iltem Type COURSE System Data
*Description|Cnurse

Short Description|Cnurse

*ltem Order| 700

Program Format Tree Node
[l Grading ltem Type

ltem Type Properties

Credits

Degree
Instructions

[tem Parameters

Child Academic ltems
Show Connectors
[ add parent before children

Results
Child Grading Items
Requires Enrollment Category

Activity Management Mapping

Content Definition Coursewark

Content Type Course

AIR Entity SCC_ENTITY_20120613165428
APT Entity SCC_ENTITY_20120525001450

Extension Record 3SR_AIR_H_CRESE

1 CRSE_ID
2 CRSE_OFFER_NBR ]
3 CRS_TOPIC_ID O

irst 4] 220f24 [} Last

[+][=]

The main purpose of the COURSE academic item is to serve as a pointer to an established Course
ID, Course offering (CRSE_OFFER) or Course topic. Because a course has predefined unit/
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credit value (at the CRSE _CATALOG level) the credits and so on for a COURSE item are always
inherited directly from there—the item has no credit value itself.

* Attribute Restrictions:

Cannot have Credits or Item Parameters, because these define a credit value that could contradict
the Course Catalog definition. The Credits check box and the Item Parameters check box are not
available for selection.

Child Items are allowed, because AIR can be used to support a model where components could be
graded, (themselves defined as academic items) rolling up to a parent course.

Cannot have Grading Items.

The Requires Enrollment Category check box is selected and cannot be edited.

*  COMPONENT: Component

*  COMPONENT is used to build Course components in AIR, such as Lectures and Labs. When a
COMPONENT item type is built in AIR, the component field is visible and prompts against the
XLATTABLE for the field SSR_ COMPONENT

Copyright © 1988, 2023, Oracle and/or its affiliates. 281



Setting Up Program Enroliment Chapter 7

This example illustrates an academic item type of COMPONENT.

Academicltem Type | Attributes
Find | View Al First Kl 23 024 I Last

[+][=]

Academic ltem Type COWMPONENT System Data
*Descﬁptionh:nmpnnent

Short Deacﬁpﬁon|Cnmpnnent
*ltem Order| 300

Program Format Tree Node
[ Grading ltem Type

ltem Type Properties

Credits

Degree
Cinstructions

Item Parameters

Child Academic ltems
] Show Connectors
[ Add parent before children

[ IResults
[ child Grading Items
[ Requires Enrollment Category

Activity Management Mapping

Content Definition Coursework

Content Type Component

AIR Entity SCC_ENTITY_20120613165411
APT Entity SCC_ENTITY_20120525001442

Extension Record S5R_AIR_H_CMPMNT

Associated Field Reguired

1 SSRE_COMPONENT

* Use the Component item type if you want to represent course component structures in AIR
program structure for possibly grading students at the component level in the Academic Progress
Tracker (APT).

* Attribute Restriction: The Component item type is delivered with the check boxes for all attributes
cleared, but you can select the check boxes.

*  COURSEGROUP: Course Group
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*  COURSEGROUP is used to point to a Course Group ID that allows you to define a ‘wild card’
course listing.

This example illustrates an academic item type of COURSEGROUP.

Academic [tem Type Attributes

Find | View Al First K 47 of 24 I Last

[+][=]

Academic Iltem Type COURSEGROUP system Data
*Descﬁptionh:nurse Eroup

Short Descnption|t3|:|urse Eroup
*ltem Order| &00

Program Format Tree Hode
Grading ltem Type

ltem Type Properties

[ credits

Degree
Instructions
ltem Parameters

Child Academic ltems
Show Connectors
Add parent before children

[ ] Resuilts
Child Grading Items
Requires Enrollment Category

AIR Entity SCC_ENTITY_20120613165454
APT Entity 3CC_ENTITY_20120525001532

Extension Record 33R_AIR_H_CGRP

| Asszsociated Field Reqguired

1 88R_CRS_GRP_ID

*  The main purpose of the COURSEGROUP item type is to serve as a placeholder (or pointer) to
a loosely defined list of courses defined using wildcard indicators. Some attributes are therefore
restricted.

« Attribute Restrictions:

Cannot have Child Academic Items or Grading Items.
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The Requires Enrollment Category check box is selected and cannot be edited.

¢  COURSELIST: Course List
*  COURSELIST is used to define a list of courses that can be attached to another academic item.

This example illustrates an academic item type of COURSELIST.

Academic ltem Type Attributes

Find | View Al First Kl 18 of 24 I Last

[+][=]

Academic ltem Type COURSELIST System Data
*Description |C|:|L|rse List

Short Description |C|:|L|rse List

*Item Order| 00

Program Format Tree Node
Grading Item Type

[tem Type Properties

[ Credits

[ | Degree
Instructions

ltem Parameters

Child Academic [tems
Show Connectors
[ ] Ackd parent before children

[ ] Results
Child Grading ltems
Requires Enrollment Category

AIR Entity SCC_ENTITY_20120613165445
APT Entity SCC_ENTITY_20120525001514

* The COURSELIST academic item type is provided for defining academic items that represent
lists of courses. While user defined items can be used for this same purpose, various system edits
are triggered by using the delivered COURSELIST item.

See Setting Up Academic Item Registry Entries, Item Details, and Item Security

* Attribute Restrictions:

Only COURSE items can be assigned as child items.
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Cannot have Grading Items.
The Child Academic Items check box is selected and cannot be edited.

The Requires Enrollment Category check box is selected and cannot be edited.

*  MILESTONE: Student Milestone
*  MILESTONE points to a predefined Milestone definition.

This example illustrates an academic item type of MILESTONE.

Academic Iltem Type Attributes
Find | View Al First Kl 24 or 24 I | ast

[+ [=]

Academic ltem Type MILESTOMNE System Data
*Description |Stu dent Milestone

Short Description |Student WMilestone
*Item Order| 200

Program Format Tree Hode
Grading Item Type

ltem Type Properties

[ Credits

[ ] Degree
[instructions
[]item Parameters

Child Academic [tems
Show Connectors
Add parent before children

[ |Results
Child Grading ltems
O Requires Enrollment Category

AIR Entity SCC_ENTITY_20120613165353
APT Entity SCC_ENTITY_20120830020753

Extension Record SER_AIR_H_MLSTH

| Azzociated Field Reguired

1 MILESTOME
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*  The main purpose of the MILESTONE academic item is to serve as a pointer to an established
Milestone table entry, where the rules for the completion of the milestone are defined.

» Attribute Restrictions: Cannot have Child Academic Items or Grading Items.

Identifying Child Item Types and Syncing Entities

This section discusses how to use the Item Type Matrix to identify child item types. It also discusses the
processes that you must run each time that you create a new academic item type or make changes to an
existing item type.

Page Used to Identify Child Items and Sync Entities

Page Name Definition Name Navigation Usage
Item Type Matrix SSR_CHILD ITEM_TYP Set Up SACR > Product Identify child item types and
Related > Student sync entities.

Records > Program
Enrollment > Item Type
Matrix

Using the Item Type Matrix

Access the Item Type Matrix page ((Set Up SACR > Product Related > Student Records >
Program Enrollment > Item Type Matrix).
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This example illustrates the fields and controls on the Item Type Matrix page (1 of 3). You can find
definitions for the fields and controls later on this page.

Item Type Matrix

Expand All | collapse Al *Sortitems by | tem Order v|

Sync Entities |

| P pRraG: Program of Study |

| > PHASE: Phase |

| P STAGE: Stage of Program |

P ACCUMUSPECIALISATION: Specialisation generic

P LEVEL: Level

P YEAR: Year
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This example illustrates the fields and controls on the Item Type Matrix page (2 of 3). You can find

definitions for the fields and controls later on this page.

= SEMESTER: Semester

Academic Iltem Type SELIESTER
Description Semester

[tem Order 400

Valid Child tem Types

System Data

Program Format Tree Node

select An&demic tem Type Description

ftem |Program
Order | Hode

] MAJOR Kajor 425
REQUIREKENT Requirament 450
DIFFERENTIATION Differentiation 460
MINOR Kinor 460
SPECIALISATION Specialisation 460
CLUSTER Course Cluster 500
UELIST UE List 500
O DSTEST3 Test ltemn 550
COURSEGROUP Course Group 600
COURSELIST Course List g00
O DSTEST2 DS Test 600
LE Teaching Unit 600
COURSE Course 700
INTERNSHIF Internship 700
THESIS Thasis 700
COMPONENT Component 800
MILESTOME Student Milestone 900
o selectAll

1 Daselact Al
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This example illustrates the fields and controls on the Item Type Matrix page (3 of 3). You can find
definitions for the fields and controls later on this page.

¥ COURSEGROUP: Course Group

Academic Item Type COURSEGROUP

Description Course Group System Data
Item Order 500 Program Format Tree Node

This item 15 not set up to have child academic items.

Identifying Child Item Types

As explained earlier in the “Setting Up Academic Item Types” section, the Item Order value of an
academic item (defined on the Academic Item Type page) indicates which items are potential child items
for that academic item.

After you create your academic item types, use the Item Type Matrix component to determine which
item types (those with a higher item order than the item itself) can be defined as child item types for each
academic item.

When the Child Academic Items check box is cleared on the Attributes page for an academic item type, a
message appears in the Item Type Matrix for that item type: This item is not set up to have child academic
items.

The Valid Child Item Types grid is refreshed whenever the component is opened. For each item type, the
system retrieves all other academic item types with an item order (SSR_ITEM_TYPE.SSR _ITEM_LVL)
that is greater than its own item order.

Field or Control Description

Select Select this check box to identify the item as a valid child for

the academic item type.

Note: Only item types for which this check box is selected are
listed as potential child items in any prompt for this item. This
applies in:

Program Format definition.

Academic Item Registry: adding child elements

Academic Progress Tracker: adding child items and
substituting items.

See Setting Up Program Formats

See Defining Academic Item Details

See Managing APT Items
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Field or Control Description

Sort items by Sort by ltem Order, Item Type, or Item Description. The

default value is Item Order.

Syncing Entities

If you implemented Program Enrollment before April 2013, you must run the processes listed here after
you apply those updates.

Each time that you create a new academic item type, make changes to an existing academic item type,
or set or make changes to the child item matrix for an academic item type, you must run the following
processes:

L.

3.

Item Type Matrix Sync Entities

Here on the Item Type Matrix page (SACR, Product Related, Student Records, Program Enrollment,
Item Type Matrix):

*  Click the Sync Entities button. This initiates the SSR_PE_SYNC process.
*  Check the Process Monitor to ensure that the process completes successfully.

This process can be scheduled using the process scheduler

Note: If you make changes on the Item Matrix page, be sure to save those changes before you
launch the Sync Entities Process.

Entity Property Sync

Go to the Entity Property Sync page (SACR, System Administration, Entity, Entity Property Sync)
and:

*  Click the Sync All Entities button.

*  Check the Process Monitor to ensure that the process completes successfully.

Wipe Entity Cache
Remain on the Entity Property Sync page and:

» After the Sync All Entity Properties process has completed successfully, click the Wipe Entity
Cache button.

*  Check the Process Monitor to ensure that the process completes successfully.

See “Setting Up Entity Registry” (Campus Community Fundamentals)

Note: You must also run these processes when you add common attributes for the AIR (SSR_AIR HDR,
SSR_AIR _ELEM) and APT (SSR_APT HDR) record contexts.
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See Using Item Attributes to Extend AIR Data Elements

See Using Item Attributes to Extend APT Instance Header Data Elements

Setting Up Rules for Program Enroliment

This section discusses how to:
*  Setup rule types.
* Associate rule types with execution events.

See Program Enrollment Activity Management (PEAM) Documentation in My Oracle Support (ID
1400723.1).

» Using the Rules Engine for Program Enrollment Student Self-Service: System/Example Data

» Using the Rules and Engine for Program Enrollment Calculation and Evaluation: System/Example
Data

Note: The Rules Engine requires PeopleTools 8.53.

See “Understanding the Rules Engine” (Campus Community Fundamentals)

See “Setting Up the Rules Engine” (Campus Community Fundamentals)

Page Used to Set Up Rules for Program Enroliment

Page Name Definition Name Navigation Usage
Program Enrollment - Rule SSR_RULE TYPE TBL Set Up SACR > Product Set up rule types.
Type Table Related > Student

Records > Program
Enrollment > Rule Type

Table
Program Enrollment - SSR_EXEC EVENT Set Up SACR > Product | Associate rule types with
Execution Event Rule Types Related > Student execution events.

Records > Program
Enrollment > Execution
Event Rule Types

Setting Up Rule Types for Program Enroliment

The Program Enrollment - Rule Type Table provides a link between Program Enrollment-related features
and the Rules Engine (RE) in these ways:

* Provides a functional 'wrapper' around a RE Rule Group (the RE construct that determines what a rule
can do, the inputs and outputs of a rule and so on) that makes sense in the context of the Academic
Item Registry, and which therefore simplifies rule prompting, and provides context for the user.
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*  When attached to an execution event, a rule type enables the invocation of rules, based on a user
action (in the User Interface) or some other system event (see “Associating Rule Types with

Execution Events” later in this section).

» Because a rule type can categorize rules from a functional perspective, the combination of type and
execution event can be used to enable different behaviors and controls in a User Interface.

*  Controls rule prompting in the Academic Item Registry component such that available rules can be

restricted by item type.

Access the Program Enrollment - Rule Type Table page (Set Up SACR > Product Related > Student
Records > Program Enrollment > Rule Type Table).

This example illustrates the fields and controls on the Program Enrollment - Rule Type Table page. You
can find definitions for the fields and controls later on this page.

Rule Type Table

Rule Type SSR_PE_COURSE_REQ

I~ System Data

*Description |Course Requisite

Rule Category Name AFT Functions
*APT Usage Validation

C A
& selected

Academic ltem Type
1 Course
Add row

Long Description |Use with rules that execute when a user attempts to add a course. @@

Rule Group Name Academic Progress Tracker ltem (version 1.1)

Associated Academic Item Types

. E] , L= )
Find | View Al | B0 | 8 First B g o1 B Lot

[

[-]

Field or Control

Description

Rule Type and Description

Enter a Rule Type code (20 character limit) and a Description
(30 character limit).

System Data

If a rule type is delivered as system data, this check box is
selected and is not available for edit.

Rule Group ID, Search, Rule Group Name, and Rule
Category Name

A Rule Type must be associated with a single Rule Group.
Click the Search button to launch a search using a standard
Rules Engine search utility. When you select a Rule Group ID,
the Rule Group Name and Rule Category Name are displayed.
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Field or Control

Description

APT Usage

Determines how rules of this type relate to an APT Instance.
Select from:

*  Validation: Rules of this type can be associated with an
Execution Event and can be used to validate APT entries.
A Validation rule type must be associated with at least one
academic item type.

*  Result Calculation: Rules of this type can be associated
with an academic item type on the Result Type
component as the default calculation rule for that result
type/academic item type combination.

*  APT Status Evaluation: Rules of this type can be
associated with an academic item type on the Rule Type
table. Academic Item types associated on the rule type
table can be used in APT Status Evaluation rules in the
APT Administrative Roster.

See Setting Up Result Types.

Copy

This button is available only when you add a new rule type.
The copy feature provides a prompt against all rule types
defined in the system, including those for which the System
Data check box is selected (delivered rule types).

Delete

When a rule type is saved successfully, a Delete button is
available. Delete is not available for rule types for which the
System Data check box is selected.

Associated Academic Item Types

This grid is available only when the APT Usage value is Validation or Evaluation.

Field or Control

Description

All

Select this option to indicate that this rule type can be assigned
to any academic item regardless of academic item type. Assign
rule types to academic items on the Rules / Results page in the
Academic Item Registry component.

Note: This option is not available for APT Status Evaluation

Selected

When you select this option, the Academic Item Type field
becomes available and you can select the academic item types
to which the rule type can be assigned. The Rules / Results
page is available in the AIR component only for academic
items of the type selected here.
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Delivered Rule Types

The following Rule Type definitions are delivered as system data, specifically for use in Program
Enrollment Self-Service. These rule types can be used on the My Education Plan and Schedule Builder
components.

See “Using Program Enrollment Self-Service Features” (Campus Self Service )
SSR_ACE - AIR Connector Engine:

This rule type is not tied to a Rules Engine Rule Group definition and does not invoke the Rules Engine,
but rather serves as a hook to invoke the AIR Connector Engine API. This API validates a student’s
course choices against the structure or ‘tree’ defined in the Academic Item Registry for a particular
planning node.

The following example shows the program tree requirements for year one of a program. In this particular
case, the Item Type Stage is a planning node for this program.

Expand | . Enroliment
Comipas Itern De=scription Caory ltem Type Item ID
= Year 1- Foundation and Business Core Stage 00000002139
= |- BA Bus Mgt-Semester 1 Study Period 00000002140
i - ECON 2:Macroeconomic Principles Mandatary Course 00000000388
v 1~ and ECON 3: Microeconomic Principles Mandatory Course 00000000389
} i- and POLSCI 1:Infro to US Govt and Politics Mandatory Course 00000000100
1 i- and Modem European Languages - Intro Level Electives Course Group 00000001697
V1= or Sunvey of Modern Math | Electives Course 00000002151
= 1- and B.A Bus Mgt- Semester 2 Study Period 00000002141
i 1= ECON 198: Special Topics in Economics Mandatory Course 00000002152
i 1- and ECON 1004B: Economic Methods Il Mandatory Course 00000000448
i 1- and Social Sciences for Busingss Electives Course Group 00000002210
= | i- andBusiness Foundation - Economics Options Eleclives Requirement 00000002153
- e Required -
= § | - Economics Year 1 Option ListA Eta‘lﬁ:’es Course List 00000001743
e B . . Required y
1 1 1 i~ (ECON 1011:Industrial Economics Eledlives Course 00000000397
. . Required
! 1 1 i- andSOC 103: Social Problems) Electives Course 00000000019
k : Redquirad
T 1 1 i- or(ECON 1014: Economics of Social Problems Electives Course 0 4
fonn ) Required
V1 1 i- and SOC 180: World Pop Probs) Elediives Course 00000000171
Coe ) " . Required )
= § | - orEconomics Year 1 Option ListB Ele‘z:ljves Course List 00000001744
N - Required
1 1 1 1= (ECON 1012 Inintl Political Economy Elaclives Course 00000000398
P . ) Required .
f 1 1 1= and POL SCI 101: Introduction to Government) Eledlives Course 00000000095
oo - Required
y 1 1 i- or(ECON 1013: Public Sector Economics Eleclives Course 00000000399
e . Required
P 1 i- and POL SCI 105: Intro to World Politics) Eleclives Course 00000000097

To satisfy the course requirements for Year 1, students must satisfy the course requirements for each
Study Period within the year, Semester 1 and Semester 2 as follows:

e For Semester 1, students must have ECON 2 and ECON 3 and POL SCI 1 and select a course from
the Modern Languages Course Group or select Survey of Modern Math.

¢ For Semester 2, students must have ECON 198 and ECON 1004B and select a course from the Social
Sciences Course Group and satisfy the Business Foundation options requirement.

* For Business Foundation options, students must select one pair of courses from List A or List B.

» To satisfy List A or List B student must select a matching pair of courses.
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The Air Connector Engine (ACE) process traverses this tree and verifies that each of these requirements
— as defined by the AND/OR connectors in AIR — have been met. If all items are not satisfied, an error
message is returned.

Currently, ACE can be invoked on the student My Education Plan and Scheduler Builder components.
(see Execution Event Rule Types below).

SSR_PE_COURSE_REQ - Course Requisite:

This rule type is linked to the delivered Rules Engine Rule Group Academic Progress Tracker Item
(version 1.1). 1t is associated with delivered COURSE academic item type, but others, including user
defined item types can be added. This rule type allows the user to deploy a subset of their rules such as
those that check for course requisites.

SSR_PE ITEM PRECOND - Academic Item Precondition:

This rule type is also linked to the Rule Group Academic Progress Tracker Item (version 1.1). It is
associated with the delivered COURSELIST academic item type, but others, including user defined item
types can be added. This rule type allows the user to deploy a subset of their rules such as whether a
student has meet a condition that is satisfied based on data typically associated with the student, such as a
particular Academic Plan or Sub-Plan code.

The following Rule Type definitions are also delivered as system data, and are used to calculate and
evaluate results.

« SSR_PE CALC RESULTS:

» This rule type is linked to the Rule Group Academic Progress Tracker Item (version 1.1). Rules of this
type can be used to calculate student results for a specific academic item and result type.

« SSR_PE EVAL STATUS:

This rule type is linked to the Rule Group Academic Progress Tracker Item (version 1.1). Rules of this
type can be used to evaluate the APT Statuses for an academic item within the student's APT. Only
academic item types associated against this rule type can be used in APT Status Evaluation rules in
the APT Administrative Roster.

See Program Enrollment Activity Management (PEAM) Documentation in My Oracle Support (ID
1400723.1).

» Using the Rules Engine for Program Enrollment Student Self-Service: System/Example Data

» Using the Rules and Engine for Program Enrollment Calculation and Evaluation: System/Example
Data

Related Links

Assigning Rules and Result Types to Academic Items
“Understanding the Rules Engine” (Campus Community Fundamentals)

“Setting Up the Rules Engine” (Campus Community Fundamentals)

Associating Rule Types with Execution Events

Execution Event rule types determine how and when the Rules Engine is invoked in Program Enrollment,
by tying rule types to a specific action that a user might take in the delivered User Interface. The
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PeopleCode event referenced in the Execution Event definition is a pointer to the code that invokes the
Rules Engine when the action occurs, such as user a clicking a button in the User Interface. Each event in
turn can invoke certain rule types, each of which can be set to active or inactive.

See the Using the Rules Engine for Program Enrollment Student Self-Service: System/Example Data

document in My Oracle Support (ID 1400723.1).

Access the Program Enrollment - Execution Event Rule Types page (Set Up SACR > Product
Related > Student Records > Program Enrollment > Execution Event Rule Types).

This example illustrates the fields and controls on the Program Enrollment - Execution Event Rule Types
page. You can find definitions for the fields and controls later on this page.

Execution Event Rule Types

*Status I Active - I

Execution Event SSR_PE_WVAL_PLAMMER = System Data

*Description |r‘.fIEF| Validate Planner

PeopleCode Event FieldChange
Menu Name SSR_PROG_ENRL_SS
Component Name SSS_PE_SS_PLNR
Page Name S55_MEP
Record (Table) Name SSRE_MEP_WRK
Field Name SSR_FB_WALIDATE

7' " Run All Rules

3 SSR_PE_ITEM_PRECOND

Event Description [Stydent Self-Service My Education Plan - AuditValidate button: d@@
this event executes when a user clicks the AuditValidate bution.
The validation orocess acts on the Plannina node selected in the Ll

PE Self-Service
My Education Plan

My Education Plan

Validate / Audit

1 SSR_ACE AIR Connector Engine

2 35R_PE_COURSE_REQ Course Requisite

Academic ltem
Precondition

Personalize | Find | View Al | El First 4] 1-30f3 n Last

Field or Control

Description

System Data

This check box displays for Execution Event Rule Types
definitions delivered by Campus Solutions Development. See
further information below.

Status

Campus Solutions Development events are delivered as
Inactive. Events must be Active for Rules Engine invocation to
occur.

Copy

This button is available only when you add a new execution
event. The copy feature provides a prompt against all
execution events defined in the system, including those for
which the System Data check box is selected. (see below).
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Field or Control

Description

Delete When an execution event is saved successfully, a Delete button
is available (Delete is not available for execution events for
which the System Data check box is selected).

PeopleCode Event Select a value: Field Change, Field Edit, Save Edit, or Save

Pre-Change. The event selected here documents where

the trigger PeopleCode that invokes the Rules Engine is
called from by the component processor. In most cases, and
specifically for the delivered self-service execution events, the
PeopleCode event is Field Change.

Menu Name, Component Name, Page Name and Field Name

These fields are used to document the actual page/field
location where the execution event occurs.

Run All Rules

Copyright

When this check box is deselected, rule execution stops when
the first error is encountered. For example, if a student adds
three courses to their planner in self-service and each of those
courses has a Course Requisite rule attached to them, and the
student fails the first requisite, an error is returned for the first
requisite but the other two requisite rules are not checked. If
the Run All Rules check box is selected, all three rules are
executed.

Rule Types Grid

Use this grid to indicate which types of rules should be executed when the triggering event occurs.

Field or Control

Description

Rule Type

Prompts against the Program Enrollment - Rule Type table.

Process Entire Rule

This check box determines whether the entire rule (of this
type) is executed when it is invoked for this event. For
example, if a Course Requisite rule requires successful
completion of Course A and Course B and the Process Entire
Rule check box is selected, the Rules Engine checks to see if
both conditions are satisfied and can return the results of both
parts of the rule to the User Interface (for example, Course A
was not satisfied but Course B was satisfied). Otherwise the
Rules Engine executes the rule until the first error condition.
Using the same requisite example, processing stops when the
Course A component of the rule fails.
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Field or Control Description

Rule Execution Error Handling Determines whether a rule type is applicable to a certain event

and — if it is applicable — whether the user or process can
proceed with a task (or system process) if the called rule(s)

return errors or failure. Select from:

*  Obey: If error/failure is returned by the called rule, the
user cannot proceed; record would not be processed in a

batch process.

*  Warn: If error/failure is returned by the rule, the system
returns a warning message, but the user/process can

continue.

*  N/A (not applicable): Rules of this type are not invoked
for this event.

Status Determines whether a rule type is active for a particular event.

If the status is Inactive, rules of this type are not executed.

Delivered Execution Event Type Definitions

The following Execution Event Rule Type definitions are delivered. These events are tied specifically
to the My Education Plan and Scheduler Builder components to enable invocation of both Rules Engine
based rules and the AIR Connector Engine.

See the Using the Rules Engine for Program Enrollment Student Self-Service: System/Example Data
document in My Oracle Support (ID 1400723.1).

Note: The trigger code for these execution events has been added only for the PeopleCode events
specified in the definition (FieldChange).

SSR_PE UPD PLANNER - My Education Plan Update Planner

If active, this event executes when a user clicks the Update Planner button on the student self-service
My Education Plan component. The Update Planner button saves any course selection if all validation
(including Rules Engine validation) logic is satisfied. Only those rule types with a status of Active are
executed. The following rule types are tied to this event:

« SSR PE COURSE REQ - Course Requisite

* SSR PE ITEM PRECOND - Academic Item Precondition

SSR PE VAL PLANNER - My Education Plan Validate Planner

If active, this event executes when a user clicks the Audit/Validate button on the student self-service
My Education Plan component. The validation process acts on the Planning node selected in the
component. All rules for the planning node and its child items are invoked if they are of a rule type
that is valid for this event. Only rule types with an Active status are executed. The following rule types
are tied to this event:
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* SSR_ACE - AIR Connector Engine
* SSR PE COURSE REQ - Course Requisite

* SSR PE ITEM PRECOND - Academic Item Precondition

SSR_PE_AUD_SCHD - Schedule Builder Audit

If active, this event executes when a user clicks the Audit button on the student self-service Schedule
Builder component. The Audit button invokes validation logic (including Rules Engine Validation)
and return messages to the user if error conditions are found. Only those rule types with a status of
Active are executed. The following rule types are tied to this event:

* SSR_ACE - AIR Connector Engine

« SSR PE COURSE REQ - Course Requisite

SSR_PE _ENRL SCHD - Schedule Builder-Enroll in Classes

If active, this event executes when a user clicks the Enroll in Classes button on the student self-
service Schedule Builder component. The Enroll in Classes button saves class selections and invokes
validation logic (including Rules Engine Validation) for the current (enrollment) term node and takes
the user to the next step of the enrollment process. The rule invocation applies to all APT items for the
term node, meaning that any rules attached to non-course items can be invoked.

» Ifno errors or warnings are returned, the user is transferred to a confirmation page where they can
confirm their class selections before submitting,.

» Iferrors or warnings are returned, the user is first transferred to a results page, where errors and
warnings are listed by item.

» Ifat least one class selection is error free (that is, the associated APT course item or parent item
passed validation) a continue button is available and the user can proceed to the confirmation step:
Class selections where the validation for the associated APT course item (or parent items) failed
is not included on the confirmation page.

Only those rule types with a status of Active are executed. The following rule types are tied to this
event:

* SSR_ACE - AIR Connector Engine
« SSR PE COURSE REQ - Course Requisite

* SSR PE ITEM PRECOND - Academic Item Precondition

SSR PE ENRL SCHD_CAL - Schedule Builder Calendar view-Enroll in Classes

If active, this event executes when a user clicks the Enroll in Classes button on the student self-service
Schedule Builder Weekly Calendar view page. Although rule types for this event can be configured
differently, the behavior associated with it mimics that for the Schedule Builder Enroll in Classes
button (see above). Only those rule types with a status of Active are executed. The following rule
types are tied to this event:
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* SSR_ACE - AIR Connector Engine
* SSR PE COURSE REQ - Course Requisite

* SSR PE ITEM PRECOND - Academic Item Precondition

Related Links

“Using Program Enrollment Self-Service Features” (Campus Self Service )
“Understanding the Rules Engine” (Campus Community Fundamentals)
“Setting Up the Rules Engine” (Campus Community Fundamentals)

Setting Up Program Formats

This section provides an overview of program formats and discusses how to define program formats.

Understanding Program Formats

Program Format determines the structure of a Program of Study. In AIR, program format applies
specifically to an academic item that has a type of Program of Study (PRG).

The inherent flexibility of the AIR structure means that different institutions define their program
hierarchies in different ways. You must therefore define frameworks to assign to the programs for your
particular institution. The system then uses that framework to impose a template on a PRG academic item.

The Program Format:

» Identifies those levels (or nodes) of a program that equate to a year of program (or level, stage).
* Identifies the levels that equate to term (STRM) value for enrollment purposes.

* Provides the basis for a template for building a program of study.

See Building Programs by Format

Page Used to Set Up Program Formats

Page Name Definition Name Navigation Usage

Program Format SSR_ PROG FORMAT Set Up SACR > Product Define program formats.
Related > Student
Records > Program
Enrollment > Program
Format > Program
Format
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Defining Program Formats

Program Format definitions are created by Institution, with a user defined Format ID. The program
format is created by assigning a tree node ID to the academic items that are used to build a program of
study. Because this format represents the structure or framework of a program of study, it uses only those
academic items that have been identified as Program Format Tree Nodes.

Note: If you built out Program Formats in your environment before January 2012, you must adjust your
Program Format definitions after you apply the January 2012 updates. In order to use the APT Activation
process, you must enter a Planning Node Item Type value here on the Program Format page. (See the
description of the Planning Node Item Type field for further information.)

If you built out Program Formats in your environment before October 2012 using the add session level
property, you must adjust your Program Format definitions after you apply the October 2012 updates.

Access the Program Format page (Set Up SACR > Product Related > Student Records >
Program Enrollment > Program Format > Program Format).
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This example illustrates the fields and controls on the Program Format page. You can find definitions for

the fields and controls later on this page.

Program Format

Institution PeopleSoft University UK
Format ID  Uk-2vYR-SEM-FRG

- ltem Type Usage

Planning Hode YEAR

*Description |3 Yt Programme with Semester

ear
Year of Program YEAR Year
Equates to Term YEAR Year
Add Session Level
Session SEMESTER Q. semester

[1]

* Date Controls

Student Planning Term/Session Table

* Tree View
10 - Programime of Study

" 20- Year 1

~ 25- Gernester |
) a0- Sernester 2
" 35-Year 2

“ 40 - Sermester |
) 45 - Semester 2
" 50- Year 3

""" 55 - Semester 1
B0 - Semester 2

*NodelD | 10

Academic tem Type FPRG

First B0 4 f 10 O Last
(=]

Frogramm of Study

*Description |Pr0gramme of Study

Save and RefreshTree

The Planning Node Item Type, Year of Program Item Type, and Equates to Term Item Type fields all
prompt against the Item Type Matrix (SSR_ITEM_CHILD) table for item types for which the Program
Format Tree Node check box is selected in the Academic Item setup component.

See Identifying Child Item Types and Syncing Entities

See Setting Up Academic Item Types
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Field or Control

Description

Planning Node

Enter a value to indicate which node of the Program Format
definition should be used for APT Activation purposes. If,
for example, the Planning Node Item Type is Phase, this
indicates that a student is allowed to plan and enroll by Phase
—the Activate icon is available at the Phase level in APT as
the student progresses through a program. If a Planning Node
Item Type is not entered, the entire program is available for

planning and enrollment.

See Managing APT Items

Year of Program

Enter a value to identify this item type as the one that is used
to map to Year Of Program in the Program Format tree, where
the program is constructed of a number of units which are
completed in a number of years. You cannot select PRG item
type for this field.

Equates to Term

Enter a value to indicate that the node is used to map to

a Campus Solutions Term (STRM) value for enrollment
purposes. This flag is used for Enrollment Cohort purposes.
You cannot select PRG item type for this field.

See Setting Up Enrollment Cohorts

See Managing APT Items

Add Session Level

If you select this check box, you are prompted to enter
a session academic item. Enrollment cohorts attached to
this program format can be mapped to term and session
combinations, using the Session field on the Program

Enrollment Cohort page.

Note: If you use session level, the Equates to Term Item Type
must be mapped to a term and session combination.

See Setting Up Enrollment Cohorts

See Managing APT Items

Session

Enter a value for an academic item type that represents a
Campus Solutions Session in your program format. This might
be used if you have configured your Campus Solutions Term
values to represent an academic year within which Campus
Solutions Sessions represent your actual terms, semesters or

some other component of an academic year.
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The Date Controls setup is used in student self service.

Field or Control Description
Student Planning When you add a new program format definition, you must
specify whether Student Planning is controlled by the

Academic Period Table or the Term/Session Table.

Note: When the item type values in the Planning Node and

Equates to Term fields are the same, the system sets the

Student Planning period value to Term/Session Table and grays

the field. When these values are not the same, users can select

Academic Period Table or Term/Session Table, but this value

cannot be changed after the component is saved.

*  Academic Period Table: Student planning is subject to
the start and end dates of an Academic Period for which
the Period Type is Planning Period. When you select
this option, the Planning Period field is available on the
Enrollment Cohort page for those cohorts based on this on
this program format.

See Defining Academic Periods
See Setting Up Enrollment Cohorts

»  Term/Session Table: Student planning is subject to the
dates in the Display in Self-Service group box on the
Term Table page. If the program format includes session
level, planning is subject to the dates in the Program
Enrollment Controls group box on the Session Table page.
See “Defining Terms, Sessions, and Session Time
Periods” (Campus Solutions Application Fundamentals)

Tree View

The tree view provides a tree representation of the node structure that you enter at the Node ID scroll
level—see the example page above. Each node in the tree links to the node definition that it represents.
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Field or Control

Description

Node ID

Enter a node ID. The lowest Node ID value must have an
Academic Item Type value of PRG. Node IDs for successive
(child) nodes must increment. For example, a Program Format
with three nodes, such as Program, Stage and Study Period
could use 10 for Program, and then numbers starting at 1000
for the Stage nodes - for example 1000, 2000 and 3000. The
child Study Period nodes could then number within each
range (for example 1100, 1200 for Study Periods within the
first stage).

Parent Node ID

Enter a parent node ID. The value that you enter here must
already exist as a node ID. For example, if you previously
added a Node ID of 100 for Academic Item Type PRG, then if
you enter a Node ID of 200 for Academic Item Type STAGE,
you can assign it a Parent Node ID of 100 to indicate that 200
(STAGE) is a child node of 100 (PRG).

Academic Item Type

Select an academic item type. This field prompts against a
view of the Item Type Matrix table (SSR_ITEM_CHILD) for
items that are defined as Program Format Tree Nodes.

See Identifying Child Item Types and Syncing Entities

See Setting Up Academic Item Types

Node IDs that have the same parent node ID must share the
same academic item type: the value appears by default in

the field and is not available for edit when this is true. For
example, if you add Node ID 200 for Academic Item Type
STAGE with a Parent Node ID 100 (PRG), then, when you
add Node ID 300 with a Parent Node ID of 100, the Academic
Item Type of STAGE is automatically assigned to Node ID
300.

Setting Up AIR Administrator Security

It is useful to read this section in the context of these other sections in the document:

o Setting Up Program Formats (earlier in document).

* Setting Up Academic Item Registry Entries, Item Details, and Item Security (later in document).

e Building Programs by Format (later in document).

A Program Format definition provides a framework for building academic requirements in the Academic
Item Registry. Program Format provides a template for building programs in a prescribed way, using the
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Build Program by Format component. This component is the main tool for defining programs of study
using academic items that are defined in the Academic Item Registry.

The majority of users will use the Academic Item Registry component primarily to build the content that
is compiled into a program of study using the Build Program by Format component. For this reason, the
use of Program Format node academic items is restricted in the Academic Item Registry component, so
that most users can assign only non-Program Format Tree node items as children of other items. This
prevents deviation from authorized program structures.

Exceptions to program formats can be made only by users who are authorized as Academic Item Registry
Administrators.

Warning! We recommend that any exceptions be given careful consideration and testing as an exception
to an established hierarchy may not be supported in the various processes and user interfaces that use the
program format definition for validation and formatting purposes.

Page Used to Set Up AIR Administrator Security

Page Name Definition Name Navigation Usage
Academic Item Registry SSR_AIR OPR_SCRTY Set Up SACR > Secure Set up AIR administrator
Admin Student Administration > | security.

User ID > Academic Item

Registry Admin

Setting Up AIR Administrator Security

306

Access the Academic Item Registry Admin page (Set Up SACR > Secure Student Administration >
User ID > Academic Item Registry Admin).

This example illustrates the fields and controls on the Academic Item Registry Admin page. You can find
definitions for the fields and controls later on this page.

Academic ltem Registry Admin

User ID; Ps Locherty Betty

*Academic Institution

PSUNY L PeopleSoft University [=]
GLAKE ) GreatLakes University [=]

AIR Administrator security is based on User ID.

Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 7 Setting Up Program Enroliment

Field or Control Description
Academic Institution Select the institution to grant administrator privileges for this
user ID.

AIR Administrator privileges apply to the Academic Item Registry component only. When User ID: PS
adds child items to an Academic Item in the Academic Item Registry component the prompt shows all
authorized child items, including those items identified as Program Format tree nodes.

See Setting Up Program Formats

See Setting Up Academic Item Registry Entries, Item Details, and Item Security

See Building Programs by Format

Setting Up Enroliment Cohorts

This section provides an overview of enrollment cohorts and discusses how to define program enrollment
cohorts.

Understanding Enroliment Cohorts

The AIR feature allows you to define programs without regard to term, using stages or years for example.
For enrollment purposes, the requirements that a student must take for a phase, year, or stage (or whatever
type of item designation might be used) must be mapped to a Campus Solutions term (STRM). The
Enrollment Cohort feature provides this link, attaching a student to a list of terms (beginning at the
student’s admit term) that follows the outline of the student’s program of study. The Enrollment Cohort
uses the Program Format definition to produce a term-based enrollment map for a cohort of students
(based on admit term) and is assigned to a student on matriculation.

Page Used to Set Up Enroliment Cohorts

Page Name Definition Name Navigation Usage

Program Enrollment Cohort SSR_PE COHORT Set Up SACR > Define enrollment cohorts
Foundation Tables > Term
Set Up > Enrollment
Cohort > Program
Enrollment Cohort

Defining Enroliment Cohorts

Access the Enrollment Cohort page (Set Up SACR > Foundation Tables > Term Set Up >
Enrollment Cohort > Enrollment Cohort).
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This example illustrates the fields and controls on the Enrollment Cohort page. You can find definitions

for the fields and controls later on this page.

Enroliment Cohort
Academic Institution PeopleSoft University
Academic Career Undergraduate
FormatID 1YEAR MURSING 1 Year Mursing Certificate
Category
=]
*Description |sasd
Term Categories to Include
Term Category
1 [ Regular Term v| [ [=
Refresh Term Prompts
Criteria Find | View All First ‘&' 1of1 ‘&' Last
*pcademic Load|- Full-Time v Cohort Tag Q [+][=]
*Cohort Term | 0630 |Q_ 2009 Fall
Generate
Schedule Personalize | Find | & E First ‘4 1.30f3 '} Last
*SeqNbr *NodeID Node Description *Term Term Description
100 30/@  Semester 1 Nursing 0630 |@ 2009 Fall # =
200 40/ Semester2 Nursing 0631 |@ 2009 Year [+ =
300 50|Q Nursing Summer Session 0632 |Q 2009 Fall Qtr =

Enrollment Cohort definitions are created by Institution, Career, which enables prompting for term values
(because terms are created by Institution and Career) and Program Format ID.

Field or Control

Description

Term Category

The Term Category values that you select here determine
which terms are available for use by the Generate function.
See information about the Generate function later in this
section.

Academic Load

Enrollment cohorts are assigned by academic load. You must
enter at least one Acad Load value. The same enrollment
cohort can be used for different academic loads. For example
if a 3 year program is completed over six terms, and the
requirements for a part-time version of that program can

be easily distributed over more terms, for example, twelve,
you could use the same enrollment cohort. However, if the
enrollment pattern is markedly different depending on a
student’s approved academic load, it would be more practical
to create distinct program formats and enrollment cohorts for
each possible academic load configuration.
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Field or Control

Description

Cohort Tag

Use this field to assign different versions of the same
Academic Load/Cohort Term to different students.

This feature might be used when an institution uses a

Term value to represent an academic year, and the terms or
semesters that constitute the academic year are represented as
sessions on the Session Table. A Cohort Tag could be assigned
for each session to which students are admitted.

The values available here are defined on the Academic Cohort
Table page for the Institution/Career combination.

See “Defining Academic Cohorts for Program Enrollment”
(Campus Solutions Application Fundamentals)

Cohort Term

The value that you select here represents the first term of
enrollment for this particular cohort. For example a cohort
admitted for a 3 year program beginning Fall 2010 would have
a Cohort Term equal to the term value Fall 2010, 0670.

Generate

The generate function provides a quick way of assigning term
values to a particular program format framework. The process
works as follows:

*  Selects all Node IDs that are attached to a Program
Format ID where the Equates to Term field on the
Program Format page indicates that the node will be used
to map to a Campus Solutions Term value for enrollment
purposes.

*  Using the Cohort Term value, selects all Term (STRM)
values from the TERM_TBL (using the Institution and
Academic Career values). If Term Categories have been
entered, the selection is narrowed to include only those
terms that meet the criteria.

*  The number of terms selected depends on the number of
Equates to Term nodes in the Program Format definition.

» Inserts a row in the grid for each Equates to Term node,
where the first node term value equals the Cohort Term
value.

*  The term value for each subsequent row is the next
highest term value from the previously selected list of
TERM_TBL.STRM values.

*  When no terms match the term categories selected,
you receive an error message and the Term grid is not
populated. This message (Message Catalog entry 14731,
95) is delivered with a severity of Error. If the installation
chooses to change this to Warning the message is
displayed and the grid is populated with the Program
Format Tree Nodes.

See Managing APT Items
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Field or Control Description

Seq Nbr (sequence number) Enter a user defined sequence number for ordering the term
TOWS.

Node ID Select a node ID to map to a term. The values available are
based on the Node IDs that you set up on the Program Format
page.

A node can be mapped to one or more terms.

Multiple nodes can be mapped to the same term.

Session This field is available if the Add Session Level check box is
selected and a Session academic item type has been entered on
the Program Format page.

Planning Period This field is available when the Program Format (on which the
Enrollment Cohort is based) uses the Academic Period Table
for Student Planning Date Controls.

See Setting Up Program Formats

The default value is Always Open. To display other values, the
system uses the Institution/Career of the enrollment cohort and
lists all academic periods with a type of Student Planning for
which the academic period end date is greater than the system
date.

Setting Up Enroliment Categories for Program Requirements

This section provides an overview of enrollment categories and discusses how to define enrollment
categories.

Understanding Enroliment Categories

Enrollment Categories are user defined codes that determine how academic items (courses or other items)
are represented and seeded in a student APT record. In student self-service, Enrollment Category also
determines the actions that students can take in relation to an individual course, such as whether can they
can add or remove it from their schedule builder or whether they can drop once enrolled.

310 Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 7 Setting Up Program Enroliment

Page Used to Set Up Enroliment Categories for Program Requirements

Page Name Definition Name Navigation Usage

Enrollment Category SSR_ENRL CAT Set Up SACR > Product Define enrollment categories.
Related > Student
Records > Program
Enrollment > Enrollment
Category > Enrollment
Category

Defining Enrollment Categories

Access the Enrollment Category page ((Set Up SACR > Product Related > Student Records >
Program Enrollment > Enrollment Category > Enrollment Category).

This example illustrates the fields and controls on the Enrollment Category page. You can find definitions
for the fields and controls later on this page.

Enroliment Category

Academic Institution P3LMNY PeaopleSoft University

Find | Wiew All First n 10f3 u Last

*Enrollment Category |[ELEC [=]

*Description |Electives

*Short Description | Electives

[ | Automatically move to APT
D Auto-request Cart/Enroliment

Student Self Service Access

Allow Add/Remove from APT
Allow Add/Remove from Cart
Allow Class Drop
Field or Control Description
Automatically move to APT If you select this check box, academic items with this

enrollment category are moved to a student’s APT instance
during the APT seeding process.

See Managing APT Items
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Field or Control

Description

Auto-request Cart/Enrollment

If you select this check box, courses with this enrollment
category are available for selection by the process which
builds enrollment requests/schedule builder entries for groups
of students.

Student Self Service Access

Select check boxes to allow students to perform various
enrollment functions in Self Service.

See “Using Program Enrollment Self-Service Features” (Campus Self Service )

Setting Up Result Types

Due to the flexible nature of AIR based program requirements, you must define the level at which you
track unit and credit totals for example, and also, the type of data that you want to track at those levels.
The Result Types feature provides you with the means to build these student data profiles, to define the
type of data to be tracked (for example, Total Enrolled Credits, Total Completed Credits) and the format

of that data.

This section discusses how to define result types.

Note: The Result Type design is still being finalized and some components of this feature are planned for

the future.

Page Used to Set Up Result Types

Page Name

Definition Name

Navigation Usage

Result Type

SSR_RESULT TYPE

Set Up SACR > Product Define result types.
Related > Student
Records > Grading >
Result Type.

Defining Result Types

Access the Result Type page (Set Up SACR > Product Related > Student Records > Grading >

Result Type).
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This example illustrates the fields and controls on the Result Type page. You can find definitions for the

fields and controls later on this page.

Setting Up Program Enroliment

Result Type

Result Type STAGE_WGHT_AVG

"Effective Date 01/01/1900 [3

*Description Weighted Average for Stage of Program

"Short Description W._ Average - Stage

“Result Value Field Type | Frae-form Text

v

“Institution

| Associated Academic Institutions

status [cive ]

[ system Data

PeopleSoft University hd

Add Institution

& Print in Transcript

& show in Student Self-service

Calculation Rule 1D

| Stage of Program

| [SCC_RULE_ID_20140401143152

Add Academic em Type

Calculate Stage
@, Weighted
Average

Result Types are defined by Institution.

Field or Control

Description

System Data

For future use.
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Field or Control

Description

Result Value Field Type

Determines which fields are available for entry on the page,
and, when the Result Type is applied to an APT attempt, which
fields are available for entry in APT.

See Using Item Attributes to Extend AIR Data Elements

Values are:

*  Free-form Text: A 50 character description field. This is
the default value.

»  List of Valid Values: The Valid values for this Result Type
grid becomes available.

*  Numeric: The Integer Positions and Decimal Positions
fields become available.

*  Result Scale: Enables the Result Scale field in the
Associated Academic Institutions grid. Use the Result
Scale table (SSR_RES MAP_TBL) to define the rules for
a set of scores or results for use in Activity Management
and for use with a Result Type in APT. The result scale
can specify a valid range/format, and map scores/marks to
a grade.

See Setting Up an Activity Management Framework

»  Table Validation: The Record (Table) Name field
becomes available.

»  Translate Tuble Validation: The Field Name field
becomes available.

Valid values for this Result Type

Available when the Result Value Field Type is List of Values.

Result Value: The values that you define here appear in the
Result prompt in an APT attempt.

See Managing APT Items

Integer Positions

Available when the Result Value Field Type is Numeric.

Controls the number of digits before the decimal for Numeric
attribute types.

Decimal Positions

Available when the Result Value Field Type is Numeric.

Controls the number of decimal places available for Numeric
attribute types.
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Field or Control Description
Record (Table) Name Available when the Result Value Field Type is Table
Validation.

Prompts against a view listing all tables where there is:
*  Asingle key or

*  Records with two keys where the second key is Effective
Date (EFFDT) or

*  Records with two keys where the first key is either
INSTITUTION or SETID or

*  Records with three keys where the first key is either
INSTITUTION or SETID and the third is EFFDT.

Field Name Available when the Result Value Field Type is Translate Table
Validation.

Prompts against the PSXLATTABLE.

Updated by Activity Management, Display in Self Service and Print in Transcript fields are planned for
future use.

Associated Academic Institutions

Use the Associated Academic Institutions grid to enable a result type for one or more institutions and to
assign a result scale if the Result Value Field Type is Result Scale. When an Institution and Result Scale
combination is defined, the specified result scale is used to validate entries for this result type.

Field or Control Description

Institution Select an institution.

Result Scale If the Result Value Field Type value is Result Scale, the Result
Scale field is available and lists all active result scales for this
institution.

Default You must select a default result scale if more than one result

scale is entered for the same institution. The default is used
when a result (for this result type) is manually entered on the
Academic Progress Tracker component.
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Item Type Usage

Field or Control Description

Academic Item Type Select the academic item types to which this result type can be
attached in AIR.

Calculation Rule ID Select a Calculation Rule ID to be used for the select item

type. The prompt returns rules that meet the following criteria:

*  The rule must be associated with a rule type for which
the APT Usage is Result Calculation. Note that rules are
associated with a rule type based on their rule group.

See Setting Up Rules for Program Enrollment

*  The rule type must also be attached (again, via the rule
group) with the delivered Rule Category APT Functions.

In My Oracle Support (ID 1400723.1), see:

»  Using the Rules Engine for Program Enrollment
Student Self-Service: System/Example Data

»  Using the Rules and Engine for Program Enrollment
Calculation and Evaluation: System/Example Data

Auto-create in AIR When you select this check box, an AIR Result Type row is
created each time that a user adds a new academic item of this
type in AIR.

Content Type Usage

Field or Control Description

Content Definition Currently Coursework is the only delivered Content
Definition.

Academic Content Type Select the academic content type to which this result type can
be attached in Activity Management.

Auto-Create in AM This check box is planned for future use.

See Setting Up Academic Item Registry Entries, Item Details, and Item Security

See Setting Up an Activity Management Framework
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Setti

ng Up Academic Item Registry Entries, Item Details, and Item

Security

Unde

Copyright

This section provides an overview of AIR entries and discusses how to:
* Access the AIR component: AIR Search.

* Define AIR entries.

» Use item attributes to extend AIR data elements.

* Use item attributes in AIR.

* Assign item attributes to child academic items.

* Define academic item details.

*  Assign rules and result types to academic items.

* Maintain AIR rich text fields.

* Define academic item security.

*  Manage Special Edits in AIR for COURSE, COURSEGROUP, and COURSELIST Academic Items.

* Use the Academic Item Registry Copy Function.

rstanding AIR Entries

Use the Academic Item Registry (AIR) component (SSR_PE AIR) to define Academic Item Registry
entries, item details, and security.

The Academic Item Registry allows you to define all the various parts of a program offering—courses,
lists of courses, milestones, years, stages—and to connect those parts into an overall program template.
The data defined in this template is then available to all types of users, from prospective students,
applicants, and students, to advisors, faculty, and administrators. Hierarchies are built using parent/child
relationships. Within the hierarchies, each item can have its own parameters (for example, total number
of credits, minimum result) that define how any child items are used in determining an outcome/result for
the item.

Note: To prevent deviation from authorized program structures, most users can assign only non-Program
Format Tree node items as children of other items in AIR. Exceptions to program formats can be made
only by users who are authorized as Academic Item Registry Administrators.

See Setting Up AIR Administrator Security

Effective Dates in AIR

The academic item elements (child academic items) of an academic item must have an effective date
that is less than or equal to the item itself. For example, you set up 3 COURSE items with the following
effective dates:
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¢ Course 1: 01/01/1900
¢  Course 2: 01/01/2000

*  Course 3: Today’s date

Chapter 7

A STUDYPERIOD item with an effective date of 01/01/1900 can use only Course 1 as a child item.

A STUDYPERIOD item with an effective date of today’s date can use all three courses as child items.

Course Academic Iltems

You can create course academic items here in the AIR component. Alternatively, you can use the

SSR_CRSE_AIR batch process in the Create Course Academic Item component to create academic items
for multiple courses at the same time. You can then use the AIR component or the Course Academic Item
(SSR_CRSECAT_AIR) component to add individual courses as needed.

SeeCreating Academic Items for Courses

Pages Used to Set Up Academic Item Registry Entries, Item Details, and

Item Security

Page Name

Definition Name

Navigation

Usage

AIR Search

SSR_AIR_SRCH MAIN

Curriculum

Management > Academic
Item Registry > Academic
Item Registry (AIR) >
Search

Access the Academic Item
Registry.

Find References

SSR_AIR_SRCH_REFS

Curriculum

Management > Academic
Item Registry > Academic
Item Registry (AIR) >
Find References

Find out where a particular
academic item ID is being

used in the Academic Item
Registry.

AIR Search component.

Academic Item Registry SSR_AIR Access this page from the Define AIR entries.
AIR Search component.
Item Details SSR_AIR DTL Access this page from the Define academic item type

details

Element Parameters

SSR_AIR ENPARM SEC

Click the Element Parameters
link on the Item Details page.

View and update parameters

Rules / Results

SSR_AIR_RULE

Access this page from the
AIR Search component.

Assign rules and result types
to academic items.
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Page Name Definition Name Navigation Usage
Rich Text Fields SSR_AIR DESCR Access this page from the Maintain AIR Rich Text
AIR Search component or: enabled fields.
Click the Report Description
link on the Academic Item
Registry page.
Click the Instructions link on
the Item Details page.
Click the Rule Report
Description link on the Rules /
Results page.
Security SSR_AIR _SCRTY Access this page from the Define academic item
AIR Search component. security.

Accessing the Academic Item Registry Component - AIR Search

A custom search component is used to access the AIR component (Curriculum Management, Academic
Item Registry, Academic Item Registry (AIR)). You can perform targeted searches to retrieve existing
items and also use the Find References feature to see whether a particular academic item is referenced
by another item. For delivered academic item types, item type specific fields are provided for additional
search criteria. The following example shows fields available for item type COURSE.

Access the AIR Search page (Curriculum Management > Academic Item Registry > Academic
Item Registry (AIR) > Search)).

Copyright © 1988, 2023, Oracle and/or its affiliates.

319




Setting Up Program Enroliment

320

Chapter 7

This example illustrates the fields and controls on the Academic Item Registry Search page. You can find
definitions for the fields and controls later on this page.

Add a New Value

From 01/01/1900

*Academic Institution PSUNY

Academic Item Type
Academic Item ID

Description

Internal Description

Academic Item Attribute

Academic Organization

Find an Existing Value Find References

To 06/16/2021 |[#)
Q, PeopleSoft University
Q
Q,

Add New ltem

Je

Rezet

Field or Control

Description

Saved Search

Prompts against saved searches for the user.

Delete

Deletes the saved search selected in the Saved Search field.

Academic Institution

Select the institution value for the search or to add a new
academic item.

Academic Item Type

Select the academic item type for the search or to add a new
academic item.

Academic Item ID

Select an academic item ID.

Description

Enter all or part of an academic item description. The system
uses this value to search against the AIR description field.

Internal Description

Enter a searchable Internal Description.

Academic Item Attribute

Enter an academic attribute to search by. The system uses this
value to search against academic item attributes attached to
academic items.
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Field or Control

Description

Academic Organization

Enter an academic organization. The system uses this value
to search against the academic organization values attached to
academic items.

Format ID and Available to Assign

This field and check box are available when the search
Academic Item Type value is PRG (Program).

Subject and Catalog Nbr These fields are available when the search Academic Item
Type value is COURSE.
Course Group ID This field is available when the search Academic Item Type

value is COURSEGROUP.

Course ID Course Offering Nbr and Course Topic ID

These fields are available when the search Academic Item
Type value is COURSE.

Course Component

This field is available when the search Academic Item Type is
COMPONENT.

Milestone This field is available when the search Academic Item Type is
MILESTONE.

Search Launches a search against the Academic Item Registry using
the specified criteria.

Reset Clears the search criteria.

Add New Item Academic items are created by Institution and Academic Item

Type. You must enter these values on the search page to add a
new item.

Save Search As

Provide a name for the search criteria. The system saves these
criteria to the database under the User ID of the user.
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Search Results

The system returns a list of academic items matching the search criteria. The results grid can be used to
retrieve a selected item in the Academic Item Registry component or to search for references for that item
by other academic items.

Personalize | Find | View All | IEII : Fir.lstll 1-20 of 73 o Last
[temid ~  [Deseripon =~ [  FindReferences
1 00000000614 LAW 620: Econ Anly Law (o)
2 00000000567 ECOMN 110: International Economics 63
3 00000000559 ECOM 100: Macroeconamic Analysis (o)
4 00000000545 ECOM 312 Intership Applied Economics [aa)
5 00000000544 ECOM 311: Independent Study 63
6 00000000543 ECOM 310: Directed Readings 63
¥ 00000000542 ECOM 230 Government and Economy [aa)
8 00000000541 ECOM 224 Health Economics 63
9 00000000540 ECON 220: Labor Economics 63
10 00000000539 ECOM 217: Pol Economy of the Military 63
Field or Control Description
Item ID Click this link to access the Academic Item Registry
component.
Find References Click this icon to access the Find References page of the
search component.

Using the Find References Page

Use the Find References page to find out where a particular academic item ID is being used in the
Academic Item Registry.
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This example illustrates the fields and controls on the Academic Item Registry Find References page. You
can find definitions for the fields and controls later on this page.

Search '_ Find References

*Academic Institution PSUNV Q PeopleSoft University

Academic Item ID 00000000529

Find

Q ECON 112: Intl Political Economy

Personalize | Find | L First (4] 1-20f 2 ) | Last

| |ParentitemID  |Parent item Type Reference Hierarchy

{PRG - 00000001752)B A Economics >
{PHASE - 00000001754} B.A Economics Part| =

1 00000001757 STUDYPERIOD {STAGE - 00000001755} BA Econ - Year 1 >
{STUDYPERIOD - 00000001757} BA Econ- Year 1 -
Semester 2

2 00000001804 STUDYPERIOD {STUDYPERIOD - 00000001804}BA Econ - Year 1 -
—_— Semester 2

Field or Control Description

Parent Item ID Click this link to view the AIR item for which the selected
item is an immediate child item.

Parent Item Type The Academic Item Type value of the parent item.

Reference Hierarchy Displays a representation of the AIR based free in which the
Parent Item ID exists. The system displays the data as follows:
{Academic Item Type/Academic Item ID} Academic Item
description.

Accessing an Existing Item in the Academic Item Registry

Existing academic items in the AIR component are always retrieved using search results. When an item
is retrieved, your page security determines the mode in which you access the component. For example if
you have Update/Display access only, you cannot access historical rows. Once you are in the Academic
Item Registry component, you can:

* Click OK to save changes and return to the Search component.
* Click Cancel to return to the Search component without saving changes.

* Click Apply to save changes and continue working with the same academic item in the Academic
Item Registry component.
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Adding a New Item to the Academic Item Registry

As described in the previous documentation, you add a new item by entering an Institution and Academic
Item Type value and clicking Add New Item on the Search page. Once you are in the AIR component, the
OK, Cancel, and Apply controls are available.

Defining AIR Entries

324

AIR entries are created by Institution and Academic Item Type.
The Academic Item Type definition determines which fields are available in the component.

Academic Item Type prompts against the Academic Item Type Definition table (SSR_ITEM _TYPE) for
the installation.

Access the Academic Item Registry page (access this page from the AIR Search component).
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Here is an example of the Academic Item Registry page for Academic Item Type: Program of Study.

Academic ltem Registry

Academic Item Registry || Item Details || Rules/Results Rich Text Figlds || Security

Academic Institution PeopleSoft University

Academic ltem ID 00000001720
Academic Item Type Program of Study

Find First (4 1o0of1 (k) Last

*Effective Date|08/01/2008 |[H) ~Status | Active v [+ [=]

*Description | Business Administration - Graduate
Internal Description Q.

Report Description

Degree MS &}

- Requires Approval

Available to Assign

Last Prospect Date El
Last Admit Date El
Format ID GB-2YR Graduate Business - 2 Year
Report Template Mapping Find | View All First (4 10f1 (k' Last
[+ [=]
*Report Name Q,
*Template 1D &}
Component Name Q.
Process Name Q.
ltem Attributes Find First (4) 1of1 (k) Last
[H =]

*Attribute | v

Show in Student Self-service
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Here is an example of the Academic Item Registry page for Academic Item Type: Course.

Academic [tem Registry

Academic Item Registry || Item Details || Rules / Results

Academic ltem ID 00000000003
Academic Item Type Course

*Effective Date |01/01/1900 |[5]

Course Offering Nbr 111G,

Course Topic ID &}

Internal Description

Report Description

Item Attributes

Rich Text Fields || Security

Academic Institution PeopleSoft University

*Status | Active ht

*Course 1D | 001157 Q. Art Survey

Subject / Catalog ART 101

*Description ART 101: Art Survey

[ Requires Approval

Find First 4 10f1 ([} Last

[+][=]

Find First (4) 10of1 (p) Last

[+ =]

*Attribute |

Show in Student Self-service

Go to Add to New Activity Reqgistry

Add to Existing Activity Registry

Some fields appear on this page only when a particular extension record is used. You associate extension
records with academic item types on the Attributes page (Set Up SACR, Foundation Tables, Academic

Structure, Academic Item Type, Attributes).

See Defining Academic Item Type Attributes

The Course ID, Course Offering Nbr, and Course Topic ID fields are available when the extension record
SSR_AIR H CRSE is used (associated with the delivered item type of COURSE). Course Offering Nbr
and Course Topic ID may or may not be required depending on the way that you have configured the
extension record for the COURSE academic item type.

Field or Control

Description

Academic Item ID

A system generated identifier.

326
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Field or Control

Description

Course ID

Click on the related link to access the Course Catalog
component for the Course ID. Click OK or Cancel to return to
this page.

Course Component

This field is available when the extension record SSR_AIR
H_CMPNT is used—you can define components within AIR
that can be used as child items of courses.

Course Group ID

This field is available when the extension record SSR_AIR
_H CGRP is used (associated with the delivered item type
of COURSEGROUP). Click on the related link to access the
Course Group component for the Course Group ID.

Milestone

This field is available when the extension record SSR_AIR
H_ MLSTN is used (associated with the delivered item type
of MILESTONE). Click on the related link to access the
Milestone Table component for the Milestone ID.

Internal Description

Enter a searchable description.

Report Description

Click this link to move to the Rich Text Fields page of this
component where Rich Text Editor features are available for
this for this description field.

See Maintaining AIR Rich Text Fields

Degree

This field is available if the Degree check box is selected

on the Attributes setup page for an academic item type. The
Degree attribute is typically used for a Program of Study item
that leads to a degree/certificate award. Note: Currently this
field is informational only.

Credits

This field is available if the Credits check box is selected on
the Attributes setup page for the academic item type. Enter a
credit value.

Requires Approval

Note: This check box is planned for future use.

Available to Assign

This check box appears only for Program of Study academic
item types. The check box is selected by default, indicating
that the program of study can be assigned to students. Clear
the check box if you want to build a program but not make it
available to be assigned to students.

Last Prospect Date

This field is available only for Program of Study academic
item types. Enter the last date that this PRG item can be used
for a prospect. Note: Currently this field is informational only.
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Field or Control Description

Last Admit Date This field is available only for Program of Study academic
item types. Enter the last date that this PRG item can be used
for an applicant. Note: Currently this field is informational
only.

Format ID This field is available and required only for Program of Study
academic item types.

Add to New Activity Registry and Add to Existing Activity | When the Academic Item Type is Course, this page displays
Registry links to Activity Management.

Click the Add to New Activity Registry link to access the
Activity Registry component (SSR_AC REGISTRY) in Add
mode and create a new Activity Registry entry.

Click the Add to Existing Activity Registry link to access the
Maintain Course Content Cross Reference component and add
the course to an existing Activity Registry entry.

See Setting Up an Activity Management Framework

See Understanding Activity Management

Report Template Mapping
The Report Template Mapping fields appear on the page only for Program item types.

The flexible nature of the Academic Item Registry requires that users have a way to define reports that
can interpret and illustrate their user defined program structures. This is particularly important in the area
of student results and outcomes, where user defined result types can allow an institution to hold and report
student results (grades, scores, credits and so on) and statistics at any point in a program tree. For this
reason, we have delivered a self-service component that can be populated with HTML via a Peoplesoft

BI Publisher Report Definition. This feature allows users to create a Results page referencing their user
defined program structures and result/statistics profile. The AIR Report Template Mapping feature allows
users to map a specific BI Report to specific program. The same report can also be shared by different
programs with the same program format and result profile.

Currently the Report Template Mapping feature is used solely to attach a user defined BI report definition
to the student self-service results component. The steps for associating a report to the self-service results
component are:

* In BI Publisher:
* Create a data source/upload a sample data file.

* Design and define a report definition.

» In AIR: Associate the report with the self-service Results component using Report Template Mapping.

A sample report has been delivered with the April 2014 updates.
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See the following document in My Oracle Support (ID 1400723.1): Using BI Publisher and the XMLP
Results Template to Display Students’ Results and Outcomes in Program Enrollment Self Service:
Sample Template.

See PeopleTools: Bl Publisher for PeopleSoft

Field or Control Description

Report Name Prompts against a view of active BI reports defined with a type
of ‘XML’ (XML File) or ‘XMD’ (XML Doc Object).

Template ID Prompts against valid templates for the selected Report Name.

Component Name Currently prompts against a view that returns components
enabled for the program enrollment student self-service XML
menu (currently the delivered SSR_APT DAT RPT CM

component).

Process Name Planned for the future.

Item Attributes

The Item Attributes area is available when a Common Attribute(s) has been associated with an academic
item type entity. Associate item attributes and academic item types on the Common Attributes — Record
Context page. See the following section “Using Item Attributes to Extend AIR Data Elements”.

Using Item Attributes to Extend AIR Data Elements

The Common Attribute Framework allows you to extend the delivered AIR functionality without
customizations, by enabling you to add different types of data elements to your program structures.

An item attribute can be associated with one or more academic item types, and after it is linked to an
academic item type, that attribute can be assigned to all academic items of that type. You can link to
the attribute at the academic item level itself, or when the attribute is added as a child academic item of
another academic item.

Note: Any existing academic item attributes (created prior to Additional Features July 2012) must be
recreated using the Common Attribute Framework.

The Common Attribute Framework allows you to associate attributes with a functional area by a Record
Context. Common Attributes have been enabled for the Academic Item Registry at the Academic [tem
and Child Element levels, each with its own Common Attribute Record Context and Attribute Record.
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Field or Control Description

Academic Item *  Record Context: SSR_AIR HDR

»  Attribute Record: SSR_AIR_ADD

Attributes associated with this Record Context/Attribute
Record combination are attached to an academic item and can
be assigned on the Academic Item Registry page of the AIR
component.

Child Element *  Record Context: SSR_AIR ELEM

»  Attribute Record: SSR_AIR_ELEM_AD

Attributes associated with this Record Context/Attribute
Record combination are attached to child academic items
(that is, they exist as an attribute of an academic item in the
context of a parent academic item) and can be assigned using
the Element Attributes link on the Academic Item Elements
grid in the AIR component.

See “Understanding Common Attribute Framework” (Campus Community Fundamentals)

See “Defining a Common Attribute” (Campus Community Fundamentals)

See “Associating a Common Attribute to a Record” (Campus Community Fundamentals)

Steps for Creating Common Attributes for AIR

To create common attributes for AIR:

1.

Define the attribute using the Common Attribute component (Set Up SACR, Common Definitions,
Common Attributes Setup, Common Attribute).

Attach that attribute to the Academic Item (SSR_AIR _HDR) and/or Child Element
(SSR_AIR_ELEM) Record Contexts (Set Up SACR, Common Definitions, Common Attributes
Setup, Record Context).

Associate the attribute with one or more Academic Item Entities, using the Entities Association field
in the Record Context component. Entity Association controls usage in the AIR component. An
attribute without an entity association can be used with any item type.

Note: If you implemented Program Enrollment before April 2013, you must run the processes listed
here after you apply the April 2013 updates.

Item Type Matrix Sync Entities

Navigate to the Item Type Matrix component (Set Up SACR, Product Related, Student Records,
Program Enrollment, Item Type Matrix) and run the SSR_PE_SYNC process. The sync process
ensures that the newly added attribute(s) are recognized as valid properties of the designated AIR
Entities (or all AIR Entities if specific entities were not specified):

*  Click the Sync Entities button. This initiates the SSR_ PE_SYNC process.
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*  Check the Process Monitor to ensure that the process completes successfully.

This process can be scheduled using the process scheduler.

5. Entity Property Sync

Navigate to the Entity Property Sync page (SACR, System Administration, Entity, Entity Property
Sync) and:

*  Click the Sync All Entities button.

*  Check the Process Monitor to ensure that the process completes successfully.

6. Wipe Entity Cache
Remain on the Entity Property Sync page and:

» After the Sync All Entity Properties process has completed successfully, click the Wipe Entity
Cache button.

*  Check the Process Monitor to ensure that the process completes successfully.

See Identifying Child Item Types and Syncing Entities

See “Defining a Common Attribute” (Campus Community Fundamentals)
See “Associating a Common Attribute to a Record” (Campus Community Fundamentals)

See “Setting Up Entity Registry” (Campus Community Fundamentals)

Defining Attributes for Academic Iltems and Child Elements

Note that because attributes each have their own specific Record Context, you must associate attributes
that can be used at both levels under each context. For example if the Common Attribute ‘Course Level’
can be assigned to a COURSE academic item and then overridden at the child element level (that is, when
the course is a child of another item) you must associate the Course Level attribute to the SSR_AID HDR
record context and the SSR__AIR ELEM record context. Attributes can be copied from one Common
Attribute Framework Record Context to another.

Using Item Attributes in AIR

As explained above:

* The selections that you make in the Entity Associations field in the Record Context component
determine which types of academic items those attributes can be applied to in AIR.

» The Attribute Type determines the type of data that you can enter in the [tem Attributes grid in AIR.

* An Attribute can be required when associated with a particular record context (the Required check
box is selected on the Record Context page in Common Attributes setup). If an attribute associated
with the SSR_AIR HDR context is set to required, the attribute is added automatically when a user
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creates a new academic item, and a value is required to save the component (if a default has not been
assigned in the attribute definition).

Note: Users must provide a value even if they add a non-required attribute.

*  Attributes

can also be repeatable if this property is enabled in the Record Context definition (the

Repeatable check box is selected on the Record Context page in Common Attributes setup).

See “Defining

See “Associati

a Common Attribute” (Campus Community Fundamentals)

ng a Common Attribute to a Record” (Campus Community Fundamentals)

However, despite these variations, you always use the same process to add attributes in AIR: select the

Attribute and t

hen enter or select a Value—for example, date, text, numeric value, or a code where the code

is a member of the List of Values defined for the attribute, a Table value, or XLAT value.

An academic item:

* Can have multiple item attributes, at the academic item level itself or as a child item of another

academic 1

tem (see Child Academic Items below).

* Can have multiple rows for the same item attribute as long as the attribute Value is different (for
example Attribute A, with Value 1, Attribute A with Value 2).

When attributes have been assigned to the SSR_AIR _HDR context, the Item Attributes scroll area is
available on the Academic Item Registry page.

Academic Item Registry Item Details Rules ! Results Rich Text Fields Security

Academic Institution PeopleSoft University

Academic Item ID 00000001757
Academic Item Type Study Period

Item Attributes

*Effective Date [01/01/1900 [ *Status [Active - =]
*Description |[BA Econ - Year 1 - Semester 2

Find First n 10of1 u Last

Report Description

BA Econ - Year 1 - Semester 2 - Study Period is made up of 3 mandatory courses as well as the
opportunity to select electives.

I~ Requires Approval

Find First n 1of1 “ Last

=

*Attribute | Cluster Code =l
[cLUSTER A QU Cluster A

I Show in Student Self-service
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Field or Control Description

Attribute The name of the attribute. This value comes from the
description entered for the attribute on the Common Attribute
component.

Value This field changes depending on the type of attribute. This

could be a numeric, date, time or text field. Alternatively,
the field could prompt against a list of values if one has been
defined for the attribute.

Show in Student Self-service If you select this check box, the attribute is displayed in the
filter results in Course Groups component.

Wider use of this check box is planned for the future.

See Defining Filters

See Setting Up Academic Item Registry Entries, Item Details, and Item Security

Assigning Item Attributes to Child Academic Items

As mentioned previously, item attributes can be assigned to child academic items, allowing you to assign
attributes to academic items in the context of a parent item. For example, an item that represents a course
CHEM 399 might have a requirement for minimum score, but only when the course is taken at a certain
point in certain program (for example, semester 3 of the Nursing program). This could be coded as a
numeric attribute (applicable to the COURSE item type) that can be applied to CHEM 399 as a child of
the item representing semester 3 of the nursing program.

Note: An element attribute can override or add to any and all attributes attached to that item at the header
level.

Access the Element Attributes (SSR_AIR_ENATTR_SEC) page (click the Element Attributes link in
the Attributes tab, Academic Item Elements grid on the Item Details page in AIR).
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Here is an example of the AIR Item Details page from which you access the Element Attributes page:

Academic item Registry Item Details Rules [ Results Rich Text Fields Security

Academic Institution PeopleSoft University

Academic Item ID 00000001757
Academic ltem Type Study Period

First n 1of1 u Last
Effective Date 01/01/1900 Status Active [=]

Description BA Econ - Year 1 - Semester 2

Instructions

Each of the Mandatory courses for BA Ecnonomics - Year 1 - Semester 2 will automatically
be placed in your Schedule Builder. Carefully review the options below for elective courses.

~ Academic Item Parameters Personalize | Find | \

~ Academic ltem Elements

[

Elements | Settings T Attributes | Parameters | Rules

*Element-level Atiribute Element Atiributes

[=] ECON 1001B: Economic Principles 11 |Use defaull item attributes Ll Element Aftributes
[=] ECON 1004B: Economic Methods |1 |Use default item attributes ;| Element Attributes
[=] ECON 112: Intl Political Economy |Use defaull item attributes :l Element Aftributes
[=] Economics Year 1 Options |Use defaull item attributes :[ Element Aftributes

The Element-level Attribute value selected on the Attributes tab carries over to the Element Attributes
page but can be changed:
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This example illustrates the fields and controls on the Element Attributes page. You can find definitions

for the fields and controls later on this page.

Element Attributes

Seq Nbr

* Default Attributes

Attribute Course Level

4

Academic Institution PSLUMNY

Show in Student Self-service

PeopleSoft University
Academic Item ID 00000001757 BAEcon-Year 1-Semester 2
Effective Date 01/01/1900

Child ltem ID 00000000529 ECOM 112: Intl Political Economy

Level 4

Find First n 1 of1 u Last

Element Attributes

*Attribute Course Level

5

aQ

[] Show in Student Self-service

*Element-level Attribute Addto default attributes

Level 5

First n 1 of1 n Last
[=]

Field or Control

Description

Default Attributes

All attributes linked to this academic item (ECON 112 in the
example) at the item header level are displayed. This attribute
is associated with the Record Context SSR_AIR_HDR and
stored in the SSR_AIR ADD table.
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Field or Control

Description

Element-level Attribute

The value selected in the Attributes tab (on the Item Details
page) appears by default but can be changed. Values are:

»  Use default item attributes: The user cannot enter new
values.

*  Add to default attributes: The Attribute and Value fields
in the Elements Attributes group box are available. Any
value that is added is used in addition to the default value
(s). In the example above, ECON 112 would have two
attributes when used as child of BA Econ — Year 1 —
Semester 2: Level 2 and Level 3.

*  Override default attributes: The Attribute and Value fields
are available in the Element Attributes group box. Any
value that is added is used instead of the default value(s).
In the example above, ECON 112 would have an attribute
of Level 3 rather than Level 2 when used as child of BA
Econ — Year 1 — Semester 2.

See Defining Academic Item Details

Attribute Select an attribute. The values available here are based on the
attributes that are associated with the Child Element (SSR_
AIR_ELEM) context.

Value This field becomes available when you select an attribute.

For information about the Item Details page, see Defining Academic Item Type Details later in this

section.

Defining Academic Item Details

Access the Item Details page (access this page from the AIR Search component.)
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This example illustrates the fields and controls on the Item Details page (1 of 2). You can find definitions
for the fields and controls later on this page.

Academic [tem Registry Itern Details

Effective Date 01/01/1900

Instructions

Each of the Mandatory courses for BA Ecnonomics - Year 1 - Semester 1 will automatically
be placed in your Schedule Builder. Where available, you will be able to select the section in

Rules / Results Rich Text Fields Security

Academic Institution PeopleSoft University

Academic ltem ID 00000001756
Academic ltem Type Study Period

Description BA Econ - Year 1 - Semester 1

which you wish to enroll.

* Academic ltem Parameters

Personalize | Find | ‘iew A

Enroliment Cate

[=] | Ful-Time vl | o
[=] | Full-Time w| | Mandatory v

| 15.00
[ 15

| 15.00 5.00 5.00

Minimum
Number of
Courses

1501 5| 5

This example illustrates the fields and controls on the Item Details page (2 of 2). You can find definitions
for the fields and controls later on this page.

+ Academic ltem Elements
" Elements | Sefings | Atributes | Rules

EHE

# =] 2 [And v]

[ [=)[ 3 A v
@ 2[4 [Ad V]

[+ E1[ 5 [And_v]

%Corrﬁctur| { |*Academic ltem Type |*Child ltem ID

\COURSE Q 00000000388 @, Mactoeconomic (| ] - 9]
LA
ECON 3

[COURSE Q [00000000389 |  Microeconomic  +(| +)| -/ |
Principles

[COURSE Q [00000000345 @ Inwoductionto  +(| +)| -(] -]
Intl Economics
POL SCI 1: Intro

(COURSE Q [00000000100 @ loUSGovtand +(| +)| -/ |
Palitics
STATS 101.

[COURSE (00000000565 C  Statistical «(| )| - o]
Analysis |

= Grading Elements

Personalize | Find | Viev

o2z
|‘!’:| | B=

[+ =]
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Field or Control Description

Instructions This field is available if the Instructions check box is selected
on the Attributes page in Academic Item Type setup. Click the
Instructions link to access the AIR Rich Text Fields page and
enter instructions for self-service users.

See Maintaining AIR Rich Text Fields

Academic Item Parameters

This grid is available if the Item Parameters check box is selected on the Attributes page in the Academic
Item Type setup.

Enter parameter data by load and enrollment category, to be used in Self Service (planned for the future).

Parameters can be overridden at the child item level.

Field or Control Description

Enrollment Category When a value is not selected in the Enrollment Category
field, the values in the Minimum/Maximum fields represent
overall totals. Enrollment Category values are defined on the
Enrollment Category (SSR_ENRL CAT) page.

See Setting Up Enrollment Categories for Program
Requirements

Minimal Credits Enter the minimum credits that a student must achieve for the
child items of this item in order to pass the item, if applicable.
Note: Currently this field is informational only.

Maximum Credits Enter the maximum credits allowed for child items of this
item, if applicable. Note: Currently this field is informational
only.

Minimum Number of Courses Enter the minimum number of child courses that a student
must pass in order to pass this item, if applicable. Note:
Currently this field is informational only.

Maximum Number of Courses Enter the maximum number of child courses that can be
taken for this item, if applicable. Note: Currently this field is

informational only.

Academic Iltem Elements

This grid is available if the Child Academic Items check box is selected on the Attributes setup page for
an academic item type.
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Academic Item Elements establish the relationship between one academic item and one or more other
academic items, where one or more items are connected as children of another item. Child elements
typically represent all of the items that a student must complete in order to satisfy the requirements for a
particular academic item. For example a Program of Study academic item might have a number of child
elements that are Year or Stage academic items, and the student might need to successfully complete each

of those stages in order to complete the program.

Elements Tab:

Field or Control

Description

Connector

This field is available if the Show Connectors check box is
selected on the Attributes page for an academic item type. The
And option is selected by default, except for COURSELIST
items—when child COURSE items are added, the Connector
default option is Or:

Special processing applies when a child item with an academic
item type identified as a Program Format Tree Node is used

- the child item connector attribute is limited to And. An

error message is returned on save if the Academic Item
Elements grid contains one or more items that are identified as
Program Format Tree Nodes and there is one row in which the
connector is Or.

See Setting Up Academic Item Types

Academic Item Type

Select a child academic item type based on the values that
you set up in the Item Type Matrix component. Only items
identified in the Item Type Matrix as valid child items of this
AIR item are available for selection.

See Using the Item Type Matrix

Available values are also dependent on the AIR security of the
user. Academic Item Types defined as Program Format tree
nodes are excluded from the prompt unless the user has been
authorized as an AIR administrator.

SeenSetting Up AIR Administrator Security

Child Item ID Select a child item ID. The values that are available here are
based on the Academic Item ID value (system generated) that
appears on the Academic Item Registry page for the academic
item type.

Description Displays the description for the Child Academic Item ID.

Click the link to view the item definition for the child item.
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Use the Parentheses buttons to add or delete left or right parentheses. Parentheses are used to group items
for AND/OR constructs. For example: (course 1 and course 2) or (course 3 and course 4).

Settings Tab:

This example illustrates the fields and controls on the [tem Details page: Settings tab. You can find
definitions for the fields and controls later on this page.

* Academic ltem Elements

ECON 2
Macrogconomic
Principles

ECON 3
Microeconomic
Erinciples

ECON 10:
Introduction to Intl
Economics

POL SCI 1: Intro to
US Govt and
Politics

STATS 101:
Statistical Analysis |

[+]

[+]

I
o M o o 0

[+]

3.00

3.00

3.00

3.00

3.00

Personalize | Find | View Al |30 | 8 First B 45005 B 1ot

Maximum Enroliment D - it
-

3.00 MAND CQ,  Mandatory L1

|—1
3.00 MAND @, Mandatory [1] [ 1
3.00 MAND C  Mandatory [ 1 [ 1
1
a1

3.00 MAND @, Mandatory [ 1
3.00 [MAND'C,  Mandatory [ 1

In order to show all fields on this tab, the example Settings tab is for a different academic item — Study
Period - than the one used in the example of the Elements tab — Stage of Program.

Minimum Units and Maximum Units values are displayed if the child academic item is a Course.

Field or Control

Description

Enrollment Category

The Enrollment Category column appears only if the Requires
Enrollment Category check box has been selected for the child
academic item type.

See Defining Academic Item Type Attributes

Weight

Enter a numeric value to determine the weight given to the
child item in calculating the overall result/score for an item.
The default is 1 and the value can be set to 0. Note: Currently
this field is informational only.

Number of Attempts Allowed

Enter a numeric value to indicate the maximum number

of times that this child element can be attempted for this
academic item. For example, you might indicate that a Course
can be attempted only once within a Study Period.

This value is used by the APT Request process when creating
new attempts for a planning node.
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This example illustrates the fields and controls on the [tem Details page: Attributes tab.

= Academic ltem Elements

" Elements | Setngs | Amributes | Rules
Description

[=] ECON 2: Macroeconomic Principles

[=] ECON 3: Microeconomic Principles

[=] ECON 10: Introduction to Intl Economics
[=] POL SCI 1: Iniro to US Govt and Politics

[=] STATS 101: Statistical Analysis |

First Bl 15075 B Last

*Element-level Atiribute

| Use default item attributes

Personalize | Find | View a1 | B | 2

Element Afiributes

| Use default item attributes Element Attributes

| Use default item attributes Element Aftributes

| Use default item attributes Element Aftributes

Lef Ll e L 1w

| Use default item attributes Element Attributes

Field or Control

Description

Element-level Attribute

Determines how attributes that are linked to the child element
are to be used in the context of the parent item. The values are:

Use default item attributes: Any attributes linked to this

element at the item header level apply in the context of the
parent. For example if ECON 2 has attribute ‘Level” with a
value of ‘2°, this value applies when the course is used as a
child of this item (for example, a semester or study period).

Override default attributes: Any attributes linked to this
element at the item header level are to be ignored in favor of
attributes that are applied to this item in the context of the
parent (see Element Attributes below).

Add to default attributes: Any attributes linked to this element
at the item header level are used in addition to Element
attributes defined at this level (see Element Attributes below).

Element Attributes

Click this link to access the Element Attributes page to view,
override or add attributes.

See Assigning Item Attributes to Child Academic Items

Parameters Tab:

This example illustrates the fields and controls on the [tem Details page: Parameters tab.

* Academic Item Elements
" Elements | Settngs T Aftributes T Parameters

Bl , 4=
Personalize | Find | View 21 | B | 8 First B0 1o or2 I Last

Description ElomenticueiParameters _______|Eloment Parameters
[=] BA Econ - Year 1 - Semester 1 | Use default item parameters _~| Element Parameters
[=] BA Econ - Year 1 - Semester 2 |Use default tem parameters j Element Parameters
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This tab is available only if the Item Parameters check box is selected on the Attributes page in the

Academic Item Type setup.

To add to or override the data in the Academic Item Parameters grid, select Add to default parameters or
Override default parameters and then click the Element Parameters link to access the Element Parameters

page and update the data.

Viewing and Updating Parameters

Access the Element Parameters page (click the Element Parameters link on the Item Details page).

This example illustrates the fields and controls on the Element Parameters page.

Element Parameters

Academic Institution FSUNYV
Academic Iltem ID 00000001755 BAEcon-Year1
Effective Date 01/01/1900
Seq Nbr 1
Child tem ID 00000001756 BAEcon -Year 1- Semeaster 1

PeopleSoft University

Default Parameters Personalize | Find | View Al | 5| B8 First B 1.2 or2 B Last
- Enrollment Minimum Maximum

Academic Load (5 e —— e —— Humber of Humber of

Category Credits Credits B B

Full-Time 15.00 | 12.00 | 4.00 4.00

Full-Time \Mandatory 12.00 | 12,00/ 4.00 4.00

*Element-level Parameters [l [ 000 =TTl (=] -

Element-Level Parameters

*Academic
Load Category

Enrollment Maximum

Credits

Minimum
Credits

ew ol | U] H

Persgnalize | Find | %

Minimum Maximum
Number of NHumber of
Courses Courses

0.00 | 0.00

Use the Element Parameters page to view the parameters defined for this item. You can also override the
parameters or make additions to them. This allows the overridden (or additional) values to be used for
display purposes when an item is accessed in the context of its parent.
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Field or Control

Description

Item Type

Select a grading academic item type. Only those academic
item types for which the Grading Item Type check box has
been selected on the Attributes setup page are available here.

See Defining Academic Item Type Attributes

Assigning Rules and Result Types to Academic Iltems

Access the Rules / Results page (access this page from the AIR Search component.)

This example illustrates the fields and controls on the Rules / Results page. You can find definitions for

the fields and controls later on this page.

Academic Institution PeopleSoft University

Academic Item ID 00000002155
Academic Item Type Concentration

Academic Item Registry Item Details Rules | Results Rich Text Fields Security

Effective Date 01/01/1900

Description Marketing Concentration

Find | View All First 4] 1o0f1 n Last

Status Active =

*Rule Type [SSR_PE_ITEM_PRECOND Q

Rule Search |

Rule Check for Sub-Plan Condition: Marketing
Name
[+ Show in Student Self-service

Rule Report Description

option.

Checks APT/Program stack for MARKETING Sub-Flan as a conditon for seleting an APT

H =

Academic Item Precondition

* Result Types

[W. Average - Stage | il Calculate Stage Weighted Average =

Personalize | Find | i |_?HE First B 4 074 I Last

The Rules / Results page is available if an item is configured to have Rules and/or Result Types attached

to it as explained in the following documentation.
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Item Rules

The Item Rules section is available only if the academic item type (of the item) is associated with at least
one rule type on the Rule Type Table page.

See Setting Up Rules for Program Enrollment

You can assign multiple rules to an academic item but each rule must be of a different rule type.

The rules that you assign here are available for use in User Interfaces and batch processing.

Field or Control Description

Rule Type Select a rule type from those defined on the Program
Enrollment - Rule Type Table page.

Rule Search Click to launch the standard Rules Engine search:

*  The Rule Group Name associated with the rule type on
the Program Enrollment - Rules Type Table is passed to
the search criteria and cannot be changed.

*  Rule Category is required.

*  Rule Engine Search is used to return rules with the passed
group name as well as any criteria that you add.

See “Understanding the Rules Engine” (Campus Community
Fundamentals)

See “Setting Up the Rules Engine” (Campus Community

Fundamentals)

Show in Student Self-service When this check box is selected, the Rule Name and
associated description appear on the self-service Item Details
page.

Rule Report Description When a rule is returned from the search, the Rules Engine

Long Description is used as a default but you can edit it by
clicking the Rule Report Description link and accessing the
Rich Text fields page.

Result Types

The Result Types grid is available only if the academic item type (of the item) is associated with at least
one result type on the Result Type page.

Note: Any result type, for which the Auto-create in AIR check box is selected (by academic item type)
on the Result Type setup component, is inserted into the Result Types grid when a new academic item is
created. Calculation rules associated to the result type are also inserted in the grid.

Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 7 Setting Up Program Enroliment

Field or Control Description

Result Type The result types available here are those attached to the
academic item type in the Item Type Usage grid on the Result
Type page.

Use Default Calc Rule If this check box is selected, the default calc rule associated

with this item type/result type combination on the Result Type
setup component is used and cannot be changed. If the check
box is deselected, the Rule Name field is available and the

prompt can be used to select a valid rule.

See Setting Up Result Types

The result types assigned to an item are moved to APT when the item is added for a student.

See Creating and Managing APT Instances Using the Academic Progress Tracker Component

Maintaining AIR Rich Text Fields

Access the Rich Text Fields page (click the Report Description link on the Academic Item Registry
page).
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This example illustrates the fields and controls on the Rich Text Fields page.

Chapter 7

Maintaining AIR Rich Text fields

Academic tem Registry | Item Details Rules [ Results Rich Text Fields Security

Academic Institution PeopleSoft University

Academic Item 1D 00000002155
Academic ltem Type Concentration

First n 1of1 u Last

Effective Date 01/01/1900
Description Marketing Concentration

* Report Description

First n 1of1 u Las!

Rule Type SSR_PE_ITEM_PRECOND Academic ltem Precondition
Rule ID SCC_RULE_ID_20130807153122
Rule Name Check for Sub-Plan Condition: Marketing

Rule Report Description g @ & a @ Bal=DEa& O | g{
: Format = | Font »| Size -
BT Y ] . ; . . .
P E B E B = = 2 P A'l B

Checks APT/Program stack for MARKETING Sub-Plan as a conditon for seleting an
APT option

See Defining AIR Entries
See Defining Academic Item Details

See Assigning Rules and Result Types to Academic Items

The Rich Text fields page allows you to maintain all three AIR Rich Text enabled fields in one place. A

rich text field is available for Report Description and Instructions. Each Rule associated with this item can
also have its own rich text enabled description.
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Defining Academic Item Security
Access the Security page (Click the Item ID link or Add New Item button on the AIR Search page).

This example illustrates the fields and controls on the AIR Security page. You can find definitions for the
fields and controls later on this page.

[ I I I | securiy ]

Academic Institution PeopleSoft University

Academic Item ID 00000001757
Academic Item Type Study Period

Find | View All First [ 4] 10f1 n Last

Effective Date 01/01/1900 Status Active =+ =

Description BEA Econ - Year 1 - Semester 2

& Available to all academic organizations

T Grant access to selected academic organizations

Security for AIR Entries

AIR items are secured using the existing User ID based Campus Solutions Academic Organization
security. A user’s academic organization privileges (as defined under Academic Organization Security
(SACR, Security, Secure Student Administration, User ID, Academic Org Security) determine whether a
user has update or read only access to a particular academic item.

See “Securing Academic Organizations” (Campus Solutions Application Fundamentals)
» Updating or viewing an existing academic item:

When a user retrieves an AIR entry, the system compares the entries in the AIR security table
(SSR_AIR_SCRTY) to the user’s academic organization security profile (SCRTY_TBL ACAD).
If the security option is Grant access to selected academic organizations and a matching academic
organization row is found (or if Available to all academic organizations is selected), the user has
update access to the item. If no match is found, the user has read only access to the component.

e Adding a child academic item:

A user can select any academic item, however the same edit (as explained above) is performed to
determine if the child item is accessible (once added to the grid) in update or read-only mode.

¢  Course Academic Items:

When a user creates a new course item, the Grant access to selected academic organizations option
is selected by default and not available for edit. If the user specifies a course offering, the system also
displays the relevant academic organization. If the user does not specify a course offering, the system
retrieves the academic organizations for all offerings of the course when the component is saved.
Only users with access to the organizations listed on the Security page can maintain the course.
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Managing Special Edits in AIR for COURSE, COURSEGROUP, and
COURSELIST Academic Iltems

Academic items with the delivered item type of COURSE, COURSEGROUP, and COURSELIST are
subject to a series of edits and restrictions:

*  Course Item (Academic Item Type = COURSE):

*  Only one instance of a Course ID/Offer Number/Topic ID combination is allowed in AIR. When
a COURSE academic item type is saved, an edit is performed to check for a match on Course
ID, Course Offer Nbr, and Topic ID. If you try to create an academic item with the following
attributes: Course ID: 007125, Course Offer Nbr: 1 (ECON 198), Course Topic ID: 1, and a match
is found, you receive an error message pointing to the existing academic item. The same edit
applies for offerings for which no course topics are defined - only one academic item is allowed
for the course offering.

*  When a COURSE item is added as a child of another academic item other than COURSELIST
(see the following information about COURSELIST items), the COURSE item must have an
Enrollment Category.

e Course List Item (Academic Item Type = COURSELIST):
*  Only COURSE item types can be assigned as child items.
*  When a COURSELIST item is added as a child of another academic item the COURSELIST item

must have an Enrollment Category.

*  Course Group Item (Academic Item Type = COURSEGROUP):
When a COURSEGROUP item is added as a child of another academic item the COURSEGROUP
item must have an Enrollment Category.

Using the Academic Item Registry Copy Function

A copy function is available when you create a new AIR item. This allows you to clone a previously
created item of the same type (and all of the related children etc.) and make adjustments to it for another
use. For example a generic year 1 or foundation year stage could be defined and then copied and adjusted
to suit the needs of different types of programs.

Note that when you copy an item that has child items, the cloned item and the original item share the
same child items.

In Add mode on the Academic Item Registry page, the Copy from AIR button is available. Click the
button to access a look up page.

Field or Control Description

Academic Institution Displays the value of the Institution that you entered when
adding the new academic item.
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Field or Control Description
Academic Item Type Displays the Item Type that you entered for the new academic
item.

After you select an item, the data is copied and can be edited.

Course List Copy Function

For Course List academic items, in Add mode, the Copy AA Course List button is available in addition
to the Copy from AIR button. If you select the Copy AA Course List option, only those rows in the AA
course list that do not have a wild card indicator are copied. Click the button to access a look up page:

* AA Academic structure fields are available for searching, in addition to Course List.

*  When an item is selected, all course list rows that do not have wild card indicator rows are copied
over: that is any row from CLST_DETL TBL where WILDCARD ID =Y is excluded.

Creating Academic Items for Courses

Program Enrollment, as delivered, allows you to create academic items that point to a course ID, course
offering, course topic, or course offering/topic.

Use the Course Academic Item (SSR_CRSECAT AIR) component to create academic items for
individual courses or the Create Course Academic Item (SSR_RC CRSEAIR) component batch process
to create academic items for multiple courses.

This section discusses how to:
* Create academic items for an individual course.
¢ View academic item details for courses.

* Create academic items for multiple courses.

Pages Used to Create Academic Items for Courses

Page Name Definition Name Navigation Usage

Course Academic Item SSR_CRSECAT_AIR Curriculum Create academic items for an
Management > Academic |individual course.
Item Registry > Course
Academic Item

Course Academic Items SSR_CRSE_AIR DTL Click the Details link on the | View course academic item
Details Course Academic Item page. | details.
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Page Name Definition Name

Navigation Usage

Create Course Academic Item | SSR_ RC CRSEAIR

Create academic items for
multiple courses.

Curriculum

Management > Academic
Item Registry > Create
Course Academic Item

Creating Academic Items for an Individual Course

350

Access the Course Academic Item page (Curriculum Management > Academic Item Registry >

Course Academic Item).

Click the link next to the Course ID to access the Course Catalog (CRSE_CATALOG) component.

See Creating Course Offerings

Field or Control

Description

Effective Date

This is the maximum effective dated row (less than or equal
to the system date) for the course from the Course Catalog
(the Course Academic Item search page prompts are the same
as those for the Course Catalog search page but only the
maximum effective dated row is returned).

Course Catalog, Course Offer, Course Catalog Topic, and
Course Offer Topic

Data appears based on the data in the Course Catalog — for
example, if no topic exists in the Course Catalog, the Select
check box is not available for edit for the Course Catalog
Topic.

Select

Use this check box to indicate that you want to create an
academic item for a course, offering, topic, or offering/topic.

Item ID

This link appears if an academic item already exists in the
Academic Item Registry component - click the link to access
the component.

See Setting Up Academic Item Registry Entries, Item Details,
and Item Security

Description

View the description for an existing academic item. If no
academic item exists, the Course Description appears here by
default and you can edit it.

Note: The Description field for entries under Course Offer

and Course Offer Topic is populated with the Subject and
Catalog Number values for the offering as well as the Course
Description, For example a course with the Description Intro
Spanish, with an offering with a subject of SPAN and a Catalog
Number of 100, appears as SPAN 100: Intro Spanish.
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Field or Control Description

Select All and Clear All Click these buttons to select or clear all the check boxes in the
Select column.

Create Academic Item Click this button to create academic items in the AIR
component for the course, offering, topic, and offering/topic
for which the Select check box is selected. When an academic
item is created:

*  The Item ID link appears here on the Course Academic
Item page.

*  The Course Academic Item link appears on the
Offerings page in the Course Catalog component. Click

the link to access the Course Academic Item page.

See Creating Course Offerings

Details Click this link to access the Course Academic Item Details
page and view a summary of the course academic items that
have been created.

Item Attributes

Any attributes that have been defined as required for the Academic Item record context
(SSR_AIR_HDR)-the Required check box is selected on the Record Context page in the Common
Attribute setup—and associated with the COURSE item type entity (‘AIR Course’) defaults into the Item
Attributes scroll area. These attributes cannot be deleted and you must select a value in order to create an
academic item.

See Setting Up Academic Item Registry Entries, Item Details, and Item Security

See “Defining a Common Attribute” (Campus Community Fundamentals)

See “Associating a Common Attribute to a Record” (Campus Community Fundamentals)

Viewing Academic Item Details for Courses

Access the Course Academic Item Details page (click the Details link on the Course Academic Item
page).
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This example illustrates the fields and controls on the Course Academic Item Details page . You can find
definitions for the fields and controls later on this page.

Course Academic Item Details
Academic |r|5tit|_|ti|jr| PEUP‘J.".". EﬂECtI‘.’E D’ﬂte |:| 1.'I|:| 1.'|1 E“:”:'
Course ID 003276 Status Active
Description Survey of American Literature
Details
Field or Control Description
Details View details of all the academic items that have been created
for the course. This is not a stored message and exists for
the life of the component or until the Create Academic items
button is clicked again.

Creating Academic Items for Multiple Courses

Access the Create Course Academic Item page (Curriculum Management > Academic Item
Registry > Create Course Academic Item).

352 Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 7

Setting Up Program Enroliment

This example illustrates the fields and controls on the Create Course Academic Item page. You can find
definitions for the fields and controls later on this page.

Create Course Academic Item

Run Control ID:  PS

“Academic Institution PeopleSoft University ol

Report Manager

Run Centrol Options

Process Manitor L

| | Course Catalog
[¥| Course Offer

| | Course Catalog Topic
| Course Offer Topic

| Population Selection

Selection Tool:
Query Name:

PS5 Query
SSR_POP_CRSEAIR_ACADORG

Population Selection

-

Edit Prompts
Q

Launch Query Manager Preview Selection Results

+|Use Course Select

Clear List I

Course ID

1 (001248 o General Accounting

Personalize | Find | View All | .‘?][ #

First Kl 1 of 1 B Last

F &

Item Attributes

*Attribute Campus v FE[=
Q

*Artribute | Course Level - +| =
Q

Run Control Options

Field or Control

Description

Course Catalog

This check box is selected by default. The SSR_CRSE
AIR process creates an academic item for the course for the
selected institution.

Course Catalog Topic If this check box is selected, the process creates an academic
item for each course topic that exists for the course ID.
Course Offer If this check box is selected, the process creates an academic

item for each course offering that exists for the course ID.
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Field or Control Description

Course Offer Topic If this check box is selected, the process creates an academic
item for each course offering and topic combination that exists
for the course ID.

Population Selection

The Population Selection group box is a standard group box that appears on run control pages when the
Population Selection process is available or required for the transaction. Selection tools are available
based on the selection tools that your institution selected in the setup of the Population Selection process
for the application process and on your user security. Fields in the group box appear based on the
selection tool that you select. The fields behave the same way from within the group box on all run
control pages and application processes. If your institution uses a specific delivered selection tool to
identify IDs for a specific transaction, you must use it.

Select the Population Selection check box to use the Population Selection process to select the courses for
which you want to create academic items. When you select this check box, the Selection Tool and Query
Name fields become available.

Field or Control Description
Selection Tool Select External File or PS Query.
Query Name The following queries are delivered:

*  SSR POP_CRSEAIR ACADGROUP: Select courses by

institution and academic group.

*  SSR POP_CRSEAIR ACADORG: Select courses by

institution and academic organization.

*  SSR_POP_CRSEAIR_BYDATE: Select courses by
creation date using institution, operator id and date/time

when the course was added.

*  SSR POP_CRSEAIR SUBJECT: Select courses by
institution and course subject.

If you create queries, you must use the bind record SSR_
CRSECAT BND.

See “Understanding Population Selection” (Campus Community Fundamentals)

See “Using the Population Selection Process” (Campus Community Fundamentals)
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Field or Control

Description

Use Course Select

If this check box is selected, you can manually select the

courses for which you want to create academic items.

Clear List

Click this button to remove all Course ID rows and clear the
Course ID field.

Item Attributes

Any attributes that have been defined in the Common Attribute setup as required for the Academic Item
record context (SSR_AIR HDR) and associated with the COURSE item type entity (‘AIR Course’)
default into the Item Attributes scroll area. These attributes cannot be deleted and you must select a value

in order to run the process.

See Using Item Attributes to Extend AIR Data Elements

See “Defining a Common Attribute” (Campus Community Fundamentals)“Associating a Common
Attribute to a Record” (Campus Community Fundamentals)

Running the Create Course Academic Iltems Process

Field or Control

Description

Run

Click to run the SSR_CRSE_AIR process and create course
academic items in AIR.

When an academic item is created:

*  The Item ID link appears on the Course Academic Item
page.

*  The Course Academic Item link appears on the
Offerings page in the Course Catalog component. Click
the link to access the Course Academic Item page.

See Creating Course Offerings

Building Programs by Format

This section provides an overview of building programs by format and discusses how to:

e Use the Build Program by Format component in Add mode.

* Use the Build Program by Format component in Update/Display mode.
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Understanding How to Build Programs by Format

The Academic Item Registry component allows you to create program elements and to establish links
between those elements. However, because no intrinsic program hierarchy is built into the structure, you
cannot use the component to build a program in ‘top-down’ fashion. That is, the program and its parts
cannot be built and assembled in a single task flow. The Build Program by Format component provides
this single task flow user experience by using the Program Format structure to establish a framework—
and therefore a program hierarchy—upon which you can assemble a program of study. This single task
flow streamlines the program building process, allowing you to chart your progress towards completion.
When data entry is complete you can easily access a complete view of the program.

See Setting Up Program Formats

Note: Build Program by Format always obeys the Program format. Therefore, a user cannot insert an
unauthorized tree node (even if the user is an AIR administrator).

See Setting Up AIR Administrator Security

The task is accomplished in three steps:
* You provide a Program Format ID.
* The component renders the Program Format Tree structure.

*  You follow the tree guideline to build the elements of the program by adding new academic items or
using previously built academic items.

All program items are audited against their program format definition when the program academic item is
retrieved in the Build Program by Format or Program Template components.

Note: The Build Program by Format component restricts the type of items that can be assigned within a
program tree:

When you assign an item to a tree node, you must create or use an academic item of the same type that
was used in the program format definition.

Child Items: Only items with an item type that is not defined as a Program format tree node can be
assigned as a child to an item that you create or update in this component.

Page Used to Build Programs by Format

356

Page Name Definition Name Navigation Usage

Build Program by Format SSR_PROG_BUILDER Curriculum Build programs by format.
Management > Academic
Item Registry > Build
Program by Format >
Build Program by Format

Build Program by Format SSR_PRG BLDR SEL Click the link for any item Specify how you want to
(select mode) type in the tree other than assign the item for the node.
PRG.
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Using the Build Program by Format Component in Add Mode

To build a program by format in Add mode:

1. Add the program by selecting an Institution and Program Format.

This example illustrates step 1 in the Build Program by Format (Add mode) process.

Build Program by Format

. Find an Existing Value | Add a New Value

Academic Institution: PSUNY Q

Format ID: UG_3YR_REG Q
Academic Item ID: 0000000000(

Add

2. The Program Format appears in a Tree view when the component opens:
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This example illustrates step 2 in the Build Program by Format (Add mode) process.

Build Program by Format

Academic Institution PeopleSoft University

Academic Item ID

FormatID UG_3YR_REG 3 Year Program

100 - 3 Year Program
1000 - Year 1
1100 - Semester 1
1200 - Semester 2
2000 -Year 2
2100 - Semester 1
2200 - Semester 2
3000 - Year 3
3100 - Semester 1
3200 - Semester 2

Each node of the tree is a link/prompt for you to:

Build a new academic item for the node or

Associate an existing item with the node or

Clone an existing item to create a new item for the node.

You must assemble the program in accordance with the tree structure. Begin at the root (program)
node. If you click any other link you receive a message instructing you to assign the item for the
Parent node. The message returns the node ID that should be used (in this example it would be 100).
This same message is returned if you skip a level in the tree. In this example if you assign the item for
node 100, but then click the link for 1100, the error message instructs you to first assign the item for
the parent (1000).

3. Program (Node Academic Item Type = PRG):

Click the link for the root node that represents the Program of Study: you are transferred to the AIR
component where you create a new academic item for the Program node.
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This example illustrates step 3 in the Build Program by Format (Add mode) process.

Academic [tem Registry

Academic Item Registry Item Details Rich Text Fields Security

Academic Institution Great Lakes University

Academic Item ID
Academic Item Type Stage of Program

Find First (4 1of1 (¢ Last

*Effective Date 01/01/1900 *Status | Active h =]

*Description
Internal Description Q,

Report Description

Degree &}

O Requires Approval

Item Attributes Find First (4) 10f1 (b Last

[+ [=]

*Attribute | v

Show in Student Self-service

The Institution and Academic Item Type (Program of Study) appear by default and cannot be
changed. All of the features of the AIR component are available. You can:

Save and return to the Build Program by Format page by clicking OK.
Discard any changes and return by clicking Cancel.
Save any changes and remain on the AIR component by clicking Apply.

When you click OK, the item is saved, an academic item ID is assigned, and you are returned to the
Build Program by Format main page:
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This example illustrates the Build Program by Format main page after you save the AIR component.

Build Program by Format

Academic institution Great Lakes University
Academic Item ID (0000001459

100 - 00000001469
1000 - Year 1
1100 - Semester 1
1200 - Semester2
000 - Y r
100 - Semester 1
22!-'-' = Semesier 2
2000 - Year 3
3100 - Semaster 1
3200 - Semester2

Program Structure

Format ID UG_3YR_REG 3 Year Program

Program of Study 00000001469 100 - 3 Year Program

The tree node where the item was assigned is highlighted and inactivated. The Program Structure tab
opens and the academic item (and any child items) that was assigned to the node is listed.

If updates are required, use the Item ID link to access the item.

Any Other Item Type (other than PRG) in the Tree

When you click the link for any other item type in the tree, you are transferred to the Build Program by
Format - Select Mode (SSR_PRG BLDR SEL) page where you specify how you want to assign the item
for this node. By default, the Item Type value is the item type of the node and cannot be changed.
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This example illustrates the fields and controls on the Build Program by Format (select mode) page. You
can find definitions for the fields and controls later on this page.

Build Program by Format

Institution PeopleSoft University
FormatlD UG_3YR_REG 3 Year Program

! Create New Item
" Use Existing Item
" Clone Existing Item

Item Type STAGE

Field or Control

Description

Create New Item

When you select this option, you are transferred to the AIR
component. Institution and Academic Item Type values appear
by default and cannot be changed. After you create the item

in AIR and click OK, you are returned to the Build Program
by Format main page and the node is inserted in the program
structure.

Use Existing Item

When you select this option, the Academic Item ID field
becomes available (the Item Type value is the item type of the
node and cannot be changed). The academic items that are
available match the Institution, Item Type, and Effective Date
of the Program Node. If you select an existing item, you are
returned to the Build Program by Format main page and the
node is inserted in the program structure.
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Field or Control

Description

Clone Existing Item

362

If you select this option, the academic items that are available
match the Institution, Item Type, and Effective Date of

the Program Node. If you select an existing item, you are
transferred to the AIR component. The Effective Date is, by
default, the Effective Date of the Program Node and cannot
be changed. After you clone the item, you are returned to the
Program by Format main page and the node is inserted in the
program structure.

Note that when you copy an item that has child items, the
cloned item and the original item share the same child items.

Using the Program Structure Tab

When academic items are assigned to the tree nodes, the program structure is tracked in the Program
Structure tab on the Build Program by Format page. The display is updated as academic items are created/
assigned to tree nodes. Rows are inserted for each assigned item as well as any child items entered for the
item (or child items that were attached to an existing item).

This example illustrates the fields and controls on the Build Program by Format page (Program Structure
tab). You can find definitions for the fields and controls later on this page.

m

Build Program by Format

Academic Institution PeopleSoft University

Academic ltem 1D 00000001715

FormatID UG_2YR_REG 3¥ear Program

100 - 00000001715
1009 - Year 1
1100 - Sanmasher 1
1200 - Semaster 2
2000 - Year 2
2100 - Semester 1
2200 - Semester 2
3100 - Serraster 1

3200 - Semester 2

- B.5.Economics - Year 1
i- Yi-Sem1-B.5. Economics
! i- ECOM 2 Macrogconomic Principles
i 1= andECON 3: Microeconomic Principles
i 1= andECOM 10: Introduction to Intl Economics
i 1- and ACCT 1001: Infreduction 1o Accounting
i 1= and COUM 3 Public Communication
i- and ¥1-5em 2 - B.5. Economics
{ ECOM 113 Moneyand Bankiag
i and ECOM 112: Ind Political Econony
i and ECOM 203: Public Economics
i and 85 Econ ¥1-Sem1 Electhves
i i- BS Economics Year 1 Eledives
] i 1= ECON 113:Lalin Amarca
] i 1~ and ECON 148 The Economics of Crime
i 1 1 i- and ECOMN 187: Econ znd Social Challenges
i i i- and ECON 176 Ecomomic Themes in Film
i i 1= and ECON 183 The Muddie East
1 1= or BS Economics Year 1 - Finance

Program of Study

Stage 00000001687 1000 - Year 1
Study Period 00000001688 1100 - Semester 1
Course Q0000000405

Course 20000000406

Course Q0000000407

Course 00000000303

Course 00000000002

Study Perod 000000689 1200 - Semester 2
Course 00000000172

Course CO000000183

Course Q0000000412

Regquirsment Q0000001707

Course List 0000000IT0S

Course 00000000154

Course Q0000000165

Course Q0000000166

Course 00000000167

Course 00000000168

CourseList 00000001706

DODOOEITAS 100 - 3 Year Program
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Field or Control Description

Expand/Collapse You can expand or collapse any related child data.

Item ID Click this link to transfer to the AIR component.

Format Node The value that appears here is based on the setup on the
Program Format (SSR_PROG_FORMAT) page.

Using the Build Program by Format Component in Update/Display Mode

You can use the Build Program by Format component to retrieve and update an existing program. Items
can be assigned to tree nodes and existing items can be maintained. The search record is restricted to
academic items with an academic item type of PRG.

Viewing Program Format Audit Messages

When you retrieve a program, the Program Format audit is run and missing tree nodes (and missing child
nodes) are identified and listed on the page in the Program Format Audit Messages grid:

Build Program by Format

Academic Institution  PeopleSoft University
Academic Item 1D 00000001715
FormatiD UG_3YR_REG 3 Year Program

= 100 - 3 Year Program
* 1000 - Year 1
1100 - Semester 1
1200 - Semester 2
2000 - Year 2
2100 - Semester 1
2200 - Semester 2

* 3000 -Year 3 I%
31100 - Semester 1

2200 - Semester 2

Program Structure

Expand [
Colapse Item Description .Item Type

= B.S.Economics Program of Study 00000001715 100 - 3 Year Program
= i~ B.5. Economics - Year 1 Stage 00000001687 1000 - Year 1
= }- andB.5. Economics - Year 2 Stage 00000001690 2000 - Yaar 2

! 1. ¥2.Sem 1 .B.S. Economics Study Period 00000001691 2100 - Semester 1

i i- and¥2-Sem 2 - B.5. Economics Study Period 00000001692 2200 - Semester 2

Program Format Audit Messages

Description

1 Missing Stage tem (Mode 3000) under parent Academic term 1D 00000001715,
2 Missing Study Period itern (Moadea 3100) undar parent node 3000,
3 Missing Study Period item (Mode 3200) under parent node 2000

The audit occurs each time that you retrieve a program using the Build Program by Format component—
if a program is left unfinished, the audit messages appear the next time that a program is retrieved.

When an item has not been assigned to a node in a particular branch of a tree, a message is returned in the
following format: Missing <Item Type Description> item (Node <Tree node ID of child>) under parent
Academic Item ID <Academic Item ID assigned to the PRG node>.
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In the example above an academic item has not been assigned for the tree node 3000 — Year 3:

Error message sequence 1 identifies the item type and the ID for the missing node, with a reference to the
item ID of the parent program node.

Error messages 2 and 3 (for the missing study periods) refer to the parent only by the node ID, because an
academic item has not been assigned.

Using the Messages Tab
Select the Build Program by Format page, Messages tab.

This example illustrates the fields and controls on the Build Program by Format page (Messages tab).

Build Program by Format

Academic Institution PeopleSof University
Academic ltem 1D 00000001715
FormatID UG_3YR_REG 3 Year Program

100 - 3 Yaar Program
1000 - Year 1
1100 - Semester 1
T 1200 - Semester 2
2000 - Year 2
T 2100 - Semester 1
© 2200 - Semester 2

B.5. Economics Program of Study
# - B.S5.Economics - Year 1 Stage
E i - and B.5. Economics - Year 2 Stage
i+ Y2.58m 1 - B.5. Economics Study Period
i i- and Y2-Sem 2 - B.S. Economics Study Period
. . A . Invalid accumulator ifem. This item type is noltin the
i~ andL1-Year 1 -BAE ear program format definition
.o R - - Invalid accumulater item. This item type is notin the
y= 81-Semester1-BAE Study Period program format definition

In addition to the program format audit messages, the Build Program by Format component also

displays messages when an invalid Program Format Tree Node item has been inserted in a program tree.
This could occur if you retrieved an item associated with a tree node in the Academic Item Registry
component, because this action is prevented on the Build Program by Format component. The error is
detected by the audit process and an error message is displayed on the Errors tab on the Build Program by
Format page. When messages are present, the Errors tab appears as the Messages tab.

Field or Control Description

Messages The message identifies the invalid node. This item type is not
attached to a node in the tree branch.

Generating and Viewing Program Templates

This section provides an overview of program templates and discusses how to:
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* Generate and view an AIR based program template.

* View the Template — Long page.

Understanding Program Templates

Setting Up Program Enroliment

Use the program template to generate and view a program of study (or any other academic item) in its
entirety. On the page, the academic item and its children appear in a composed view that displays all the
levels within that item. You can use links to view detailed information and make changes at any level in

the template.

Pages Used to Generate and View Program Templates

Page Name Definition Name

Navigation

Usage

Template SSR_AIR TEMPLATE

Curriculum

Management > Academic
Item Registry > Program
Template > Template

Generate and view a program
of study or other academic
item in its entirety.

Template — Long SSR_AIR TMPLT1

Curriculum

Management > Academic
Item Registry > Program
Template > Template —
Long

View the long display of the
AIR Report description for the
selected academic item.

Generating and Viewing an AIR Based Program Template

Access the Template page (Curriculum Management > Academic Item Registry > Program

Template > Template).

This example illustrates the fields and controls on the Template page. You can find definitions for the

fields and controls later on this page.

Template

Template - Long

Academic Institution PeopleSoft University UK

Academic Item 1D 00000001103 BSci(Enag)in Mechanical Engineering
Academic [tem Type Frogram of Study

As of Date [12/03/2013 [5]  Generate

Enrollment
C llapse Item Description e Item Type Item 1D

e

BSc (Eng) in Mechanical Engineering

i\ - BSc Mechanical Engineering First Year of Study

i - and BSc Mechanical Engineering Second Year of Study
i

1

HHE

- and BSc Mechanical Engineering Third Year of Study
- and BSc Mechanical Engineering Fourth Year of Study

]

Program of Study

Year
Year
Year
Year

00000001103
00000001099
00000001100
00000001101
00000001102
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Here is an example of the page with the items expanded:

Template Template - Long
Academic Institution PeopleSoft University UK
Academic [tem ID 00000001103 BSc(Eng)in Mechanical Engineering
Academic ltem Type Frogram of Study
As of Date [19/03/2013 [#  Generate | Program Format Structure View |
Item Type ltem ID

= BSc (Eng) in Mechanical Engineering Program of Study 00000001103

= - BSc Mechanical Engineering First Year of Study Year 00000001099

= \ |- EBOOS/EBO10 - Commaon 1stYear Core Courses Core Course List 00000001078
11 1- CHEM1008FA: Chemistry for Engineers Core Course 00000001022
11 1- and MATHS 1017F: Engineering Mathematics A Core Course 00000001023
i1 1- and MATHS 1018F: Englneering Mathematics B Care Course 00000001024
11 1- and MATHS 10423: Engineering Statistics Core Course 00000001025
1 1= and MEMNG 1002W: Engineering Drawing Core Course 00000001026
i 1 1- and MEMG 1004W: Engineering | Caore Course 00000001027
11 1= and PHYSICS 1012F: Engineering Physics A Core Course 0oooooo102a
i1 1- and PHYSICS 1013F: Engineering Physics B Core Course 00000001029
V1 1= and MEMNG 1000X; Practical Training Core Course 00000001030

= - and BSc Mechanical Engineering Second Year of Study Year 000000014100

= I - EBOOS/EBO0 - Commaon 2nd Year Core Courses Core Course List 00000001079
11 - EENG 2030F: Electrical Engineering | Core Course 00000001031
I 1 i- and EENG 20313: Electrical Engineering Il Core Course 00000001032
V1 - and MATHS 2083F: Vector Calculus for Engineers Core Course 00000001033
V1 1- and MATHS 2084F: Linear Algebra Core Course 00000001034
V1 1= and MEMNG 2020W: Design | Core Course 00000001035
11 1- and MEMG 20225 Thermofluids | Care Course 00000001036
11 1- and MEMNG 2023F: Dynamics | Core Course 00000001037

Field or Control Description
As of Date The system uses the date that you enter to retrieve the correct

effective dated row for the select item and related child items.

Generate Click this button to retrieve the definition for the selected
academic item, and all child items attached to it.

When the template is generated, the item and any related child
items are displayed in the collapsed form, as shown in the
first page example above. Items can be expanded using the
Expand/Collapse button. After an item has been expanded, the
Program Format Structure View button becomes available and
can be used to collapse all items, as shown in the second page

example.
Expand/Collapse Expand or collapse any related child data.
Item Description The Description from the Academic Item header is displayed

(SSR_AIR_HDR.DESCRS50).

Enrollment Category The description for the Enrollment category of the item (SSR_
AIR_ENRL.SSR_ENRL_CAT) is displayed.

Item Type The item type description is displayed for the academic item.
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Field or Control Description

Item ID Click the link to access the Academic Item Registry
component for the selected ID. You can make and save
changes in that component before you return to the Program
Template component.

Note: When a Program item is accessed from the Template
view, the Program Format structure is enforced and academic
item types that are identified as Program Format Tree Nodes
cannot be added or deleted.

See Setting Up Academic Item Types

See Setting Up Program Formats

Viewing the Template — Long Page

Access the Template — Long page (Curriculum Management > Academic Item Registry >
Program Template > Template — Long).
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This example illustrates the fields and controls on the Template Long page.

Template Template - Long

Academic Institution PeopleSoft University UK

Academic tem ID 00000001102 BSc (Eng)in Mechanical Engineering
Academic item Type Program of Study

as of Date 10042012 [ Generate | Program Format Structure View |

Enroliment

Cate ltem Type |I!am 1]

Item Description

< DEPARTMENTS
Mechanical Engineeering

BSc (Eng) in Mechanical Engineering

Thie Mechanical Engineering degrea provides students with a solid understanding and

appraciation of the materials and forces of nature, The undergraduate programme is

structured around the study of mathemalics, physics, chemistry, malenals, basic electrical

engineering, the design pracess and management studies. Exciting caraers, requiring the

talents of mechanical engineers for the design. development and manufacture of technologies, Program of Study 00000001103
produds and processes, indude automotive, aircraft and space industries, air condiioning

and refrigeration, food and packaging industry, blomechanical research and development,

energy and power utillsation, and the environmental industry, to name a few. Many of our

graduates have followed successful career paths and are now caplaing of industry.

This programme concentrates on instruction in the areas of solid mechanics, dynamics and
thrermofluids, accompanied by experimental verification. Communication skills are addressed
through expert instruction and application in repors of experimentation and design. Design is
made central to the curriculum where team skills and, finally, individual skills are developed.
Curriculum flexibility in the final year of study allows students to select courses thal can provide
an introduction 10 a career in Mechanical Engineering.

< The first year of study contains Common First Year Core Courses equating to 144 credits,
and a Practical Training Course. Students should atternpt and complete all Core Courses Year 00000001099
and the Practical Training Course,

= Bachelor of Science in Engineering in Electro-Mechanical Engineering (EB010)
o
Bahlar of Science in Engineering in Mechanical Engineering (EBD0S)
The undergraduate Bachelor of Science in Engineering degree programmes in Eleclro-  Core Course List Q0000001078
Mechanical Engineeeing and Mechanical Engineering have a commaon first and second

year Curriculum.

Studants should complete and pass all Core Coursas in the [ist below:

* CHEM 1008FA& Chemistry for Engineers Caore Course 00000001022
¢ and MATHS 1017F: Engineering Mathematics A Core Course 00000001023
* and MATHS 1018F. Englneering Mathematics B Core Course 00000001024
* and MATHS 10425: Engineering Statistics Caore Course 00000001025
* and MEMM 1007 Enninesrinn Nrawinn rnre Moiree ANAANANANZA

The Template - Long page includes the long display of the AIR Report description for the selected
academic item (that is, the highest item node).

Setting Up Course Groups

This section provides an overview of course groups and discusses how to:
* Define course groups.

* Define course group details.

*  View test output.

¢ Define filters.
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*  Copy course groups.

Understanding Course Groups

Setting Up Program Enroliment

The AIR feature provides the ability to define simple or complex lists of courses (Course ID, Course
Offering, Course Topics), but the structure cannot accommodate the commonly used (in academic
requirements) wild card course option, where, for example, the student is instructed to take one 200 level
course from the Economics Department.

Use the Course Group feature in conjunction with the academic item type COURSEGROUP. A Course
Group consists of one of more sets of wild card criteria that can be used to build a loosely defined list of

courses.

Pages Used to Set Up Course Groups

Page Name

Definition Name

Navigation

Usage

Course Group Header

SSR_CRS_GRP_HDR

Curriculum

Management > Academic
Item Registry > Course
Groups > Course Group
Header

Define course groups.

Course Group Detail

SSR_CRS_GRP_DTL

Curriculum

Management > Academic
Item Registry > Course
Groups > Course Group
Detail

Define course group details.

Management > Academic
Item Registry > Course
Groups > Filters

Test Output SSR_CRS_GRP OUT Curriculum View test output.
Management > Academic
Item Registry > Course
Groups > Test Output

Filters SSR_CRS _GRP_FILTER Curriculum Define a subset of the

available Course Group
criteria fields as filters for use
in student self-service.

Defining Course Groups

Access the Course Group Header page (Curriculum Management > Academic Item Registry >
Course Groups > Course Group Header).
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This example illustrates the fields and controls on the Course Group Header page. You can find

definitions for the fields and controls later on this page.

Course Group Header Course Group Detail Test Output Filters

Academic Institution  PeopleSoft University

Course Group ID 000000021

Report Description

Test

Academic Item Registry Entries
Description
00000002277 B.S Nursing Year 2 Semester 1 Fall Electives

Find | View All First (4 10f1 (» Last

*Effective Date 01/01/1900 |3 *Status [ Active

~] #[=]

Automatically Execute

*Description |B.S Nursing Year 2 Semester 1 Fall Electives

SQL Where Clause where INSTITUTION=:1 and ((SUBJECT='NATSCI' and CATALOG_NBR like ' 1__"))

Internal Description
Nursing elective

Personalize | Find | View All | {2 First (4 10f1 (» Last

Course Groups are defined by Institution and a system generated ID number.

Field or Control

Description

Report Description

Click this link to access a new window in which Rich
Text Editor features are available. The HTML output for
the formatted text appears as display only in the Report
Description field.

Automatically Execute

When this check box is selected, the list of courses defined by
this Course Group is returned directly to the self-service Ul
(My Education Plan); otherwise, the results are accessed on a
secondary page.

See “Using Program Enrollment Self-Service Features”
(Campus Self Service )

SQL Where Clause On save, the system connects all of the Course Group Detail
lines and generates and displays a SQL where clause using the
criteria from each detail row.

Test Click to initiate a SQL count statement which returns the

number of course offering (CRSE_OFFER) rows that meet the
criteria in the Course Group Detail line(s):

The row count is returned in a modal message, with an option
to view the results.

To address performance concerns, you receive a warning when
over 300 rows are returned, giving you the option to refine the
search or continue to view the results.
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Field or Control Description

Add AIR Entry for this Course Group Click this button to create an academic item for this Course
Group definition. The button creates a new item for this course
group and transfers the user to the Academic Item Registry
component.

Defining Course Group Details

Access the Course Group Detail page (Curriculum Management > Academic Item Registry >
Course Groups > Course Group Detail).
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This example illustrates the fields and controls on the Course Group Detail page. You can find definitions

for the fields and controls later on this page.

Course Group Header || Course Group Detail

Academic Institution PeopleSoft University

Course Group 100 000000013

Effective Date 01/01/1300

*Sequence Number| 10

Test Qutput

Status Active

Description Liberal Arts and Management Upper Division

Filters

First K 1 o 1 B Last

Find | View Al

[+[=]

First Bl 1 or2 I gt

[+ [=]

Find | Wiew Al

*Descﬁption|Liheral Arts Upper Divisicn

Subject Area |

Catalog Nbr |25#%

@

Academic Career|

Academic Group |LEIART

College of Liberal Arts

Academic Drganization|

Campus|

Requirement Designation|

Course Attribute |

Course Attribute Value |

op|lppppp| PP

Academic Item Attribute |

v|

Test |

SOL Where Clause CATALOG_MBR like 3__ " and ACAD_GROUP='LBART

Field or Control

Description

Sequence Number

Enter a user defined sequence number.

Description

Enter a description for the Group Detail row.

372
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Field or Control

Description

Catalog Nbr

Enter % to match one or more characters—for example, 20%
retrieves all catalog numbers where the first two characters are
2 and 0.

Enter _ (underscore) to match a single character.

Enter # to match any single numeric character.

Academic Career, Academic Group, Academic
Organization, Campus, Requirement Designation, Course
Attribute, and Course Attribute Value

Enter valid values in these fields to further refine the selection
criteria for the Course List against the Course Catalog.

Academic Item Attribute

Enter an academic item attribute to further refine the selection
criteria. The system uses this to select criteria against the
academic item registry.

Value

Viewi

Copyright

When an Attribute is used, you can enter a Value—a prompt is
available if the Academic Item Attribute has an Attribute Type
of LOV, Table, or Translate.

Refer to the previous documentation for the Course Group Header page for descriptions of SQL Where

Clause and Test.

ng Test Output

Access the Test Output page (Curriculum Management > Academic Item Registry > Course

Groups > Test Output).
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This example illustrates the fields and controls on the Test Output page. You can find definitions for the

fields and controls later on this page.

Course Group Header | Course Group Detail

Academic Institution PeopleSoft University
Course Group 1D 000000018

o
Personalize | Find | View Al | -'E| it

Test Output Filters

Where Clause where INSTITUTION=:1 and ({CATALOG_NBR like '3 “and
ACAD_GROUP=LBART) or (SUBJECT="MGWMT and CATALOG_NER like 3 n

1 Microecon Policy Analysis |

1 Microecon Policy Analysis Il

1 Macro Stabilization Policy |

1 Macro Stabilization Policy Il

1 Technology and Growth |

1 Technology and Growth I

1 Mathematical Economics |

1 Mathematical Economics Il

1 Dissertation |

1 Diszertation Il

1 Financial and Risk Analysis |

1 Financial and Risk Analysis Il

1 Strateqgic HR Management |

1 Strategic HR Management Il

First n 1-14 of 14 u Last

Approved

Approved

Approved

Approved

Approved

Approved

Approved

Approved

Approved

Approved

Approved

Approved

Academic em 1D E;’“’“
1 ECON3001A4 00000000414 666741
2 ECON3001B 00000000415 666742
3 ECON 30024 00000000416 666743
4 ECON3002B 00000000417 666744
5 ECON3003A 00000000421 666748
6 ECON 300328 00000000429 GEETS6
7 ECON 30124 00000000423 686750
8 ECON3012B 00000000424 686751
9 ECON 30204 00000000419 666746
10 ECON 30208 00000000420 666747
11 ;L’”;T:CE 00000000447 666774
12 FIANCE 00000000448 666775
13 MGMT 30014 00000000453 66780
14 MGMT 3001B 00000000454 666781
4

i

When you click the Test button on the Course Group Header or Course Group Detail page and click OK
to view the results, you are transferred to the Test Output page where the results appear in a grid that you
can scroll through (the Tools zoom feature is available).

Defining Filters

374

Access the Filters page (Curriculum Management > Academic Item Registry > Course Groups >

Filters).
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This example illustrates the fields and controls on the Filters page. You can find definitions for the fields
and controls later on this page.

Course Group Header Course Group Detail Test Output Filters

Academic Institution FeopleSoft University
Course Group ID 000000018

Effective Date 01/011900 Status Active #[=
Description Liberal Arts Upper Division

SQL Where Clause where INSTITUTION=:1 and ((CATALOG_MER like °3 “and
ACAD_GROUP=LEBART) or (SUBJECT="MGMT and CATALOG_NER like

3N
[ Automatically Execute
sernvice
) Field [ Attribute Description
¥/ Subject SUBJECT Subject Area
[ career
[T campus
["] Academic Organization 1 ECON Economics
[¥] Academic Group 2 FINANCE Finance
[¥] academic tem Attribute 3 MGMT Management
Refresh
Field | Attribute Description
ACAD_GRoOUP Academic Group

Find | View Al B2 First B B s

| |Fietd Value |Description
1 LBART College of Liberal Arts

Field | Attribute Description
INSTRUCTION Language of Instruction
LAMNGUAGE

1 EMGLISH Englizh
2 SPANISH Spanish

Use this page to define a subset of the Course Group criteria fields as filters for use in Student Self
Service. Because the filters are to be used only when a course group definition returns a large result set,
the Select filters for student self service options are available only if the course group is not set up to
automatically return results in the user interface (the Automatically Execute check box is not selected on
the Course Group Header page).
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Field or Control

Description

Select Filters for student self service

The options are: Subject, Career, Campus, Academic
Organization, Academic Group, Academic Item Attribute.

If an option is selected, then when you save or refresh

the page, the system creates a list of distinct values (with
descriptions) for the filter field, using the entire result set for
the Course Group. For example, if the result set for a Course
Group is 100 courses and Subject and Academic Group are
the filters, then a list of distinct Subject values and Academic
Group values are displayed. Because the filter values are saved
to the database, use the Refresh button if changes have been
made to the filter options or if changes have occurred in the
Course Catalog or Academic Item Registry that could have
affected the result set.

Matching values for selected filter fields:

For each filter that is selected, a value field is generated
with a Field/Attribute, Description format. This format
accommodates the use of Common Attribute Framework
based attributes. Only those attributes for which the Show in
Student Self-service check box is selected on the Academic
Item Registry page can be used as filters. For example, if the
result set includes three distinct attributes but only one is set
to Show in Student Self-service, then only that attribute is
displayed in the filter results.

See Using Item Attributes in AIR

See “Using Program Enrollment Self-Service Features”
(Campus Self Service )

Copying Course Groups

When you add a new Course Group, two copy options are available on the Course Group Header page:

Field or Control

Description

Copy AA Course List Copy an existing Academic Advisement course list that uses
a Wild Card indicator. When you select this option, the copy
process copies only those rows in the AA course list where the
wild card indicator =Y.

Copy Course Group Copy previously created course groups.

376
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This is an example of the Course Group Header page with the two copy options.

Course Group Header Course Group Detail

Academic Institution PecopleZoft University

Course Group 1D 000000000

*Effective Date 07/02/2013 [#]

TestOutput | Filters

Copy AA Course List |

Copy Course Group |

First n 1 of1 n Last

Find | View Al

[+ [=]

*Description |

Report Description

Automatically Execute

Field or Control

Description

Copy AA Course List

When you click the Copy AA Course List button:

You are transferred to the Copy Academic Advisement
Course List look up page.

You select a Course List for the Institution of the new
Course Group.

The Course List look-up prompts against a view of the
Course List Detail table, for Course Lists that have a Wild
Card Indicator (CLST_DETL TBL where WILDCARD _
IND ="Y").

If the selected Course List has detail rows within it where
the wild card indicator = N, those rows are not copied.

Copy Course Group

When you click the Copy Course Group button:

You are transferred to the Copy Course Group look up
page.

You select a Course Group ID from a list of existing
Course Groups for the Institution of the new Course
Group.

You are transferred back to the Course Group component
and all eligible data is copied. You can then make
adjustments as needed.
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Setting Up for the Academic Progress Tracker

The program data that you define in the Academic Item Registry is ultimately stored at the student level
in the Academic Progress Tracker (APT). The APT record for a student is keyed by an instance which
also provides a link to the academic program of the student.

See Understanding the Academic Progress Tracker

This section discusses how to:
* Enable program enrollment.

*  Map Campus Solutions academic programs, plans and subplans to AIR based programs of study.

Chapter 7

Note: As of April 2012, the option to hold the APT Instance at the Academic Plan level is no longer
available. The APT Instance is held at the Academic Program level only.

Pages Used to Set Up for the Academic Progress Tracker

Page Name Definition Name Navigation Usage

Academic Institution 9 SSR_INST PE Set Up SACR > Enable Program Enrollment.
Foundation Tables >
Academic Structure >
Academic Institution
Table > Academic
Institution 9

Program Enrollment Mapping | SSR_ PROG_PE Set Up SACR > Map Campus Solutions
Foundation Tables > academic programs, plans
Academic Structure > and subplans to AIR based
Academic Program programs of study.
Table > Program
Enrollment Mapping

Enabling Program Enroliment

Your institution must enable Program Enrollment at the Academic Structure level in order to define
academic program/plan/subplan mapping and to enable the tracking of an APT instance on the
Admissions and Student Records program stacks.

See “Enabling Program Enrollment and Activity Management Defaults” (Campus Solutions Application
Fundamentals)

Mapping Campus Solutions Academic Programs, Plans and SubPlans to
AIR Based Programs of Study

378

Admission applications, admission, matriculation, and core student program management continue to use
Campus Solutions academic program structures. Institutions that want to use AIR based programs for
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tracking student programs and enrollment must map the Campus Solutions academic structure attributes
of those offerings - the programs, plans, and subplans - to AIR program of study academic items. A
mapping table is provided at the Academic Program Table level for this purpose.

Access the Program Enrollment Mapping page (Set Up SACR > Foundation Tables > Academic
Structure > Academic Program Table > Program Enrollment Mapping).

This example illustrates the fields and controls on the Program Enrollment Mapping page. You can find
definitions for the fields and controls later on this page.

(1§ PBIData Graduation Program Enrollment Mapping Research Processing Options | Advisement

Academic Institution: PSUMY PeopleSoft University
Academic Program: BALAL  BaALiberal Arts Programs
First n 10f1 n Last
Effective Date: 01/01/1900 Status Active
Academic ltem Registry Mapping End | View A1  First b:.:0 Last
=
*Group ID: | 20 [ pefault
*Description: |B4 Economics

*Approved Academic Lﬂﬁd_ Full-Time Vﬂ. E]

*Academic ltem ID 00000001753 @ g 4 Economics
Default Grading Basis |GRD Q  Graded

Use this page to create rules that map an academic program and one or more plan combinations to AIR
Program of Study academic items.

This page is available only if the Enable Program Enrollment check box is selected on the Academic
Institution 9 page.

Academic Item Registry Mapping

Field or Control Description

Group ID Enter a number to be used as an identifier for a group of plans
and subplans.

Default Select this check box to indicate which Group ID is the

default. When you select this check box, the Academic Plan/
Academic Sub-Plan grid is not available because the default
is a catch-all for a program with any unmapped plan/subplan

combination.
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Field or Control Description
Academic Plan Enter one or more academic plans per Group ID.
Academic Sub-Plan Enter one or more subplan values associated with the plan.

You must enter a new row of Academic Plan for each subplan
that you enter.

Approved Academic Load and Academic Item ID Enter at least one Approved Academic Load value and one
Academic Item ID value per Group ID.

Edits

A Plan cannot be used with a null subplan value and an actual subplan value within the same group. A
combination like the following is invalid:

Group ID: 10

* Academic Plan: PSYCH
* Academic Sub-Plan: 41
* Academic Plan: PSYCH
* Academic Sub-Plan: null

This mapping combination is not allowed because it is contradictory - with subplan equals 4/ and subplan
equals any plan. This condition returns an error message for incorrect definition, referencing the group
number.

Related Links

“Defining Academic Programs” (Campus Solutions Application Fundamentals)
“Defining Academic Plans” (Campus Solutions Application Fundamentals)
“Defining Academic Subplans” (Campus Solutions Application Fundamentals)

Setting Up APT Action Security

380

Use the APT Action Security page to determine the actions that a user can select on the APT
Administrative Roster page, based on User ID security. For example, a user may be able to add a course
academic item to a student’s Academic Progress Tracker (APT) but not remove it. Be careful when
granting users access to APT actions such as remove items, because a user can remove planning nodes
and even the program if no action has been taken on the item or any of its children.

Note: When setting up security for the APT Action Add Item, add the parent item as well as the academic
item. For example, if you set up an APT Action Add Item for Course academic item and the course is to
be added to a parent semester, you must also set up the APT Action Add Item for Semester academic item.
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If security is not granted for a specific academic item and action, the user cannot select the academic item
on the search pages and prompts on the APT Administrative Roster page.

See Managing the APT Administrative Roster

Page Used to Set Up APT Action Security

Page Name

Definition Name

Navigation

Usage

APT Action Security

SSR_APT ACT SCRTY

Set Up
SACR > Security > Secure
Student

Secure APT actions for
the adding, removal, and
substitution of academic items

Administration > User
ID > APT Action Security

and result entry, calculation
and evaluation.

Defining Security for APT Actions

Access the APT Action Security page (Set Up SACR > Security > Secure Student
Administration > User ID > APT Action Security).

This example illustrates the fields and controls on the APT (Academic Progress Tracker) Action Security
page. You can find definitions for the fields and controls later on this page.

APT Action Security

Useril: SR9878 Administrator APT

*Academic ltem Type | |:APT Action

LoURSE ® O Course Add lterm | ReadWrite [+][=]
COURSELIST Q_ Course List [ Add ftem v|Readwite  [#] [=]
COURSE O Course |Remo-.-e lem v| ReadMWrite (=]
COURSELIST Q_ Course List [Remove ltem v|Readwite  [#] [=]
REQUIREMENT Q. Requirement [ Remove tem v | Readwrite =]
COURSE Q, Course [ Create Substitution v| Readwrite  [#] [=]
COURSELIST ) Course List | Create Substitution v| Readwrite =
COURSELIST ), Course List | Enter Results v | ReadWrite = =
COURSE Q) Course | Enter Results | ReadWrite [+ [=]
SEMESTER Q) Semester | Enter Results v| ReadWrite = =
YEAR <, Year |Enter Results Vl ReadWrite [+l [=]
SEMESTER @, Semester | Enter APT Status v|Readwite  [#] [=]
COURSE Q_ Course | Enter APT Status v | ReadWirite =]
YEAR Q Year | Enter APT Status v| Reagwite [ [=]
COURSELIST Q, Course List | Enter APT Status v|Readwite  [+] [=]
COURSELIST @ Course List | Calculate Results v| Readwrite [ [=]
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Setting Up APT Reason Codes

Your institution can use the APT Reason Code Table page to set up reason codes to be used in the
Academic Item Attempt Results section of the APT Items page. For example, a student may be granted
a higher result and compensation due to ill-health or other mitigating circumstances; a result may be
excluded due to plagiarism. You can set up reasons to be added to a specific result. A reason code can be
stored for each result row in the APT Items page if required. You can also add the reason code when you
enter results on the APT Administrative Roster page.

See Managing APT Items

See Managing the APT Administrative Roster

Page Used to Set Up APT Reason Codes

Page Name Definition Name Navigation Usage

APT Reason Code Table SSR_APT RSN TBL Set Up SACR > Product Set up reason codes for
Related > Student Academic Item Attempt
Records > Program Results.
Enrollment > APT Reason
Code Table

Defining APT Reason Codes

382

Access the APT Reason Code Table page (Set Up SACR > Product Related > Student
Records > Program Enrollment > APT Reason Code Table).
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This example illustrates the fields and controls on the APT Reason Code Table page.

Academic Institution:

Reason Code:

*Effective Date:

*Description:

Short Description:

Long Description:

APT Reason Code Table

PSUNY PeopleSoft University

COMP

Find | View Al

*Status:

01/01/1800 [5]

¥ Show in Student Self Service

I Active vI

First n 1 of 1 u Last
[=]

[Result Compensation

|Comp

‘| @ a i= H &
EORS & o) | .

i Fomat ~ | Font *| Size
B I U ==

- -

- -

E = = = 1— ==

E === i—  E—

; E = = | i= = = A~

Student result compensated and higher mark authorized due to

exceplional performance on the program to date.

Field or Control

Description

Show in Student Self Service

Planned for the future.

Using the Common Attribute Framework to Extend Class
Associations for Program Enroliment

The Common Attribute Framework (CAF) can be used with Program Enrollment Self-Service to associate
a student with specific sections of a class. There are two configuration options: Required Match and Filter
Default. An example of a Required Match is where a student’s attribute value, e.g. Student Language
French, matches only those classes with the same value. Filter Default automatically selects classes based
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on the student’s attribute value, but students can deselect the filter and select another student language
attribute value (for example, English). Institutions can define the values they want to use within the
Common Attribute Framework to be able to associate students with specific classes.

Related Links

Using the Common Attribute Framework to Extend Class Associations

Setting Up Common Attribute Framework to Extend Class Associations for
Program Enroliment

384

1. Add the common attributes you want to use to associate students with specific classes.

a.

Go to Set Up SACR > Common Definitions > Common Attribute Setup > Record
Context).

In Record (Table) Name, make sure you select ACAD PROG.

In the Attributes region, specify the common attributes you want to use. The following images
show examples of adding Student Language and Student Shift as the common attributes.

This example illustrates adding common attribute "Student Language" to filter classes.

Record Context Secondary Page Opfions

Delete Record Context

Record (Table) Name: ACAD_PROG
*Description: |Student Program attributes +/ System Data
*Attribute Record: |SSF€_F‘RDG_CAF 2l Student Program CAF table
Override Prompt Table; | Q

[|Extend to staging record

Entity Name: |Atiribute Student Program attr Q

Attribute Filter Class: |

Attribute Display Type Copy Attributes from

(® Inline Subpage () Secondary Page | 3, Copy |
Atiributes find |Viewa  First Bl 1or2 O Lot
T - ¥
*Attribute Sequence: 1 Status: =

*Common Attribute: | STUDENT LANGUAGE O Student Language

O Required ] Repeatable

F Entity Associations
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This example illustrates adding common attribute "Shift" to filter classes.

Record Context Secondary Page Options

Delete Record Context

Record (Table) Name: ACAD_PROG
*Description: |Student Program attributes + System Data
*Attribute Record: |SSR_PROG_CAF @, Student Program CAF table
Override Prompt Table: | Q
[ | Extend to staging record
Entity Name: |Attribute Student Program attr Q
Attribute Filter Class: | Q
Attribute Display Type
® Inline Subpage O Secondary Page | Q Copy |
- +
-Attribuio Soquence: |2 Status: =]
*Common Attribute; | SHIFT ), Student Shift
] Required ] Repeatable
F Entity Associations

d. Click Save.

e. Access the Record Context page again (Set Up SACR > Common Definitions > Common
Attribute Setup > Record Context).

f. In Record (Table) Name, select CLASS ASSOC.
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This illustrates adding a common attribute to Record Name CLASS_ASSOC. You can find
definitions for the fields and controls later on this page.

Record Context Secondary Page Options

Delete Record Context

Record (Table) Name: CLASS_ASSOC

*Description: (CAF for CLASS_ASSOC Record * System Data
*Attribute Record: 'SSR_ASSOC_CAF @, CAF record

Owverride Prompt Table; | Q

! Extend to staging record

Entity Name: (ClassAssocAtiribute Q

Attribute Filter Class: | Q

Atiribute Display Type Copy Atiributes from

'® Inline Subpage ' Secondary Page | Q Copy |

Attributes

Find | View Al  First B8 1054 I Last

A - +
*Attribute Sequence: 1 Status: =]

*Common Attribute: STUDENT LANGUAGE () Student Language

|| Required #| Repeatable

~ Entity Associations Find | View Al | & First BN 4 051 B | ot

1| Q [+ [=]

g. Add the same attributes you added to ACAD_PROG so that you can select these attributes on the
Associated Class Attributes page (step 3), and then click Save.

2. Configure class search to use the common attribute.
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This example illustrates configuring class search filters for program enrollment.

Search Configuration Class Result Options Class Detail Options

Class Search Profile SSAPT

] show Class Result Instructions

Message Set Number | 14690 Message Number 3265
Message Text Use the class section links to access additional class detail

Use Search Result Filters

Filter items Find | 0] B First B gaor2 0 1wt
Sequence |~
Cnnlnon Common Atiribute
'“h"'
[Student Shift | [Required Match w| =
2 [+ [Student Language | [Required Match v =

Go to Set Up SACR > Product Related > Student Records > Curriculum
Management > Class Search Configuration.

In Class Search Profile, click SSAPT.
This profile allows you to match students to specific classes based on certain filters.
Click Class Result Options.

In the Filters group box, select Use Search Filter Results if there are a number of class attributes
so that students can use these as filters when searching for classes.

In the Filters group box, select Use Common Attribute to add the attributes you created.
In the Match column, you can select:

Required Match, which requires an exact match on the Student Program and Class Association
attributes. If there is only one class attribute that matches the Student Program attribute, the class
section appears by default in My Schedule Builder. If there are multiple classes that match the
Student Program attribute, then all classes are displayed. If you select Use Search Results Filters
on the Class Result Options page, the student cannot deselect the filter for the attribute that is

set as a ‘Required Match’ in My Schedule Builder. For example, there may be classes taught

in French and Flemish. The Student Program attribute is ‘Flemish’. In the class table, there are
two Flemish courses and one French course. The student cannot deselect the matching language
Flemish classes, but can view, and (optionally) select the other French class.

Filter Default, which does not require a match between the Student Program and Class
Association attributes. For example, there may be multiple classes for the attribute Shift (Shift

1, Shift 2, and so on). The Student Program attribute is Shift 2. Because Filter Default does not
require a match, the attribute for Shift 1 is also displayed and can be selected. Although Shift 2 is
selected as the default (because it matches the Student Program value), the student can deselect
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Shift 2 and then select Shift 1. The classes that appear in the search results are based on the initial
default. It is also possible to select both attributes.

For more information about the Class Result Options page, see Defining Class Search Result
Options.

3. Link the attribute to classes:

Go to Curriculum Management > Schedule of Classes > Maintain Schedule of Classes.
Click Associated Class Attributes.
From the Associated Class Attributes region, add the attribute and assign a value.

This illustrates how to linking common attributes to a class.

Associated Class Attributes
Course 1D: GEBETO Course Offering Nbr: 1
Academic Institution: PSUNY PeopleSoft University Class Section: 2
Term: 0770 2016 Fall Session: Regular
Subject Area: ECON Economics Associated Class: 2
Catalog Nbr: 3 Microeconomic Principles
Associated Class Atftributes Find  First Bl 12 02 B Last
[=]
*Attribute | Student Shift v
2 QU second shitt
[=]
«Attribute | Student Language v
FL Q' Flemish

When you are done adding attributes and assigning values, click OK.

If there are other sections to which you want to link attributes, go to the next section in the list,
then repeat steps b to d.

Click Save.

4. Link the attributes and values to the student’s Program/Plan record.

a.

Go to Records and Enrollment > Career and Program Information > Student Program/
Plan.

Click Additional Information.
This tab appears when you set up the attribute for the Record Name ACAD PROG.

In the Program Data region, add a program attribute and assign a value.
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This example shows program attributes set for Student Shift = 2, and Student Language = FL.

This shows an example of linking common attributes to a student's program plan.

‘Wendy Smarihouse

0099

Academic Career: Career Reguirement Term

Student Program | StudentPlan | StudentSub-Plan | Additional Information | StudentAttibutes | StudentDegrees [

Program Data

Academic Program BALAU BEA Liberal Arts Programs

W EH @

Student Career Nbr: 0

First B 1 or 1 I Last

Find | View Al

Program Attributes Find First 4 12052 BN Last
=Attribute | Student Language v FHE]
FL 2 Flemish
#| Show in Student 85
=Attribute | Student Shift A =]
2 Q. second shift
#| Show in Student 5§

Academic Plan

Academic Plan
Plan Attributes

BUSNMGMT Business Management

*Attribute v
#| Show in Student 5§

First B 1 or1 B Last

Find | View Al

First K 4 o4 B Last

To check your setup, log in as a student:
1. Go to Self Service > My Education Plan.

2. Click Build Schedule.

The first example shows classes that have a ‘Required Match’. The student cannot deselect the
attribute that is required (Flemish). The classes initially displayed are based on the required attribute.
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This illustrates an example of class search results when filtered by Student Language.

Chapter 7

My Schedule Builder

Search Results

PeopleSoft University | 2016 Fall

.=:':E1 B ciosed Await List

Return to My Schedule Builder

2 class section(s) found Apply Filter

¥ ECON 2: Macroeconomic Principles

Student Language

Class |Se|:t'ml| |Davs & Times |Rnnm |Instr|||:tnr |Heetil|g Dates |Status | | D French (1)
1862 Z-LEC TBA TBA Staff TEA . selact Flemish (2]
Reqgular
Class |Se|:t'ml| |Days & Times |Rnnm |Instr|||:tnr |Heetilu_| Dates |Status | |
2875 3-LEC TEBA TEA Staff TEA . select |
Regular

If an attribute is set as ‘Filter Default’ on the Class Result Options page, a match is not required.

In the following example, a student may have a Student Program attribute of Shift with a value of
Shift 2. Because this is not a required match, students can deselect the Shift 2 attribute and select Shift

1 or both.

This illustrates an example of class search results using a default filter.

My Schedule Builder

Search Results

PeopleSoft University | 2016 Fall

.=I':e'| Hciozed A\‘,‘ait List

Return to My Schedule Builder

1 class section(s) found Apply Filter

¥ ECON 2: Microaconomic Principles

Student Shift

Class |Section Days & Times Room Instructor Meeting Dates |Stat||s | | D First Shift (1)
2874 2-LEC TEA TEA Staff TEA . select I Second Shift (1)
Reqular

Student Language

Flemish (2]
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Understanding Instructor Workload

Higher-education institutions, particularly community colleges, need to set maximum limits on the
workload that is assigned to faculty and other individuals. These institutions also need to track and
report actual workload assignments. To accommodate these needs, Student Records has a feature called
Instructor Workload, which performs full-time equivalency tracking.

The Instructor Workload feature enables you to monitor the instructional and non-instructional workload
for selected faculty, instructors, and staff. This feature enables you to define workload limits for groups
or individuals. In addition, you can define multiple types of instructional and non-instructional work
assignments, using different workload standards for each type of assignment. You can have separate
workload upper limits for part-time and full-time individuals and can set automated controls that prevent
workload assignments beyond those limits.

If you use the Instructor Workload feature, the system automatically updates full-time equivalency
workload values when you enter data on the class scheduling pages. You can also use a background
process to copy workload data from one term to another, to update term workload records, or to produce a
simple report.

Note: The term instructor predominates in this product documentation and in field names on pages, but it
can include any individual with an employee ID at the institution. Advisors, teaching assistants, and even
students can be tracked using this feature. This information is entirely user-defined.

The formulas described in the following sections are the two primary calculations that the Instructor
Workload feature performs to update an individual's total term full-time equivalency percentage. Refer to
these formulas for clarification when you are familiar with all of the setup pages.

Course Component Workload Hours Formula

The Instructor Workload feature uses the following formula to calculate the default workload hours of a
course component on the Meetings page:

[(academic progress units x assigned percent) + (component workload hours x assigned percentage)]

X (subject/component multiplier) x (instructor term multiplier) % (load factor)

Note: The system supplies the multiplier values to 100 percent by default if the user does not specify
them.

At the academic institution level (Academic Institution 4 page), workload hours for courses are a
combination of academic progress units and component workload hours (for example, 0 percent academic
progress units and 100 percent component workload hours). Workload hours for noncourses are entered
directly on the Term Workload page.
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The Academic Subject Table has a subject/component multiplier specific to both the subject and
component (for example, math laboratory component multiplier 80 percent, math lecture component 110
percent, math independent study component 50 percent, and so on).

The Term Workload page has an instructor term multiplier that is supplied by default from the Instructor
Assignment Class table.

To divide one course component into more than one assignment, you can use a load factor. Inserting
multiple rows per course component and assigning each one a load factor (percentage) enables you to
divide a component into different assignment types, divide a component among instructors, or both. For
example, you might assign instructor A to teach 30 percent of the lecture component, and instructor B to
teach 70 percent of the lecture component. The user is responsible to set the load factor. The total load
factor for one course component should equal 100 percent.

Note: You must manually enter workload hours for all assignments that are made directly on the Term
Workload page. In other words, the system does not supply these types of manual noncourse-based
assignments by default using the previous calculation.

In the following example, instructor A is sharing the teaching load for Math 200 with another instructor.
This is why you set the load factor to 50 percent. This causes the default workload hours to change from
5 to 2.5 and the assignment full-time equivalency percent to change from 33.33 percent to 16.67 percent.
Notice that instructor B, who is sharing the load with instructor A to teach Math 200, somehow earns

an assigned full-time equivalent (FTE) of 33.33 percent. In addition, the default workload hours read

5, rather than 2.5, as they do for instructor A. This is because you assigned a multiplier of 200 percent

to instructor B for this term. All class components to which you assign instructor B count double for

this term. Also, notice that instructor A is supervising an independent study course, Physics 499. This
subject and component are set to be multiplied by only 50 percent. This is so that whoever teaches
physics with a component of independent study earns half credit for the task. Because of this, even
though the component workload hours of 3 are 10 percent of the 100 percent weekly workload hours for
this assignment type, the subject component multiplier halves this value so that the instructor earns an
assigned FTE of 5 percent. This process also causes the default workload hours to differ from those set on
the Class Associations - Class Components page (halved from 3 to 1.5).

Instructor | Assignment | Class Subject / Assignment | Load Factor | Meetings Assign FTE
Associations Component | Type / Page:
Multiplier 100% Default
Class Weekly Workload
Component Workload Hours
Page: Hours
Workload
Hours
Instructor Math 200 5 Math Lecture/ | RegLec/ 15 50% 2.5 16.67%
A Term 100%
Multiplier =
100%
Physics 201 5 Phys Lecture/ | RegLec/15 100% 5 33.33%
100%
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Instructor | Assignment | Class Subject/ Assignment | Load Factor | Meetings Assign FTE
Associations Component | Type / Page:
Multiplier 100% Default
Class Weekly Workload
Component Workload Hours
Page: Hours
Workload
Hours
Physics 499 |3 Phys Ind IndStudy/30 | 100% L.5 5%
Study/50%
Total Term
FTE% = 55%
Instructor Math 200 5 Math Lecture/ | RegLec/ 15 50% 5 33.33%
B Term 100%
Multiplier =
200%
Total Term Total Term
FTE% =33. |FTE%=33.
33% 33%

Instructor Assignment Percentage Formulas

The Instructor Workload feature uses three formulas to calculate an individual's assignment full-time
equivalency percentage. The system uses one of two formulas to calculate assignment FTE for regular
classes and for open entry and open exit (OEE) classes. It uses another formula to calculate assignment
FTE for assignments made directly to the Term Workload page.

Note: The Use Term/Session Weeks in Calc check box on the Academic Institution 4 page enables you to
exclude the assigned number of weeks—in the session—and the total weeks in a term from the workload
calculation formulas.

Regular Assignment FTE Formula

The system uses the following formula to calculate an individual's assignment full-time equivalency
percentage for a regular scheduled class (non-OEE):

(assignment workload hours x assigned number of weeks x 100) / (100 percent weekly workload hours %
total weeks in term).

Term

Definition

assignment workload hours

The number of workload hours that are assigned to the

instructor.
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Term

Definition

assigned number of weeks

The total number of weeks in the session for which the
instructor is teaching. This number is derived from the session
table.

100 percent weekly workload hours

The standard number of weekly hours that are required
(for example, 15 hours). This number is derived from the
assignment type table.

total weeks in term

Derived from the term/session table.

Open Entry and Open Exit Assignment FTE Formula

The system uses the following formula to calculate an individual's assignment full-time equivalency

percentage for an OEE class:

(assignment workload hours x assigned number of weeks x 100) / (100 percent OEE workload hours x

total weeks in term)

Term

Definition

assignment workload hours

The number of workload hours that are assigned to the

instructor.

assigned number of weeks

The total number of weeks in the session for which the
instructor is teaching. This number is derived from the session
table.

100 percent OEE workload hours

The standard number of term hours that are required (for
example, 225 hours). This number is derived from the

assignment type table.

The formula that the Instructor Workload feature uses to calculate an individual's assignment full-time
equivalency percentage from an assignment that is made directly to the Term Workload page is:

(assignment workload hours % 100)(100 percent weekly workload hours)

Term

Definition

assignment workload hours

The number of workload hours that is assigned to the
instructor.

394
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Term Definition
100 percent weekly workload hours The standard that is required (for example, 15 hours). This
number is derived from the assignment type table.

Examples of FTE Percent Formulas

The following example shows instructor C's assignments. The Biology 100 lecture is quite
straightforward. Three workload hours, compared to a 100 percent weekly workload hours value of 15,
result in the Biology 100 course totaling 20 percent of the instructor's workload (3 hours is 20 percent
of 15 hours). The Biology 100 lab, however, is associated with an assignment type of Notincl//0 (do not
include). This results in zero workload hours, therefore contributing no assignment FTE percentage.

In addition, instructor C teaches Biology 105 over the internet, with an assignment type of Internet.
Notice that this assignment type has a 100 percent weekly workload hours value of 6, which means that 6
hours taught on the internet is 100 percent of an individual's workload. This course assignment creates an
assignment FTE of 50 percent (3 hours is 50 percent of 6).

Finally, instructor C advises the Pre-Med Club. This assignment has a workload hours value of 9, which
translates into 30 percent of the instructor's assignments (9 is 30 percent of 30).

Instructor D is a good example of how an individual can earn a total term FTE of 100 percent, while
assigned only to advising (no class instruction). All types of assignments can contribute to total term FTE
percentage.

Instructor E shows how OEE classes can effect FTE. This instructor teaches Psych (psychology) 210,
with a workload hours value of 60. Because this section of Psych 210 is an OEE class, multiply the
workload hours by the total weeks in the session, and then multiply by 100 (60 x 15 x 100 = 90000).
Divide the result by the 100 percent OEE workload hours (225), times the total weeks in the session (15),
and you get an FTE of 26.67 percent for this class.

Instructor Assignment Component Class Assign Type/ Assignment FTE
Component %
Workload 100% Weekly
Hours / OEE Workload Hours
Workload Hours
or

100% OEE Wkid

Hrs
Instructor C Biology 100 Lecture 3 ReglLec/15 20%
Biology 100 Laboratory 1 NotIncl/O 0
Biology 105 Lecture 3 Internet/6 50%
(Internet)
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Instructor Assignment Component Class Assign Type/ Assignment FTE
Component %
Workload 100% Weekly
Hours / OEE Workload Hours
Workload Hours
or
100% OEE Wkid
Hrs
Advise Pre-Med N/A 9 Student Club 30%
Club Advisor/ 30
Total Term FTE%
=100%
Instructor D Advise Math Club | N/A 15 Student Club 50%
Advisor/ 30
Advise Math N/A 15 Student Club 50%
Honor Society Advisor/ 30
Total Term FTE%
=100%
Instructor E Psych 210 OEE Lecture [60] [RegLec/225 (15 26.67%
weeks)]
Psych 378 OEE Lecture [90] [Reglec/225 (15 40%
weeks)]
Psych 378 Lecture 3 RegLec/15 26.67%
Advise Psych Club | N/A 1 Student Club 11.11%
Advisor/9
Total Term FTE%
=104.45%

Prerequisite for Setting Up Instructor Workload

396

Before you can track instructor workload, Student Records setup tables must be fully operational so that
the faculty workload pages can retrieve complete and accurate data.
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Related Links
Student Records Integrations

Student Records Business Processes

Student Records Implementation

Implementing Instructor Workload Setup Tables

To set up instructor workload, use the Assignment Type component (ASSIGNMENT TYPE) and the
Instructor Assignment Class component (INSTRUCTOR_CLASS).

Here is a high-level overview of how to set up instructor workload:

1.

2.

Create assignment types.
Create instructor assignment classes.

Activate the Instructor Workload feature by selecting the Calculate Workload check box and
updating required fields.

Update Academic Subject table with component multiplier percentage.

Update the Course Catalog - Components page with workload hours, as necessary.

Adjust workload hours on the Class Components page, as necessary.

(Optional) Update the Term Workload page with instructor assignment class value and other data.

This task is optional because assignments that are made on the Meetings page automatically create a
Term Workload record for the individual if none exists for the term that you are assigning. However,
this process uses default values to specify a full-time equivalency percentage for the individual.

Schedule a new course, assign an instructor, and enter workload hours, if needed.

Update workload hours after you schedule a course or manually create a noncourse assignment on the
Term Workload page.

10. Return to the Term Workload page so that you can view the instructor's updated workload.

Pages Used to Implement Instructor Workload Setup Tables

Page Name Definition Name Navigation Usage

Assignment Type ASSIGNMENT _TYPE Curriculum Establish new assignment
Management > Instructor/ | type values that can be
Adyvisor Information > associated with course
Assignment Type > components or other
Assignment Type noncourse-based instructor

assignments.
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Page Name

Definition Name

Navigation

Usage

Instructor Assignment Class

INSTRUCTOR_CLASS

Curriculum

Management > Instructor/
Advisor Information >
Instructor Assignment

Class > Instructor
Assignment Class

Establish new instructor
assignment class values

and defaults that the system
can reference on both the
Term Workload page and the
Academic Institution 4 page.

Enter an alphanumeric code
(one to six characters in
length) for the instructor
assignment class. Each
instructor assignment class
value is associated with only
one academic institution.

Academic Institution 4

INSTITUTION_TABLE4

Set Up SACR >
Foundation Tables >
Academic Structure >
Academic Institution
Table > Academic
Institution 4

Activate the Instructor
Workload feature to establish
high-level limits, workload
preferences, and default
values for instructor workload
at your institution.

Before you access the
Academic Institution page,
create an assignment type and
an instructor assignment class.

Management > Course
Catalog > Course
Catalog > Components

Subject Workload SUBJ_ WORKLD TBL Set Up SACR > Specify the weight of each
Foundation Tables > component in each subject.
Academic Structure >
Academic Subject Table >
Subject Workload

Components CRSE CATALOG_CMPNT | Curriculum Enter workload hour data that

serve as a default value that
the system uses to populate
the same components on the
Class Components page when
you schedule a class.

Class Components

CLASS_ASSOC_CMPNT

Curriculum

Management > Schedule
of Classes > Adjust Class
Associations > Class
Components

Use the Workload Hours
field to enter or update
workload hours data for each
scheduled class component of
a course.

Creating Assignment Types

Access the Assignment Type page (Curriculum Management > Instructor/Advisor Information >
Assignment Type > Assignment Type).
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This example illustrates the fields and controls on the Assignment Type page. You can find definitions for
the fields and controls later on this page.

Assignment Type
Find | * A Fir=t E 1of 1 |I| Last
Assignment Type: REG E|
Academic Institution: PSLIMNY PeopleSoft University
“Effective Date: 001A900 [ gramus: | Active -]
*Description: Regular
Short Description: Regular

= Yiew on Schedule of Classes
T Include Assignment in Workload

100% Weekly Workload Hours: 14.00

100% OEE Workload Hours: 225.00

The assignment type affects how the system calculates the assignment full-time equivalency percentage
when you assign an instructor to a course component (on the Meetings page) or to any other type of
manual assignment (on the Term Workload page).

Note: To use the Instructor Workload feature, an Assignment Type with ASSIGN_TYPE ='NON' must
exist (hard-coded) for each academic institution in your database. This value is automatically created
when you activate the feature on the Academic Institution 4 page. You cannot delete or inactivate these
values for any academic institution for which you have activated the Instructor Workload feature.

Assignment types might include standard lecture class, standard lecture Internet, standard lab,
overload, unpaid, academic counseling, thesis supervision, and so on. For example, a course that

is taught on the internet might weigh differently than a course that is taught in a classroom. You can
create different assignment types to represent this variation. In addition, some assignment types (such as
academic counseling) might not be applicable for association with a course. In these instances, you can
specify assignment type options that disable this value as a choice on the Meetings page.

Field or Control Description

Effective Date Enter an effective date for the assignment type value that you
establish on this page.

Note: You can use only those assignment types with effective
dates that are earlier than or equal to the effective date of the
Academic Institution table as academic institution defaults on
the Academic Institution 4 page.

Assignment types with effective dates later than the effective
date of the Academic Institution table can still be used
throughout the system; they cannot be set up as academic
institution default values.
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Field or Control

Description

Status

Select a status for the assignment type value. Select Active
when adding a new assignment type. Select Inactive only if
your institution no longer uses the listed values. In particular,
you cannot inactivate assignment type values (set on the
Academic Institution 4 page) that the system references.
Values for this field are delivered with your system as
translate values. Do not modify these values in any way.
Any modifications to these values require a substantial
programming effort.

Short Description

Enter the short description to associate with the assignment
type value. This description appears in the grid on the
Meetings page and on the Term Workload page. Be sure to
use a short value that clearly describes the assignment type
value. For example, you might want to describe an assignment
type of Standard 15-Hour Assignment with a short description
of Stnd15. In that case, the grid prompt value also appears as
Stnd15. The short description is to the first ten characters of
the description.

View on Schedule of Classes

Select if you want the assignment type to be an available drop-
down choice on the Meetings page. This check box does not
control whether the assignment type appears on the Schedule
of Classes report; it just determines whether the assignment
type can be associated with a course component. Leave

this check box cleared if you do not want the assignment

type available for pairing with components. For example,

an assignment type of academic counseling or student club
advisor might not be something that you want associated with
a course component. It is an assignment type that is created
specifically for use on the Term Workload page. In this case,
do not select this check box. However, an assignment type of
In-person lecture might be something that you want available
on the Meetings page. In this case, do select this check box.

Include Assignment in Workload

Select if you want components with this assignment type to
be included in the instructor's total term full-time equivalency
percentage.

100% Weekly Workload Hours

Enter the 100 percent weekly workload hours value that
specifies the normal weekly workload for this assignment
type. This field enables you to assign different weekly full-
time hours for different assignment types. For example, the
standard class lecture full-time hours might be 15 per week,
the standard internet lecture full-time hours might be 20 per
week, and academic counseling full-time hours might be 35
per week.

400
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Field or Control Description

100% OEE Workload Hours If this assignment type can be affiliated with classes that are
offered in an open entry and exit format, enter a 100 percent
OEE workload hours value that represents the full-time load
for an entire term. For example, if you have a 100 percent
weekly workload hours value of /5 for this assignment type,
you can multiply this value by the number of weeks in the
term to which this assignment type belongs (100 percent
weekly workload hours [/5 ] x number of weeks in a term [/5]
=100 percent OEE workload hours [225]).

Creating Instructor Assignment Classes

Access the Instructor Assignment Class page (Curriculum Management > Instructor/Advisor
Information > Instructor Assignment Class > Instructor Assignment Class).

This example illustrates the fields and controls on the Instructor Assignment Class page. You can find
definitions for the fields and controls later on this page.

Instructor Assignment Class

Find | Wigwe Al First E 1of 1 |I| Last

Instructor Assighnment Class: FULL El
Academic Institution: PEUMY FeapleSoft Univarsity

*Effective Date: S REEN Status: | Betve 7|

*Description: Full-time

“FullPart Time: I Full-Time 'I

~ Calculate Workload:

V' Limit workload:

*Assigned FTE % 120.00

*Instructor Multiplier %: 100

Instructor assignment class values cluster different types of individuals with similar workload
requirements. For individuals in a particular instructor assignment class, the default settings that you
establish here can be modified on the Term Workload page.
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Field or Control

Description

Effective Date

Enter an effective date for the instructor assignment class that
you establish on this page.

Note: Only those active instructor assignment classes with
effective dates less than or equal to the effective date of the
Academic Institution table can be used as academic institution
defaults on the Academic Institution 4 page.

Instructor assignment classes with effective dates greater than
the effective date of the Academic Institution table can still
be used throughout the system, but they cannot be set up as
academic institution default values.

Status

Select a status for the instructor assignment class. Select

Active when adding a new instructor assignment class. Select
Inactive only if your institution no longer uses the value listed.
In particular, you cannot inactivate an instructor assignment
class that the system references on the Academic Institution

4 page. Values for this field are delivered with your system

as translate values. Do not modify these values in any way.
Any modifications to these values require a substantial
programming effort.

Description

Enter the description to associate with the instructor
assignment class value. All alphanumeric characters are valid.
This description appears in a related display on the Term
Workload and Academic Institution 4 pages.

Full/Part Time

Select a full-time or part-time value to indicate the traditional
status of instructors who are assigned to this instructor
assignment class. The default is Full-Time. Values for this
field are delivered with your system as translate values. Do not
modify these values in any way. Any modifications to these
values require a substantial programming effort.

Calculate Workload

Select to apply the Instructor Workload feature to instructors
in this assignment class by default. This selection determines
whether the system creates term detail records at all. This
selection alone does not control whether the Instructor
Workload feature produces a limit warning. You must select
the Limit Workload check box in conjunction with this check
box for warnings to appear. If you want to set up an instructor
assignment class specifically for those instructors who never
have load calculations performed, set up a separate instructor
assignment class and do not select this check box. The value
selected here is used to populate the Calculate Workload
check box on the Term Workload page as a default value. You
can change this setting on an individual and term-by-term
basis on the Term Workload page.
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Field or Control

Description

Limit Workload

Select to apply the limits to instructors in this instructor
assignment class by default. This feature controls whether

the system produces error messages or warnings when
assignments cause an individual's total term FTE percent to
exceed either the individual's assigned FTE percent or the
academic institution warning limits, whichever comes first. If
you select the Calculate Workload check box, this check box
is available. The value selected here is used to populate the
Limit Workload check box on the Term Workload page as a
default value. You can change this setting on an individual and
term-by-term basis on the Term Workload page.

Assigned FTE % (assigned full-time equivalent percent)

Enter the assigned FTE percentage to indicate the traditional
assignment of instructors assigned to this instructor
assignment class. This value represents the percentage of

the institution-wide standard to assign to instructors in this
class. For example, a field value of 700.00 enables you to
make assignments for instructors in this instructor assignment
class up to a total term FTE percent of 100. If you want to
hold instructors in this instructor assignment class to only 80
percent of the institution-wide standard, then you might set
the value to 80.00. Finally, if you often overbook full-time
instructors in a particular instructor assignment class (perhaps
to ultimately drop them from an assignment at the beginning
of the term), then you might want to set this value to 720.00.
This field's default value corresponds to the full-time and
part-time value that you select. The value entered here is used
to populate the Term Workload page as a default value for
individuals in this instructor assignment class.

You can change this setting on an individual and term-by-term
basis on the Term Workload page.

Instructor Multiplier %

Enter the instructor multiplier percent to associate with

this instructor assignment class. This value contributes to

the default workload hours formula for courses that are
assigned on the Meetings page for individuals in this instructor
assignment class. For example, if you want to give a certain
group of instructors double credit for the course components
to which they are assigned, set this value to 200. However,

if you want instructors to get only half credit for their course
assignments, you might assign them to a different instructor
assignment class with this field set to 50. This multiplier

does not apply to noncourse-based assignments that are made
directly to the Term Workload page. By default, this field
displays /00 when you are in Add mode. The value that is
entered here is used to populate the Term Workload page as a
default value. You can change this setting on an individual and
term-by-term basis on the Term Workload page.

Defining Instructor Workload Preferences for Your Institution

Access the Academic Institution 4 page (Set Up SACR > Foundation Tables > Academic
Structure > Academic Institution Table > Academic Institution 4).
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This example illustrates the fields and controls on the Academic Institution 4 page. You can find
definitions for the fields and controls later on this page.

Academic Institution 3 Academic Institution 4 emic Institution

Academic Institution: PSLINY FeaopleSoft University

Effective Date: 04404 14 800 Status: Active

¥ calculate Workload

Workload Hours

- . PN 100.00
Full-Time ¥Warning Limit %: Course Component Workload Hrs%: 100
Part-Time Warning Limit %: 50.00 Academic Progress Units %;

¥ Use Term/Session Weeks in Calc

Default WYalues

Full-Time Assigned FTE %: 120.00 Assignment Type: LEC & Lecture
Assionment Type

Part-Time Assigned FTE%: | 5000 Instructor Assignment Class: YLl S0 Fliitime

Field or Control Description

Calculate Workload Select to activate the workload feature for your institution and
to display related fields. Before you select this check box, you
may want to insert a new effective-dated row on the Academic
Institution 1 page.

Full-Time Warning Limit % Enter the full-time warning limit percent for the Instructor
Workload feature to reference at all times across the
institution. This value indicates the institution-wide setting for
those individuals who are assigned to an instructor class that

is full-time. If an assignment is made that causes a full-time
individual's total term FTE percentage to exceed this value,

the system issues a soft warning. The system produces the soft
warning only if the individual's Limit Workload check box is
selected on the Term Workload page.

Part-Time Warning Limit % Enter the part-time warning limit percent for the Instructor
Workload feature to reference at all times across the academic
institution. This value indicates the institution-wide setting for
those individuals who are assigned to an instructor class that is
part-time. If an assignment is made which causes a part-time
individual's total term FTE percentage to exceed this value, a
soft warning is issued. The system issues the warning only if
the individual's Limit Workload check box is selected on the
Term Workload page.
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Field or Control

Description

Use Term/Session Weeks in Calc (use term/session weeks in
calculation)

Select this check box to include the assigned number of weeks
—in the session—and the total weeks in the term within the
workload assignment FTE calculation. Clear this check box to
exclude the assigned number of weeks—in the session—and
the total weeks in the term within the workload assignment
FTE calculation.

Choosing How to Sum Workload Hours

Field or Control

Description

Course Component Workload Hrs% (course component
workload hours percent)

Copyright

Enter a percentage to specify your institution standard for
compiling course workload. For example, you might want to
calculate workload hours based solely on the defined workload
hours that are associated with the course component. In this
instance, set the Course Component Workload Hrs% field
to /00 and the Academic Progress Units % field to 0 (or
leave the second field cleared). When these two fields are

set this way, any time that you assign an instructor to teach a
course component at the specified academic institution, the
course component workload hours calculation uses only the
course component workload hours value (and not the progress
units) for the course. In addition, if you want to sum workload
hours based on both fields, you can do this by setting each

of the fields to the appropriate percentages. In this instance,
ensure that the two values total 100.
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Field or Control

Description

Academic Progress Units %

Enter a percentage to specify your institution standard for
compiling course workload. For example, you might want to
calculate workload hours at your institution based solely on
the academic progress units that are associated with the course
component. In this instance, set the Course Component
Workload Hrs% ficld to 0 (or leave this second field cleared)
and the Academic Progress Units % field to /00. When
these two fields are set this way, any time that you assign

an instructor to teach a course component at the specified
academic institution, the course component workload hours
calculation uses only the academic progress units for the
overall course as set on the Class Associations page (and

not the course component workload hours). This causes any
component of the course (lecture, laboratory, and so on) to be
calculated based on the academic progress units for the overall
course as set on the Class Associations page. In addition, if
you want to sum workload hours based on both fields, you
can do this by setting each of the fields to the appropriate
percentages. In this instance, ensure that the two values total
100.

Note: The preceding field values apply only to assignments
that are made on the Meetings page. Although not required by
the system, these two fields should total 100.

Note: Workload hours for assignments (which are not course-
based) that are made directly to the Term Workload page do
not reference either the Course Component Workload Hrs
% or Academic Progress Units % fields. Instead, the user
enters the assignment workload hours manually. For example,
an assignment that is made directly to the Term Workload page
for advising the math club might have a manually assigned
workload entry of 3 to represent the number of hours per week
that this assignment requires.

Assigning Workload Hours to Courses and Class Components

Workload for courses can comprise academic progress units and course component workload hours. If
your Academic Institution 4 page setting specifies that some percentage (1-100) of workload comprises
course component workload hours, specify course workload hours in the course catalog. In addition,
you might want to specify or update these hours for each component on the Class Associations - Class

Components page.
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Specifying Default Values for Your Institution

Field or Control Description
Full-Time Assigned FTE % (full-time assigned full-time Enter the full-time assigned FTE percent to appear in the
equivalent percent) Assigned FTE % field on the Instructor Assignment Class

page when a value of Full-Time is selected for the Full/Part
Time field on that page. This is only a default value, and you
can change it on the Instructor Assignment Class page.

Part-Time Assigned FTE % (part-time assigned full-time Enter the part-time assigned FTE percent to appear in the
equivalent percent) Assigned FTE % field on the Instructor Assignment Class
page when a value of Part-Time is selected for the Full/Part
Time field on that page. This is only a default value, and you

can change it on the Instructor Assignment Class page.

Assignment Type Enter the assignment type to appear on the Meetings page each
time that the system assigns a course component. This setting
is only a default value, and you can change it on the Meetings

page.

Instructor Assignment Class Enter the instructor assignment class to appear on the Term
Workload page. This setting is only a default value, and you

can change it on a case-by-case basis on the Term Workload

page.

Note: You cannot inactivate or delete the assignment type and instructor assignment class that are
referenced on the Academic Institution 4 page.

Related Links

“Defining Academic Institutions” (Campus Solutions Application Fundamentals)

Defining Subject and Component Multipliers

Access the Subject Workload page (Set Up SACR > Foundation Tables > Academic Structure >
Academic Subject Table > Subject Workload).
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This example illustrates the fields and controls on the Subject Workload page. You can find definitions for
the fields and controls later on this page.

Academic Subject Table

Academic Institution: PR

Subject Area: PHYSICS

Effective Date: 01011900

Suhject Taxonomy

Subject Workload

FeopleSoft University
Phvsics

First Izl 1of 1 II' Lazt

Eind | “igwe A
Status:  Active

First E 13 of 3 II' Laszt

“Course Component: [Lecture  +] *Component Multiplier %: 100 [=]
*Course Component: I ind Study ] *Component Multiplier %: a0 [=]
*Course Component: [Laboratory ] *Component Multiplier %: 75 [=]

The system uses these values as part of the course component workload hours formula to calculate the
assignment FTE percentage on the Meetings page. You do not need to enter values for course components

that are multiplied by 100 percent.

Field or Control

Description

Course Component

Select a course component to associate with courses in the
academic institution and subject area that you specify. Values
for this field are delivered with your system as translate values.
You can modify these values. The course component value
indicates the parts of the course offering, for example, Lecture,
Laboratory, Ind Study (independent study), and so on.

One subject area can have multiple components.

See Defining Course Components.

Component Multiplier %

Enter a component multiplier percentage value that represents
the weight of this type of component. By default, this field
displays /00. The system uses this value as part of the course
component workload hours formula to calculate default
workload hours on the Meetings page. You do not need to
enter values for course components that are multiplied by 100
percent unless you prefer to store this data for documentation.

As noted in the workload hours formula, multiplier values are
100 percent by default if they are not found.

See Course Component Workload Hours Formula.

Linking Workload Hours to Courses

You can use the Workload Hours field and the OEE Workload Hours (open entry and exit workload
hours) field on the Course Catalog - Components page to enter workload hour data. The value that
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you specify in each of these fields serves as a default value that the system uses to populate the same
components on the Class Components page when you schedule a class. In other words, if you set the
lecture Workload Hours field to 3 on the Course Catalog - Component page, then whenever you
schedule a lecture for this course, the lecture component Workload Hours field has a default value of 3
workload hours on the Class Components page for this component. Similarly, if you set the lecture OEE
Workload Hours (open entry and exit workload hours) field to 45 on the Course Catalog - Component
page, then whenever you schedule a lecture for this course in an open entry and open exit session, the
lecture component OEE Workload Hours (open entry and exit workload hours) field has a default value
of 45 workload hours on the Class Components page. If necessary, you should modify the component
values on the Class Components page.

Related Links
Defining Course Components
Linking Workload Hours to Class Components

Use the Workload Hours field on the Class Associations - Class Components page to enter or update
workload hours data for each scheduled class component of a course.

Related Links
Modifying Class Components
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Setting Up Transfer Credit Processing

Understanding the Transfer Credit Business Process

This section lists prerequisites and discusses the transfer credit business process.

Prerequisites

Before you set up transfer credit rules and process transfer credit, complete all other setup for Student
Records. You must define academic careers, academic programs, academic plans, the course catalog,
grading bases, terms, and sessions. It is helpful to write out the rules for accepting transfer credit before
you enter the rules in the system.

Transfer Credit Business Process
Setting up the Transfer Credit feature is complicated but can save you a lot of time in the future.

Setting up for processing transfer credit involves defining the external organizations from which you
accept transfer credit and defining all of the subject areas and courses that the external organization

can transfer. A key aid to completing the setup for the Transfer Credit feature is to point any external
organization or internal institution to any other external organization's or internal institution's catalog of
courses. It is thus possible to create one group of external courses that a number of external organizations
share. Sharing course information saves time because you do not have to duplicate your data entry effort
if one or more organizations have the same or similar courses. It is especially helpful when dealing with
a large transfer population from schools where courses are virtually the same or catalogs are shared. For
instance, if your academic institution receives many transfer students from a state college system, you can
create one catalog of external courses for the state college system where all state colleges in that system
can point to for these courses.

Transfer equivalency rules that you create are the foundation of the Transfer Credit process. After

you define external organizations, you create equivalency rules for courses and tests, then attach these
equivalency rules to specific academic programs and academic plans. You also attach an equivalency rule
to an external organization or internal institution.

After you complete the setup, you are ready to process transfer credit. Transfer credit processing is based
on a concept of modeling various scenarios of transfer credit articulation. You set up model scenarios for
an individual, dependent on the individual's chosen academic program and plan to demonstrate different
options of transferring credit. Based on your setup, you have the ability to model as many transfer credit
scenarios as you want for prospects, applicants, and current students. You also have the flexibility to
articulate models based on predefined rules or rules that you create manually.

Important! Much of this organizational setup is shared with PeopleSoft Campus Community and
PeopleSoft Recruiting and Admissions. Therefore, you should coordinate your efforts.
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Defining External Organizations

Before you can use transfer credit processing, use the Organization Table (ORGANIZATIONS)
component to define external organizations. As you define external organizations, specify their locations,
contacts, departments, and characteristics. Also, specify whether the organization is a vendor.

As part of the external organization setup within this component, transfer credit processing requires that
you:

* Select the Offers Courses check box on the School Data page in the Organization School Data
(SCC_EXT ORG_ADM) component to identify the external organization as one that offers courses.

You can also access this page via a link on the Organization Table page. This page enables you to
create external courses to be used in transfer credit articulation rules.

» Enter the data that applies to the external organizations that offer courses on the School Data page.

When forming transfer credit rules, the system uses the values that you define for the external
organization in the Career, Term Type, and Unit Type fields and the Catalog Information group
box as system default values. Furthermore, if you indicate that an external organization has a shared
catalog with another external organization, the system uses the catalog organization that you specify
as the default value on the Course Transfer Rule page.

Defining external organizations functionality is shared with Campus Community and Recruiting and
Admissions.

Related Links
“Understanding Organizations” (Campus Community Fundamentals)
“Creating Organization Records” (Campus Community Fundamentals)

Setting Up External Subjects

You define subject categories for external organizations on the External Subject Table page. Then, you
link these subjects to external organizations and the courses they offer. The subject area that you enter
on the External Subject Table page can be tied to specific external organizations on the School Subject
Maintenance page. For every external organization from which you anticipate receiving academic work
for transfer articulation, define all subject areas on this page.

Related Links

“Entering Codes for External Organizations” (Campus Community Fundamentals)

Setting Up External School Subjects

To set up external school subjects, use the School Subject Maintenance (SCHOOL SUBJECTS)
component.

This section discusses how to link external subjects to external organizations.
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Page Used to Set Up External School Subjects

Page Name

Definition Name

Navigation

Usage

School Subject Maintenance

SCHOOL_SUBJECTS

Set Up SACR > Common
Definitions > External
Education > School
Subject Maintenance >
School Subject Maintenance

Link external subjects

to specific external
organizations, specifying

the subject areas that your
institution accepts as transfer
credit from the external
organization. You use these
subject areas to build external
courses.

Linking External Subjects to External Organizations

Access the School Subject Maintenance page (Set Up SACR > Common Definitions > External
Education > School Subject Maintenance > School Subject Maintenance).

Important! The catalog of courses for one external organization can be used by multiple institutions.
Plan carefully before you use this page to enter every subject area for every institution from which you
might receive transfer credit.

Field or Control

Description

School Subject

Enter a school subject for the external organization. This field
contains no edits and, thus, enables you to enter any value.
Only the values in the prompt box display a description.

External Subject Area

Enter the external subject area that corresponds to the school
subject. This field is useful when an external organization

has a number of school subjects that are the same but have
different names, such as ENGL and English. You can associate
both school subjects with each other, for example, by tying
each school subject to the external subject area of ENGL.

Entering External Courses

To set up external courses, use the School Course Classification (SCHOOL COURSES) component.

This section discusses how to record external courses.
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Page Name

Definition Name

Navigation

Usage

School Course Classification

SCHOOL_COURSES

Set Up SACR > Common
Definitions > External
Education > School
Course Classification >
School Course Classification

Record the specific course
offerings for each subject area
of an external organization.
You use these course
classifications when you
create course transfer rules.

Recording External Courses

414

Access the School Course Classification page ((Set Up SACR > Common Definitions > External
Education > School Course Classification > School Course Classification).

This example illustrates the fields and controls on the School Course Classification page. You can find
definitions for the fields and controls later on this page.

School Course Clas
Org ID: oooo1o133 Corme
School Subject: EmGL

School Course Humber

*School Course Number: 2

School Course Details

*Effective Date:
*Description:

Short Description:
*External Subject Area:

*Career:

sification

Il College

10

01011990 [ sgiatus: | Active -]

English Literature to 1800
Lit1800
ENGL QU Engligh

Undergrad 'I

External Course Type:
External Units:

Course :I' Course Level:

3.00

IReguIar 'I

Note: If you want to inactivate an external course, you must enter a status of inactive and remove the

external course from your course equivalency rules.

Field or Control

Description

School Course Number

Enter the course number at the

catalog number of the external

specified external organization

for the course that you are classifying. This value is usually the

course.

External Subject Area

Enter the external subject area for this course at the specified
external organization. This field is where school subjects that
are the same but have different names can both be represented
by the single external subject area that you enter.
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Field or Control Description

Career Enter the career for this course at the specified external
organization. Values for this field are delivered with your
system as translate values. You can modify these values.

External Course Type Enter the external course type for this course at the specified
external organization. Values for this field are delivered with
your system as translate values. You can modify these values.

Course Level Enter the level for this course at the specified external
organization. Values for this field are delivered with your
system as translate values. You can modify these values.

External Units Enter the number of external units that this course is worth at
the specified external organization.

Note: External courses are converted to the unit type of your academic institution based on the rules on
the External Term Table page.

Setting Up External Terms

Define external terms on the External Term page. When tracking information about external institutions
for a prospect, applicant, or student, you may want to know the specific term to which that information is
related. For example, if you are entering external transfer credit information, you want to record the term
to which the transfer credit information pertains. Because external institutions use various term structures,
use this page to define all external terms. You can also set up how you want external terms converted to
your term structure on this page.

Note: The system uses the conversion multipliers on the Unit Conversion Table page when calculating
internal transfer credit (for instance, transferring between academic careers).

Related Links

“Entering Codes for External Organizations” (Campus Community Fundamentals)

Setting Up Test and Component Information

To create test credit transfer rules, define your test components and test codes:

» Use the Test Component page to set up test components used in your rules for test credit
equivalencies.

Example test components include English Composition and Essay, German Language and Listening,
and so forth.
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* Use the Test Tables page to set up test codes and to link test components to them.

Note: Minimum scores are also defined for test transfer equivalency rules.

Related Links

“Understanding External Test Score Data Processing” (Recruiting and Admissions)

Setting Transcript and Statistics Defaults

Use the Organization Affiliation page to enter details about the affiliation of your institution with specific
external organizations. The only relevant fields for transfer credit processing that contain the default
values for printed transcripts are in the Transfer Credit Transcript Print group box on this page. You
can override the default values for specific transcript types on the Transfer/Test/Other Credits page of the
Transcript Type (TSCRPT_TYPE) component.

Field or Control Description

Level of Detail Enter a value to indicate the transfer credit level of detail to
print on transcripts for a student transferring credit from this
external organization:

Summary: Enter this value to print a student's total transferred
units and grade point average (GPA) from this external
organization on the student's transcript. Enter this value if you
use the Historical Course Enrollment page for your conversion
process.

Detail: Enter this value to print what you selected in the
Details to Print field.

Details to Print If you enter Detail in the Level of Detail field, use this field
to enter the details to print on the transcript: None, External
Courses, External and Internal, or Internal Equivalent
Courses.

Include Transfer Credit in GPA Select this check box if you want the transfer credit from this
organization to be included in the student's GPA. If you clear
this check box, the system does not include transfer credit
grade points in the student's GPA.

Related Links

“Entering Affiliations with Organizations” (Campus Community Fundamentals)

Making Overall Statistics Adjustments

Use the Terms in Residence page to modify a student's terms in residence or to adjust transfer credit
values.
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Related Links
Maintaining a Student's Terms in Residence

Defining Study Agreements

Page

To set up study agreements, use the Student Agreement Table (STUDY AGREEMNT TBL) component.

You can attach study agreements to individual student records on the External Study page of the Term
Activation (STDNT ACTIVATION) component. Study agreement codes are normally used to represent
study abroad, exchange, and visiting programs.

This section lists the page used to define study agreements.

Used to Define Study Agreements

Page Name Definition Name Navigation Usage

Study Agreement Table STUDY_AGREEMNT TBL |Set Up SACR > Common | Create study agreements
Definitions > Study for use with external
Agreement Table > Study |organizations.
Agreement Table

Crea

Unde

Copyright

ting Course Transfer Equivalency Rules

To set up course transfer equivalency rules, use the Transfer Subject Area (TRNSFR_SUBJ AREA)
component and the Course Transfer Rules (TRNSFR_RULE) component.

This section provides an overview of course transfer equivalency rules and discusses how to:
* Define component subject areas.

* Define subject area elements.

* Review and adjust incoming course information.

¢ Define course transfer rules.

rstanding Course Transfer Equivalency Rules

After you set up all of the tables discussed in the previous topics, you can begin to create your course
transfer equivalency rules. The Transfer Credit process enables you to articulate course credit manually
or with predefined course transfer equivalency rules. Most likely, you will create predefined rules for
external organizations or internal academic institutions from which you receive the majority of your
transfer students. You can create manual rules for those organizations from which you infrequently
receive transfer students.
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In this section, we review how to create the predefined course equivalency transfer rules for modeling
transfer articulations for a prospect, applicant, or student. An equivalency rule is attached to an external
organization or internal academic institution and can contain numerous transfer components. You
might even decide to define more than one course transfer equivalency rule for an external organization
or internal academic institution to account for academic program and academic plan differences in
articulation rules.

The term component is used in documentation about the Transfer Credit process and should be
distinguished from the same term used in PeopleSoft PeopleTools, where it refers to a page or a group of
pages under a menu item. In the Transfer Credit feature, a component ties each incoming course and its
internal equivalents together. Thus, for each incoming course and its matched equivalent, a corresponding
component exists. Together, these data elements represent a line or sequence within the overall course
transfer rule. Thus, a course transfer rule is generally made up of hundreds, possibly thousands, of
components, each of which contains a number of data elements, including the transfer priority number,
the incoming courses, and the internal equivalents. For simplicity, we refer to components related to
transfer credit as transfer components.

To manage this large volume of transfer components, group them into distinct component subject

areas for each external organization or internal academic institution by using the Transfer Subject Area
component. Because component subject areas are user-defined and not enforced by the Subject table

of your academic institution, you can define a component subject area with a value that you can later
associate with a given course transfer equivalency rule. For example, you can create a component subject
area called Mathematics for an external organization and define all of the incoming math and statistics
courses and their internal equivalent courses within this component subject area. Alternatively, you can
define one component subject area for math courses and one component subject area for statistics courses.

After you define component subject areas, use the Course Transfer Rules component to assign component
subject areas to the course transfer rules that you create for each external organization or internal
academic institution.

The system stores the data for each component subject area in intermediary tables (TRNSFR_RULE and
TRNSFR _RSUB) that are independent of the course-transfer equivalency rule tables (TRNSFR_SUBJ,
TRNSFR_COMP, TRNSFR_FROM, TRNSFR_TO). All of these tables are associated with each other
through parent-and-child relationships in the table structure.

Articulating Variable Unit Courses

To ease the articulation of variable unit courses, Campus Solutions can determine transfer unit values in
one of three ways:

1. By the units of the internal equivalent course as they appear in the course catalog.
2. By a fixed value, determined by the institution.

3. By the units of the incoming course, whether a set or variable value, with the option of setting a
maximum limit.

Rather than having the transfer model determine the transfer units for an incoming course based on the
units of the internal equivalent course in the course catalog as they appeared at the time that you set up
the transfer rule, which can cause the system to get out of synchronization, you can determine the units
by the internal equivalent course or by a fixed value. See the examples at the end of this section for more
information.
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Excess Credit Courses

You can award excess credit to a specified course. For example, if a student took MATH 1A for four
units, but the internal equivalent was only worth three units, then you can set up an excess credit
course and award the excess units to that course. See the examples at the end of this section for more
information.

Note: The PeopleSoft Academic Advisement application treats the excess credit course as another
transfer course, bringing in the course ID, grade, and requirement designation as it does for the internal
equivalent course. Like the internal equivalent, the excess credit course is also coded as "TR" on the
degree audit. If your business practice is to use one particular course ID to collect excess credit for a
variety of incoming courses, be aware that each instance of the course will appear on the advising report.

Transfer Status: Rejected
The system automatically rejects courses for any of these reasons:
* The Transfer Course check box is cleared on the Subject Area Elements page for the applicable rule.
* The enrollment date of the incoming course is not entered or the system is unable to calculate it.
When no date is entered, the system automatically calculates a date like this:
* Ifno term year is entered, the system uses the year 1900 as the year that the class was taken.

* If no external term is entered, the system uses January 1 as the month and day that the class was
taken.

» Ifan external term is entered without a term year, the system finds the appropriate month from the
external term table (for instance, fall may be month 8) and calculates the rest.

In this instance, the date that the class was taken would be August 1, 1900.

* The official grade is blank.

Related Links

Understanding Transfer Credit Processing
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Pages Used to Create Course Transfer Equivalency Rules

Page Name Definition Name Navigation Usage

Transfer Subject Area TRNSFR_SUBIJECT Records and Enrollment > | Describe component subject
Transfer Credit Rules > areas for a transfer credit
Transfer Subject Area > source, otherwise known as
Transfer Subject Area an external organization or

internal academic institution.
Also set up incoming course
default information for the
transfer components that you
define within this component
subject area. The system
applies these defaults to

each incoming course that
you specify on the Subject
Area Elements page of this

component.
Subject Area Elements TRNSFR_DETAIL Records and Enrollment > | Define the transfer
Transfer Credit Rules > components of the component
Transfer Subject Area > subject area.
Subject Area Elements
Incoming Course Information | TRNSFR FR_SEC Click the Incoming Course | Adjust the default information
Information link on the for a particular incoming

Subject Area Elements page. | course within the component
subject area. Default
information for incoming
courses of a particular
component subject area

is defined on the Transfer

Subject Area page.
Course Transfer Rules TRNSFR_RULE Records and Enrollment > | Define course transfer
Transfer Credit Rules > equivalency rules for external
Course Transfer Rules > organizations or internal
Course Transfer Rules academic institutions.

Defining Component Subject Areas

Access the Transfer Subject Area page (Records and Enrollment > Transfer Credit Rules >
Transfer Subject Area > Transfer Subject Area).
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This example illustrates the fields and controls on the Transfer Subject Area page. You can find
definitions for the fields and controls later on this page.

Transfer Subject Area
Academic Institution: FEUMNY FPeopleSoft University
Source ID: oooo1o143 Fresnao City College

Component Subject Area:  FCC-EMGLISH

Find | First E 1of 1 E La=t
*Effective Date: 0101980 [ sgratus: =
Description: [English Courses

Catalog Org Type:
Catalog Organization: Fresno City Caollege

Component Defaults

Min { Max Units: 1.00 98.00 Term Type:
Min  Max Grade Pts per Unit: 1.000 4.500

‘Internal Equiv Course Value: | Specify Fixed Units £ |

Excess Credit Defaults

Course ID:

2,

Requirement Designation:

General Fields

Field or Control Description

Catalog Org Type (catalog organization type) Designates the table from which you select a catalog
organization for the component subject area of the specified
source.

External: The system prompts you with external organizations
in your system. Define external organizations on the
Organization Table page.

Internal: The system prompts you with academic institutions
in your system. Define academic institutions on the Academic
Institution Table page.
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Field or Control

Description

Catalog Organization

Enter the catalog organization for this component subject

area of the specified source. By default, the system displays
the specified source as the catalog organization, but you can
override this value. The system prompts you with values based
on the value that you entered in the Catalog Org Type field.
When defining course equivalencies for the component subject
area of the specified source on the Subject Area Elements
page, the system prompts you with incoming courses based on
the catalog organization value that you enter here.

You can use any external organization or internal academic
institution as the catalog organization to define course
equivalencies for this component subject area of the specified
source. However, after you define a course equivalency on
the Subject Area Elements page, the Catalog Org Type and
Catalog Organization fields become unavailable.

Component Defaults

Use the fields in the Component Defaults group box to define default information for incoming courses
that you select for this component subject area of specified source on the Subject Area Elements page.
Later, you can override these default values for an individual incoming course by clicking the Incoming
Course Information link for the incoming course to change on the Subject Area Elements page.

Field or Control

Description

Min/Max Units (minimum and maximum units)

Enter the default minimum and maximum units for all
incoming courses that you define for this component subject
area of the specified source.

Term Type

Enter the default term type for all incoming courses that you
define for this component subject area of the specified source.
By default, the system displays the term type defined on the
School Data page in the Organization School Data component.
Values for this field are delivered with your system as translate

values. You can modify these values.

Min/Max Grade Pts Per Unit (minimum and maximum

grade points per unit)

Enter the default minimum and maximum grade points per unit
for all incoming courses that you define for this component

subject area of the specified source.

422

Copyright © 1988, 2023, Oracle and/or its affiliates.




Chapter 9

Setting Up Transfer Credit Processing

Field or Control

Description

Internal Equiv Course Value (internal equivalent course

value)

Defin

Copyright

Enter a default value for this component subject area. Select
from these options:

Use Catalog Units: The system determines the number of
units that the student obtains for the incoming course based on
the unit setting for the internal equivalent course in the course

catalog.

Specify Maximum Units: The system uses the units of the
incoming course but does not exceed the maximum units that
you enter in the Max Units to Transfer field.

Specify Fixed Units: The system awards the student the
number of units that you enter in the Units field.

Excess Credit Defaults

Field or Control

Description

Course ID

If you want to create excess credit courses, enter a default for
this component subject area. The system places excess units
into this course when a student has taken more units for the
incoming course than is allowed in the internal equivalent
course. See the Course ID field description in the following
section: Defining Subject Area Elements.

Requirement Designation

If you want to assign a requirement designation to your excess
credit courses, enter a default for this component subject area.
Requirement designations further define the type of transfer
credit being received. Requirement designation values are
defined on the Requirement Designation Table page.

Related Links
Understanding Requirement Designations

ing Subject Area Elements

Access the Subject Area Elements page (Records and Enrollment > Transfer Credit Rules >

Transfer Subject Area > Subject Area Elements).
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This example illustrates the fields and controls on the Subject Area Elements page (1 of 2). You can find
definitions for the fields and controls later on this page.

Academic Institution:

Source ID:

Effective Date:

Description:

Subject Area Elements

*Sequence Number:
*Description:

*Term Type:
Transfer Course:
*Transfer Priority:
Contingent Credit:

Component Subject Area:

Subject Area Elements

PSLIMNY PeopleSoft University
000010143 Fresno City College
FCC-ENGLISH

01i01i1980 Status:

English Courses

0ao1

Reviews Histary

First E 1of 1 E Last
=

Active

First [« 1ota O Lagt

F[=]

|Reading and Composition
~
T

I

| Specity Fixed Units =l

‘Internal Equiv Course Yalue:

Save Excess Units to a Course: r

This example illustrates the fields and controls on the Subject Area Elements page (2 of 2). You can find

definitions for the fields and controls later on this page.

*SeqH 1 =]

WildCard: -

*Subject: EMGL 2 English

Course Number: |1 @ Reading and
Compasitian

Incorning Course Information

“SeqH: 2 FHE

WildCard: -

*Subject: EMGL Q. English

Course Number: |11 Q Freshman Composition

Incoming Course Infarmation

*Course ID: [003271' @ ENGLCOMPID =
*Offer Number: l—"O\ Reading Camp |

Units: ’w

*Default Grade: |Ely Incaming Caurse j

*Course; [seq 1: ENGL1D =]

*Course ID: [003273/Q  ENGLCOMPI2 =]
*Offer Numhber: l—"O\ Reading Comp Il

Units: 'W

*Default Grade: | By Transfer Equivalency Setup j

Within each transfer component, you define the incoming courses and internal equivalent courses. For
each transfer component, you define the term type of the incoming course, the transfer priority in relation
to other transfer components within the component subject area, and some general information.

General Fields

Field or Control

Description

Sequence Number

The sequence number is the numeric counter that distinguishes
each transfer component of the component subject area from
other transfer components. By default, the system populates
the first sequence number of the component subject area with
0001 and increases the number by one as you add transfer

components.
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Field or Control

Description

Description This field describes the transfer component of the component
subject area. By default, the system displays the description
from the Transfer Subject Area page. You can override this
default value.

Term Type Enter the term type for this transfer component of the

component subject area. By default, the system displays the
term type from the Transfer Subject Area page. Values for this
field are delivered with your system as translate values. You

can modify these values.

Transfer Course

Select to have the incoming courses on this transfer component
of the component subject area transfer to your academic
institution, provided that the student's incoming course meets
all conditions of the course transfer rule.

Clear to have the Transfer Credit process reject the incoming
courses that you enter on this row of the component subject
area. A course evaluated in this way has a status of rejected
on the Transfer Course Details page of the Course Credits
component.

Transfer Priority

Enter the transfer priority number for this transfer component.
The Transfer Credit process evaluates the courses within the
component subject area according to the transfer priority of
each transfer component. The transfer component that has the
highest priority takes precedence. If an individual's incoming
course meets all conditions of the course transfer rule to
which this component subject area is assigned, the Transfer
Credit process uses the equivalent course as defined on the
transfer component that has the highest transfer priority. If the
individual's incoming course does not meet the conditions of
the course transfer rule to which this component subject area
is assigned, the Transfer Credit process evaluates the incoming
course against the transfer component with the next highest
transfer priority.

For example, if you have a rule where a student can receive
credit based on the grade or the number of units that the
student completes, you set up two separate components using a
different transfer priority for each. If a student takes math 101
for two units or gets an A, the internal equivalent is Math 102;
and if a student takes math 101 for three units or gets a C, the
internal equivalent is Math 99.
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Field or Control Description

Contingent Credit Select to have the incoming courses transfer to your academic
institution as contingent credit, provided that the individual's
incoming course meets all conditions of the course transfer
rule to which this component subject area is assigned. A
course evaluated in this way has a status of contingent on the
Transfer Course Details page of the Course Credits (TRNS
_CRSE) component. You can manually change the status of
the incoming course from contingent to accepted after the
individual meets the contingency.

For example, Education 310 at UC Santa Cruz is equivalent to
Education 312 at PSUNYV, provided that the student also has
submitted verification of an internship. Select the Contingent
Credit check box for this incoming course. During the
Transfer Credit process, the course credit transfers but the
incoming course has a status of contingent on the Transfer
Course Details page.
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Field or Control Description
Internal Equiv Course Value (internal equivalent course Enter a value to indicate how you want the system to
value) determine the number of units the student receives from the

incoming course. Select from the following:

*  Use Catalog Unit: The system determines the number of
units the student gets for the incoming course based on
the unit setting for the internal equivalent course in the

course catalog.

To determine the units in the course catalog, the system
compares the start date of the articulation term to the
effective date in the course catalog.

*  Specify Maximum Units: With two internal equivalents,
the system adds the values of the incoming courses to
determine the total amount that is available to transfer, up
to the maximum specified, and uses the rest for the excess
course when the Save Excess Units to a Course check

box is selected.

Note: Entering this value precludes the user from having
two internal equivalents without selecting the Save
Excess Units to a Course check box. To use a many-to-
many or one-to-many rule, select Specify Fixed Units or
Use Catalog Units.

»  Specify Fixed Units: The system uses the number of units
that you enter in the Units field, which appears in the
Internal Equivalent group box when you select this
option.

By default, the system populates the Units field with the
course catalog unit value of the internal equivalent when

the transfer rule is set up. You can change this value.

Note: If the unit value or effective date in the course
catalog changes, the Units field on this page does not

change.
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Field or Control

Description

Save Excess Units to a Course

Select if you want to save excess units from the incoming
course to a specified internal course. For example, if the
incoming course was taken for four units, and the internal
equivalent course is worth only three units, the extra unit can
be credited to a second internal course, most likely an elective

course.

Note: Only one excess unit course can be assigned per transfer
equivalency rule. Also, you cannot save excess units to a

course when there is more than one internal equivalent.

Incoming Course

Use the Incoming Course group box to define the external course information for a specific transfer
component. The incoming courses and internal equivalent courses that you define are the transfer

components of the component subject area.

Field or Control

Description

Seq# (sequence number)

The system automatically assigns a sequential number to
each incoming course to identify unique transfer component
records within the data table. These sequence numbers have no

programming significance.

W (wildcard)

Select to use the # wildcard character at the end of the Course
Number field value for the incoming course. If you clear this
check box, the system requires you to use a complete course

number.

Subject

Enter the subject area of the incoming course. For incoming
courses from external organizations, define subject values on
the School Subject Maintenance page. For incoming courses
from internal academic institutions, subject areas are tied to

courses in that academic institution's course catalog.
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Field or Control

Description

Course Number

Enter the course number for the incoming course. If you are
using an external organization for the catalog organization

(as defined on the Transfer Subject Area page), the system
prompts you with courses that you associated with the external
organization on the School Course Classification page. If

you are using an internal academic institution for the catalog
organization, the system prompts you with courses defined

for that academic institution in the Course Catalog (CRSE
CATALOG) component.

If you selected the W check box, you can substitute the #
wildcard character for the last character of the course number
so that you can map a series of incoming courses to one
internal equivalent course. For example, you can enter /#

to map course numbers 10 through 19 to a specific internal
equivalent course, you can enter /0# to map course numbers
100 through 109 to specific internal equivalent course, or you
can enter /## to map all 100 level courses to a specific internal
equivalent course. Otherwise, the system prompts you with
values from the School Course Classification Table page.

Incoming Course Information

Click to access the Incoming Course Information page, where

you can enter detail information about this incoming course.

Copyright

Internal Equivalent

Use the Internal Equivalent group box to define the
course for this transfer component.

internal course that is equivalent to the incoming

Field or Control

Description

Course ID Enter the course that is equivalent to the incoming course for
this transfer component.
Offer Number Defaults to the offer number of the course that you entered, as

defined in your academic institution's course catalog. You can
override this value.
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Field or Control

Description

Max Units to Transfer (maximum units to transfer)

This field appears when you enter Specify Maximum Units in
the Internal Equiv Course Value field. Enter the maximum
number of units that a student can transfer for this incoming
course. For example, if the incoming course is a variable unit
course that can be taken for one to five units, and you want

the system to use the incoming units to populate the internal
equivalent units, but you want to accept only up to three units
for this course, you could enter 3 in this field. However, if you
want the system to use the units of the incoming course, but do

not want to impose a maximum, accept the default of 99.

Units

This field appears when you enter Specify Fixed Units in the
Internal Equiv Course Value field. Enter the number of units
that you want the internal equivalent to be worth, regardless
of the number of units the incoming course is worth. For
example, if you enter 3 in this field, a student can take the
course for one unit, two units, or seven units, but still receives
three units for the internal equivalent. Defaults to the value are
defined in the course catalog. You can change this value. This
value does not change when you change the units in the course

catalog.
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Field or Control

Description

Default Grade

Enter a value in this field to indicate how you want the
Transfer Credit process to determine the grades for internal

equivalent courses.

The By Grade Order value is available only for many-to-one
and many-to-many equivalency rules. When you enter this
value, the Grade Order ficld becomes available. The value
that you enter in this field determines which incoming grade
the Transfer Credit process uses. For example, if the rule is
that two incoming courses—ENG101 with a grade of A and
ENG102 with a grade of B—can be transferred as the internal
equivalent ENGL1301, and you enter a grade order of 2nd
Highest, the Transfer Credit process transfers the B grade to
the internal equivalent course.

Note: The Transfer Credit process copies the grade from the
incoming course to the equivalent course if the grade is a valid
value for the grading scheme and the grading basis of the

student's academic program.

Enter the value of Incoming Course in the Default Grade field
if you want the Transfer Credit process to copy the grade from
the incoming course to the internal equivalent course. When
you enter this value, the Course field becomes available. For
many-to-one and many-to-many equivalency rules, enter a
value in the Course field to indicate which course you want
the transfer credit process to use. In a many-to-many rule,

each internal equivalent can use a different incoming course to
determine the grade.

Note: The Transfer Credit process copies the grade from the
incoming course to the equivalent course if the grade is a valid
value for the grading scheme and the grading basis of the
student's academic program.

Enter the value of By Transfer Equivalency Setup in the
Default Grade field if you want the Transfer Credit process

to use the transfer grade value defined on the Academic
Program Table (ACADEMIC PROG TBL) component for the

academic program specified on the transfer credit model.

Excess Credit Group Box

This group box appears when you select the Save Excess Units to a Course check box.
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Field or Control

Description

Course ID

Enter an excess credit course for this transfer equivalency rule.
If a student earns more units for an incoming course than the

internal equivalency rule allows, the system awards the student
units in the course that you enter here. The course should be an

elective course for which repeat checking is not activated.

Note: Each time that a student is awarded excess units in a
course, the articulation of units appears as a separate instance
of the class. Therefore, you should select the Repeat for
Credit check box on the Catalog Data page in the course
catalog for the course that you enter. Also, you should

set the Units Allowed for the course to 999 and the Total
Completions Allowed to 99 on the Catalog Data page.

Offer Nbr (offer number)

By default, the system displays the offering number of the
course that you entered according to the definition of that
course in your academic institution's course catalog. You can

override this value.

Max Units to Transfer (maximum units to transfer)

Enter the maximum number of excess units that you want to
award students. If you do not want to set a maximum, accept
the default value of 99.

Requirement Designation

Enter a requirement designation if you want to define the type
of transfer credit being received. This value appears by default

from the course catalog.

Related Links

Defining Course Catalog Data
Understanding Requirement Designations

Reviewing and Adjusting Incoming Course Information

Access the Incoming Course Information page (click the Incoming Course Information link on the

Subject Area Elements page).
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This example illustrates the fields and controls on the Incoming Course Information page. You can find
definitions for the fields and controls later on this page.

Incoming Course Information

School Subject: hATH
School Course Nbr: 15
Course Level: Fegular
External Units: 3.00

Begin / End Date:

hathematics

Trigonometry

014011900 [3) 12/31/9999 [#

Min / Max Units: 1.00 99.00 ‘Maximum Age: 99
Min / Max Grade Pts per Unit: 1.000 4.500
Field or Control Description

Begin / End Date

By default, the system populates the begin and end date of
the incoming course with 01/01/1900 and 12/31/9999. You
can override these default values. These dates inform the
Transfer Credit process when this incoming course is valid for
the course transfer equivalency rule to which you attach this
component subject area.

Min / Max Units (minimum and maximum units)

The system displays the default minimum and maximum units
for incoming courses within this component subject area. You
can override these default values.

For example, you might want to specify the same incoming
course twice but differentiate each specification by how many
units are earned. In this case, specify the same incoming
course multiple times but with different minimum and
maximum unit ranges.

Min/Max Grade Pts Per Unit (minimum and maximum
grade points per unit)

The system displays the default minimum and maximum grade
points per unit for incoming courses within this component
subject area. You can override these default values.

Maximum Age

This field defines the maximum age in years of the incoming
course. This prevents an individual from transferring credit for
this course to your academic institution when the individual
took the course more years ago than the number that you
specify here. By default, the system sets the maximum age

of an incoming course to 99 years, but you can override this
default value. For instance, you might want restrict individuals
from receiving transfer credit for a course when an individual
has taken the course more than 4 years previous to the date
your institution processes that individual's transfer credit.
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Access the Course Transfer Rules page (Records and Enrollment > Transfer Credit Rules > Course
Transfer Rules > Course Transfer Rules).

This example illustrates the fields and controls on the Course Transfer Rules page. You can find
definitions for the fields and controls later on this page.

Course Transfer Rules

Academic Institution: PEUNY

Transfer Subject Area

[+][=] [SMCC-ARTS Q
[#][=] |SMCC-EMGLISH Q
F[=] [BMCC-HISTORY Q,
[#][=] [SMCC-LANGUAGES &

[F[=] |sMCC-MATH Q

FPeopleSoft University

Source ID: oooo1o147

Equivalency Rule: SMCC

“Effective Date: 0UDIN980 () gtatys:  |Actve 7]
*Description: Santa Monica College - LALFAL

Art Courses
English Courzes
Histary Courses
Foreign Languages

Math Courses

Find | “ieww &1 First E 1of 1 IE Last

[#[=]

First E 1-5cf 5 E Last

For each transfer equivalency rule, attach component subject areas that you have defined for the source

in the Transfer Subject Area (TRNSFR_SUBJ AREA) component. You can define multiple course
transfer equivalency rules for a single source. For example, you might define multiple rules to account for
academic program and academic plan differences in equivalency rules. The effective date functionality
enables you to add and delete component subject areas that are no longer valid for the equivalency rule.

When adding a new transfer equivalency rule, you must also specify the credit source type of either
external organization or internal academic institution. The credit source type instructs the system from
which table you will select your source ID. By selecting external organization, the system prompts you
with the source IDs of external organizations in your system. By selecting institution, the system prompts
you with source IDs of academic institutions in your system.

Field or Control

Description

Transfer Subject Area

Enter the component subject areas to tie to the course transfer
equivalency rule. Each component subject area defines the
incoming courses, their internal equivalent courses, and detail
about how the Transfer Credit process must function. The
Transfer Credit process uses the transfer component data for
component subject areas to determine an individual's transfer
credit.
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Reviewing Examples of Course Equivalencies

This section provides examples of the following course equivalencies:

*  Many-to-one.

* Many-to-many.

*  Course rejection.

*  Multiple equivalencies for the same course.

¢ Excess credit.

These examples demonstrate some of the ways that you can set up the Subject Area Elements page for

course equivalencies.

Example of a Many-to-One Course Equivalency

This example illustrates a many-to-one course equivalency:

Subject Area Elements

Academic Institution: PSLIMY FeopleSoft University
Source 1D: aooo1o147 Santa Monica City Callege
Component Subject Area:  SMCC-MATH

Effective Date: 01/01/1982 Status: Active

Description: Math Caurses

Subject Area Elements

'Sequence Number:
‘Description:

‘Term Type:
Transfer Course:
‘Transfer Priority:
Contingent Credit:

‘Seqi: [ 1

WildCard: O
‘Subject:

MATH Q

aat1

math 16 andzo

T
O

ath

Course Number: |16 Q

Fre-Calculus

Incoming Course

#[=]

‘Internal Equiv Course Value:

Save Excess Units to a Course:

Internal Equivalent

‘Course ID: a01004 &
*Offer Number: 13
Units: ’W

Eeview Histary

=)

First KB 1105 11 (] Laat

F[=]

| Specity Fised Linits v
O

#[=]

MATH 107

Frecalculus

‘Default Grade: | By Transfer Equivalency Setup  »

Incoming Course Information

‘Seqs:
WildCard:

2

O
‘Subject: MATH Q
Course Number: 0 Q

Incoming Course Information

#[=]

Math

Calculus 1
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When the Transfer Credit process applies this rule, it uses the transfer grade value defined on the
Academic Program Table component for the academic program specified on the transfer credit model.

Example of a Many-to-Many Course Equivalency

This example illustrates a many-to-many course equivalency:

Subject Area Elements
Academic Institution: PSLIMY FPeopleSoft University
Source ID: aoooqo147 Santa Manica City College
Component Subject Area:  SMCC-MATH Beview History
+
Effective Date: 01/01/1982 Status: Active El
Description: Math Courses
Subject Area Elements Find y irst K0 19 o 19 [M] Last
‘Sequence Number: o =
‘Description: |Math Courses
Transfer Course:
*Transfer Priority: 1 *Internal Equiv Course Value: | Specify Fixed Linits il |
Contingent Credit; Ll Save Excess Units to a Course: O
Internal Equivalent
‘Seg: 1 =11 | scourse In: 001003 Q. MATH 10 (=]
WildCard: O *Offer Number: 1C,  Remedial Algebra
‘Subject: MATH QU Math e .00
Course Number: 1% Q Intermediate Algebra ‘Default Grade: | By Incoming Course v |
Ineoming Course Information "Course: |Seq 1 MATH 14 v|
‘Seq: 2 =11 | scourse In: 001001 @ MATH 101 (=]
WildCard: ¥ *Offer Number: 1C,  College Algebra
*Subject: MATH A wath Units: 3.00
Course Number: |19 L agebra & Trigonometry ‘Default Grade: | By Incoming Course V|
Incorming Course Inforrmation ‘Course: |Seq 20 MATH 15 v|

When the Transfer Credit process applies this rule, it uses the transfer grade for MATH 14 for one course
and the transfer grade for MATH 15 for the other course.

Example of a Course Rejection Equivalency

To reject a course, clear the Transfer Course check box. The Internal Equivalent group box fields
become unavailable.

436 Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 9 Setting Up Transfer Credit Processing

This example illustrates a course rejection equivalency:

Subject Area Elements
Academic Institution: PELIMY FeapleSoft University
Source ID: aooo1o14y Santa Monica City Callege
Component Subject Area:  SMCC-MATH Review Histary
+
Effective Date: 01i01/1982 Status: Active =]
Description: Math Courses
Subject Area Elements 1 §
‘Sequence Number: o013 =]
‘Description: |Math 8- Reject
“Term Type:
Transfer Course: ]
‘Transfer Priority: 1 ‘Internal Equiv Course Value:
Contingent Credit: Save Excess Units to a Course:
Incoming Course Internal Equivalent
'SeqE: 1 (=l ‘Course ID: =]
WildCard: O ‘Offer Number:
‘Subject: MATH QU ath T
Course Number; |02 Q Preparatory Math ‘Default Grade:
Incoming Course Information

Example of Multiple Equivalencies for the Same Course

The following examples show multiple equivalencies for the same course.

For Santa Monica City College, the student's transfer course articulates to different math courses at
PSUNY, depending on the number of units that a student takes for Math 20. In this example, there are
two component rules—one for Math 20 taken between one and two units and another for Math 20 taken
between three and four units.
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This example illustrates the one to two unit equivalency:

Chapter 9

Subject Area Elements
Academic Institution: PEUNY PeopleSaft University
Source ID: 000010147 Santa Monica City College
Component Subject Area:  SMCC-MATH Eeview History
+
Effective Date: 01/0171382 Status: Active =]
Description: Math Courses
Subject Area Elements !
'Sequence Number: oo12 (=]
‘Deseription: math 20- 1 to 2 units
“Term Type:
Transfer Course:
‘Transfer Priority: 1 “Internal Equiv Course Value: | Specify Fixed Units b
Contingent Credit: O Save Excess Units to a Course: O

Incoming Course Internal Equivalent

‘Saqi: [ 1 El course:  [001004/CL maTH 107 =
WildCard: F ‘Offer Number: | 1 Precaloulus

‘Subject: MATH S patn Units: [ z2m0

Course Number: |20 A Calculus 1 ‘Default Grade: | By Transfer Equivalency Setup v

Incoming Course Information

The incoming course maps to Pre-calculus.

Incoming Course Information

School Subject: MATH M ath
School Course Nbr: 20 Caleulus 1
Course Level: Regular

External Units: 3.00

Begin /End Date: 01011800 [5) 1213149899 5]

Min / Max Units: | 1.00 2.00 ‘Maximum Age: 39

1000 | 4,500

Min / Max Grade Pts per Unit: |

The minimum and maximum units are /.00 and 2.00, respectively.
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This example illustrates the three-to-four unit equivalency:

Transfer Subject Area Subject Area Elements

Academic Institution: PEUNY PeopleSaft University
Source ID: 000010147 Santa Monica City College
Component Subject Area:  SMCC-MATH Eeview History
+
Effective Date: 01i01/1982 Status: Active =
Description: Math Courses
Subject Area Elements 13 of 13
'Sequence Number: uo13 (=]
‘Deseription: math 20 - 3to 4 units
“Term Type:
Transfer Course:
‘Transfer Priority: 2 “Internal Equiv Course Value: | Specify Fixed Units b
Contingent Credlit: O Save Excess Units to a Course: O

Incoming Course Internal Equivalent

‘Saqi: [ 1 El coursemn: (001008 QL maTH 111 =
WildCarid: O \Offer Number: | 1 Calculus |

‘Subject: MATH A path Units: EXT)

Course Number: |20 A caleulus 1 ‘Default Grade: | By Transfer Equivalency Setup

Incorming Course Information

The incoming course maps to a Calculus I instead of Pre-calculus.

This example illustrates the Incoming Course Information page for the three-to-four unit equivalency:

Incoming Course Information

School Subject: MATH ath
School Course Nbr: 20 Calculus 1
Course Level: Fegular

External Units: 3.00

Begin / End Date: 01011900 [3) [12/31/9339 [5)

Min / Max Units: 3.00 4.00 ‘Maximum Age: 33

1.000 | 4.500

Min / Max Grade Pts per Unit: |

The minimum and maximum units are 3.00 and 4.00, respectively.

Example of an Excess Credit Course Equivalency

Excess credit occurs when the external course is worth more units than the internal equivalent course.
Identify an existing course or create a new course to manage excess credit.
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This example illustrates an excess credit course equivalency:

Incoming Course

Subject Area Elements
Academic Institution; PELINY Peoplesoft University
Source ID: ooooto147 Santa Monica City College
Component Subject Area:  SMCC-MATH Feview History
First [ 1 of 1 [+ Last
+
Effective Date: 01011982 Status: Active El
Description: Math Courses
Subject Area Elements First K 11 o 11 [ Last
‘Sequence Number: no11 =]
‘Description: |M ath 16
Transfer Course:
‘Transfer Priority: 1 ‘Internal Equiv Course Value: | Specify Fixed Units i |
Contingent Credit: O Sawve Excess Units to a Course:

Internal Equivalent

'Seqi: 1 = | course in: 001004 O MATH 107
WildCard: " ‘Offer Number: 1C  Precalculus
‘Subject: MATH QU Math o 2.00

Course Number: 18 Q Pre-Calculus

Incoming Course Information

‘Default Grade: |ElvTransferEquivalencv Setup v|

Excess Credit

‘Course ID: BEEBT4 O MATH 1%
*Offer Number: 1, Math Excess
Max Units to 95.00

Transfer:

Requirement Designation: ’— Q

Converting Existing Transfer Components into Component
Subject Areas

440

If you are upgrading your Student Records system and you have existing transfer component data in your
application tables, run the delivered upgrade script, UPG_SR. This upgrade script moves your existing
transfer component data from the former application-data table structure into the current application-
data table structure. It assigns all transfer components within an existing course transfer equivalency rule
to a single component subject area that is named after the original rule in which the transfer component
resides. After you run the upgrade script, use the Transfer Subject Area component to access each of the
component subject areas that the upgrade script creates, just as you would any other component subject
area that you manually define. The data for all component subject areas, regardless of how they were
created, are stored in the same table (EXT TRNSFR SUBJECT).

Next, you must go to the Course Transfer Rules page and create your course transfer equivalency
rules, attaching the component subject area to rules, as appropriate. The system writes course transfer

equivalency rule data to the EXT TRNSFR_RULE SUBIJ table. You can continue course transfer credit
processing using predefined rules, as usual.
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Copying Transfer Components Between Component Subject
Areas

This section discusses how to copy transfer components between component subject areas.

Page Used to Copy Transfer Components Between Component Subject
Areas

Page Name

Definition Name

Navigation

Usage

Subject Area Copy Function

RUNCNTL _TRNSFR CPY

Records and Enrollment >
Transfer Credit Rules >
Copy Subject Areas >
Subject Area Copy Function

As necessary and as time
permits, copy transfer
components from larger,

more general component
subject areas into new, smaller
component subject areas.

Copying Transfer Components Between Component Subject Areas

Access the Subject Area Copy Function page (Records and Enrollment > Transfer Credit Rules >
Copy Subject Areas > Subject Area Copy Function).
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This example illustrates the fields and controls on the Subject Area Copy Function page. You can find
definitions for the fields and controls later on this page.

Subject Area Copy Function

Run Control I: PS5 Report lanager Process Monitor Run |

Refresh |

Subject Area Information i First (4 0 1 07 Last
From Seq #: ’ Description: Long Beach City College El
*Academic Institution: FEUNY PeopleSot University
*Source ID: 000010148 Long Beach City College - LA
*Component Subject Area: LBCC Long Beach City College 1
*Effective Date: 010011970
Incoming Subject: BIOL

[” Break by Incoming Subject
*From Component Seq#: nont *To Component Seq#: 9434
TO Subject Area Info
*To Component Subject Area; BIOL Descr: BIOL
*Effective Date To: [

Deselect All Filter | Fetch Data |

Sequence# | Description Incoming Course Equivalent Course
W 0001 Subject Course Nbr Course ID Offer Mbr
|L0ng Beach City College 1 BIOL " Qo37oo0 1
Biology Biology | General Biology | BIOLOGY 100

The copying functionality is intended primarily for academic institutions that receive a large number of
transfer credit courses from a single source. On this page, you select the component subject area from
which you want to retrieve transfer components, define the basics of the new component subject area

to create, then retrieve the transfer components from the existing component subject area based on your
parameters. Sort through the list of results to select the transfer components to include in the new transfer
subject area, then run the Transfer Rule Subject Area Copy COBOL/SQL process (SRPCCARX) to create
the new, smaller component subject area and to copy the selected components into it. After you run the
process, you can edit the newly created component subject area in the Transfer Subject Area component.
Attach this new component subject area to course transfer equivalency rules in the Course Transfer Rules
(TRNSFR_RULE) component and resume course transfer credit processing as usual.

Important! If you are copying a large component subject area, you should either use the Incoming
Subject field or the Break by Incoming Subject check box to separate the large component subject
area into smaller ones based on incoming subject. Alternatively, use the From Component Seq# and To
Component Seq# fields to copy blocks of 500 transfer components at a time into smaller component
subject areas based on transfer component sequence numbers. You are not required to copy transfer
components by subject area—it is just a logical breaking point for large component subject areas.
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Field or Control

Description

Refresh

Click to refresh the page.

From Seq # (from sequence number)

The sequence number is the numeric counter that distinguishes
each row of the process request apart from other rows. By
default, the system sets the first sequence number to / and
increases the number by one as you add rows.

Description

Enter a description for this row of the process request.

Academic Institution

Enter the academic institution to which the component subject
area to copy belongs.

Source ID

Enter the identification code of the source to which the
component subject area to copy belongs.

Component Subject Area

Enter the component subject area to copy. The system displays
values based on the academic institution and source that you
specified for this process request.

Effective Date

Enter the effective date of the specified component subject
area. The effective date indicates the row to copy within the
specified component subject area.

Incoming Subject

Enter an incoming subject to filter by subject through all
transfer components of the specified transfer component
subject area. When you click the Fetch button, the system
retrieves only the transfer components with this incoming
subject and automatically selects to copy them into the new,
smaller component subject area during processing. This field
prompts against the external subject table for the specified
external organization. If you use this field, the Break by
Incoming Subject check box becomes unavailable for entry.
Note that you can assign the To Component Subject Area
field and its related Description field the same name as the
incoming subject because component subject areas are keyed
by source ID. Alternatively, you can assign these fields unique
values.
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Field or Control Description

Break by Incoming Subject Select to break by incoming subject all the transfer
components of the specified component subject area. If

you select this check box, the Incoming Subject field, To
Component Subject Area field, and its related Description
field become unavailable for entry.

When you click the Fetch button, the system retrieves all
transfer components, separates them by incoming subject

into unique rows on the run control page, assigns each row a
sequence number, and automatically selects to copy all transfer
components into new, smaller component subject areas during
processing. For example, LBCC has eight different incoming
subjects in their component subject area, so the system creates
eight rows for eight new component subject areas. In addition,
the system automatically populates the Incoming Subject
field, the To Incoming Subject Area ficld, and its related
Description field for each row. The Incoming Subject field
remains unavailable for edit, but you can edit the other two
fields.

From Component Seq# (from component sequence number) | Indicate the first transfer component to retrieve from the
specified component subject area. By default, the system sets
the value of this field to 000!. You can override this default
value.

To Component Seq# (to component sequence number) Indicate the last transfer component to retrieve from the
specified component subject area. When you click the Fetch
button to retrieve transfer components, the system displays all
transfer components within the specified range. By default, the
system sets the value of this field to 9999. You can override
this default value.

To Component Subject Area Enter the identification code of the new component subject
area to create based on the preexisting component subject area
that you specified.

Description Enter a description of the new component subject area.

Effective Date To Enter the effective date of the new component subject area to

create based on the preexisting component subject area that
you specified to copy.

Fetch Click to retrieve the transfer components from the preexisting
component subject area that you specified to copy.

Sequence # (sequence number) The system displays the sequence number of the transfer
component from the preexisting component subject area that
you specified to copy.
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Field or Control

Description

Description

The system displays the description of the transfer component
from the preexisting component subject area that you specified
to copy.

Incoming Course

The system displays the subject, course number, and
description for the incoming course of the transfer component.

Equivalent Course

The system displays the course ID, offering number, and
description for the internal equivalent course of the transfer
component.

Select All or Deselect All

Click to select or clear all of the transfer components in the
list at the bottom of the page. This functionality is useful when
you are splitting a component subject area with a large amount
of transfer components.

For example, you have a math component subject area with
300 transfer components and you want to group 250 within a
new, higher math component subject area and the remaining
50 within a new, lower math component subject area. To create
the higher math component subject area, retrieve all of the
transfer components from the math component subject area,
click the Select All button, and then clear the check boxes for
the 50 excluded components. When you create the lower math
component subject area, select all of the 50 included transfer
components.

Filter

Click to filter the list of transfer components that appear at
the bottom of this page. The system displays only the transfer
components that you have checked. The checked transfer
components are the only ones that the Subject Area Copy
Function process uses when creating the new component
subject area.

Unfilter

The system displays this button whenever you have filtered
the list of transfer components that appear at the bottom of
the page. Click this button to reset the list back to its original
number of transfer components.

Defining Course Equivalencies for Academic Programs and Plans

This section provides an overview of course equivalencies for academic programs and plans and discusses

how to:
*  Set up basic academic program and plan data.

* Set equivalency rules.
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Understanding Course Equivalencies for Academic Programs and Plans

To set up course equivalencies for academic programs and plans, use the Program/Source Equivalency
(EXT_EQUIV) component.

After you set up your course transfer equivalency rules, you must use the Program/Source Equivalency
component to select the academic programs and plans within your academic institution to which you want
to assign these rules.

If you have multiple equivalency rules for a given external organization or internal academic institution,
you can attach these rules to various academic program and academic plan combinations. For instance, if
you create two course transfer equivalency rules for an external organization, then you can link one rule
to the Liberal Arts program and the other rule to the Liberal Arts program and English plan. The English
equivalency rule includes English course-specific equivalencies that are different from the liberal arts
equivalencies.

Note: The Basic page enables you to attach course transfer equivalency rules to a specific academic
program or academic plan. The system requires that you attach the rule to an academic program, but
attaching the rule to an academic plan is optional.

Example of How the System Uses Effective Dating

The Transfer Credit Setup tables use effective dating to determine the correct row of data to use when
determining the correct rule to be used at articulation.

You are articulating a student in Term 0370 - Fall 1999. The begin date for Fall 1999 is September 1,
1999. The system determines the correct row of data to use using this procedure:

1. The system accesses the Program/Source Equivalency page and finds the row that is less than or equal
to September 1, 1999.

The date of this row is January 1, 1900.

2. The system accesses the Course Transfer Rules and finds the row that is less than or equal to January
1, 1900.

The date for this row is January 1, 1990.
3. The system locates the rules for the row that is less than or equal to January 1, 1900, and uses that

rule.

Pages Used to Define Course Equivalencies for Academic Programs and
Plans

Page Name Definition Name Navigation Usage
Program/Source Equivalency | EXT TRNSFR Records and Enrollment > | Set up basic parameters, such
- Basic Transfer Credit Rules > as grading basis and transfer
Program/Source grade, for processing transfer
Equivalency > Basic credit within a specified
academic program or plan.
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Page Name Definition Name Navigation

Usage

Records and Enrollment >
Transfer Credit Rules >
Program/Source
Equivalency > Rules
Specification

Rules Specification EXT TRNSFR EQUIV

Set the course equivalency
rules for academic programs
or academic plans. The
system uses these rules to
evaluate transfer credit from
the specified institution. On
this page, like the external
course catalog, you have

the flexibility to point to
any organization's ID to use
as the source ID for course
equivalency rules.

Setting Up Basic Academic Program/Plan Data

Access the Program/Source Equivalency - Basic page (Records and Enrollment > Transfer Credit

Rules > Program/Source Equivalency > Basic).

This example illustrates the fields and controls on the Program/Source Equivalency - Basic page. You can

find definitions for the fields and controls later on this page.

[ Basic

Institution: PELUIMNY FPeopleSoft Liniversity

Academic Program: LAL Liberal Arts Undergraduate
Academic Plan:

Source ID: Qooo10147 Santa Monica City College
*Effective Date: 02/011390 [= *Status: IActive 'I
*Description: SMCC - LAl

*Grading Scheme: UGD|Q Undergraduate Grading Scheme
*Grading Basis: GRD & Graded

*Transfer Grade: T Q Transfer

Transfer HS Courses: r

Santa Monica City College

Fir=t E 1 af 1 |I| Last

[+ [=]

When accessing this page in Add mode, enter the credit source type from which you select your

source ID. By entering external organization, the system prompts you with the source IDs of external
organizations in your system. You define external organizations on the Organization Table page. By
entering institution, the system prompts you with source IDs of academic institutions in your system. You

define institutions on the Academic Institution Table page.

Field or Control Description

Effective Date

In addition to the common definition of this element, the
system uses the effective date in conjunction with the
articulation term on the Transfer Course Detail page to
determine the validity of equivalency rules.
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Field or Control

Description

Grading Scheme

By default, the system displays the grading scheme of the
specified academic program. Define grading schemes for
academic programs on the Academic Program page in the
Academic Program Table component. Define grading schemes
for academic careers on the Academic Career Table page. You
can override this default value now, and you can override this
value later for individual transfer courses that you process.
This grading scheme defines all of the valid grading bases
from which you can select a default transfer grade for this
academic program/plan and source combination.

Grading Basis

By default, the system displays the grading basis default for
transfer credit according to the specified academic program.
Define grading-basis defaults for transfer-credit values on

the Academic Program page in the Academic Program Table
component for academic programs. Define grading-basis
defaults for transfer-credit values on the Academic Career
Table page for academic careers. You can override this default
value now, and you can override this value later for individual
transfer courses that you process. This grading basis defines all
of the valid grades from which you can select a default transfer
grade for this academic program, academic plan, and source
combination.

Transfer Grade

By default, the system displays the default transfer grade of
the specified academic program. Define default transfer grades
for academic programs on the Academic Program page in the
Academic Program Table component. Define default transfer
grades for academic careers on the Academic Career Table
page. You can override this default value now, and you can
override this value later for individual transfer courses that
you process. This transfer grade defines the grade that an
individual receives for courses that articulate into the specified
academic program or academic plan.

Transfer HS Courses (transfer high school courses)

To include any course taken during high school in an
individual's transfer credit for this academic program,
academic plan, and source combination, select this check box.
Clear this check box to exclude courses taken during high
school.

Setting Equivalency Rules

Access the Rules Specification page (Records and Enrollment > Transfer Credit Rules > Program/

Source Equivalency > Rules Specification).

448
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This example illustrates the fields and controls on the Rules Specification page. You can find definitions

for the fields and controls later on this page.

Rules Specification

Academic Institution: PELIMY FPeopleSoft University
Academic Program: LAl Liberal Arts Undergraduate
Academic Plan:
Source ID: 000010147 Santa Monica City College
First E 1of 1 |I| Last
Effective Date: 020111990 =
Rule Source Type Rule Source ID Course Equivalency Rule
*‘Dafault: IE}{T Org 'I oooo10147 Q SMCC QL
Santa Monica City College Santa Monica College - LAUFAL
Override: I :" Q Q
Agreement: I :" K Q

You must specify the credit source type from which you will select your source ID. If you enter external
organization, the system prompts you with the source IDs of external organizations in your system. If you
enter institution, the system prompts you with source IDs of academic institutions that you defined in your

system.

All of the following group boxes have Agreement, Override, and Default fields. Each identically named
field functions as a row of data to define a course equivalency rule. Each of these fields is documented
once, following the group box definitions. As the Transfer Credit process evaluates courses, it uses the

rules in this order: agreement, override, default.

Rule Source Type

Use the fields in this group box to select the table from which you will select each of your course
equivalency rules for this academic program/plan and source combination. Select from the following

choices.

Field or Control

Description

External Org (external organization)

The system prompts you with the external organization
source IDs in your system. Because external organizations
and internal academic institutions can share the same course
catalog, you might want to point to a different source ID for
the course catalog.

Institution

The system prompts you with institution source IDs in your
system.
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Rule Source ID

Use the fields in this group box to select the source ID for the course transfer equivalency rule for this
academic program/plan and source combination. You can point to any sources rules.

Course Equivalency Rule

Use the fields in this group box to select the specific course transfer equivalency rules for this academic
program, academic plan, and source combination.

Common Course Equivalency Rule Fields

Field or Control Description

Agreement The Transfer Credit process uses the course equivalency

rule that you specify on this row first. If the transfer course
meets the criteria of the rule specified on this row, the process
applies the rule to the transfer course and evaluates the course
no further. If you did not specify a rule for this row, or if

the transfer course does not meet the criteria of the rule, the
process then evaluates the course equivalency rule that you
specify on the Override row.

Override The Transfer Credit process uses the course equivalency

rule that you specify on this row next. If the transfer course
meets the criteria of the rule specified on this row, the process
applies the rule to the transfer course and evaluates the course
no further. If you did not specify a rule for this row, or if

the transfer course does not meet the criteria of the rule, the
process then evaluates the course equivalency rule that you
specify on the Default row.

Default The Transfer Credit process uses the course equivalency

rule that you specify on this row last. If the transfer course
meets the criteria of the rule specified on this row, the process
applies the rule to the transfer course and evaluates the course
no further. If you did not specify a rule for this row, or if

the transfer course does not meet the criteria of the rule, the
process will not articulate the course. In this case, the transfer
course appears on the Transfer Course Details page with a

status of no rule.

Note: If you have only one rule for this source, you must enter it in Course Equivalency Rule field in the
Default row. The Default row is the only row on the page that requires a course equivalency rule.
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Creating Test Transfer Equivalency Rules

To set up test transfer equivalency rules, use the Test Transfer Rules component (TEST RULES).

This section discusses how to define test transfer equivalency rules.

Page Used to Create Test Transfer Equivalency Rules

Page Name Definition Name Navigation Usage

Test Credit Rule/Component | TEST CREDIT COMP Records and Enrollment > | Define sets of test transfer
Transfer Credit Rules > equivalency rules.
Test Transfer Rules > Test
Credit Rule/Component

Defining Test Transfer Equivalency Rules

Access the Test Credit Rule/Component page ((Records and Enrollment > Transfer Credit Rules >
Test Transfer Rules > Test Credit Rule/Component).

This example illustrates the fields and controls on the Test Credit Rule/Component page. You can find
definitions for the fields and controls later on this page.

Test Credit Rule/Component

Institution: FELMNY FeopleSoft University
Test Equivalency Rule: SATI
Find | “iesw All First E 4 of 1 II' Last
*Effective Date: 017011900 EJ *Status: IAC“\I’E 'I EI
*Description: SAT Test Rules - LAU
Find | iew &l First [ 1ors D Laat
*Test ID: SAT Q Scholastic Assessment Test| FE
Test Component: MATH & Math
*Equiv Component: oo
*Description: Math Priority: 1
Min / Max Score: 200.00 800.00 Min Percentile:
Begin | End Date: 01/01/1900 F1[12/31/9999 5 Maximum Age: 99

*Course ID: 001310 & Complex Variahles for Apps
*Course Offering Nbr: 1 MATH 125
Units Taken: 3.00
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Setting up test transfer equivalency rules is similar to setting up course credit transfer equivalency rules.
For each test equivalency rule that you define, describe the rule, select the test and test component for the
rule, and specify course equivalencies for the test component.

Field or Control

Description

Test ID

Enter the identification number of the test for which you are
defining this test equivalency rule.

Test Component

Enter the component of the test for which you are defining this
test equivalency rule.

Equiv. Component (equivalent component)

The equivalency component number is the numeric counter
that distinguishes each row of the test equivalency rule
apart from other rows. By default, the system enters the first
equivalency component of the test equivalency rule as 0001
and increases the number by one as you add rows.

Description (lower)

This field describes the row of the equivalency test rule.

By default, the system displays the description of the

test component according to the description on the Test
Component Table page. You can override this default value.

Transfer Priority

Enter the transfer priority number for this row of the test
equivalency rule. The Transfer Credit process evaluates the
rows within the test equivalency rule according to the transfer
priority of each row. The test component within the row that
has the highest value takes priority. If an individual's transfer
test meets all conditions of the test equivalency rule, then the
Transfer Credit process uses the equivalent course as defined
on the row with the highest transfer priority. However, if

the individual's transfer test does not meet the conditions of
the test equivalency rule, then the Transfer Credit process
evaluates the row with the next highest transfer priority.

Min/Max Score (minimum and maximum score)

Enter the minimum and maximum score of applicable transfer
tests for this row of the test equivalency rule, or enter the
minimum percentile.

Minimum Percentile

Enter the minimum percentile of the applicable transfer tests
for this row of the test equivalency rule, or enter the minimum
and maximum score.

Begin/End Date

By default, the system sets the begin and end date of the
transfer test to 01/01/1900 and 12/31/9999. You can override
these default values. These dates inform the Transfer Credit
process when the applicable transfer test must be taken for this
row of the test equivalency rule.
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Field or Control Description

Maximum Age This field defines, in years, the maximum age of the transfer
tests for this row of the test equivalency rule. This prevents

an individual from transferring test credit into your academic
institution if the individual took the test more years ago than
the number of years that you specify here. By default, the
system sets the maximum age of a transfer test to 99, but you
can override this default value. For instance, you might want
restrict an individual from receiving transfer credit for a test if
the individual took the test more than 4 years prior to the date
that your institution processes the individual's transfer credit.

Course ID Enter the course to which the given test component is
equivalent. The system prompts you with courses from your
academic institution's course catalog. You can add rows to
create a one-to-many test equivalency rule.

You are prompted from your course catalog. The system
automatically populates the Course Offering Number and
Units Taken fields with values from the course catalog
definition. You can enter a different offering number and enter
different units.

Course Offering Number By default, the system displays the course offering number of
the specified course according to the value in your academic
institution's course catalog. You can override this default
value.

Units Taken By default, the system displays the units taken value of the
specified course according to the value in your academic
institution's course catalog. You can override this default
value.

Related Links

Creating Course Offerings

Defining Test Equivalencies for Academic Programs and Plans

To set up test equivalencies for programs and plans, use the Program/Test Equivalency (TEST_EQUIV)
component.

This section discusses how to set test equivalencies for academic programs and plans.

Copyright © 1988, 2023, Oracle and/or its affiliates. 453



Setting Up Transfer Credit Processing Chapter 9

Page Used to Define Test Equivalencies for Academic Programs and Plans

Page Name Definition Name Navigation Usage
Test Credit Equivalency TEST_CREDIT _EQUIV Records and Enrollment > | Set the test transfer
Transfer Credit equivalency rules that the
Rules > Program/Test Transfer Credit process
Equivalency > Test Credit |uses to evaluate transfer test
Equivalency credit for specific academic
programs and academic plans.

Setting Test Equivalencies for Academic Programs and Plans

Access the Test Credit Equivalency page (Records and Enrollment > Transfer Credit Rules >
Program/Test Equivalency > Test Credit Equivalency).

This example illustrates the fields and controls on the Test Credit Equivalency page. You can find
definitions for the fields and controls later on this page.

Test Credit Equivalency

Institution: PSUMNY FeopleSoft University
Academic Program: LAl Liberal Atz Undergraduate
Academic Plan:

First E 1 of 1 II' La=t
=
*Effective Date: 01i01/1900 [ ‘Status: | Active -|
“Dascription: SAT Test Results - LAU
*Grading Scheme: ueh 4 Undergraduate Grading Scheme
*Grading Basis: GRD & Graded
*Transfer Grade: T Q Transfer
Test Equivalency Rules
*Default: SATI SAT Test Rules - LAU
Owerride: Q
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General Fields

Field or Control Description

Grading Scheme By default, the system displays the grading scheme of the
specified academic program. Define grading schemes for
academic programs on the Academic Program page in the
Academic Program Table component. Define grading schemes
for academic careers on the Academic Career Table page. You
can override this default value now, and you can override this
value later for individual transfer tests that you process. This
grading scheme defines all of the valid grading bases from
which you can select a default transfer grade for this academic

program or academic plan.

Grading Basis By default, the system displays the grading basis default for
transfer credit according to the specified academic program.
Define grading-basis default for transfer-credit values for
academic programs on the Academic Program page in the
Academic Program Table component. Define grading-basis
default for transfer-credit values for academic careers on the
Academic Career Table page. You can override this default
value now, and you can later override this value for individual
transfer tests that you process. This grading basis defines all of
the valid grades from which you can select a default transfer
grade for this academic program or academic plan.

Transfer Grade By default, the system displays the default transfer grade of
the specified academic program. Define default transfer grades
for academic programs on the Academic Program page in the
Academic Program Table component. Define default transfer
grades for academic careers on the Academic Career Table
page. You can override this default value now, and you can
override this value later for individual transfer tests that you
process. This transfer grade defines the grade an individual
receives for tests that articulate into the specified academic
program or academic plan.

Test Equivalency Rule

Use the fields in this group box to select the specific test transfer equivalency rules for this academic
program or academic plan. As the Transfer Credit process evaluates test credit, it applies the rules in this
order: Override, Default.
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Field or Control Description

Default The Transfer Credit process uses the test equivalency rule

that you specify on this row last. If the transfer test meets the
criteria of the rule specified on this row, the process applies the
rule to the transfer test and evaluates the test no further. If you
did not specify a rule for this row, or if the transfer test does
not meet the criteria of the rule, the process does not articulate
the test. In this case, the transfer test appears on the on the Test
Credit Details page with a status of no rule.

Note: If you have only one rule for this academic program
or academic plan, you must enter it in the Default field. The
Default field is the only required field on the page.

Override The Transfer Credit process uses the test equivalency rule

that you specify on this row first. If the transfer test meets the
criteria of the rule specified on this row, the process applies the
rule to the transfer test and evaluates the test no further. If you
did not specify a rule for this row, or if the transfer test does
not meet the criteria of the rule, the process then evaluates the
test equivalency rule that you specify on the Default row.

For example, you might have a general test equivalency

rule for the Undergraduate Liberal Arts program but have

a different rule for the English plan within this academic
program. You would create two test transfer equivalency rules,
enter the Liberal Arts program equivalency rule in the Default
field, and then enter the English plan equivalency rule in the
Override field.
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Setting Up Attendance Tracking

Prerequisites for Setting Up Attendance Tracking

Before you can generate class attendance rosters or record student attendance, you must:
1. Define attendance type translate values in PeopleSoft Application Designer.

2. Set a default attendance type for each academic institution in your system.

3. Define courses in the course catalog.

4. Define all possible instruction modes, attendance types, and attendance type data for each course

component in the course catalog.

5. (Optional) Set the attendance tracking generation flag for each class in the schedule of classes.

Setting Up Attendance Tracking Data

This section discusses how to:

» Define attendance type translate values.

* Select a default class meeting attendance type.

* Define attendance tracking options for course components.

» Indicate attendance roster generation for a class.

Pages Used to Set Up Attendance Tracking

Page Name Definition Name Navigation

Usage

Academic Institution Table 3 | INSTITUTION TABLE3 Set Up SACR >
Foundation Tables >
Academic Structure >
Academic Institution
Table > Academic
Institution 3

Specify a default class
meeting attendance type for
each institution.

Course Catalog - Components | CRSE_CATALOG_CMPNT | Curriculum
Management > Course
Catalog > Course
Catalog > Components

Set catalog-level defaults for
both batch attendance roster
generation and instruction
mode.
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Page Name Definition Name Navigation Usage
Schedule of Classes - Basic CLASS _ENTRY *  Curriculum Modify the Generate Class
Data Management > Mtg Attendance (generate

Schedule of Classes > | class meeting attendance)
Schedule New Class > | check box and instruction

Basic Data mode values that appear
by default from the Course
Curriculum Catalog - Components page.

Management >
Schedule of Classes >
Maintain Schedule of
Classes > Basic Data

Defining Attendance Type Translate Values

PeopleSoft Application Designer delivers the following attendance type translate values: Conference,
Instructor Consultation, Field Trip, Class Meeting, and Study Group. Use PeopleSoft Application
Designer to modify or add to these values. The field name is CLASS ATTEND TYP. However, be
careful to not delete a value that is in use.

Selecting a Default Class Meeting Attendance Type

Use the Academic Institution Table 3 page to specify a default class meeting attendance type for each
institution. In background processing mode, the system generates only one roster per class (even if you
specified multiple attendance types on the Components page), so the value that you specify applies to
all classes. The system uses the default attendance type value that you specify to determine the correct
attendance type row and related attendance type detail for each class. Each class should have at least one
row on the Course Catalog - Components page, with the same attendance type as the default attendance
type.

Related Links

“Setting Additional Institution Defaults and Options” (Campus Solutions Application Fundamentals)
Defining Attendance Tracking Options for Course Components

Use the Course Catalog - Components page to set catalog-level defaults for both batch attendance roster

generation and instruction mode and to define all possible attendance types and attendance type detail
data.

Related Links
Defining Course Components
Indicating Attendance Roster Generation for a Class
Use the Schedule of Classes - Basic Data page to modify the Generate Class Mtg Attendance (generate

class meeting attendance) check box and instruction mode values that are supplied by default from the
Course Catalog - Components page. You can set this option at the catalog level and the schedule of
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classes level. This check box enables you to select the exact course components and classes for which
your institution generates attendance rosters.

Related Links
Defining Basic Data for Class Sections
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Preparing to Track Student Data

Common Elements Used in Preparing to Track Student Data

Field or Control Description

Transcript Level Select the transcript level on which you want the given data to
print. Values for this field are delivered with your system as
translate values. You can modify these values. The delivered
values are Degr Prog (degree progress), Not Print, Official,
Stdnt Life (student life), and Unofficial.

Related Links

Understanding Transcript Levels

Setting Up Academic Standing

Copyright © 1988, 2023, Oracle and/or its affiliates.

To set up academic standing, use the Academic Standing Table component (ACAD_STDNG_TBL) and
the Academic Standing Rule component (ACAD_STDNG_RULE).

With academic standing action codes and rules, you can create sets of guidelines for every academic
career within your institution. You can then use these codes and rules to assign academic standing

to students, either by running the Acad Standing/Honors Awards process (SRPCEASD) through the
Academic Standing/Honors and Awards page to evaluate students' academic standing, or by entering
academic standing codes directly onto a student's term history record through the Academic Standing

page.

This section discusses how to:

* Define academic standing action codes.
* Create academic standing rules.

* Link academic standing, honors, and award rules to academic programs.

Related Links
Tracking Academic Standing
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Page Name

Definition Name

Navigation

Usage

Academic Standing Table

ACAD STDNG TBL

Set Up SACR > Product
Related > Student
Records > Student
Standing and Awards >
Academic Standing

Table > Academic
Standing Table

Define academic standing
action codes for every
academic career within your
institution.

Academic Standing Rule

ACAD STDNG RULE

Set Up SACR > Product
Related > Student
Records > Student
Standing and Awards >
Academic Standing Rule >
Academic Standing Rule

Create academic standing
rules. Academic standing
rules are keyed by academic
career, so define a broad
description for an academic
standing rule (such as
Undergraduate Rules or
Graduate Rules). Within each
rule, you create detail lines
that correspond with academic
standing action codes that you
define.

Standing/Honors

ACAD PROG_STDG TBL

Set Up SACR >
Foundation Tables >
Academic Structure >
Academic Program

Table > Standing/Honors

Link academic standing rules
to academic programs.

Defining Academic Standing Action Codes

462

Access the Academic Standing Table page (Set Up SACR > Product Related > Student Records >
Student Standing and Awards > Academic Standing Table > Academic Standing Table).
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This example illustrates the fields and controls on the Academic Standing Table page. You can find
definitions for the fields and controls later on this page.

Academic Standing Table

Academic Institution: PEUMNY FeopleSoft University
Academic Career: UGRD Undergraduate
Find [view i [4] 4 of 1
*Effective Date: 01/01/1900 [# “Status: [active =] =
*Academic Standing Action: mlE] E'
*Description: Dismiszal 1 Short Description: |Dismissal
*Academic Standing Status: Dismissed |
*Formal Description: Dismissed
*Internal Description: Dismissed

*Transcript Level: I Official 'I

Creating academic standing action codes is a precursor to defining academic standing rules. Therefore, to
define academic standing action codes, you must think about how they can be used in the rule sets for the
academic standing process.

For example, suppose that students at your institution receive two warnings before being placed on
probation and the warnings are of different degrees. That is, if students receive a second warning it is
more severe. In this case you would define two different academic standing action codes for warnings
because you want to distinguish them. Later, you define rule details for these codes, and for all other
academic standing action codes defined on this page.

Note: If you want to inactivate an academic standing action code that is attached to an academic standing
rule, delete the code where it is attached to the rule on the Academic Standing Rule page and enter a
status of /nactive on the Academic Standing Table page.

Field or Control Description
Academic Standing Action Enter an academic standing action code.
Academic Standing Status Select an academic standing status. Values for this field are

delivered with your system as translate values. You can modify
these values. The delivered values are Dismissed, Good
Standing, Probation, and Subject to Dismissal.

You can have many academic standing action codes that
contain the same academic standing status. For example, DIS/,
DIS2, and DIS3 can all contain a status of Dismissed.

Formal Description Enter a formal description. If you choose to have the academic
standing action appear on a student's transcript, the system
displays the formal description.
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Field or Control

Description

Internal Description

Enter a description to be used for internal purposes only.

Transcript Level

Select the transcript level on which you want the academic
stranding to print. Values for this field are delivered with
your system as translate values. These translate values can
be modified. The delivered values are Deg Prog (degree
progress), Not Print, Official, Stdnt Life (student life), and
Unofficial.

Related Links

Understanding Transcript Levels

Creating Academic Standing Rules

Access the Academic Standing Rule page (Set Up SACR > Product Related > Student Records >
Student Standing and Awards > Academic Standing Rule > Academic Standing Rule).

This example illustrates the fields and controls on the Academic Standing Rule page (1 of 2). You can
find definitions for the fields and controls later on this page.

*Academic Standing Rule

Academic Standing Rule

Academic Career:  LUGRD Undergraduate

*Effective Term Term Description Short Description

UGRD

Academic Standing Rule: UGRD Effective Term: 0280 14947 Fall
GPA and Units Detail Find | Wiew &) =
Seq. Ho: ’T *Academic Standing Action: iz Q Dismissal 1 =
Cumulative GPA: ra 2000 angor: [#nd =
Current Term GPA: IF Q 20000 mngior: I :I'
Cumulative Units Passed: l_ Q
Current Units Passed: I_ <
Cumulative Units Attempted: [ a
Current Units Attempted: l_ Q
Academic Year GPA: l_ xQ [ Exclude No GPA Attempted Units

FeopleSoft University

1 1997 Fall Academic rules for undergrads |AS—Ugrd E|
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This example illustrates the fields and controls on the Academic Standing Rule page (2 of 2). You can
find definitions for the fields and controls later on this page.

Academic Standing Detail Fincl A Fir=t E 1cf 2 [} Last
Seq. No: 10 Academic Standing Action:  DIS1 Dismissal 1 EI
[T Any Academic Standing Set [ No Academic Standing Set
Prior Term Academic Standing:
PRE1Q Frobation 1 Q
Q Q
Q Q
Q Q
Q Q

Field or Control Description

Academic Standing Rule Enter an alphanumeric code that identifies this academic
standing rule code.

Effective Term Select the effective term of the rule. When the system uses the
rules that you define here in the Academic Standing process, it
verifies that the rule is effective within the term for which the
process is running.

Seq No (sequence number) Enter the sequence number order in which the system
evaluates the rule. Sequence your rules from the most severe
academic standing action to the least severe. After a student's
academic standing matches one academic standing rule, the
Academic Standing process applies the academic standing
action code to the student's record and moves on to the next
student.

Academic Standing Action Enter the academic standing action code that you want the
system to post to students' records if the rule is satisfied.

The system populates the Academic Standing page with the
appropriate code once you run the academic standing process.
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Field or Control

Description

Cumulative GPA, Current Term GPA, Cumulative

Units Passed, Current Units Passed, Cumulative Units
Attempted, Current Units Attempted, and Academic Year
GPA

These criteria form your rules. For each criterion that you
choose to use in this rule, select a qualifier: Greater Than,
Greater Than or Equal To, Less Than, or Less Than or Equal
To. Do not modify these values. Then, enter the numeric value
for each criterion. In the preceding example, the cumulative
grade point average must be less than 2.000 and the current
grade point average must be less than 2.000.

Use the last prompt box to add the connector for the rule: And,
Or; and blank for none.

You can skip any criteria and only enter information in the
criteria pertinent for your rule. See the examples to understand
the sequencing of rules.

Note: For the Academic Year GPA field, the system looks

at the term for which academic standing is being processed,
determines the academic year in which the term falls based

on the value in the Term/Session Table component, determines
the student's statistics from all terms in that academic year,
calculates the student's grade point average, then compares the
student's grade point average against the value that you enter
on this page.

Exclude No GPA Attempted Units

Select this check box in order to exclude from reporting

all classes that were attempted, but are not included in the
student's GPA (for example, Pass/No Pass courses, W grades,
and so on). The grade's corresponding Include in GPA check
box on the Grading Scheme Table page must be cleared (not
selected) in order for the system to exclude it from processing.
Clear this check box in order to include in your report all
attempted coursework, regardless of the assigned grade.

Any Academic Standing Set

Select if it does not matter what academic standing action
codes students can have on their records prior to this rule
evaluation. The other fields on the page become unavailable
for input.

No Academic Standing Set

Select if the student's record should possess no academic
standing action code.

Prior Term Academic Standing

Select any academic standing code that the student must
possess in a prior term to satisfy the rule. For example, in
the preceding page shot, the student must possess the PRBI
(probation 1) code in addition to meeting the grade point
average requirements.

Note: By selecting the No Academic Standing Set check box and selecting prior academic standing
values, the academic standing rule reads as an OR statement. For this rule to apply, the student's record
must either possess the academic standing values for the prior term that you select, possess no academic
standing action code, or have no prior term for comparison.
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Example of an Academic Standing Rule

Suppose that you defined seven different academic standing action codes for undergraduates. Because you
want to use all of these codes in the Academic Standing process, you have eight rule detail lines in your
academic standing rule, each line numbered from sequence number /0 (being the most severe academic
standing action code) to sequence number 90 (being the least severe academic standing action code).

The following examples demonstrate some ways to set up academic standing rules.

The Sequencing of Rule Details

This example illustrates the Academic Standing Rule page for the Dismissal 2 action:

Academic Standing Rule

Academic Career:  UGRD Undergraduate PeopleSoft University
*Academic Standing Rule *Effective Term  Term Description Short Description
UGRD 0290 11997 Fall academic rules for undergrads | |as-Uard =]
Academic Standing Rule: UGRD Effective Term: 0280 1997 Fall
GPA and Units Detail Find | % 1  of 8
Seq. No: W *Academic Standing Action: Dls2 Q Dismissal 2
Cumulative GPA: et 2000 ppgor: |And -
Current Term GPA: IF Q 2.0000 andior: I’”‘”d :"
Curnulative Units Passed: l_ Q
Current Units Passed: [ &
Cumulative Units Attempted: 6B Q 20000 pngor: | =l
Current Units Attempted: I_ Q
Academic Year GPA: l_ Q [ Exclude No GPA Attempted Units

Academic Standing Detail

Seq. No: 20 Academic Standing Action:  DIS2 Dismissal 2
[T Ay Academic Standing Set [ Mo Academic Standing Set
Prior Term Academic Standing:
PRB1 & Frobation 1 PRBZ  Q Probation 2
PRB3 |Q Probation 3 Q
On this page:

* The system evaluates this rule second because the sequence number is 20, and one other rule detail
line with a lower sequence number exists.

* The cumulative grade point average and current grade point average requirements are higher than that
of the sequence number /0 rule, but can be the same or less than that of subsequent rules.

You can have the same grade point average requirement, for instance, for probation and dismissal.
Differentiate these actions by the prior academic standing codes students must possess.
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»  Students must possess one of the academic standing action codes listed in the Prior Term Academic
Standing Value field in addition to satisfying the grade point average rules, to satisfy the Dismissal 2

rule detail.

This example illustrates the Academic Standing Rule page for the Probation 2 academic standing action

code:

Academic Standing Rule

Academic Career:

*Acadernic Standing Rule

LGRD  Undergraduate

*Effective Term

UGRD 0280

Academic Standing Rule:

GPA and Units Detail

UGRD

PeopleSoft University

Term
241947 Fall

Description Short Description

Effective Term: 0280 1997 Fall

irst 4] 4of 8 o Last

Seq. MNo: W *Academic Standing Action: PREZ O Frobation 2 El
Cumulative GPA: [

Current Term GPA: IF Q 20000 angior: I :I'

Cumulative Units Passed: ’_ &

Current Units Passed: l_ Q

Cumulative Units Attempted: [ &

Current Units Attempted: [ a

Academic Year GPA: l_ Q [ Exclude No GPA Attempted Units

Academic Standing Detail

FRBZ Frobation 2 [#][=]

[ Mo Academic Standing Set

Seq. Mo: 40 Academic Standing Action:
[ Any Academic Standing Set

Prior Term Academic Standing:

WRMNT U warning - may be placed on PRB WRNZ QU warning-may be placed on pran
On this page:

other detail lines with lower sequence numbers precede it.

The rule detail line is evaluated fourth by the system because the sequence number is 40, and three

The system posts the Probation 2 academic standing action code on student records when they

possess a current term grade point average less than 2.000 in conjunction with one of the academic

standing action codes selected.

Students must possess one of the academic standing action codes listed in the Prior Term Academic

Standing Value field in addition to satisfying the grade point average rules, to satisty the Probation 2

rule detail.
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In your rules, the least severe rule detail line is one for Warning-may be placed on prbn (warning-may be

placed on probation).

This example illustrates the Academic Standing Rule for this rule:

Academic Standing Rule

Academic Career: LUGRD Undergraduate

*Academic Standing Rule Term Description

*Effective Term

FeopleSoft University
Short Description

UGRD 0280 1 1997 Fall

Academic Standing Rule: UGRD Effective Term: 0250 18497 Fall

GPA and Units Detail

Sex. Mo: IT *Academic Standing Action: RN Warning-may he placed an prbn
Cumulative GPA; RS 2000 ppgior: | And M

Current Term GPA: lE & 20000 apgior: I :"

Cumulative Units Passed: I_ Q

Current Units Passed: l_ Q

Cumnulative Units Attempted: [ a

Current Units Attempted: l_ Q

Academic Year GPA: l_ Q [T Exclude No GPA Attempted Units

Academic rules for undergrads |AS-Ugrd

Academic Standing Detail

Academic Standing Action:  \WRMN2
[ No Academic Standing Set

Seq. Mo: 70
[ Any Academic Standing Set

Prior Term Academic Standing:

WRNT @

—

VWarning - may he placed on PRE

Warning-may he placed on prbn

On this page:

* The rule detail line is evaluated last by the system because the sequence number is 80, and seven other

detail lines with lower sequence numbers precede it.

*  Students must possess a cumulative grade point average and a current term grade point average that is

greater than or equal to 2.000.

In addition, the student must possess one of the following academic-standing action codes stipulated

on the Academic Standing Rule page.

*  Students must possess at least one of the academic standing action codes on their record, in addition
to the rules set on the Academic Standing Rule page to satisfy the Warning-may be placed on prbn

rule detail.
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Good Standing Rule Detail
In your rules, the last rule detail line is one for Good Standing.

This example illustrates the Academic Standing Rule page for this rule:

Academic Standing Rule

Academic Career: UGRD Undergraduate PeopleSoft University

*Academic Standim Rule *Effective Term Term Descri)tinn Short Descri)tiun
UGRD 0290 Q. 1997 Fall Acadernic rules for undergrads |AS-Ugrd =

Academic Standing Rule: UGRD Effective Term: 0290 1997 Fall

GPA and Units Detail A
Sed. No: ’W *Academic Standing Action: cooD |Q Good Standing El
Cumulative GPA; loE Q 2000 ppgjor;  |And M
Current Term GPA: lE Q 2.0000 mngior: | OF i
Cumulative Units Passed: I_ Q
Current Units Passed: l_ Q
Cumulative Units Attempted: [ a
Current Units Attempted: l_ Q
Academic Year GPA: l_ & [T Exclude Ho GPA Attempted Units

Acadernic Standing Detail Find | Wiew & First Bs.s [+ Last
Seq. No: an Academic Standing Action:  GOQO0OD Good Standing El

¥ Any Academic Standing Set [” Mo Academic Standing Set
On this page:

» This detail line is evaluated last because the sequence number is 90, and all other rule detail lines
precede it possessing lower sequence numbers.

» Students must possess a cumulative grade point average and a current-term grade point average that is
greater than or equal to 2.000.

In addition, the student may possess any academic standing action codes stipulated on the Academic

Standing Rule page.

Linking Academic Standing, Honors, and Awards Rules to Academic
Programs

Access the Standing/Honors page (Set Up SACR > Foundation Tables > Academic Structure >
Academic Program Table > Standing/Honors).
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This example illustrates the fields and controls on the Standing/Honors page. You can find definitions for
the fields and controls later on this page.

Academic Standing

Academic Standing Rule:

Exclude Term Category 1:
Exclude Term Category 2:

Exclude Term Category 3:

Effective Date: 01/0141900

Academic Pragram StandingHonors Taxanarmy lepeatiincompleta Enrollment
Academic Institution: FELINY  PeopleSoft University
Academic Program: Lall Liberal Arts Undergraduate

LIGRD Q

[T calculate in Batch Onky
¥ Associate with Academic Prog
™ Obey Fully Graded Date

e
Ma
e

Status: Active

Firzt E = |E| Last

Arademic rules for undergrads

Honor Award Rule:

Exclude Term Category 1:

Exclude Term Category 2:

Exclude Term Category 3:

Honor and Award Date Flag:

Honors/Awarids

LIGRD Q

[T calculate in Batch Only

[T Associate with Academic Prog
™ Obey Fully Graded Date

Mo
e
Ma

Lndergraduate Honars

| System Date

Academic Standing

Field or Control

Description

Academic Standing Rule

Select the academic standing rule for this academic program.
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Field or Control

Description

Calculate in Batch Only

Select to calculate academic standing through a background
process using the Academic Standing/Honors Awards page.
If you select this check box, the system does not calculate

academic standing dynamically, such as when you post grades.

Clear to have the system call the academic standing process
when posting or changing a grade on the Quick Enrollment or
Enrollment Request pages, and when posting a grade on the
Grade Roster page. The academic standing process inserts an
updated academic standing row, viewable on the Academic
Standing page of the Term History component, except when a
student's class is graded with a grade that count towards GPA
and then later changed to a non-GPA grade. In such a scenario,
you must manually update the student's academic standing on
the Academic Standing page.

Obey Fully Graded Date

Select to calculate academic standing only when grades are
posted on or later than the fully graded date. The system does
not calculate academic standing if this check box is selected
and grades are posted before the student's fully graded date.
You define the default fully graded date on the Academic Term
Calendar 3 page in the Academic Calendar component and an
individual student's fully graded date on Term Control Dates

page in the Term Activation component.

Associate with Academic Prog (associate with academic
program)

Select to associate the academic standing rule only with
students in this academic program. This is especially useful
for students who might be in multiple academic programs; you
might want to apply different academic standing rules with
different academic programs. If you do not select this check
box, the system associates the academic standing rule with the
student's academic career.

Exclude Term Category 1, Exclude Term Category 2, and
Exclude Term Category 3

Select the terms in which the system does not calculate
academic standing. Values for this field are delivered with
your system as translate values. You can modify these values.

Honors/Awards

Field or Control

Description

Honor Award Rule

Select the honor award rule for this academic program.
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Field or Control

Description

Calculate in Batch Only

Select to calculate the honors and awards in batch through the
Academic Standing/Honors Awards page. If you select this
check box, the system does not calculate honors and awards

dynamically, such as when you post grades.

Obey Fully Graded Date

Select to calculate honors and awards only when grades are
posted on or later than the fully graded date. The system does
not calculate honors and awards if the Obey Fully Graded
Date check box is selected and grades are posted before the
student's fully graded date. You define the default fully graded
date on the Academic Term Calendar 3 page in the Academic
Calendar component and an individual student's fully graded
date on Term Control Dates page in the Term Activation
component.

Associate with Academic Prog (associate with academic
program)

Select to associate the honor/award rule only with students in
this academic program. This is especially useful for students
who might be in multiple academic programs; you might want
to apply different honor/award rules with different academic
programs. If you do not select this check box, the system
associates the honor/award rule with the student's academic

career.

Exclude Term Category 1, Exclude Term Category 2, and
Exclude Term Category 3

Select the terms in which the system does not calculate honors/
awards. Values for this field are delivered with your system as
translate values. You can modify these values.

Honor and Award Date Flag

Select the date type that the system posts to students' records
for their honors and awards. Values for this field are delivered
with your system as translate values. You can modify these
values with some programming effort. Values are System Date
and Fully Graded Date.

Setting Up Honors and Awards

To set up honors and awards, use the Honors/Awards Table component (SA_ HONORS AWARDS) and
the Honors/Awards Rule component (HONOR_AWRD_RULE).

Honors and awards include internal and external awards that you want to record for students. With
honor and award codes and rules, you can create sets of guidelines for every academic career within
your institution. You can then use these codes and rules to assign honors and awards to students, either
by running the Acad Standing/Honors Awards process (SRPCEASD) through the Academic Standing/
Honors and Awards page to evaluate students' honors and awards, or by entering honor/award codes
directly onto a student's record through the Honors and Awards page.
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This section discusses how to:

¢  Define honor/award codes.

¢ Create honor and award rules.

Related Links

Tracking Honors and Awards

Pages Used to Set Up Honors and Awards

Chapter 11

Page Name

Definition Name

Navigation

Usage

Honors/Awards Table

SA_HON_AWRD TABLE

Set Up SACR > Product
Related > Student
Records > Student
Standing and Awards >
Honors/Awards Table >
Honors/Awards Table

Define honor and award
codes for internal and external
awards.

Honors and Awards Rule

HONOR_AWRD RULE

Set Up SACR > Product
Related > Student
Records > Student
Standing and Awards >
Honors/Awards Rule >
Honors and Awards Rule

Create honor and award rules.

Standing/Honors

ACAD PROG STDG TBL

Set Up SACR >
Foundation Tables >
Academic Structure >
Academic Program

Table > Standing/Honors

Select honor and award
rules and parameters for this
academic program.

Defining Honor/Award Codes

Access the Honors/Awards Table page (Set Up SACR > Product Related > Student Records >
Student Standing and Awards > Honors/Awards Table > Honors/Awards Table).

Field or Control

Description

Internal/External Indicate whether the honor or award relates to an external
organization or your internal institution.
Grantor Enter the grantor of the honor or award.
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Field or Control

Description

Transcript Level

Select the transcript level on which you want the honor

or award to print. Values for this field are delivered with
your system as translate values. These translate values can
me modified. The delivered values are Degr Prog (degree
progress), Not Print, Official, Stdnt Life (student life), and
Unofficial.

Creating Honor Award Rules

Access the Honors and Awards Rule page ((Set Up SACR > Product Related > Student Records >
Student Standing and Awards > Honors/Awards Rule > Honors and Awards Rule).

This example illustrates the fields and controls on the Honors and Awards Rule page. You can find
definitions for the fields and controls later on this page.

Honors and Awards Rule

Academic Career:  UGRD Undergraduate

*Honor Award Rule

*Eifective

lozen @

Term
1397 Fall

UGRD

Honor Award Rule: UGRD

GPA and Units Detail

*Honor Award Group: ’F
*Honor/Award: DEANLE  Q
Cumulative GPA: 6B |Q
Current Term GPA: ’_ Q
Cumulative Units Passed: ’_ Q
Current Units Passed: ’_ Q
Cumulative Units Attempted: [ la
Current Units Attempted: [6E @
Academic Year GPA; [ &

Description

PeopleSoft University
Short Desc

Undergraduate Honars

Effective Term:

*Seq. No:

Dean's List

3.500

An

12.000

(=]
First IE' 1 af 1 II' Last

[Ugrd Hanor

0290 1997 Fall

20 =
dior: |And hd

Honoriaward Group: 1)

HonorAward: DEAMLE
Any Academic Standing Set

Current Term Academic Standing:

[ A

Seq. No:

Cean's List

No Academic Standing Set [

|

20

Define rules for every honor and award code that you want to use in the Honors/Awards process. Honor
and award rules are keyed by academic career; therefore, create a broad description for your honor and
award rules (such as Undergraduate Rules or Graduate Rules). To define honor and award rules, name the
rule, define parameters for the rule, and select the academic standing codes that a student must currently
possess in order for the rule detail line to be satisfied. Every rule detail line can have current academic-
standing code requirements. For instance, you can require that in addition to other criteria you defined,
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the student possesses the academic standing code of GOOD to meet the requirements for the Highest

Freshman GPA Award.

Field or Control

Description

Honor Award Rule

Enter an alphanumeric code that identifies this honor and
award rule code.

Effective Term

Select the effective term for the rule. When the system uses
the rules in the Honor/Award process, it verifies that the rule is
effective within the term for which the process is run.

Honor/Award Group

The default honor and award group number is 01. Group
awards together that are mutually exclusive, because the
system processes honors and awards by group, and within a
group by sequence number.

For example, the President's Award and the Dean's List honors
are mutually exclusive. If students are granted one award they
are not granted the other. By grouping the awards together, you
prevent the system from granting a student both awards.

Seq No (sequence number)

Enter the sequence in which the system evaluates the rule.
Sequence your rules from the most restrictive to the least
restrictive.

In our example, the President's Award has a sequence number
of 10 and the Dean's List honor has a sequence number of 20.
The President's Award is more restrictive than the Dean's List
honor, so it is sequenced first. The Dean's List honor is slightly
less selective, so it is sequenced second.

Honor/Award

Select the honor and award code that the system posts to
students' records if they satisfy the rule. Define honor and
award codes on the Honors/Awards Table page. The system
populates the student Honors and Awards page with the
appropriate code when you run the Honors/Awards process.
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Field or Control Description

Cumulative GPA, Current Term GPA, Cumulative These criteria form your rules. For each criterion that you
Units Passed, Current Units Passed, Cumulative Units choose to use in this rule, select a qualifier: Greater Than,
Attempted, Current Units Attempted, and Academic Year | Greater Than or Equal To, Less Than, or Less Than or Equal
GPA To. Do not modify these values. Then, enter the numeric value

for each criterion. In the preceding example, the cumulative
grade point average must be greater than or equal to 3.750 and
the current grade point average must be greater than or equal
to 3.750.

Use the last prompt box to add the connector for the rule: And,
Or; and blank for none.

You can skip any criteria and only enter information in the
criteria pertinent for your rule.

Note: For the Academic Year GPA field, the system looks

at the term for which academic standing is being processed,
determines which academic year the term falls in based on

the value in the Term/Session Table component, determines
the student's statistics from all terms in that academic year,
calculates the student's grade point average, then compares the
student's grade point average against the value that you enter
on the page.

Any Academic Standing Set Select if the student would be eligible for this honor or award
no matter what his or her academic standing.

No Academic Standing Set Select if the student would be eligible for this honor or award
only if he or she was not assigned an academic standing code.

Current Academic Standing Values Select the academic standing values a student must possess

to satisfy this rule. Define academic standing values on the
Academic Standing Table page. In the preceding example, the
student must possess the academic standing code of GOOD
to satisfy the rule. Define academic standing values on the
Academic Standing Table page.

Setting Up Special Grade Point Averages

To set up special grade point averages, use the Student Special GPA component (SPECIAL GPA TYPE).

Every institution has its own unique way of calculating grade point averages. Special grade point averages
are averages that you define for your institution that differ from the cumulative grade point average. You
can enter special grade point averages for a student's academic program, academic plan, or academic
subplan. You can then use these special grade point averages to meet your institution's analysis and
reporting needs.

This section lists the page used to set up special grade point averages.
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Related Links
Tracking Special Grade Point Averages
Page Used to Set Up Special Grade Point Averages
Page Name Definition Name Navigation Usage
Student Special GPA SPCGPA_TYPE _TBL Set Up SACR > Product Define the types of grade

Related > Student
Records > Grading >
Student Special GPA >
Student Special GPA

point averages (GPAs) that
your institution tracks by
entering an effective date,
status, and description for

each GPA type.

Reviewing Committees and Committee Members

Use committees to indicate advisory roles. Committees can be faculty standing committees, dissertation
committees, thesis committees, and so on. Because committees are discussed in more detail in the
PeopleSoft Campus Community documentation, we only review them briefly here.

To use committees and committee members:

1. Define committee types and the roles of committee members on the Committee Table page.

2. Assign specific committees to the committee types that you defined on the Committee Table page.
3. Assign committee members to specific committees on the Committee Members page.

Related Links

“Setting Up Committee Types and Roles” (Campus Community Fundamentals)

“Creating Committees” (Campus Community Fundamentals)
“Assigning Committee Members” (Campus Community Fundamentals)

Setting Up Milestones

To set up milestones, use the Milestone Table component (MILESTONE TBL) and Milestone Template
component (MILESTONE TMPL).

Milestones are non-course related but vital requirements that a student must complete toward degree
progress to graduate. You might be able to relate milestones most easily to graduate student progress, but
your institution might also use milestones for undergraduates as well. After you define milestones, you
can assign milestones and advisors to a student, as well as record the student's completions of milestones
and attempts to fulfill them, by using the Student Milestones component.

This section discusses how to:

¢ Define milestone codes.
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* Create milestone templates.

Related Links

Tracking Milestones

Pages Used to Set Up Milestones

Preparing to Track Student Data

Page Name

Definition Name

Navigation

Usage

Milestone Table

MILESTONE TBL

Set Up SACR > Product
Related > Student
Records > Enrollment >
Milestone Table >
Milestone Table

Define milestones.

Milestone Templates

MILESTONE_TMPL

Set Up SACR > Product
Related > Student
Records > Enrollment >
Milestone Templates >
Milestone Templates

Create milestone templates to
reduce data entry later on.

Defining Milestone Codes

Access the Milestone Table page (Set Up SACR > Product Related > Student Records >
Enrollment > Milestone Table > Milestone Table).
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This example illustrates the fields and controls on the Milestone Table page. You can find definitions for
the fields and controls later on this page.

Milestone Table

Academic Institution: PeaopleSaoft University

IMilestone: ALDITION

*Effective Date: 010011900 [+ *Satus: [=]

*Description: |Audition

*Formal Description: \Audition

*Calculate Required Date: | Expected Grad Term Start Date  w |

*Calculate Anticipated Date: | Expected Grad Term Start Date w |

*Transcript Level: | Print on Official v |

*Print Milestone Detail: | Always Print w |

Attempts Allowed: |_2

Grading Scheme: s Q Undergraduate Grading Schemea

Grading Basis: PMP Q FPassiMot Pass
Self-Service Availability

Allow Student Self-Service Allow Advisor Self-Service
Allow Student Attachment Allow Advisor Attachment

Information For Students:

Performance students should contact their assigned advisor for instructions and requirements regarding @
auditions.

Enter Milestone Levels Here Personalize | Find | = I wH First Kl 12 o2 I Last
*Milestone Level *Description *Formal Description

[DANCE [Dance Audition [Dance Audition (=]
|I'\-1USIC |h-1usi|: Perfarmance Audition |Music Perfarmance Audition (=]

Note: To inactivate a milestone code, remove that code from every milestone template in addition to
entering a status of Inactive on this page.

Field or Control Description

Calculate Required Date and Calculate Anticipated Date If you enter a value, for example Expected Grad Term Start
Date, the date/term is calculated when you add a milestone for
a student on the Student Milestone page or when you run the
Process Milestone process.
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Field or Control

Description

Print Milestone Detail Select a print milestone detail to indicate whether the
milestone detail information appears on the transcript.
Milestone detail information includes the details on the
Student Milestones page.

Attempts Allowed Enter the number of attempts students can make at completing

the milestone. This field is a default data entry and tracking
aid. You can override the attempts allowed on individual
student records.

Grading Scheme

Select a grading scheme for the milestone. When you enter the
milestone on a student's record, you can override the grading
scheme.

Grading Basis

Select a grading basis for the milestone. Link grading bases to
grading schemes on the Grading Scheme Table page. You can
override this value on individual student records.

Self-Service Availability

Field or Control

Description

Allow Student Self-Service

Select the check box to allow students to access information
about the milestone in Self Service.

If the check box is selected, the milestone appears in the
Milestone section on the Student Center page. Students click
the details link to access the Student Milestones Details self-
service page (SS_SR_MILESTON_SEC).

Field or Control

Description

Allow Advisor Self-Service

Select the check box to allow advisors to access information

about the milestone in Self Service.

If the check box is selected, advisors can access the Student
Milestones Details self-service page through the Advisor
Center.
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Field or Control Description

Allow Student Attachment and Allow Advisor Attachment Select the check box to allow students and advisors to
add attachments — for example, an advisor might attach
instruction or reference materials for students to use.

Information for Students The information that you enter here can be viewed by students
in Self Service.

See “Setting Up a Self-Service Student Center” (Campus Self Service ).

“Understanding Self-Service Student Center” (Campus Self Service )*“Using Self-Service Student Center”
(Campus Self Service )

Enter Milestone Levels Here

Field or Control Description

Milestone Level Enter an alphanumeric code that identifies this milestone level
code. You use milestone levels for detailing the progress of a
milestone and for informational purposes. For example, you
might define a milestone of Written Comprehensive Exams for
doctoral students and have four levels within that milestone to
designate the four sets of comprehensives required.

(NZL) Defining Milestones for Unit Standards

When you define a milestone for New Zealand institutions, use the NQF Detail group box to enter a
Milestone Type of U and link NQF codes to the milestone.

See Linking NQF Codes to Milestones.

Related Links

Tracking Milestones
Creating Transcript Text

Reviewing Transcript Print Areas

Creating Milestone Templates

Access the Milestone Templates page (Set Up SACR > Product Related > Student Records >
Enrollment > Milestone Templates > Milestone Templates).
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This example illustrates the fields and controls on the Milestone Templates page. You can find definitions

for the fields and controls later on this page.

Milestone Templates

Academic Institution: PeopleSoft University

Academic Program:

Academic Career: Undergraduate

Academic Plan:

Find | View Al | 4] 1 of 1 n
*Effective Date: 0210411997 [ *Status: =
“Description: |Undergraduate
Templates Detail Fnd|vewaAl Elqo2 0
=|Milestone: QUALEXAM  Q *Milestone Nbr: W El
Milestone Level: Q
*Description: |Undergrad Cualifying Exam
*Formal Description: |Undergrad Cualifying Exam
Milestone Title: @
Comment: &
Ilanage Milestone Documents
*Calculate Required Date: | Do Mot Calculate L |
Term Requirec: Q Date Required: e
*Calculate Anticipated Date: | Do Mot Calculate "l
Anticipated Term: Q Anticipated Date; Eﬂ
*Transcript Level: *Print Milestone Detail:
[] Advised by Committee
Personalize | Find | IEI| i First 4] 1 of 1 n Last
Attempts Allowed: ,_3
Grading Scheme: GRA Q Graduate School Grading Scheme
Grading Basis: sUS Q Satisfactory/Unsatisfactory

If you link a milestone template to only an academic institution and academic career, it can be used as a
template for any academic program or plan. If you want a milestone template to be restricted to a specific
academic program or plan, enter the program and plan in the search dialog box. When you link milestones
to academic programs you are making a template, not a permanent link. This information appears in the
Student Milestones component when you copy the template to the student's record.

For information about the fields on this page:

See Defining Milestone Codes.

Related Links
Tracking Milestones
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Setting Up Extracurricular Activities

To set up extracurricular activities, use the Extracurricular Activity Table component
(EXTRA_ACTIVITY_TBL).

You can track both internal and external extracurricular activities for individuals.

This section discusses how to set up extracurricular activity codes for this purpose. You later use the
Extracurricular Activity page to link these codes to students.

Page Used to Set Up Extracurricular Activities

Page Name

Definition Name

Navigation Usage

Extracurricular Activity Table

EXTRA ACTIVITY TBL

Set Up SACR > Product Set up extracurricular

Related > Campus activity codes, and define the
Community > Define primacy of the extracurricular
Campus Community > activities for your setID.

Setup > Extracurricular
Activity Table >
Extracurricular Activity
Table

Setting up Extracurricular Activity Codes

Access the Extracurricular Activity Table page ((Set Up SACR > Product Related > Campus
Community > Define Campus Community > Setup > Extracurricular Activity Table >
Extracurricular Activity Table).

Field or Control

Description

Activity Type

Select the type of activity that you are entering. Values for this
field are delivered with your system as translate values. You
can modify these values. The delivered values are Athletics,
Club, Employment, Music, Other, Publications, Student
Government, Theater, and Volunteer:

Internal and External

Select this option to indicate that this extracurricular activity
exists at your institution as well as at external institutions.

Internal Select this option to indicate that this extracurricular activity
exists at your institution only.
External Select this option to indicate that this extracurricular activity

exists at external institutions only.

484

Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 11 Preparing to Track Student Data

Field or Control Description

Extra Activity Primacy Enter the primacy number for this extracurricular activity.
When you run the Consolidate Academic Statistics process

it searches students' extracurricular activity records for only
the athlete extracurricular activity. The athlete extracurricular
activity is delivered with your system. It should not be
modified in any way because it has code attached to it. If the
Consolidate Academic Statistics process finds multiple athlete
records for a student, it writes the one with the lowest primacy
number to the student's consolidated statistics record.

Related Links
Understanding Consolidated Statistics Processes
Understanding Consolidate Academic Statistics Process Calculations

Managing Student Groups

Student groups enable you to set up groups (such as Athlete or Freshman) and assign these groups to
individuals. Then you can perform actions (such as run reports and processes) on a group, which affects
all of the individuals in the group.

This section lists the page used to manage student groups. You later use the Student Groups page to assign
student groups to students.

Page Used to Manage Student Groups

Page Name Definition Name Navigation Usage
Student Groups STDNT_GROUPS Student Recruiting > Set up student groups (such
Maintain Prospects > as Athletes and Resident
Academic Information > Assistants) by entering the
Student Groups > Student | effective date, status, and
Groups description of each student
group.

Setting Up Student Attributes

To set up student attributes, use the Student Attribute Table component (STDNT ATTR_TBL).
This section provides an overview of student attributes and discusses how to:
* Define student attribute codes.

¢ Define student attribute values.
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Related Links
Tracking Student Attributes

Understanding Student Attributes

Although student groups enable you track attributes such as participation in clubs, sports, and student
government, you might need an additional, more flexible structure that lets you track the attributes of your
students based on their career and program. To meet this need, use the Student Attributes feature.

The Student Attributes feature enables you to assign all sorts of attributes to a student within an academic
career or program and group together the students with similar student attributes. You can then track and
report on the student attribute data. For instance, you can track students that begin their education at the
same time as a single cohort by creating a student attribute for undergraduate incoming freshmen and
attaching the attribute to the records of these students. You can then use the data for federal reporting and
also for institutional research purposes to gain information about the type of students that you have in a
particular cohort, such as a student's typical course load or how long it takes a student to complete his or
her program and graduate.

You can create multiple attributes and multiple attribute values within a single attribute. Then when

you assign these attributes to students, you can attach to their records multiple attributes and multiple
values within each student attribute. With this flexibility, your students can belong to as many cohorts as
necessary to meet your tracking and reporting needs. You can assign these attributes to students at any
time, even during the recruiting and admissions processes because the attributes roll from PeopleSoft
Recruiting and Admissions to Student Records as part of the student's academic career and academic
program.

Use the Student Attribute Table component to define different student attributes and student attribute
values. You can create broad student attributes for entire academic careers, then attach single student
attribute values to each of those careers. For example, you can create a student attribute for undergraduate
students called Student Cohort. You can then create different values for Student Cohort on the Student
Attribute Value Table page (such as Fall 2005 Entry Class, Fall 2006 Entry Class, and Fall 2007 Entry
Class). In addition, you can create smaller student attributes for individual academic programs. You can
also define student attribute values for plans and subplans and group them under a specific academic
program.

After you define all your student attributes and student attribute values, use the Student Attributes page to
attach these attributes and attribute values to individual students and build reports on the data so you can
track statistics such as how many students in a particular cohort graduated in three years, four years, and
five years, and how heavy their course load was. The system also reports a primary student attribute as
part of the Consolidate Academic Statistics process.

Pages Used to Set Up Student Attributes

Page Name Definition Name Navigation Usage

Student Attributes Table STDNT_ATTR _TBL Set Up SACR > Product Define the various student
Related > Student attributes your institution uses
Records > Student for tracking and reporting on
Standing and Awards > different cohorts.
Student Attribute Table >
Student Attributes Table

486 Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 11 Preparing to Track Student Data

Page Name Definition Name Navigation Usage

Student Attribute Value Table | STDNT ATTR VAL TBL Set Up SACR > Product Define the values associated
Related > Student with a particular student
Records > Student attribute.

Standing and Awards >
Student Attribute Table >
Student Attribute Value
Table

Defining Student Attribute Codes

Access the Student Attributes Table page (Set Up SACR > Product Related > Student Records >
Student Standing and Awards > Student Attribute Table > Student Attributes Table).

Field or Control Description

Academic Career (Optional) Select the academic career to which the student
attribute is linked.

Academic Program (Optional) Select the academic program to which the student
attribute is linked.

Defining Student Attribute Values

Access the Student Attribute Value Table page (Set Up SACR > Product Related > Student
Records > Student Standing and Awards > Student Attribute Table > Student Attribute Value

Table).

Field or Control Description

Student Attribute Value Enter an alphanumeric code that identifies this student
attribute value.

Primacy Enter the primacy number for the student attribute. The system
uses the number to determine the primary student attribute
value it uses when you extract data to report on cohorts. This
primacy value has no relation to Financial Aid primacy. The
lowest number takes precedence.

Note: Always assign the lowest primacy number to the student attribute value that you want to use for
federal reporting of this student attribute.
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Setting Up Grading

Understanding Grade Preparation

Student Records provides a variety of grade-related features. From institution and career-based rules to
repeat schemes, grade rosters, grade change audits, and midterm deficiency analysis, you can use the
different grade-related components to set up and manage grading processes.

Grade bases comprise individual grades, and grade schemes comprise grade bases. Typically, grade
schemes are unique for each career in your institution. Grade schemes are not manually assigned to
individual classes. Instead, the system dynamically matches grade schemes that are assigned to one career
with classes of the same career.

Before you can grade students, you must define all possible grading schemes for all careers. You can have
different grading schemes for different careers. Within each grading scheme, you define all valid grade
bases, grades, and grade-related detail.

In addition, the system enables you to convert grades from one grading scheme to another. We call

this grade-basis mapping feature our intelligent grade basis exception table. For example, when an
undergraduate student enrolls in a graduate course (and the graduate course is associated with a graduate
grading scheme), you might not want to grade the student according to the graduate grade scheme. Rather,
you set up exception rules so that the system reroutes the student's grade scheme to the appropriate
undergraduate grade scheme. On the Grading Basis Exception Rule page, you define all possible
exception scenarios that the system must handle. For example, you can set up a rule that requires the
system to convert a graduate grading scheme into an undergraduate grading scheme. This way, you ensure
that grade schemes are appropriate for the student, based on the student's career (rather than the career of
the class). Setting up exception rules is optional.

Finally, when all of your grade data is set up and instructors are ready to enter grades, you must generate
the grade rosters. You can generate rosters on an individual class basis or in batch. Generating the rosters
is a required, final step in making the rosters available for grade entry.

Setting Up Your System for Grading

To set up your system for grading, use the Grading Scheme Table component (GRADE SCHEME) and
the Grading Basis Exception Rule component (GRD_BASE EXCEPTION).

This section provides an overview of grading setup and discusses how to:
* Define grading schemes.
* Define grading basis exception rules.

* Run the Grade Basis Exception report.
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* Create grade rosters for a single class.

* Create grade rosters for multiple classes.

Understanding Grading Setup

Complete these steps to set up grading:

1. Define grade basis values:

Chapter 12

a. Select PeopleTools, Utilities, Translate Values to add or change translate values.

b. Search on the GRADING BASIS field name, which takes you to the table where you define

grade basis values.

2. Define grading schemes on the Grading Scheme Table page.

3. (Optional) Define grade basis exceptions on the Grading Basis Exception Rule page.

4. (Optional) Run the Grade Basis Exception Report to review active grade basis exception mapping

rules and their details.

5. Generate grade rosters on either the Grade Roster Type page or the Create Grade Rosters page.

Pages Used to Set Up Your System for Grading

490

Page Name

Definition Name

Navigation

Usage

Grading Scheme Table

GRADING SCHEME TBL

Set Up SACR >
Foundation Tables >
Academic Structure >
Grading Scheme Table >
Grading Scheme Table

Define all valid grading
schemes. Enter each grading
scheme and the associated
grades on this page.

Grading Basis Exception Rule

GRD_BASE EXCEPTION

Set Up SACR > Product
Related > Student
Records > Grading >
Grading Basis Exception
Rule > Grading Basis
Exception Rule

Map typical student-requested
grade bases to existing
grading basis rules.

Grade Basis Exception

RUNCTL SRGBEXCPT

Set Up SACR > Product
Related > Student
Records > Reports >
Grade Basis Exception >
Grade Basis Exception

Run reports that display
active grade basis exception
mapping rules and their
details.

Copyright © 1988, 2023, Oracle and/or its affiliates.




Chapter 12 Setting Up Grading
Page Name Definition Name Navigation Usage
Grade Roster Type GRADE ROSTER TYPE Curriculum Define grade rosters on a

Management >
Grading > Grade
Roster > Grade Roster

Type

class-by-class basis. To print
the grade roster, use the
Grade Roster Print page.
Prerequisite: If you want

to use blind grading for this
class, select the Use Blind
Grading check box on the
Class Associations page or
select the Use Blind Grading
check box on the Course
Catalog Offerings page. Then,
the system populates the Use
Blind Grading check box
each time that you create a
class association.

Create Grade Rosters

RUNCTL_GRD_ROSTER

Curriculum

Management >

Grading > Create Grade
Rosters > Create Grade
Rosters

Create grade rosters for

each term and session by
subject area or by academic
organization. To print the
grade rosters, use the Grade
Roster Print page. If you want
to use blind grading for this
class, select the Use Blind
Grading check box on the
Class Associations page or
select the Use Blind Grading
check box on the Course
Catalog Offerings page so
that the system uses blind
grading each time that you
schedule the class. The system
then populates the Use Blind
Grading check box each
time that you create a class
association.

Complete Grade Flag

SSR_GRADE FLAG TBL

Set Up SACR > Product
Related > Student
Records > Grading >
Complete Grade Flag >
Complete Grade Flag

Define complete grade flag
values to be used on the
Grading Scheme Table page.
In New Zealand, these
values are used for reporting
purposes.

Defining Grading Schemes

Access the Grading Scheme Table page (Set Up SACR > Foundation Tables > Academic
Structure > Grading Scheme Table > Grading Scheme Table).
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This example illustrates the fields and controls on the Grading Scheme Table page. You can find
definitions for the fields and controls later on this page.

Grading Scheme Table

Fir=t E 1 af 1 |I| Last
=]

UGD

SetlD: PSUMNY Grading Scheme:
‘Effective Date: 0101900 B spatus:
‘Description: |Undergraduate Grading Scheme

AUD O

Undergrad

Short Desc:

First E 1aof 8 [} Last
(=]

Include in GPA

‘Grade Basis: Audit
Formal Description: Audit

Grade Basis Convert: ’— &

Grade Basis Choice Default:

Default AAWhatIf Grade: &Y X aygit

*Grade Input:

Al Convert To Grade:

[ Grade Required
Elective Graie Basis
Print On Transcript
Print Grade Basis Desc
Audit Grade Basis

Fir=t E 1of2 u Last

[#[=]

Find | View Al

[ &

Grade Points: 0.0o0
Complete: Q

In Progress Grade Include in GPA

‘Repeat Checking Option:

‘Description: |’L\L"jit
‘Short Desc: Audit

[JExclude Progress Units
"Grade Category: MOME O

Earn Credit

Cvalia Attempt [include in Self Service

DropMithdraw Penalty Grades

WoQ

Drop with Greater Penalty: v QL

Drop with Penalty: Withd renw

Withdrew

WO Withdrew

Withdraw with Greater Penalty: |\ Q Withdrew

Withdraw with Penalty:

Grading schemes are linked to academic careers and academic programs.

Field or Control

Description

Status Enter a status for this grading scheme. Enter Active when
adding a new grading scheme. Enter Inactive only if your
institution no longer uses this grading scheme.

Description Enter a description for the grading scheme.

Short Desc (short description)

Enter a short description for the grading scheme.

Grade Basis

Enter a grade basis. Grade basis values are entered into your
system as translate values, which you can modify.

A Grade Basis of NON (Non-Graded) is required for each
grading scheme. This value is assigned for non-graded
sections, such as labs associated with a lecture. To activate this
grading basis, do not select any of the check boxes and do not
enter any grades.
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Field or Control Description
Formal Description Enter a formal description of the grading basis.
Grade Basis Convert Enter a grade basis convert value to use grades that are

associated with another grading basis. If you enter a value in
this field, the Grade Input group box becomes unavailable
because the grade basis references the grade input data of
another grade basis.

Grade Basis Choice Default If you select the Elective Grade Basis check box, you can
enter a grade basis choice default to specify the default grade
basis for this grading scheme. In addition, you can enter all
of the possible grading basis choices in the fields that become
available in the bottom third of the page. The system uses the
default value during enrollment. If students have the option to
select other grade bases, they can do so at enrollment time.

Include in GPA (include in grade point average) Select to include grades from this grading scheme in grade
point average (GPA) calculations.

Grade Required Select to specify this grade basis as required, for the purposes
of the Grade Review - Transcript Release process. When

you evaluate students using the Grade Review process,

those classes in which the students are enrolled with a
required grade basis must have all of their grades; otherwise, a
transcript is not generated for the student.

Selecting this option can prevent transcripts from printing until
all of a student's term grades are posted.

See Processing Batch Transcripts (Application Engine).

Elective Grade Basis Select to enter the grading bases from which the student may
select during enrollment.

Print on Transcript Select to display, on the transcript, classes that are graded with
this grade basis. If you do not select this option, all class data
for courses that have grades that are from this grade basis do
not appear on the transcript.

Print Grade Basis Desc (print grade basis description) Select to have the formal description of the grade basis appear
on the transcript.

Audit Grade Basis Select to indicate that the grading scheme is audit-only. If you
select this check box, the following check boxes in the Grade
Input group box become unavailable: In Progress Grade,
Include in GPA, and Earn Credit.
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Field or Control

Description

Grade Input

If you enter a grade basis and clear the Elective Grade Basis
check box, or if you do not enter a value in the Grade Basis
Convert field, the Grade Input field becomes available. Enter
all of the valid grade values for the grading scheme in the
Grade Input field. Add rows as necessary.

Convert To Grade

When you post grades, the system converts the originally
entered grade to the convert to grade if a value exists in the
Convert to Grade field. This field is optional. The convert to
grade must be within the grading scheme that you are currently
defining.

Description

Enter a description for the grade input.

Short Desc (short description)

Enter a short description for the grade input.

Exclude Progress Units

Select to have the system exclude this grade from progress
units. For example, you would select this check box for a W or
withdrawal grade.

Grade Points

Enter the grade points for the grade input. The system uses
these grade points, in conjunction with the units attempted for
the class, when it calculates GPA.

Complete

This field is user-defined. Define complete values on the
Complete Grade Flag page. In New Zealand, this field is used
for reporting purposes.

Grade Category

Use this field to give a grade additional identity. You can
assign a grade category to a particular grade or a group of
grades, and then use these assignments for advanced advising
analysis purposes, such as requisite checking or academic
advising limits. By default, the system populates the Grade
Category field with None.

A typical example of a grade category is Pass or Transfer
Pass. You can use academic advising to limit the number
of classes with grade categories of Transfer Pass that count
toward degree requirements. Select from a list of grade
categories that are defined by your institution.

Grade categories are defined on the Grade Category Table
page.

See “Setting Up Grade Category Values” (Academic
Advisement).

In Progress Grade

Select to indicate that this is an in-progress type of grade.
A typical example of an in-progress grade would be an
incomplete grade.
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Field or Control

Description

Include in GPA (include in grade point average)

Select to include the grade that you specify in GPA
calculations. An example of when you would not select this
check box is for a Pass grade.

Earn Credit

Select to specify that the grade can be counted toward course
and academic advising credit.

Valid Attempt

Select to mark each grade value as representing a valid course
attempt. PeopleSoft Academic Advisement uses this setting to
distinguish between grades for valid course attempts (A, B, C,
D, F, and so forth) and grades for invalid course attempts (AU,
W, and so forth).

If you select this check box, Academic Advisement can
distinguish between valid and invalid course attempts when
the values in the Units Attempted, Earned Credit, and GPA
fields are the same.

Include in Self Service

Select to enable the grade input value to be assigned and edited
on the Faculty Center Grade roster. If you clear this check box,
instructors cannot assign or edit this grade on the self-service
grade roster. A typical example is to clear the check box for a

W, an administrative withdrawal grade.

Repeat Checking Option

Select an option to indicate whether a class with this grade
should be counted as a repeat candidate and whether the class
should be processed by the Repeat Checking process. Values
are:

* 1) Count =Y Process = Y: If you select this option, any
class with this grade is counted in the pool of repeat
attempts and is selected and processed when the Repeat
Checking process is run.

*  2) Count =Y Process = N: If you select this option, any
class with this grade is counted in the pool of repeat
attempts, but is not selected and processed when the
Repeat Checking process is run.

*  3) Count = N Process = Y: If you select this option, any
class with this grade is not counted in the pool of repeat
attempts, but is selected and processed when the Repeat
Checking process is run.

*  4) Count = N Process = N: If you select this option, any
class with this grade is not counted in the pool of repeat
attempts, nor is it selected and processed when the Repeat
Checking process is run.

This table shows an example:
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Course Grade Units Attempted | Earned Credit GPA Valid Attempt
English 101 W (user defined) 3.00 0.00 0.00 No
English 101 F 3.00 0.00 0.00 Yes

Note: The PeopleSoft Academic Advisement application considers class attempts that have no grade as
valid attempts.

Drop/Withdraw Penalty Grades

When processing drops during the penalty periods, the enrollment engine uses the penalty grades specific
to the student's grading basis, as defined on the Grading Scheme Table page. If you do not define penalty
grades for the student's grading basis, the enrollment engine instead uses the grading bases and grades
that you define on the Session Calendarl page (for withdraw grades) and the Session Calendar 2 page
(for drop grades). We strongly suggest that you define penalty grades at the grade basis level to ensure
that students receive penalty grades specific to their intended grade basis for the class, and not the penalty
grade that is assigned to all students in the session, regardless of whether the penalty grade is from the
student's original grade basis.

For example, when you drop a student from a class for which the stdnt_enrl.grading_basis_enrl = AUD
during Drop With Greater Penalty and a drop with greater penalty grade exists in the GRADE TBL

for AUD, the system assigns the drop with greater penalty grade to the student. If no drop with greater
penalty grade exists at the grade table level for an AUD grade basis, the system instead uses the grading
basis and grade from the ACAD CALSES TBL, as defined on the Session Calendar2 page.

See “Setting Up Session Cancellation and Withdrawal Dates” (Campus Solutions Application
Fundamentals).

See “Setting Up Session Drop Dates” (Campus Solutions Application Fundamentals).

Field or Control Description

Drop with Penalty Enter the penalty grade that students who are enrolled with
this grade basis receive for a class if they drop the class afier
the drop-and-retain-record deadline but on or before the drop-
with-penalty deadline. The grade for the class appears on
students' transcripts and affect their GPA accordingly. Grade
values are defined on the Grading Scheme Table page.

Drop with Greater Penalty Enter the grade that students who are enrolled with this grade
basis receive for a class if they drop the class after the drop-
with-penalty deadline but on or before the drop-with-greater-
penalty deadline. The grade for the class appears on students'
transcripts and affect their GPA accordingly. Grade values are
defined on the Grading Scheme Table page.

Copyright © 1988, 2023, Oracle and/or its affiliates.




Chapter 12 Setting Up Grading

Field or Control Description

Withdraw with Penalty Enter the grade that students who are enrolled with this grade
basis receive for a class if they withdraw after the withdraw-
without-penalty deadline but on or before the withdraw-with-
penalty deadline. The grade for the class appears on students'
transcripts and affect their GPA accordingly. Grade values are
defined on the Grading Scheme Table page.

Withdraw with Greater Penalty Enter the grade that students who are enrolled with this grade
basis receive for a class if they withdraw after the withdraw-
with-penalty deadline but on or before the withdraw-with-
greater penalty deadline. The grade for the class appears on
students' transcripts and affect their GPA accordingly. Grade
values are defined on the Grading Scheme Table page.

Grade Scheme Example: Using an Elective Grading Basis

Select the Elective Grade Basis check box for grade bases that permit students to choose different modes
of grading for a class. Before you select this check box, define all of your grading basis choices

Grading Scheme Table

Find | View &1 First [ 1 cr 1 [ | ast

SetlD: PSUMNY Grading Scheme: [W]ein] EI
‘Effective Date: 01011900 B status;
‘Description: \Undergraduate Grading Scheme Short Desc: IW
Find | View Last
‘Grade Basis: ’ﬁ A sudent Option Include in GPA =
Formal Description: ‘Student Option A
Elective Grade Basis
Grade Basis Comvert: Print On Transcript
Grade Basis Choice Default: ’ﬁ & Graded iril::t(:;ratl;a BBasi_s Desc
Default AA What If Grade: ’— Q A pladeRase
Grading Basis Choice
*Grading Basis Choice: ’m Q Audit El
*Grading Basis Choice: ,ﬁ Q Graded El
*Grading Basis Choice: W Q FassiMot Pass =

On this page, select:
* The Elective Grade Basis check box.
The system displays the Grading Basis Choice scroll area.

» All valid possible grading basis choices from which a student can choose for a class that is offered
with this grade basis of OPT.
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Grade Scheme Example: Converting Grade Basis

Enter a grade basis in the Grade Basis Convert field for Satisfactory/Unsatisfactory (SUS) grades to
convert to your new and preferred grade basis of Pass/Not Pass (PNP).

Grading Scheme Table

Find | view &1 First (U 1 5 1 0 Last

SetlD: PSLUIMY Grading Scheme: LIGD El
‘Effective Date: 01011900 @ ‘Status: Active w
‘Description: Undaergraduate Grading Schemea Short Desc: Undergrad
Grade Basis Find |
‘Grade Basis: BUS S gatistactondUnsatistactory Include in GPA
Formal Description: SatisfactorylUnsatisfactary Grade Required
Elective Grade Basis
Grade Basis Convert: PP S Fasz/Mot Pass Print On Transcript
Print Grade Basis Desc
Grade Basis Choice Default: T
Auiit Grade Basis
Default AA What If Grade: 5 Q Satisfactory

On this page, select the grade basis value in the Grade Basis Convert field. All courses that have a grade
basis of SUS convert to a grade basis of PNP.

Grade Scheme Example: Setting Up a Requirement That References a Grade
Category

At PSUNYV, the maximum number of pass grades that can apply towards a Bachelor's degree is 24 units.
From these 24 units, no more than six units can be from another institution. To establish this academic
advising limit on pass grades, create two grade categories on the Grade Category Table page: PASS for
Internal Pass and TXFR for Transfer Pass. Then, on the Grading Scheme Table page, assign to the grade P
the grade category of PASS and assign to the grade 7 the grade category of TXFR.

In PeopleSoft Academic Advisement, create an academic requirement that is a global limit. Its first
requirement line points to a derived list of all courses on a student's transcript with a grade that has a
grade category of PASS unioned with a derived list of all courses on a student's transcript with a grade
category of TXFR. The requirement line limit allows a maximum of 24 units and maximum of 999
courses (the system enforces the lower of these). Create a second requirement line (in the same academic
requirement) that is also a global limit. It points to a derived list of all courses on a student's transcript
with a grade that has a grade category of TXFR. The requirement line limit allows a maximum of six
units. Attach this academic requirement to a requirement group at the career level, with a low reporting
sequence number, so that the degree audit system evaluates it first during an advising evaluation. Any
courses over the limit of allowed credits are excluded from the evaluation and are not counted towards the
remaining career, program, plan, or subplan degree requirements.

Related Links

“Setting Up Requirement Line Item Detail” (Academic Advisement)

Defining Grading Basis Exception Rules

Access the Grading Basis Exception Rule page (Set Up SACR > Product Related > Student
Records > Grading > Grading Basis Exception Rule > Grading Basis Exception Rule).
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This example illustrates the fields and controls on the Grading Basis Exception Rule page. You can find
definitions for the fields and controls later on this page.

Grading Basis Exception Rule

Academic Institution: PSUNY PeapleSott University =

Grading Basis Mapping Rule: UGRAD

*Effective Date: 01/0111900 = Status: | #ctive 7]

*Description: Lindergraduate Mappinas

*Short Description: Undergradu

Grading Basis Mapping Find First E 1-5of 5 E Lazt

*Grading Basis Grading Basis

for Requested Class Mapped for Student
CMNC' QL cygmocrg | Grading Basis is Invalid PNP QL ppp (=]
GRD Q, Graded I Grading Basis is Invalid GRD Q Graded [#[=]
FMP Q it I Grading Basis is Imvalid PHP Gy PiNP =]
sUs Q@ SatiUnsat I™ Grading Basis is Imvalid PHP O PiNP =]
TRM T Transfer ¥ Grading Basis is Imvalid (=]

First E 1of 1 |I| Last

Find | wigw &l

If grade bases are variable at your institution, you should define grade basis mapping rules. When
students in one academic program or career enroll in classes in another program or career (that have a
different grade basis), the system uses your grade basis mapping rules to convert grade basis values to
those that are appropriate for the students' careers and programs.

Grading basis rules designate any and all schemes for grading, including the grade points for each grade.

You link grading basis exception rules to career pointer exception rules. Career pointer exceptions are

linked to academic programs.

Grading basis exception rules are keyed by academic institution.

Field or Control Description

Effective Date Enter an effective date for this mapping rule.

Status Enter a status for this mapping rule. Enter Active when adding
a new mapping rule. Enter /nactive only if your institution no
longer uses the mapping rule.

Note: If you inactivate the grading basis mapping rule, you
must also remove it from the Career Pointer Exception page.

Description Enter a description for the mapping rule.

Short Description Enter a short description for the mapping rule.
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Field or Control

Description

Grading Basis for Requested Class

The grading basis from which you are mapping. Grading basis
values are defined on the Grading Scheme Table page.

Warning! 1If a student attempts to enroll in a mapped cross-
career course and the student selects a grade basis that you did
not specify in the Grading Basis for Requested Class field as
eligible for remapping, then the system considers their request
invalid and denies the enrollment request.

Grading Basis is Invalid

Select to invalidate the grading basis. In the preceding
example, the Transfer grading basis is invalid. Students cannot
select the Transfer grading basis for classes with this mapping
rule.

Grading Basis Mapped for Student

The grading basis to which you are mapping. In our example,
when an undergraduate student enrolls in a graduate class
with a grading basis of Satisfactory/Unsatisfactory, the system
converts their grade basis to Pass/No Pass. Grading basis
values are defined on the Grading Scheme Table page.

Note: When a student enrolls, the mapped values appear prior
to posting the enrollment, regardless of whether the student

is using Campus Solutions Enrollment Request, Enrollment,
Quick Enroll, or Student Self Service Enrollment.

Grade Basis Mapping Example

To understand how the enrollment engine determines the grade basis for a particular enrollment, look at
how the system determines whether a student can enroll in a class that is not in the student's career. For
example, Michael Holt, an undergraduate, wants to enroll in Marketing 500 in the Graduate Business

career.
Michael's Career Requested Class Course's Career Grading Basis of Expected Grading
and Program Basis
Course
Undergraduate/liberal | Marketing 500 Graduate Business Satisfactory/ Pass/No Pass (PNP)
arts undergraduate Unsatisfactory (SUS)
(LAU) program

500
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When Michael tries to enroll in Marketing 500, the system first looks at the Career Pointer Exception
Rule field on the Academic Program page for Michael's academic program (LAU).

Academic Program Standing/Honors Taxonomny Repeatincomplete Enrollment
Academic Institution: PSUMNY  PeopleSoft University
Academic Program: LALl
First E 1 af 1 El Last
“Effective Date: o7ioTHe0n [ sStatus: | Active -] (=l
*Description: |Lihera| Arts Undergraduate
*Short Description: Lib Arts First Term Valid: W Q Begin Term
*Academic Career: m Q Undergraduate
Grading Scheme: WO\ Lindergraduate Grading Scheme

GB Default for Transfer Credit: |GRD <4 Graded
Default Grade- Transfer Credit; |T Q Transfer

*Academic Group: m Q College of Liberal Ars

*academic Level Rule: UGRD QU dergraduate

*Academic Calendar: w Q Undergraduate Semester Cal
Dual Academic Program: l— Q

Default Academic Plan: UMNDECLUG & Undeclared Undergraduate
Default Campus: IMQ Walnut Creek Campus

*Transcript Level: I Official hd |

Career Pointer Exception Rule: |L/BARTS QU Liberal Arts Exceptions
¥ Onilyif Outside Career

If the field is cleared, grading basis mapping does not occur. Instead, the system looks at the Academic
Career Pointers page to determine whether the student is eligible to enroll in the class. If enrollment is
allowed, the system pulls from the course grading scheme as determined by the academic career that
is noted on the Course Catalog - Offerings page. However, in our example,LIBARTS is selected in the
Career Pointer Exception Rule field. Therefore, the system uses the LIBARTS exception rule on the
Career Pointer Exception Rule page.

This example illustrates the Career Pointer Exception Rule page as explained above.

Career Pointer Exception Rule

Academic Institution: PEURNY FeopleSoft University
Career Pointer Exception Rule: LIBARTS
*Effective Date: 017011800 [z rStatus: |Actwe ~| =
‘Description: |Liberal Arts Exceptions
*Short Description: Lib Arts
Course Requested Fired First (1 1.2 of 2 O] st
*Academic Group Subject Area Catalog Nbr *Allow Enroliment  Grading Basis
Mapping Rule
LBART QL MATH Q [z00 [res =] [usraD @ =]
LBART Q@ MATH Q [400 [Fermission =] [usraD Q =]
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The system searches the Course Requested group box for rows that match the class in which the student
is enrolling. In our example, Michael Holt is trying to enroll in Marketing 500. The system looks at the
Academic Group, Subject Area, and Catalog Nbr (catalog number) fields. The catalog number of the
requested course must be equal to or greater than the catalog number on this page. Because Marketing
500 is in the MGMT academic group and the Marketing subject area, and it is greater than or equal to 500,
the system allows Michael to enroll in the class with permission. The system then maps the grading basis
to the student's career or program using the value in the Grading Basis Mapping Rule field (UGRAD).
Grading basis mapping rules are defined on the Grading Basis Exception Rule page.

This example illustrates the Grading Basis Exception Rule page as explained above.

Grading Basis Exception Rule

Find | vieww &1 First (U 1 o 1 ] Last

Academic Institution: PSUNY PeopleSoft University =

Grading Basis Mapping Rule: LIGRAD

*Effective Date: 01/01/1900 [ Status: | Petve 7]

*Description: Undergraduate Mappings

“Short Description: Undergradu

Grading Basis Mapping Fing Fir=t E 1-5cf 5 |I| Last

*Grading Basis Grading Basis

for Requested Class Mapped for Student
CNG Crdito Crd ™ Grading Basis is Invalid PHP Q PINP =]
GRD @ Gradad I™ Grading Basis is Imvalid GRD @ Gradad [*#[=]
FNP @ PP I™ Grading Basis is Invalid PNP & BIMP =]
BUS Q SatUnsat I™ Grading Basis is Invalid PNP Q O =]
TRN THEmnETD I Grading Basis is Invalid =l

The system uses the values on this page to determine how to map each grading basis. Because the grading
basis for the requested class is SUS (satisfied/unsatisfied), the system maps to PNP (pass/no pass).
Therefore, Michael's grading basis appears as PNP on enrollment pages.

The system maps the grading basis when you exit the Class Input field.

Special Note About the Elective Grading Basis

When a student attempts to enroll in a class outside of the student's career and the class is offered with

a grade basis for which the Elective Grade Basis check box is selected, the system presents the student
with the student's grading basis choice and a corresponding grade basis convert to value. Each of the pre-
mapped choices is set up in the Grade Scheme table under the career of the class and under the elective
grade basis. Because students in this cross-career enrollment situation can be exposed to grade bases

that are outside of their career, it is essential that you set up remapping rules that accommodate each of
the possible grade bases from which a student may choose. Insert rows to accommodate all possibilities
in the grading basis for the Requested Class field on the Grading Basis Exception Rules page. You do
not need to insert rows for grade bases that are invalid, but you can do so. In these situations, select the
Grading Basis is Invalid check box. For elective grading bases, you must add a row for the elective basis
(for example, if OPT, then convert to OPT), for individual grade bases that make up the elective (OPT)
grading basis (for example, if SUS, then convert to PNP), and so on.
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Running the Grade Basis Exception Report

Access the Grade Basis Exception page (Set Up SACR > Product Related > Student Records >
Reports > Grade Basis Exception > Grade Basis Exception).

Field or Control

Description

Academic Institution

The academic institution for which you are reporting. The
system populates this field. You can change the value.

As Of Date

Enter an as of date to report on all grade basis exception rules
that are active as of this date. Normally, you enter a date that is
the start of the term or term enrollment period.

Creating Grade Rosters for a Single Class

Access the Grade Roster Type page (Curriculum Management > Grading > Grade Roster >

Grade Roster Type).

This example illustrates the fields and controls on the Grade Roster Type page. You can find definitions
for the fields and controls later on this page.

Grade Roster Type

Grade Eoster

CowrsellD: 001276

Catalog: MATH
Use Blind Grading

Foundations of Higher Math
100

*Description

1 Mid-Term Grade | |Mid-Term Grade
2 Final Grade + | [Final Grade

Offer Nbr: 1

Class Section: 1
1182
Final Roster

Class Nbr:

roval Status

Mot Reviewed  w
Mot Reviewsed v

FeopleSoft University
2006 Fall

Regular Academic Session

Grading Status

"] Create =]
Grade Input
i O Create| Paost | [#] [=]

Field or Control

Description

Grade Roster Type Enter the type of grade roster that you want to generate. Grade
roster type values are delivered with your system as translate
values. While you should not change the Final Grade value,

you can add as many nonfinal grade values as you want.

Description The system provides the grade roster type description, taking it

from the translate table. You can change this value.
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Field or Control

Description

Approval Status

Values for this field are delivered with your system as
translate values. Do not modify these values in any way. Any
modifications to these values require substantial programming.
Values for approval status are Not Reviewed, Ready for
Review, and Approved.

The system does not permit you to post grade rosters that have
an approval status of Not Reviewed or Ready for Review unless
you select the Partial Post check box.

Note: You can save the data and make changes to the grades.
After you approve and post, however, you must make any
grade revisions on a student-by-student basis using one of the
enrollment pages.

Final Roster Grading Status

The system populates the Final Roster Grading Status field
based on the approval status for the class.

Override

Select this check box and click the Create button to delete
the previous grade roster and generate a new one for the class.
If you do not select this check box and just click the Create
button, the system appends any new students to the existing

grade roster.

Partial Post

Select to manually enter and post grades for a class section,
save it, and return later to finish entering and posting grades.

Note: Although you cannot approve the entire grade roster
until you enter all grades, if you select the Partial Post check
box, the system posts all grades that you entered to those
students' records.

Posting Date

The system displays the posting date when the grade roster
post process finishes.

Create

Click to create the grade roster. Go to the Grade Roster page to
enter grades.

Post

Click to post the final grades to the grade roster after you enter
them. The system changes the status on the Grade Roster 1
page to Posted. The system does not permit you to post grade
rosters that have an approval status of Not Reviewed or Ready
for Review unless you select the Partial Post check box.

Creating Grade Rosters for Multiple Classes

Access the Create Grade Rosters page (Curriculum Management > Grading > Create Grade

Rosters).

504
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This example illustrates the fields and controls on the Create Grade Rosters. You can find definitions for

the fields and controls later on this page.

Create Grade Rosters

Fun Control ID: PSS

Report Manager

Process Monitor Run

‘Acadermic nstitution: PSUNY "| PeopleSoft Univarsity

Term: 0620 O 2009 Spring

Class End Date | Class End Date Academic

Organization

Twelve Wk w (02062008 [ (032012000 [5) LIBARTS Q| Final Grade v [No v| 13 =

“Override Existing

Field or Control

Description

Academic Institution

Enter the academic institution for the grade roster process.
This value controls the type of data that is available in the
remaining fields.

Term Enter the term for the grade roster. Term values are defined on
the Term Table page.
Session

Enter the session for the grade roster. The session value is
optional. Use it to limit your roster production to a single
session within the specified term. Session values are defined
on the Session Table page.

Class End Date From and Class End Date To

Select the class end date from and to dates. The system selects
rosters to create for classes with an end date that is greater than
or equal to the value in the Class End Date From field and less
than or equal to the value in the Class End Date To field. Both
fields are optional and one may be entered without the other.

Academic Organization and Subject Area

Enter the academic organization or subject area for which to
produce the rosters. You can enter the academic organization
or subject area, but not both. If you enter an academic
organization, the Subject Area field is unavailable for

entry. Conversely, if you enter a subject area, the Academic
Organization field is unavailable for entry. Academic
organization values are defined on the Academic Organization
Table page. Subject area values are defined on the Academic
Subject Table page.

Grade Roster

Enter the type of grade roster that you want to generate. Grade
roster values are delivered with your system as translate
values. While you should not change the Final Grade value,
you can add as many nonfinal grade values as you want.
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Field or Control

Description

Override Existing Grade Roster

Available values are:

Yes: Enter to delete and override any preexisting grade rosters
when you run the Create Grade Roster process, regardless of
whether you selected the Override Grade Roster check box
on the Grade Roster Type page.

No: Enter to retain all prior grade rosters when you run the
Create Grade Roster process, regardless of whether you
selected the Override Grade Roster check box on the Grade
Roster Type page. The system produces rosters only for those
classes for which rosters have not yet been generated and
appends any currently enrolled students who are not on the
original roster.

Total

If you selected a grade roster type of MidTerm, this field
becomes available. The system enables you to create as many
rosters as you need for each class, as long as it is not a Final
Grade roster type. Enter the total number of non-final grade
rosters that are needed for each class in the Total field.

Run the PSJob SRPCGPR. Results of the Create Grade Rosters process appear on the Grade Roster page.
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Setting Up Degrees and Degree Honors

To set up degrees and degree honors, use the Degree Table component (SA_DEGREE_TABLE) and the

Degree Honors Table component (DEGREE_HONORS TBL).

The process of graduating students requires you to set up degrees and degree honors, to update student
program records, and, if necessary, to report and audit degree changes. This section discusses the first
of these requirements in detail. You should also familiarize yourself with the PeopleSoft Academic
Advisement application, an important and automated precursor to approving students for graduation.

This section discusses how to:
* Define degrees.
» Attach degrees to academic plans.

* Define degree honors.

Related Links

“Understanding Online and Batch Advisement Transcript Reports” (Academic Advisement)

Pages Used to Set Up Degrees and Honors

Page Name Definition Name Navigation Usage

Degree Table SA DEGREE TABLE Set Up SACR > Define both internal
Foundation Tables > and external degrees for
Academic Structure > PeopleSoft Recruiting and
Degree Table > Degree Admissions and Student
Table Records.

Academic Plan Table ACADEMIC PLAN TBL Set Up SACR > Define a degree for each
Foundation Tables > academic plan.
Academic Structure >
Academic Plan Table >
Academic Plan Table
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Page Name Definition Name

Navigation

Usage

Degree Honors Table DEGREE HONORS TBL

Set Up SACR > Product
Related > Student
Records > Student
Standing and Awards >
Degree Honors Table >
Degree Honors Table

Define degree honors for
your institution. Example
degree honors might be with
Distinction, Highest Honors
in, and Summa Cum Laude.

Student Records shares

this page with Recruiting
and Admissions because
admissions staff may need to
track external degree honors
of applicants.

Defining Degrees

508

Access the Degree Table page (Set Up SACR > Foundation Tables > Academic Structure >

Degree Table > Degree Table).

This example illustrates the fields and controls on the Degree Table page. You can find definitions for the

fields and controls later on this page.

Degree Table

Degree: BA

04/01/1900 |[H]

*Effective Date:

Find | View Al

*Status:
*Description: |Ela|:helnrnf.i\rts
Short Description: lEl-*ai

First n 1 of 1 u Last

Formal Description: |Ela|:helnr of Arts

Internal Degree

Years Of Education: l_

Education Level: |

QL
NZVCC Qualificatn Degree Code: Q

’7
’EC{ Bachelors

Previous Degree Type:

*Prospectus Code:

Qualification Award Category:

Report to MoE - SOR

[+ [=]
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Field or Control Description

Status Select a status for this degree. Select Active when the degree
is valid for your institution. You can keep all degrees in the
database for historical purposes by setting any degrees that
you no longer award to Inactive.

Description, Short Description, and Formal Description Enter descriptions of the degree. Later, you can identify which
description appears on the transcript.

Internal Degree Select to indicate that the degree is internal to your institution
and that it does not represent a degree from another
organization.

Years of Education No programming is tied to this field; use it for informational
purposes only.

Educational Level No programming is tied to this field; use it for informational

purposes only. Values for this field are delivered with your
system as translate values. You can modify these values.

(NZL) NZVCC Qualificatn Degree Code (New Zealand Enter the NZVCC qualification code for this degree. The
Vice Chancellors Committee qualification degree code) system uses this value when generating the Graduate
Destinations Survey report.

This field is available only when you select the NSI and SDR
Personal Data, SDR Degree check box on the SA Features
page on the Installation table.

(NZL) Prospectus Code Enter the Ministry of Education (MoE) identifier. The system
uses this value when generating the Qualification Completion
file.

This field is available only when you select the NSI and SDR
Personal Data, SDR Degree check box on the SA Features
page on the Installation table.

(NZL) Qualification Award Category (Optional) No programming is tied to this field; use it for
informational purposes only. Values for this field are delivered
with your system as translate values. You can modify these
values.

This field is available only when you select the NSI and SDR
Personal Data, SDR Degree check box on the SA Features
page on the Installation table.

(NZL) Report to MoE - SDR (report to Ministry of Select to include students awarded this degree in the
Education - Single Data Return) Qualification Completions file.

This field is available only when you select the NSI and SDR
Personal Data, SDR Degree check box on the SA Features
page on the Installation table.
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Related Links
Processing SDR Extracts

Attaching Degrees to Academic Plans

Access the Academic Plan Table page (Set Up SACR > Foundation Tables > Academic
Structure > Academic Plan Table > Academic Plan Table).

A student who is active in a program with more than one plan can potentially receive more than one
degree when you set the student's degree checkout status to Approved and click the Update Degrees
button on the Student Degrees page. Conversely, if a student has multiple plans under one program, and
each of those plans is associated with the same degree, then the student receives only one degree when
you set the degree checkout status to Approved and click the Update Degrees button on the Student
Degrees page.

This is important to consider when you are setting up degrees for plans that are linked to the same
program and in which students may have two or more of such plans under a single program at a given
time. This is also important to consider when setting up double majors. For example, if you have a
particular double major combination, for which you want only one degree, you may want to create two
separate plans to represent each major but tie the double major degree to only one of the plans. Or you
may want to create one plan that represents the double major. For students who attempt a degree with only
one of these two majors, you would assign a different plan to them, with a slightly different degree. For
example, instead of a bachelor of science degree in architecture and engineering, you might also create

a degree that is a bachelor of arts in architecture, a degree that is a bachelor of science in architecture,
and yet another degree that is a bachelor of science in engineering. Of course, you must also consider the
effect that plan assignment has on your academic advisement setup and the way that you define plan- or
program-based requirements.

Related Links
“Defining Academic Plans” (Campus Solutions Application Fundamentals)
Defining Degree Honors

Access the Degree Honors Table page (Set Up SACR > Product Related > Student Records >
Student Standing and Awards > Degree Honors Table > Degree Honors Table).

Note: The Degree Honors Table page differs from the Honors/Awards Table page in that it relates to only
internal degrees, plans, and subplans.
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Field or Control

Description

Honor Type

The type of honor and where it appears on the transcript.

For example, an honors type of Degree Plan Suffix indicates
that the honor appears on the transcript after the degree plan.

Honor type choices are Degree Prefix, Degree Suffix, Degree
Honors, Degree Plan Prefix, Degree Plan Suffix, Degree Sub-
Plan Prefix, and Degree Sub-Plan Suffix. Values for this field
are delivered with your system as translate values. Do not
modify these values in any way. Any modifications to these
values require a substantial programming effort.

Status

Select a status for the degree honor. Select Active when adding
a new degree honor. Select Inactive only if your institution will
no longer use this degree honor.

Formal Description

You can set up your transcript type so that the formal
description prints on the diploma and transcript.

Print on Diploma

No programming is tied to this field; use for informational
purposes only.

Print on Transcript

Select this check box to display the formal description of the
degree honor on the transcript.
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Understanding Transcript Levels

Important! The COBOL transcript process is a deprecated product. It is strongly recommended that you
use the Application Engine transcript process instead. For more information on the Application Engine
transcript process, see Understanding Transcript-Related Processes.

On various pages throughout your Student Administration system, you are prompted to select the
transcript level for which you want to print information. The transcript level you select determines the
type of transcript on which the information appears. Transcript levels are hierarchically based on the two-
digit numeric code in the value column of the translate table for the field TRANSCRIPT LEVEL. The
following table lists the transcript levels and their values in the translate table, and describes each one.

Note: Information in the table about the Advising Report applies only if you set up for COBOL based
transcripts, using the Transcript Type component (TSCRPT _TYPE).

Transcript Level Value Description

Not Print 00 Do not print the information on any
transcript.

Official 20 Print the information on the official

transcript, the unofficial transcript, and
the student life transcript.

Includes all information that is flagged
throughout the system as Official,
Unofficial, Student Life, and Degree
Progress. Can include an Advising
Report if you select the Advising Report
or Special Advising Report check box.

Unofficial 40 Print the information on the unofficial
transcript and the student life transcript.

Includes all information that is flagged
throughout the system as Unofficial,
Student Life, and Degree Progress.
Can include an Advising Report if you
select the Advising Report or Special
Advising Report check box.
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Transcript Level Value Description
Stdnt Life (student life) 60 Print the information on the student life
transcript.

Includes all information that is flagged
throughout the system as Student Life
and Degree Progress. Can include

an Advising Report if you select the
Advising Report or Special Advising
Report check box.

Degr Prog (degree progress) 80 Print the information on the degree
progress transcript, which can include
academic advisement information in
addition to a transcript.

Does not include a transcript. Includes
an Advising Report only if you select the
Advising Report or Special Advising
Report check box. The advising report
is ordered and evaluated for each student
by career.

When you generate transcripts, the system includes the applicable information for all transcripts types
with a value on the translate table greater than or equal to the transcript level you select. For example,
if you select Official, the system includes the applicable information on all transcript types. However, if
you select Stdnt Life, the system only includes the applicable information on student life transcripts and
degree progress transcripts.

Transcript level values are delivered with your system as translate values. Do not modify these values in
any way. Any modifications to these values require a substantial programming effort.

Defining Transcript Type Security

You can assign different levels of transcript type security to each user in your organization. Transcript
type security authorizes users who have access to the transcript request pages to create transcript requests
only for those transcript types for which they have security.

Related Links

“Setting Security for Transcript Types” (Campus Solutions Application Fundamentals)

Creating Transcript Notes

514

To set up transcript notes, use the Transcript Notes Table component (TSCRPT NOTES TBL).

Use the Transcript Notes Table page to define transcript notes that can appear alongside a particular
student enrollment record. Transcript notes only print on a student's transcript when you both attach the
predefined note to an individual student's enrollment record and process a transcript type for which the
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Print Transcript Note check box is selected. Typically, transcript notes are generic enough that they can
be reused for multiple students' enrollment records. You can attach notes to a student's enrollment record
using either the Transcript Note link on the Enrollment Request page or the Transcript Note fields on
the Student Enrollment 3 page.

Related Links

Understanding Class Enrollment Processing

Page Used to Create Transcript Notes

Page Name Definition Name Navigation Usage

Transcript Notes Table TSCRPT _NOTES TBL Set Up SACR > Product | Define transcript notes.
Related > Student
Records > Transcript >
Transcript Notes Table >
Transcript Notes Table

Defining Transcript Notes

Access the Transcript Notes Table page (Set Up SACR > Product Related > Student Records >
Transcript > Transcript Notes Table > Transcript Notes Table).

Field or Control Description

Effective Date Enter an effective date for this transcript note. The effective
date defines when the status you select is valid.

Status Select a status for this transcript note. Select Active when
adding a new transcript note. The /nactive option should only
be used if your institution will no longer use this transcript
note.

Description The description is used for system related display purposes
only. The description does not appear in the transcript.

Short Description The short description is used for system-related display
purposes only. The short description does not appear in the
transcript.

Transcript Note Sequence Nbr (transcript note sequence The transcript note sequence number enables you to create

number) multiple note lines under one note ID. When you select a

transcript note to appear on a transcript, all notes under the
note ID appear.
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Field or Control Description

Transcript Note Enter the transcript note in the free-form text field. This text
appears on the student's transcript when you both attach the
note to a student's enrollment record and process a transcript
type for which the Print Transcript Note check box is
selected.

Creating Transcript Text

Important! The COBOL transcript process is a deprecated product. It is strongly recommended that you
use the Application Engine transcript process instead. For more information on the Application Engine
transcript process, see Understanding Transcript-Related Processes.

Use the Transcript Text page to define transcript text for a specific student. Unlike transcript notes, which
are predefined and attached to students on the enrollment request pages, transcript text is created for

a specific student and is not necessarily associated with a specific enrollment record. After you create
transcript text for a student, it always appears on transcripts with the transcript type you specify, or on a
transcript that is at or above the transcript level you specify. No options at the transcript type setup level
enable you to inactivate or hide transcript text. You can limit when and how the transcript text appears by
using the filtering options on the Transcript Text page to specify valid transcript types, levels, and relative
positions for the transcript text.

Page Used to Create Transcript Text

Page Name Definition Name Navigation Usage

Transcript Text TRANSCRIPT TEXT Records and Enrollment > | Define transcript text for a
Transcripts > Transcript | specific student.
Text > Transcript Text

Defining Transcript Text

Access the Transcript Text page (Records and Enrollment > Transcripts > Transcript Text >
Transcript Text).
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This example illustrates the fields and controls on the Transcript Text page. You can find definitions for

the fields and controls later on this page.

Transcript Text

David Loshell

Academic Career: UGRD Undergraduate

*Institution: PSUNY v PeopleSoft University

SRTS0001

: +
*Print Loc Seq: 1 *Relative Position: *Print Location: | Academic Program g | =

Find | View All First n 10of1 u Last

Find | View All First 4] 10of1 n Last

: =]
*Text Seq Nbr: |-1_ Transcript Level:

Transcript Report

Transcript Type: a

Transcript Text:

Transcript Report COBOL
Transcript Type: Q
Transcript Text

Field or Control

Description

Print Loc Seq (print location sequence)

Enter the print location sequence to identify the order in which
notes appear within a print location. The default is /, and each
additional row increases by one.

Relative Position

Select the relative position of the note within the chosen print
location. You are prompted from the translate table. Values for
this field are delivered with your system as translate values.
Do not modify these values in any way. Any modifications to
these values require a substantial programming effort.

Values include:

After: Select this value if you want the transcript text to appear
immediately after the specified print location sequence.

Before: Select this value if you want the transcript text
to appear immediately before the specified print location
sequence.
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Field or Control

Description

Print Location

518

Enter the print location of the text. Print location values
are delivered with your system and you can view them on
the Print Area Table page. Modifying these values requires
programming effort. The system uses this value in conjunction
with the relative position value to determine where to print
the transcript text. If the Transcript Type or Transcript Level
that you specify is associated with a transcript type that has
the Print Location set to Do Not Display, then the transcript
text does not appear on the transcript. The transcript type setup
is the overriding rule. Print Location values are: Academic
Program, Academic Standing, Cumulative Stats, Degrees -
External, Degrees - Local, Enrollment, Milestones, Student
Personal Data, Term Honors, Term Statistics, Transcript
Print Date, Transcript Recipient, Transcript Request Reason,
Transcript Requester, Transfer Credit - Courses, Transfer
Credit - Others, Transfer Credit - Tests, and Withdrawal Info.

Note: Transcript text associated with a print location of
Academic Program appears on the transcript only if the
associated transcript type is configured such that the academic
program prints in the Transcript Header. To review a particular
transcript type's setup data, access the Transcript Type -
Program page.

Note: Transcript text associated with a print location of
Institution Data appears differently on transcripts printed
through Crystal than it does on transcripts you view online.
Transcripts printed through Crystal always display institution
data in a reserved area in the header of the transcript (upper
left corner). This reserved area has a limited number of lines
of text. For this reason, we have inactivated the Institution
Data value. Any transcript text created with a print location of
Institution Data prior to PeopleSoft Student Administration 8
remains in the database, and print as always. However, no new
entries with a print location of Institution Data can be made.
To review the setup data for a particular transcript type, access
the Transcript Type - General page.

Note: Transcript text associated with a print location of
Student Personal Data does not appear as expected for
transcript types for which student personal data is set to print
in the page header. This is because the page header has a
limited number of text lines available for printing. Therefore,
transcript text associated with student personal data and a
transcript type with student personal data printing in the page
header, will instead print the transcript text in the first lines of
text in the body of the transcript. To review the setup data for a
particular transcript type, access the Transcript Type - General

page.
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Field or Control

Description

Note: Transcript text for all types of Transfer Credit must be
associated with a transfer model. Because the model can be
applied to multiple articulation terms, the effect on printing
associated with transcript text is significant. Therefore,
transcript text associated with a transfer credit model can be
printed successfully only when the transfer credit is configured
to print in the transcript header or transcript trailer. Transfer
credit that is configured to print in the enrollment detail or
enrollment trailer does not display any associated transcript
text. To review the setup data for a particular transcript type,
access the Transcript Type - Transfer/Test/Other Credits page.

Institution

Enter the institution for which you want to create the transcript
text. The institution value determines which transcript types
are available in the Transcript Type field.

Model Nbr (model number)

Based on the print location you select, the system prompts you
for additional information. For instance, if you select a print
location of Transfer Credit - Courses, the Model Number
field appears. If you select a print location of Milestones, the
Milestone Number field appears, and so on.

Text Seq Nbr (text sequence number)

The system populates the text sequence number to / by
default. You can insert text rows and increase the text
sequence number. The sequence number determines the order
of printing on the student's transcript before or after a print
location.

Transcript Level

Select either a transcript level or a transcript type, but not both.
Select a transcript level to determine the types of transcripts on
which the system includes this transcript text.

Depending on the transcript level you select, the system prints
the transcript text on transcript types set to the same level, and
all other greater numbered transcript types on the translate
table. For example, if you select Official for your transcript
level (which has a level value of 20 in the translate table), the
system prints the transcript text on all transcript types that
have transcript levels of 20 to 80. However, if you select Stdnt
Life for your transcript level (which has a level value of 60 in
the translate table), the system prints the transcript text only on
those transcript types where the transcript level is set to Stdnt
Life or Degr Prog (degree progress), levels 60 - 80. The only
exception to this rule is Not Print.

If you select Not Print, the transcript text never prints.

Transcript Type and Transcript Text

Use the Transcript Report group box for XML transcripts or the Transcript Report COBOL group box for

COBOL transcripts.
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Field or Control Description

Transcript Type Select either a transcript level or a transcript type, not both.
Enter a transcript type if you want the text to appear only on
the type you specify.

Transcript Text Enter your free-form text in the Transcript Text field. This

text appears on the student's transcript.

For XML transcripts, this field is 1000 characters.

Note: If you use the Historical Course Enrollment page for conversion purposes, and want to display
term statistics for those enrollments, use transcript text for those statistics. Otherwise, display summary
statistics that you converted using the transfer credit process.

“Understanding Data Conversion” (Campus Solutions Application Fundamentals)

“Performing Data Conversion” (Campus Solutions Application Fundamentals)

Reviewing Transcript Print Areas

To set up transcript print areas, use the Transcript Print Area Table component (TSCRPT _PRT_AREA).

Transcript print areas are associated with codes that define areas of the transcript on which various types
of transcript data appear. Print area values are delivered with your system as translate values. Do not
modify these values in any way. Any modifications to these values require a substantial programming
effort.

Page Used to Review Transcript Print Areas

Page Name Definition Name Navigation Usage
Transcript Print Area Table PRINT_AREA TABLE Set Up SACR > Product | Review delivered transcript
Related > Student print areas.

Records > Transcript >
Transcript Print Area
Table > Transcript Print
Area Table

Reviewing the Transcript Print Area Table

Access the Transcript Print Area Table page (Set Up SACR > Product Related > Student
Records > Transcript > Transcript Print Area Table > Transcript Print Area Table).

520 Copyright © 1988, 2023, Oracle and/or its affiliates.




Chapter 14 Setting Up Transcripts

This example illustrates the fields and controls on the Transcript Print Area Table page. You can find
definitions for the fields and controls later on this page.

Transcript Print Area Table

*Print Area Sort Print Secondary B o

Code T Print Area Description Short Desc

ED ] a Enrallment Detail Enral Dt [=]
EH 5 1 Enrallment Header Enral Hdr [=]
ET ] ] Enrallment Trailer Enrol Tl [=]
MD MD Dia Mot Display Ma Display [=]
PH 1 Page Header Page Hdr [=]
TH 3 Tranzcript Header Tacrpt Hir [=]
T q Transcript Trailer Taerpt T [=]
Field or Control Description
Print Area Code An acronym that defines the transcript print area.
Sort Print Area, Secondary Print Area The values in these fields determine how the system sorts the

print areas on the transcript.

Description Text used on the Define Transcript Type component to
determine print detail.

Short Desc (short description) Value used internally by system processes. Not visible on any
pages.

Note: The values on the Transcript Print Area Table page are delivered with your system as translate
values. Do not modify these values in any way. Any modifications to these values require a substantial
programming effort.

Defining Transcript Types

Important! The COBOL transcript process is a deprecated product. It is strongly recommended that you
use the Application Engine transcript process instead. For more information on the Application Engine
transcript process, see Understanding Transcript-Related Processes.

To set up transcript types, use the Define Transcript Type component (SSR_TSCRPT_TYPE).

This component enables you to define various types of transcripts for your institution, each type with its
own unique purpose, design, and formality level.
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Note: The pages of the Transcript Type component (TSCRPT_TYPE) still exist in the system:
TSCRPT_TYPE, TSCRPT_CARS, TSCRPT_TYPE GEN, TSCRPT TYPE LOCDGR,
TSCRPT TYPE ENRL, TSCRPT TYPE TRNSFR, and TSCRPT TYPE SORT.

Use this component to set up COBOL-based transcripts.

Prerequisites

Before you can create transcript types, you must create academic careers. In addition, if you want
to create an academic advisement report that references a special requirement usage (one other than

standard), you must create requirement usage values.

Pages Used to Define Transcript Types

Page Name Definition Name Navigation Usage
Basic Data SSR_TSCRPT _TYPE Set Up SACR > Product Define transcript types,
Related > Student associate service indicators,
Records > Transcript > specify transcript levels,
Define Transcript Type > define self-service availability.
Basic Data Typical transcript types
include official, unofficial,
graduate, undergraduate,
NCAA, and continuing
education.
Careers SSR_TSCRPT CARS Set Up SACR > Product For transcript types with a
Related > Student Detail Organization value of
Records > Transcript > by Career, define all possible
Define Transcript Type > careers that this transcript
Careers type can report. When you run
the transcript request process
for this transcript type, the
system generates transcripts.
Transcripts are processed
for each career specified,
that matches a career of the
student.
General SSR TSTYPE GEN Set Up SACR > Product Define the print areas and
Related > Student details about appearance for
Records > Transcript > types of information such as
Define Transcript Type > institution, student, print date,
General and reason.
Degrees/Program SSR_TSTYPE LOCDGR Set Up SACR > Product Define the print areas and
Related > Student details about appearance for
Records > Transcript > academic program related
Define Transcript Type > elements.
Degrees/Program
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Page Name

Definition Name

Navigation

Usage

Enrollment/Statistics

SSR_TSTYPE ENRL

Set Up SACR > Product
Related > Student
Records > Transcript >
Define Transcript Type >
Enrollment/Statistics

Define the print areas and
details about appearance for
enrollment information.

Transfer/Test/Other Credits

SSR_TSTYPE TRNSFR

Set Up SACR > Product
Related > Student
Records > Transcript >
Define Transcript Type >
Transfer/Test/Other Credits

Define the print areas and
details about appearance
for transfer, test, and other
credits.

Test Scores

SSR TSTYPE TEST

Set Up SACR > Product
Related > Student
Records > Transcript >
Define Transcript Type >
Test Scores

Define the print areas and
details about appearance for
test scores.

Special GPA SSR_TSTYPE SGPA Set Up SACR > Product Define the print areas and
Related > Student details about appearance of
Records > Transcript > Special GPAs.
Define Transcript Type >
Special GPA

View Sort SSR_TSTYPE SORT Set Up SACR > Product | Display the sorting order
Related > Student for how the transcript type
Records > Transcript > information appears.
Define Tra